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Tables

Dynamic, multidimensional tables can be created in the STEP Workbench on the Tables tab of product,
classification, and product-override objects. Tables are used to present product information, such as product
names, part numbers, and prices, in a tabular format. Tables are most often used in conjunction with STEP
Publisher for print applications, though tables can also be published to websites.

The configuration options available for tables in STEP are extensive. Tables can display attribute values, assets,
references, commercial data , free text, and more. Since tables support inheritance, a table can be built once and
used for an unlimited number of product presentations. Table layouts and settings can be shared across product,
classification, and product-override hierarchies. Table types can be made dimension dependent to display
different information for different contexts. Because tables are dynamic product presentations, they will
automatically adapt to data changes in the workbench. Additionally, transformations can be applied to tables to
perform simple actions like merging common cells, changing the font size / text style, and applying color to the font
or to the cell, or for advanced transformations such as the Pivot Table Transformation.

The screenshot below shows a very simple table as previewed in STEP. It incorporates STEP names, STEP IDs,
and pricing information. Tables are typically more complex than the sample presented, but even this simple table
employs a table transformation (Alternate Row Colors), font styling, and more than one table rule line.

Paper Hats rev.0.2 - Tables

Commercial Category Profile || Proof View || Status || State Log || Tasks |
Praduct Produck Wariants ” Sub Products || References ” Referenced By " Images & Documents ]
9 Tables
Mame > |Defined At >
> PriCETEt‘E Local
> | Add Table Type
Definition |l
Select version :.ﬁ.crne Party Supplies_comm data config & mounted table/English US - :Select Preview Mode :Current Mode -
Product Name Part No. Price
Chriztmas Party Hat 121184-A Z7.00
Cosmic Party Hat 121177-A 53.90
Pink & Green Party Hat 121171-A %299
Pink & Green Pom-Pom Hat 121183-A $2.99
Politics Party Hats 1211582-A F17.76
Purple & VWhite Party Hat 121178-A 3479
ellow & Pink Party Hat 121178-A $0.29
» * [Transformation * |Parameters »
* [EH Alternate Row Colors Color 1rows "White®™ then 1 "Light Blue®. Restart count after Headings 1,
ﬂﬁ.dd Transzformation

© Stibo Systems - Confidential - STEP Trailblazer 8.3 9
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The following screenshot shows how this table looks on an InDesign page after being mounted using STEP
Publisher.

Product Name Part No. Price
Christmas Party Hat 121184-A 57.99
Cosmic Party Hat 121177-A $3.99
Pink & Green Party Hat 121171-A $2.949
Pink & Green Pom-Pom Hat 121193-A $2.99
Politics Party Hats 121192-A 317.76
Purple & White Party Hat 121178-A 54.79
Yellow & Pink Party Hat 121179-A §5.29

Prerequisites

This documentation section / user guide assumes that users have a working knowledge of STEP.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 10
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Creating Table Types in System Setup

Before a table can be defined on product, classification, or product-override objects in the Tree, the table type
must first be configured in System Setup.

System Setup

EEI--E.. Reference Types
eI Workspaces
-l Table

}% Colors
és’ Rules
% Table Types
Eﬂ Table Row Types
Ei Table Column Types
T o REyS

Setting up a table type involves defining the settings and formatting for table types, column types, and row types.
Table types, column types, and row types must all be defined under a group. Also included in the setup is the
creation of the colors and rules that will be used in the tables.

Note: You can set up table types, column types, and row types in any sequence you want. However, if you start
with no types defined at all, it is recommend that you define column types and row types before you assign them to
atable type.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 11
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Creating Column Types

Column types are used to define how columns will appear in tables, such as what text style, width, background
color, alignment, and rules will appear in columns of a specific type. Before you can define a column type, you must
first define a column type group in System Setup. A column type group is used to store individual column types.

Note: The following instructions assume that you have not set an ID or name pattern on the Table Column Type
Group (ID = table column type group) or Table Column Type (ID = table column type) object types, located under
System Setup > Object Types and Structures > Basic Object Types > Table Column Type Group. To have these
IDs and/or names autogenerate, follow the instructions provided in the Autogenerate using Name Pattern and
ID Pattern topicin the System Setup / Super User Guide documentation.

Defining Column Type Groups

1. In System Setup, go to Table > Table Column Types, then right-click and select Create Column Type
Group.

2. Inthe New Column Type Group dialog, enter an ID and Name for your column type group, then click Create.

82 New Column Type Group

1D PriceTableColumns

Mame |Price Table Columns

3. The dialog closes and the column type group is created.

4. If you need to delete the column type group, right-click it and select Delete. If the column type group contains a
column type, the column type must be deleted first.

Defining Column Types

1. In System Setup, navigate to the desired column type group, then right-click and select Create Column Type.

2. Inthe New Column Type dialog, enter an ID and Name for your row type, then click Create.

3 New Column Type

1D SalesPriceColumn

Mame |Sales Price Column

3. Thedialog closes and the column type is created.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 12
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4. Ifyou need to delete the column type, right-click it and select Delete.

Modifying the Column Type Name

After the column type is created, you can modify the name by entering a new name in the Name field on the
Column Type tab.

System Setup < Normal - Column Type =~

=1/l Table LAl column Type
- 342 Colors
&; Rules Mame »| > |Value >
% Table Types > D stibo. 1776454
--%Tﬁble Row Types >|Name MNormal I
=1L} Table Column Types
? » Defaults Vertical Adjustment:Ti
EI% Price Table Columns Etad STHee AausmenTen
¢ ] column Head * HeadingFooter Normal Row
] Footer > Publication Types All
@ Legal for Table Types
| |Name *

Defaults

Column type settings and formatting definitions, such as text alignment and column width, are applied under
Defaults. See the Configuring Column Type Formatting topic for more information.

Heading/Footer

In the Heading/Footer field, specify whether the column type should be a Normal Row, Heading (1), Sub
Heading (2), or Footer. These column type designations enable table transformations to specify how to handle
the column.

(The term 'Row' is used because columns can function similarly to rows in instances where a table is designed to
display vertically instead of horizontally. In a vertical table, a header 'row' will appear as a column on the far left
instead of a row across the top.)

< Normal - Column Type =~
Column Type

Mame »| » |Value »
> ID stibo. 1776454
» Name Marmal
» Defaults Vertical Adjustment:Top

Heading/Footer MNormal Row ~
» Publication Types
o Heading (1)

Legal for Table Types Sub Heading (2)

Footer

© Stibo Systems - Confidential - STEP Trailblazer 8.3 13
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For example, Heading and Sub Heading 'rows' can be excluded for certain transformations, such as alternate
row shading, where the Heading and Sub Heading rows should remain unformatted. Likewise, if a table is split
across columns or pages when mounted in InDesign, a row designated as a Heading will repeat on the next
column or page.

Publication Types

If the column type should only appear in tables that are mounted on pages connected to specific publication types,
follow these steps:

1. Inthe Publication Type field, click the [...] button. The Select Publication Type dialog box appears. The
dialog displays all the publication types that are available.

33 Select Publication Types

(@) Show In All Publication Types

() Spedify
Induded Excluded

Fufure Publication Tyoes q
Publication

Cancel

2. Leave Show In All Publication Types selected if the column type should be allowed in all publication types.
This is the default setting.

3. Select Specify if the column type should only be allowed in certain publication types. To exclude the column
type from a specific publication type, select the publication type, then click the right-pointing arrow to move the
publication type into the Excluded column.

4. Toensure that the column type is excluded from any publication type created in the future, select Future
Publication Types, then click the right-pointing arrow to move the publication type into the Excluded column.

5. Click OK when complete.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 14
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Legal for Table Types

All column types must be made legal (valid) for at least one table type before the table type can be used to create a
table in STEP. To make a column type valid for a table type, follow these steps:

1. Onthe Column Type tab, expand the Legal for Table Types flipper.
2. Click Add Table Type. The Select Table Type dialog displays.

< Normal - Column Type
Mame »| > |Value
> D stibo. 1776454
» Name Mormal
> Pefauits 33 Select Table Type X
» Heading/Footer
Browse JRECETG i
» Publication Types -
@ Legal for Table Types E% Table Types I_
Name Eﬁ Pivot Tables
5 Elfﬁ Price Tahles -
el |y 1
]| Add Table Type =1 - &[] Sales Price Table
Eﬁ Spedfications Tables
@ Details
Select Cancel

3. Clickthe Browse or Search tab to browse to or search for the desired table type, then click Select.

4. The column type is now legal for the table type.

Removing a Table Type
To remove (unlegalize) a table type, follow these steps:

1. Onthe Column Type tab, expand the Legal for Table Types flipper.
2. Right-click on the arrow to the left of the table type that you would like to remove, then select Remove Table
Type.

? Legal for Table Types

Mame
3 Prira Tahla
[[] Hice B
- Show All Rows

Rotate Table
Add Table Type Ctrl+Plus
Remove Table Type Cirl+Minus

© Stibo Systems - Confidential - STEP Trailblazer 8.3 15
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3. The table type is now removed.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 16
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Creating Row Types

Row types are used to define how rows will appear in tables, such as what text style, height, background color,
alignment, and rules will appear in rows of a specific type. Before you can define a row type, you must first define a
row type group in System Setup. A row type group is used to store individual row types.

Note: The following instructions assume that you have not set an ID or name pattern on the Table Row Type
Group (ID = table row type group) or Table Row Type (ID = table row type) object types, located under System
Setup > Object Types and Structures > Basic Object Types > Table Row Type Group. To have these IDs and/or
names autogenerate, follow the instructions provided in the Autogenerate using Name Pattern and ID
Pattern topic in the System Setup / Super User Guide documentation.

Defining Row Type Groups
1. In System Setup, go to Table > Table Row Types, then right-click and select Create Row Type Group.

2. Inthe New Row Type Group dialog, enter an ID and Name for your row type group, then click Create.

33 New Row Type Group

1D PriceTableRows

Mame |Price Table Rows

3. The dialog closes and the row type group is created.

4. Ifyou need to delete the row type group, select the row type group, then right-click and select Delete. If the row
type group contains a row type, the row type must be deleted first.
Defining Row Types

1. In System Setup, navigate to the desired row type group, then right-click and select Create Row Type.

2. Inthe New Row Type dialog, enter an ID and Name for your row type, then click Create.

8 New Row Type

D SalePriceR.ow

Mame | Sale Price Row

© Stibo Systems - Confidential - STEP Trailblazer 8.3 17
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3. The dialog closes and the row type is created.

4. The row type is ready for use, through in most cases row type settings and formatting definitions will need to be
applied. See the Configuring Row Type Formatting topic for more information.

5. Ifyou need to delete the row type, select the row type, then right-click and select Delete.

Modifying the Row Type Name

After the row type is created, you can modify the name by entering a new name in the Name field on the Row
Type tab.

System Setup <

Normal - Row Type ~pi

Defaults

f& Spec Table Rows

+ Workspaces L] Row Type
=]l Table
@ Mame » | » |value >
- & Colors
& RUIES * ID Etibﬂ. 1.?.?6464

E}-% Table Types 4 Name Mormal

—}- Table Row T

E Eﬁ 2 E_ ow Types "; Defaults Fule Below:0. 5 pt Keep With Next:falze
E]EE Price Table Rows
[m Header » Heading/Footer Mormal Row
[m @I * Publication Types Al

EE}--EE Table Column Types

' Legal for Table Types

Row type settings and formatting definitions, such as text alignment and row height, are applied under Defaults.
See the Configuring Row Type Formatting topic for more information.

Heading/Footer

In the Heading/Footer field, specify whether the row type should be a Normal Row, Heading (1), Sub Heading
(2), or Footer. These row type designations enable table transformations to specify how to handle the row.

Normal - Row Type

Row Type
MName > > |value »
> ID 294741
> Mame Mormal
» Defaults Wertical Adjustment:Top
* Heading/Footer Mormal Row w
* Publication Types
Heading (1)
§ Legal for Table Types Sub Heading (2)
MName Footer
» Price Table
| * |Add Table Type

© Stibo Systems - Confidential - STEP Trailblazer 8.3
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« For example, Heading and Sub Heading rows can be excluded for certain transformations, such as
alternate row shading, where the Heading and Sub Heading rows should remain unformatted. Likewise, if a
table is split across columns or pages when mounted in InDesign, a row designated as a Heading will repeat
at the top of the table in both frames.

« Footer rows are handled similarly by table transformations. For example, the text style or background
shading of Footer rows is typically different than that of the rest of the table. Therefore, Footer rows can be
excluded for certain transformations that apply to the whole of the table but should not apply to the Footer
row.

Publication Types
If the row type should only appear in tables that are mounted on pages connected to specific publication types,
follow these steps:

1. Clickinside the Publication Types field and click the [...] button. The Select Publication Types dialog box
displays. The dialog displays all available publication types.

33 Select Publication Types

(@) Show In All Publication Types

() Spedify
Induded Excluded

Fufure Publication Tyoes q
Publication

Cancel

2. Leave Show In All Publication Types selected if the row type should be allowed in all publication types. This
is the default setting.

3. Select Specify if the row type should only be allowed in certain publication types. To exclude the row type from
a specific publication type, select the publication type, then click the right-pointing arrow to move the publication
type into the Excluded column.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 19
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4. To ensure that the row type is excluded from any publication type created in the future, select Future
Publication Types, then click the right-pointing arrow to move the publication type into the Excluded column.

7. Click OK when complete.

Legal for Table Types

All row types must be made legal (valid) for at least one table type before the table type can be used to create a
table in STEP. To make a row type valid for a table type, follow these steps:

1. Onthe Row Type tab, expand the Legal for Table Types flipper.
2. Click Add Table Type. The Select Table Type dialog displays.

< Normal - Row Type
MName »| » |Value
> ID 294741
> Mame MNormal
> Defaults i
33 Select Table Type
* Heading/Footer

B .
Publication Types Search

@ Legal for Table Typsip| =g} Table Types

Name™ 51 Pivot Tables

E}% Price Tables
om

¢ =-fff] sales Price Table
Eﬁ Spedfications Tables

W

T T

W

Price Table
|* |Add Table Tvpe

W

&+ Details

Select Cancel

3. Clickthe Browse or Search tab to browse to or search for the desired table type, then click Select.

4. The row type is now legal for the table type.

Removing a Table Type

To remove (unlegalize) a table type, follow these steps:

1. Onthe Row Type tab, expand the Legal for Table Types flipper.

2. Right-click on the arrow to the left of the table type that you would like to remove, then select Remove Table
Type.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 20
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? Legal for Table Types
Name

Brira Tahla
Hide B
Show All Rows

Rotate Table

Add Table Type Ctrl+Plus
Remove Table Type Cirl+Minus

—
[
T—

3. The table type is removed.
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Creating Table Types

When you have created at least one column type and one row type, you can define the table group type and
table type itself. The process is similar to creating row types or column types. After creating the table type and
giving it at least one legal row type and one legal column type, you can start using it to create tables in the Tree.

Instructions on how to create legal row and column types are covered in this topic. For information on how to use a
table type to build a table, see the Creating Tables topic in this guide.

Note: The following instructions assume that you have not set an ID or name pattern on the Table Type Group
(ID = table type group) or Table Type (ID = table type) object types, located under System Setup > Object Types
and Structures > Basic Object Types > Table Type Group. To have these IDs and/or names autogenerate, follow
the instructions provided in the Autogenerate using Name Pattern and ID Pattern topic in the System Setup
/ Super User Guide documentation.

Defining Table Type Groups

1. In System Setup, go to Table > Table Types, then right-click and select Create Table Type Group.
2. Inthe New Table Type Group dialog, enter an ID and Name for your table type group, then click Create.

¥ New Table Type Group

1D PriceTables

Mame |Price Tables

3. The dialog closes and the table type group is created.

4. Ifyou need to delete the table type group, right-click it and select Delete. If the table type group contains a table
type, the table type must be deleted first.

Defining Table Types

1. In System Setup, navigate to the desired table type group, then right-click and select Create Table Type.
2. Inthe New Table Type dialog, enter an ID and Name for your table type, then click Create.

32 New Table Type

1D PriceTahle

Mame |Price Table
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Note: The ID for table types has a limit of 33 characters and cannot end with a'$.' For row and column types,
the ID has the usual restriction of 40 characters.

3. The dialog closes and the table type is created.

4. The table type is ready for use, through in most cases table type settings and formatting definitions will need to
be applied. See the next topic in this section, Configuring Table Type Settings and Formatting, for more
information.

5. Ifyou need to delete the table type, right-click it and select Delete.

Modifying the Table Type Name

After the table type is created, you can modify the name by entering a new name in the Name field on the Table
Type tab.

System Setup Price Table - Table Type

Table Type
@ U=zers & Grnups MName > 2 l'."alUE >
..11_ Reference Types * ID stibo, 1775444
"';jj Warkspaces A MName Price Table
B Table
-3 Colors dited by :55:58 by USER 4
@ Rules » Defaults Style:Mormal_L Background:Light Blu. ..
E}"Eﬁ Table Types » Dimension Dependencies
Eﬁ Pivot Tables ———— r - ———
H >
E]Eﬁ Price Tables Pagination Plugin Header Repeating Pagination Plugin
&#1-[ff] Sales Price Table T
Defaults

Table type settings and formatting definitions, such as text alignment and background color, are applied under
Defaults. See the Configuring Table Type Formatting topic for more information.

Dimension Dependencies

Table types can be made dimension dependent if there is free text content within the table that needs to be
translated and/or appear differently in different countries. Since free text only exists within tables (and is not tied to
attribute values), the only way to enable free text content to appear differently in different contexts is to make the
table type dimension dependent.

Note: Attributes used in a table can be dimension dependent even if the table type itself is not. Dimension-
dependent attributes will display different values for different contexts automatically when the table is viewed in a
different context.

To make a table dimension dependent:

1. Double-click inside the Dimension Dependencies field, then click the ellipsis button (...).
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Price Table - Table Type

Table Type

Mame *| > \Value *
* IO stibo, 1776444
* Mame Price Table
» Edited by 2017-10-18 12:55:58 by USER4
» Defaults Style:Mormal_L Background:Light Blue Width:4.0in Rule Abav...
» Dimension Dependendes
» Pagination Plugin Header Repeating Pagination Plugin
- Legal Row Types

2. Inthe Select Dimension Dependencies dialog, check the applicable Dimension checkbox. The number of
available checkboxes is determined by the number of dimensions that have been created in System Setup.

32 Select Dimension Dependencies

Language

Level of difficulty of applying changes: 0

Operation might be time consuming

Cancel

3. Click Apply to complete. The table type is now dimension dependent.

Dimension-Dependent Table Type Example
The following two screenshots show a dimension-dependent table type in two different Contexts.

1. Example with English Free Text values displayed in an English-language Context:
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b#4 Context| English US

Commercial

[ € - C ure 0820025 [F] I EF [l coto [1oieme
per Hats rev.0.1 - Tables

Category Profile || Proof View || Status || State Log || Tasks

> | Prod [}

Product Product Variants ” Sub Products “ References ” Referenced By ” Images & Documents ]
¢ Tables

Name * |Defined At *
> |Price Table Products

> | Add Table Type

Price Table 1 (2 3 > |4 >
Normal Mormal Mormal Normal
[1F Product name | ID Primary Prod... ﬁ Price
1 »|Header 1T name Product Name Part No. Image
2 »|Normal (& Local

2. Example with French Free Text values displayed in a French-language Context:

“ Context :French France

Commercial

~ | € - C ur [d=main 5] [F] i [ [ Goto [1oieme
per Hats rev.0.1 - Tables

Cateqgory Profile || Proof View || Status || State Log || Tasks

* |Proc [

Product Product Variants “ Sub Products “ References ” Referenced By “ Images & Documents ]
? Tables

Name * |Defined At >
> |Price Table Products

> | Add Table Type

Price Table 1 s |2 3 s |4 >
Mormal Mormal Normal Mormal
(1T Mom du produit (1T D Image du Pro...ﬁ Price
1 »Header (1T name Mom du produit | Référence L'image
2 »|Normal & Local

Pagination Plugin

The Pagination Plugin field is where the Header Repeating Pagination Plugin is selected. To choose this

plugin:

1. Onthe table type tab, click in the Pagination Plugin field and select Header Repeating Pagination Plugin.
('None' will appear as the default selection.)
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Price Table - Table Type

MName >| > |Value >
> D stibo. 1776444
> Mame Price Table
» Edited by 2017-10-18 12:55:58 by USER4
» Defaults
» Dimension Dependencies Language;
»| Pagination Plugin Header Repeating Pagination Plugin ~ Change Settings|
© Legal Row Types EI’ Repeating Pagination Plugin
= Legal Column Types

2. Click on Change Settings. The Header Repeating Pagination Plugindisplays.
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32 Header Repeating Pagination Plugin

9_

Minimum Body Rows to Keep With Heading at Bottom of Column
Minimum Body Rows to be Carried Over to Top of Next Column

Minimum Body Columns before a table width split

Minimum Body Columns after a table width split

4
MName >
» [ Add Row Type
i
MName >
* | Add Column Type
4
MName >
» [ Add Row Type
i
MName >
* | Add Column Type
i
MName >
* | Add Row Type

G AftematngRow Colors Setfngs

[+] Enable alternating row colors

[ Restart row count at always repeated headers
[]Restart row count at repeat last headers

[+] Ignore always repeated headers

[]Ignore repeat last headers

[ 1gnore footers

Mormal Colored Rows

II

Alternate Colored Rows
Mormal Color Light Blue "
Alternate Color White "

G TableRuersand Widthsetngs

[+] Use table bottom ruler on splits as bottom ruler.
[+#] Use table top ruler on splits as top ruler.

[+] Use table left ruler on splits as left ruler.

[+#] Use table right ruler on splits as right ruler.

[] Enable table split when wider than frame

] Break before table width split

[oc ]
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Instructions on how to configure the Header Repeating Pagination Plugin are not covered in this topic. For
information, see the Header Repeating Pagination Plugin topic in this guide.

Legal Row Types

Every table type must contain at least one legal (valid) row type before the table type can be used to create tables
in the product or classification hierarchies.

The following steps explain how to add a legal row type to a table type.

1. Onthe Table Type tab, expand the Legal Row Types flipper and click Add Row Type.

2. Inthe Select Row Type dialog, click the Browse tab to navigate to the desired row type(s), then click Select.
Row types may be multi-selected by holding down Shift or Ctrl when making selections.

< Price Table - Table Type
MName >| > |Value

> D stibo. 1776444

> Mame Price Table

» Edited by 2017-10-18 12:55:58 by USER4

W

Defaults 32 Select Row Type

Dimension Dependencies
pe Browse 2

Pagination Plugin

W

W

=)} Table Row Types E
7 Legal Row Types &=+-Ciph Price Table Rows l
Default > [Name i JTT] Header -

0 o Header /’ - {f mormal
O

0] Mo Eﬁ Spec Table Rows B
Add Row Tvpe 1
= Details
@ Legal Column Types I
@ Default Transformations | Select Cancel
&= Resolvable for Product Types

3. Therow types are now legal for the table type.

Removing a Row Type
To remove (unlegalize) a row type, follow these steps:

1. Onthe Table Type tab, expand the Legal Row Types flipper.

2. Right-click on the arrow to the left of the row type that you would like to remove, then select Remove Row
Type.
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Default * [Mame

> (@ Header
] HNarmal

] Hide
Show All Rows
Rotate Table

Add Row Type Ctrl+Plus

@ @ & &[]

| Remove Row Type CtrI+Minu5|

3. The row type is now removed.

Legal Column Types

Every table type must contain at least one legal (valid) column type before the table type can be used to create
tables in the product and/or classification hierarchies.

The following steps explain how to add a legal column type to a table type.

StiboSystems

1. Onthe Table Type tab, expand the Legal Column Types flipper and click Add Column Type.

2. Inthe Select Column Type dialog, click the Browse tab to navigate to the desired column type(s), then click
Select. Column types may be multi-selected by holding down Shift or Ctrl when making selections.

L 4 Price Table - Table Type

Table Type
MName >| > |value
> ID stibo. 1776444
> Mame Price Table
> Edited by _ -
32 Select Column Type
» Defaults
Browse
» Dimension Dependendies -
» Pagination Plugin E--% Table Column Types ~
. - E}% Price Table Columns -
¢ ] column Head
' Legal Column Types ] Footer
Default > [Mame il wormal
>0 Column Head) i Price
S SubHead =
> Mormal m
® o / 51Oy Spec Table Columns— w |
» 0 Pri
|| 2dd Column Type © = 1
@= Default Transformations Select
@ Resolvable for Product Types

3. The column types are now legal for the table type.

Removing a Column Type

To remove (unlegalize) a column type, do the following:
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1. Onthe Table Type tab, expand the Legal Column Types flipper.

2. Right-click on the arrow to the left of the column type that you would like to remove, then select Remove
Column Type.

? Legal Column Types
Default * |[Name

> @) MNormal
=1 Prire
> Hide
Show All Rows
Rotate Table
Add Column Type Ctrl+Plus
IRemcwe Column Type Ctrl+Minus |

2 Q@

3. The column type is now removed.

Default Row and Column Types

If more than one row type or column type is added, a default type must be specified for each. Default column
types are required to use the Create Table From Clipboard option.

Tables created using Create Table From Clipboard are simply 'pasted’ from an external application such as Excel.
Since no prompt appears that asks you to choose which row or column types to use, the system will build the table
using the specified default row and column types.

To define a default row type or column type, simply click the radio button next to the preferred row type and column
type. The default type can be overridden in the table if needed.

7 Legal Row Types

Default * |[Name
> B Header
> @) Mormal

* | Add Row Type

T Legal Column Types
Default * |Name

> @) Mormal
> B Price
* |Add Column Type

See the Creating Tables From the Clipboard topic in this guide for more information.

Default Transformations

Transformations that apply to every table created from a table type are selected from the Default
Transformations area. To apply a default transformation to the table type, follow these steps:
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1. Onthe Table Type tab, expand the Default Transformations flipper and click Add Transformation.

2. Inthe Select Transformation dialog, navigate to the relevant transformation, then click OK.

< Price Table - Table Type

Marme »| > |Value
> D stibo, 1776444
» Name Price Table
» Edited by 32 Select Transformation
» Defaults
» Dimension Dependencies
» Pagination Plugin #-£3 Layout Transformations
@ Legal Row Types I ID:I Sortings

ID:I Formatting
©=Legal Column Types I -3 Transformations
@ Default Transformations

> |

| | Add Transformation

3. Repeat these steps to add additional transformations.

Descriptions of these transformations and instructions on how to configure them are not included in this topic. See
the Table Transformations topic of this guide for more information.

Resolvable for Product Types and Classification Types

Alltable types must be made resolvable for at least one product, classification, or product-override object type
before the table type can be used to create tables in the Tree. 'Resolvable’ essentially means the same thing as
'valid.' Though a table can be built at a higher level in the product or classification hierarchy to take advantage of
inheritance, the table cannot be previewed or mounted in InDesign on any object where it has not been made
resolvable (valid). To make object types valid for table types, follow these steps:

1. Onthe Table Type tab, expand the Resolvable for Product Types and/or Resolvable for
Classification Type flipper.

2. Check the box(es) for the product type(s) and/or classification type(s) where the table should be resolvable.
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Configuring Table Formatting

When you create table types and tables, you can apply formatting rules that determine how the table looks in
InDesign and in the STEP Workbench on the Preview tab.

To format a table, you have to configure the formatting definitions in both STEP and InDesign. In STEP, you
assign formatting rules, and in InDesign the rules are interpreted. For example, if you have specified a light green
background color and a thin border, the actual color and thickness of the border depends on how the master
document is set up in InDesign.

The topics within this documentation section explain how to set formatting on entire tables, rows, columns, and
cells.

Formatting Rules
Table formatting is based on the principle of inheritance.
Formatting inheritance enables you to define table formatting once, then have that formatting apply to all tables of

the specific type. Formatting in tables can be inherited from the default settings applied to the table types, row
types, and column types in System Setup, as well as from higher levels of the product hierarchy.

For example, in System Setup, you have a table type where the row height is set to 10 mm on the row type.
However, on the actual table, you may need the row height to be 9 mm for a particular subset of products. In that
instance, the definition inherited from System Setup would need to be overridden locally.

Inherited tables in the product hierarchy also inherit all formatting applied to the source table defined on the higher
level. In turn, this formatting can be overridden on any table built on a lower level, which localizes the table. See
the Table Inheritance and Suppression topic for more information on the basic principles of table inheritance.

Additionally, definitions are inherited from within the table itself. For example, cells will inherit the formatting
applied to rows and columns; rows and columns will inherit formatting applied to entire tables, etc., and all of these
can be overridden as well.

Selecting Where to Apply Formatting Rules

Formatting rules can be defined generally in System Setup on table types, row types, and column types; and
locally in tables that are built on a specific product, classification, or product-override object.

You can apply table formatting on the following elements:
o Table types
o Column types

« Row types

« Table in product hierarchy
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« Tablerows

« Tablecells

Note: Itis recommended to apply all general formatting rules in System Setup to limit the amount of local
formatting needed on individual tables. This makes it easier for you to gain an overview of all table formatting.
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Configuring Table Formatting in System Setup and
InDesign

Table formatting is used in STEP and InDesign to enable users to format or create their own styles like fonts, text
colors, text styles, text sizes, and different background colors. For rules, users can apply thickness and colors to
the rules. These settings are required for designing tables.

Formatting definitions for STEP Tables are configured in two places: the System Setup tab inthe STEP
Workbench and in publication templates created in InDesign using the STEP'n'design plugin.

Table formatting definitions in STEP are composed of the setups for Colors, Rules, and Style Tags. The
corresponding setups in publication templates are swatches, line styles, and paragraph styles.

_ System Setup

i Structures

=0 Hyperlinks
B¢ Units

- Users & Groups
i-BY, Reference Types
[-3 Workspaces

#-Lp Table Types
-0 Table Row Types
=y Table Column Types
- Keys

The following sections of this documentation explain both the STEP Workbench and the corresponding
STEP'n'design publication template configurations required to format tables.
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Defining Table Colors in STEP

Colors in STEP are used to define the colors applied to rule lines and for the background shading of cells, rows,
columns, and entire tables themselves. These colors are used in the STEP Table Preview view in the workbench
to provide a rough approximation of what the table will look like on the InDesign page.

For these colors to display correctly on the InDesign page, each color used in a table must have a corresponding
color Swatch defined in the publication template that will be used to mount these tables InDesign. For more
information on configuring colors in the publication template, see the Configuring Table Styles in Publication
Templates topic in this guide.

The following steps describe how to create a new colorin STEP.

1. In System Setup, navigate to Table > Colors.

2. Onthe Table Colors tab, click Add Color.

» < Table Colors i
#-[& Object Types & Structures .
IZZI--% Tags
- Units Name v|Color >
% Users & Groups Black
D"E‘_‘g Reference Types Blue
-1 Workspaces
- il pable Grey
2% [Colors ~_|||> Light Blue
o e
% Table Types Magenta
Eﬂ Table Row Types E " Red
51O Table Column Types White

W

W

W

W

W

W

- Keys

- Event Queues N

- Component Models -

4| 1 | b l’ Add Calor

3. Inthe Add Color dialog, enter a name for the new color.
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33 Add Color

Name |Unnamed

Swatches Hsv HSL RGE CMYK

Recent:

OO
|
|

Preview

n - . Sample Text Sample Text

. . . Sample Text Sample Text

Cancel

4. Onthe Swatches tab, select the preferred color.
5. Alternately, you may create a color from one of the four additional tabs:
o HSV (Hue, Saturation, Value)
o HSL (Hue, Saturation, Lightness)
« RGB (Red, Green, Blue)
o CMYK (Cyan, Magenta, Yellow, Black)
5. Click OK.

Note: Even though the Add Color dialog provides fairly advanced options for creating colors, colors created in
STEP are only used to render the color of rule lines and table cells in the STEP Tables Preview. To mount tables
in InDesign with the same color, you must create a corresponding color swatch for your publication template in

InDesign. The name of the color created in STEP and the swatch created in InDesign must match exactly, as both
names are case sensitive.
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Defining Table Rules in STEP

Rules in STEP are used to define the width and color of rule lines used in STEP Tables. Rules are used in the
table Preview view in the workbench to provide a rough approximation of what the table will look like on the
InDesign page. Table rules created in STEP must also have corresponding Line Styles defined in the publication
template through the STEP'n'design Table Settings dialog. The following steps explain how to define a table rule

in STEP.

1. In System Setup, expand Table, then click Rules.
2. Onthe Table Rules tab, click Add Rule.

- Units

% Users & Groups
- B, Reference Types
e,

E

* Workspaces
|-l Table
p-

Fo

T Table Types
fﬁ Table Row Types
5+-Cffj Table Column Types
e Keys
F-ql Event Queues

]ﬁ’_‘,\ﬁ Recycle Bin

E
E
#-[& Component Models
E
4

| 1

(% Object Types & Structures o~
IZZI--% Tags

111

StiboSystems

< Table Rules

HName v|Width > |Calar
* 0.5 pt 0 Black
* 1 pt 1 Black
* 2 pt 2 Black
* Black Dashed 1 pt 1 Black
* |Red Dashed 1 pt 1 Red

I’ Add Rule I

3. Inthe New Rule dialog, enter a Name and Width for the new rule. The width of rule lines are always
measured in points. Select a Color from the dropdown list.

3% New Rule

Mame |Black 2 pt
Width |2

Color |Black v

4. Click Create.

Note: If needed, any of the aforementioned values (Name, Width, and Color) may be changed in STEP after the

rule has been created.
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Considerations and Limitations

Rule Name

The Name of the rule must exactly match the name of a corresponding line style created in the publication
template in InDesign. The name in both locations is case sensitive.

Rule Width

The value entered for Width is a number that defines the width of the rule line in points, which is typically a
number from 1 to 3 (but can be larger if needed). STEP will not accept a number lower than 1 in the Width field,
even if the output for the line in InDesign will be less than 1 pt (for example, 0.25 pt or 0.5 pt).

The Width value entered in STEP is only valid for the table preview, as the preview functionality cannot represent
a line smaller than 1 pt. Due to this, a rule line intended to only be 0.25 pt or 0.5 pt must always display as 1 ptin
STEP. The true display of the rule line in InDesign will be set in the publication template.

Rule Color

The options available in the Color dropdown list are limited to those that have already been created under Table >
Colors in System Setup. The previous section of this documentation, Defining Table Colors in STEP, explains
the process for creating colors in STEP.

Dashed, Dotted, and Other Non-solid Rule Styles

The STEP Table Preview does not support display of dashed, dotted, or other non-solid line styles. Rule lines will
still appear as solid lines in the preview. Non-solid styles are only visible from actual pages created in InDesign.

With this in mind, you may choose to differentiate a dashed rule from a solid rule in STEP by assigning a non-
standard color to the rule line. For example, a bright fuchsia color could be a visual indicator—in the table preview
only—that the rule line is 'different'.
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Defining Style Tags for Tables

Style tags in STEP are commonly used to apply text styling to STEP Tables. Style tags define styles such as bold,
underline, italic, color, left aligned, right aligned, center aligned, and so on. Style tags can be applied at the table,
column, row, or cell level. Typically, each style tag in STEP will match, by name, a corresponding paragraph style
in the InDesign publication template.

Note: The following steps describe how to configure a sample setup for a style tag and tag group intended to be

used for tables; this is not all-encompassing documentation on the subject of tags and style tags. Full instructions
for how to create style tags in STEP are located in the Tags section of the System Setup / Super User Guide

documentation.

Create a Tag Group for Table Style Tags

1.
2.
3.

In System Setup, navigate to Tags > Style Tags.
Right-click and select New Tag Group.

Give the new tag group an ID and Name that identifies the group as a container for tables-only styles, e.g.,
'Table Styles'. Click Create. (This is merely a 'best practices' suggestion—style tags used in tables may be
created in the same tag group as style tags that are used for basic text formatting in rich text editors in STEP.)

32 Create Tag Group

D Tableftyles

Name |Table Styles

Create Cancel

4. Right-click the newly created 'Table Styles' tag group, then select New Tag.

5. Give the new style tag a Name and Tag that indicates its intended output in InDesign. For example, the style

could be named Bold_C to indicate that it is a bold, centered text style. (This is merely a suggestion, as the
value of Name and Tag can be anything you would like as long as there is a matching paragraph style in
InDesign.)

Note: To avoid confusion, it is recommended to give Name and Tag the same value.

Mew Style Tag

Mame |Bold_C

Taa |Bold_C

Cancel
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6. With the newly created style tag selected, click inside the Rendering field on the Style Tag tab, then click the

7.

ellipsis button (...).

System Setup <

Bold C - Style Tag

_.'.|

IZZI--- Workflow Profiles Pl style Tag
0 qukﬂnws 9 Special Character Definition
-{E Derived Events Name 2] > [value N
- Object Types & Structures
=05 Tags MName Bold_C
|_:_| St‘_'flE! Tags . Edited E‘f
=g Table Styles Tag Bold C -
o3| Bold_C = I Rendering The Quick Brown Fox Jumps Over The Lazy Dog
ol Normal_C Show Style No
“-[e3] Normal_L
..... ol bold —| | |[Keyboard Shortcut
----- &l bolditalic List Tag _ o
..... [ Boldred § Output Formatting
..... [3] bullet Format * |Formatting Start * |Formatting Stop *
""" & bulletlist | > | Add Formatting
----- [e3] italic

In the Rendering dialog, make the selections that will approximate the intended look of the style on the

InDesign page, then click Apply.

In this example, the options to display the Bold_C style as 12 pt black Arial Bold have been selected. A

preview of the text is shown at the bottom of the dialog.

Note: The 'Paragraph Style' checkbox is only used for HTML output of style tags that are used to define bullet
lists. For more information, see the Creating Tag Groups and Tags topicin the System Setup / Super

User Guide documentation.

32 Rendering
Style
Font Size On Inherit Off
Text Col
ext Color wic O ® O
Black R
Underine () @ (O
Backaground Color
Inherit w susapt O @ O
Superscript () @ ()
[] Paragraph Style
Prefix List Tag
Preview
The Quick Brown Fox Jumps Over The Lazy Dog
Canc
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8. After the Rendering dialog closes, the view reverts back to the Style Tag tab.

9. Onthe Style Tag tab, select Yes for Show Style.

10.

11.
12.

Note: Selecting No will make the tag unavailable for selection in all dropdown lists available in STEP. No is
only used for 'hidden' styles such as stibo.STIBOSPELL, which is used by the system to highlight spelling
errors in STEP's text editors.

Leave Keyboard Shortcut blank if you intend to use this style only in STEP Tables. Keyboard shortcuts are
only relevant for tags intended for use in STEP rich text editors, since there is no way to use a shortcut to apply
a style tag anywhere inside a table.

Select No for List Tag, since this style tag will not be used to configure the output of bullet lists in HTML.

Output Formatting is not required for style tags created specifically to apply styling to tables. These style tags
are simply matched by Name to a corresponding paragraph style in InDesign.

Limitations of Style Tag Display in the STEP Tables Preview

The STEP Tables Preview will only display text as left aligned, even if the style tag is intended to display centered,
right-aligned, or justified text in InDesign. However, this is merely a limitation of the preview; the text styles will
display correctly when the table is mounted in InDesign.

Note that any settings applied in the Rendering dialog (bold, color, italics, etc.) will display properly in the preview.
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Configuring Table Styles in Publication Templates

To format STEP tables on InDesign pages, a parallel set of formatting configurations must be created in STEP
and InDesign for the following:

« Colors (used both for rule lines and background shading)
« Rulelines
o Textstyles

In STEP, these configurations are the Colors, Rules, and Style Tags created on the System Setup tab. The
corresponding configurations in InDesign are swatches, line styles, and paragraph styles. The InDesign
configurations are created in the InDesign publication template that will be used to mount (generate) tables in
InDesign.

This topic deals only with the table formatting definitions created in publication templates. Full details on how to
configure the corresponding definitions in STEP are outlined in the Configuring Table Formatting in System
Setup and InDesign topic.

Example of a Styled Table in STEP

The following screenshot shows a styled table in STEP as it appears in the STEP Table Preview. The background
colors, rule lines, and text styles have been applied using the settings created in System Setup. In order for the
table to appear with the same colors, text styles, and rule lines in InDesign, the corresponding settings must be
created in the publication template.

Note: If no styles are defined for the table in STEP, the table will be mounted in InDesign with basic InDesign
paragraph styling, and the table must then be styled manually using the standard InDesign table editor. Manual
styling of tables on InDesign pages is discouraged, as formatting not connected to STEP can be easily lost when
tables are updated.
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Select version iAcme Party Supplies/English US

viSeIect Preview MNode

Product Name Part No. Image Product Name Price
Chriztmas Party Hat 121184-A Christmas Party Hat 57.99
o
&
Cosmic Party Hat 121177-A i Cosmic Party Hat $3.99
b
Pink & Green Party Hat 121171-A Pink & Green Party Hat 52.59
F .
-\
&
Pink & Green Pem-Pom Hat  |121193-A Pink & Green Pom-Pom Hat  |32.59
Political Party Hat 121182-A Peolitical Party Hat 217.76
» | » |Transformation * |Parameters ¥

> EH |Alternate Row Colors

Color 1 rows "White" then 1 "Light Blue". Restart count after...

ﬂAdd Transformation

Configuring Table Colors in InDesign

Colors defined in STEP are configured in InDesign as Swatches, as follows:

1. InInDesign, navigate to Window > Color > Swatches (or press F5). The Swatches panel displays.

] c=100 M=0 =0 K=0
B c=0 M=100 v=0 K=D
[] C=0M=0 Y=100 K=D

& Swatches | W[ = |
PH T e % 1=
] IMaone] w A s

. [Registration] % &

[ tPaper

| REEES

[l c=15 M=100 ¥=100 K=0
[ C=75 M=5 ¥=100 K=0
[l C=100 M=30 Y=10 K=0

Mm@ A

2. Click the Options menu in the upper right corner of the Swatches panel, then click New Color Swatch.

3. Onthe New Color Swatch dialog, deselect the Name with Color Value checkbox, then type a name in the
Swatch Name field.

Note: The name of the swatch must be identical to the corresponding color created in STEP. Names of colors
and swatches are case sensitive.
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Mew Color Swatch

Swatch Name: [Light Blug| ]
[C] Name with Color Value

Color Type: | Process ~|
Color Mode: | CMYK ~ |

Cyan 4 |15 | %

Magenta g |? |%

Yellow g 0 | %

Black 4 = 0 | %

Add to CC Library: | My Library | Learn More..,

4. Adjustthe color values as needed, then click OK.

Loading Swatches From Another InDesign Document
To load swatches from another InDesign document:

1. Inthe Swatches panel, click the Options menu, and then click Load Swatches. An Open a File dialog box
displays.

2. Navigate to the InDesign file that contains the swatches that you would like to import, then click Open. (This file
does not have to be another publication template; it can be any InDesign document.)

3. The Swatches from the selected InDesign file will automatically import.

Configuring Table Line Styles in InDesign

Rules defined in STEP are configured as table Line Styles in InDesign via the STEP > Table Settings menu.
Line styles govern the lines (‘borders' or 'rulers') that appear between cells and/or surround the table.

To create line styles in the InDesign publication template:

1. Navigate to STEP > Table Settings. The Table Settings dialog displays.
2. Click Add in the lower left-hand corner. The New Line Style dialog displays.
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Table Settings

Mew Line Style

1pt | Black 0.0417 || 0.0417 | 0.0417 | 0.0694
[

(None J 0.0417 | 0.0417 | 0.0417 | 0.0417

. Populate the fields in the New Line Style dialog as follows:
« Style Name: Name of the line style. Must exactly match the name of the corresponding rule created in
STEP. Is case sensitive.

« Line Weight: Width in points. The measurement unit will always default to points regardless of what
measurement unit is being used for the rest of the page (for example, mm, inches, or picas).

« Line Colour: Color of the line style. An InDesign swatch for the color must first be created in the publication
template before the color will appear in this dropdown list.

« Line Tint: Opacity level of the line style. Default is 100%. Value must be typed.

« Line Type: Specify whether the line style should be solid (most common) or a different style such as dashed
or dotted. The same line styles available in the InDesign Stroke panel are available in the Line Type
dropdown.
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Style Name
Line Weight 1pt
Line Colour ~
Line Tint 100%
Line Type 1
Gap Colour — Colid
Gap Tint Thick - Thick
o s Thjck - Thin

Thick - Thin - Thick
Inset ~ABOVE | 0 Thin - Thick
Inset - Right Thin - Thick - Thin
Inset - Below Thin - Thin

Triple

mm = D3shed (3 and 2)
EE B Dashed (4 and 4)
e Left Slant Hash
s Right Slant Hash
i Straight Hash

® @ @ [Dotted

= Wavy

0 White Diamond

® ® ® & Japanese Dots

m = = D3shed

« Gap Colour: Only applicable for non-solid rule lines. Defines the color that goes in between the dashes,
dots, hashes, etc. The same colors (swatches) that appear in the dropdown list for Line Colour appear in the
Gap Colour dropdown. Leave blank for solid rule lines.

« Gap Tint: Opacity level of the gap color. Defaultis 100%.

« Insets (Left, Above, Right, Below): How much inset space ('padding') should be placed between the
edge of a cell that is bordered by the rule line and the text or image content within the cell. If left blank—or if a
value of 0 is inserted—the insets will default to InDesign's default table cell inset, which is 4 points (or, 0.0556
inches or 1.411 mm).

Note: If you would like no inset padding at all, enter a hairline space value of .0001. The system will recognize
this value as being so close to 0 that there will be no visible inset padding.

4. Click OK when finished. Any values entered during the initial creation of the line style may be edited later if
needed.

Loading Table Line Styles From Another InDesign Document
Toload table line styles from another InDesign document:

1. Navigate to STEP > Table Settings, then click the Import button in the lower left corner of the Table
Settings dialog box.
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Remove

2. AnOpen a File dialog box displays. Locate the InDesign publication template containing the line styles that
you would like to import, then click Open.

3. Theline styles from the selected InDesign file will automatically import.
4. Click OK to complete.

Configuring Paragraph Styles for Tables in InDesign

Style tags created in STEP and applied to tables are configured as paragraph styles in InDesign.

For example: If the tables you are mounting from STEP contain the styles 'HeaderRowStyle' and 'BodyRowStyle',
then there must be corresponding paragraph styles also named 'HeaderRowStyle' and 'BodyRowStyle'. STEP
style tags and InDesign paragraph styles are both case sensitive and must match exactly.

System Setup

-2 Object Types & Structures
EI Tags

L_—_} Style Tags

EI% Table Styles

(g Pivot Table Styles
- [e3] BodyRowStyle
-[e3] Bold_C

<3| BoldHeader

- [¢3] HeaderRowStyle
-~ [3] Mormal_C

-~ [2] Mormal _L

To create a paragraph style in InDesign:

1. InInDesign, navigate to Window > Styles > Paragraph Styles (or press F11). The Paragraph Styles panel
displays.

I’aj I.d Ij4 04$Paragraph5tyla | ro | -
Normal C _;.
-

[Basic Paragraph]

Busllet copry
bold

Bold C
MNormal_L
BokdRed
bokd—BokiRed

© Stibo Systems - Confidential - STEP Trailblazer 8.3 47



SliboSystems

2. Click the Options menu in the upper right corner of the Paragraph Styles panel, then click New Paragraph
Style.

3. Onthe New Paragraph Style dialog, enter a Style Name that exactly matches the corresponding style tag in
STEP.

Mew Paragraph Style

[Same style]

4. Continue configuring the paragraph style as needed, then click OK to complete.

Merge of Row / Column Style Names

In the case where a row with a style applied crosses a column with a style applied, a third paragraph style is
created when the table is mounted in InDesign. The name of this third paragraph style (sometimes called an
'intersection style') is a combination of the name of the paragraph style used for the row and the paragraph style
used for the column, connected by an em dash.

For example, a table may contain a row style called 'bold' and a column style called 'RedBold'. In the cells where
these rows and columns cross over each other, the two styles will overlap. When the table is mounted in InDesign,
the system will automatically create a new paragraph style called 'bold—BoldRed'.
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Style not found - creating:
bold—BoldRed

However, with the system not knowing which of the two paragraph styles to pick up, the newly created
'intersection’ style will appear as a generic (basic) paragraph style.

d |_.I |_.I 5]3 Paragraph Sty... |_

bold—EokiRed

[Basic Paragraph]
Bullet copy

bokd

Bold_C

Normal_L

* \ orma
Price s
BoldRed
bold—BoldRed

$7.99

Note: To avoid the creation of 'intersection’ styles in InDesign, it is recommended to apply text styling at the cell
level in tables where an overlap will occur between row and column styles. 'Intersection’ styles are essentially
duplicates of existing styles and can cause clutter in a long list of paragraph styles.

For more information on applying formatting to STEP Table cells, see the Specifying Local Cell Formatting
topic in this guide.
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Configuring Table Type Formatting

Settings and formatting definitions for table types are applied in System Setup. These formatting definitions are
global, meaning that they will inherit to the table type wherever it is used in STEP. Since case-by-case exceptions
to global formatting are sometimes needed, these definitions can be overridden locally, i.e., on the table itself.

Note: Style tags, colors, and rules must be created in System Setup before they can be applied to table types. For
more information, see the Configuring Table Formatting in System Setup and InDesign topic in this guide.

Table Type Defaults

To configure settings for table types in System Setup, follow these steps.

1. Onthe Table Type tab, click the ellipsis button (...) in the Defaults field.

Price Table - Table Type

MName »| > |Value >

> D stibo. 1776444

> Mame Price Table

» Edited by [2017-10-18 12:55:58 by USER4

» Defaults j
» Dimension Dependencies Language;

» Pagination Plugin Header Repeating Pagination Plugin

&~ Legal Row Types

= Legal Column Types

©- Default Transformations
- Resolvable for Product Types
- Resolvable for Classification Types

2. The Change Defaults dialog displays.
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32 Change Defaults

Width | in -
Text Style Mot Defined e
Background Color | Mot Defined e
Rule Abave Mot Defined “
Rule Below Mot Defined “
Rule Left Mot Defined “
Rule Right Mot Defined e
Vertical Alignment | Top I
Cell Rotation Mot Defined v
Process Flag Not Defined I
Cell Story Direction | Mot Defined I
Cell Image Scale
Cancel

. Use the following settings to specify the formatting of the tables that will be created from the table type:

« Width: Sets the width of the entire table. Available units are inches, millimeters, picas, and points. Though
Proportional is also available in the dropdown, this setting only applies to columns. See Configuring
Column Type Formatting for more information.

To prevent having to select a unit every time a width is set, a default unit can be set in System Settings. See
the Table Defaults section of the System Settings documentation for more information.

o Text Style: Sets the text style for the entire table. Contents of the dropdown list are populated by style tags
created in System Setup.

« Background Color: Sets the background color of the entire table. Contents of the dropdown list are
populated by table colors created in System Setup.

« Rule Above: Controls which line style is used as the top border of the table. Contents of the dropdown list
are populated by table rules created in System Setup.

« Rule Below: Controls which the line style is used as the bottom border of the table. Contents of the
dropdown list are populated by table rules created in System Setup.

« Rule Left: Controls which line style is used as the left border of the table. Contents of the dropdown list are
populated by table rules created in System Setup.

« Rule Right: Controls which the line style is used as the right border of the table. Contents of the dropdown
list are populated by table rules created in System Setup.
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« Vertical Alignment: Controls the vertical alignment of cell contents (text and images) as follows:

Alignment Description Example

Top Aligns contents to top Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Center Centers contents vertically

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Bottom Aligns contents to bottom

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Justify Aligns content evenly from top to bottom | | Purple & White Party Hat

Purple & White Party Hat

Purple & White Party Hat

« Cell Rotation: Controls the orientation of cell contents (text orimages). Cell contents can be rotated 0, 90,
180, or 270 degrees as follows:

Cell Rotation Example

0 Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat
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Cell Rotation Example

. §73232
PRI
8 ® &
180
JeH Aped apyp @ 3jding
JeH Aped apyp @ 3jding
1eH Aped apypn @ apding
270 L o o
O
EEEFETD
M0 3 M 3 @
ooododd

« Process Flag: Nothing is typically available in this dropdown list. This area is sometimes used to store
custom table settings.

« Cell Story Direction: Determines whether the contents of the cells in the table (text and images) are
displayed horizontally or vertically.

Cell Story Direction Direction

Horizontal (default) Sets the text direction to horizontal:| ABCDE

Vertical

3028V

Sets the text direction to vertical:

« Cell Image Scale: Controls the size of images linked into the cell. Images may be scaled from 25% to
500%.
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By default, the Cell Image Scale field is blank. If this field is left blank, and a width or height has not been set
on the column or row containing the image, the image will mount at 100% (actual size). If a scale value is
entered, the image will mount at the specified size, even if a width or height has been set on the column or
row.

6. Click OK when complete.

Considerations and Limitations
The following cell settings are not visible in the STEP Tables Preview:

« Vertical Alignment

« CellRotation

o Cell Story Direction
To preview these settings in the table, you must either use the Proof View in the workbench or mount the table in
InDesign.

For more information on Proof View, see the Generating Proof Views topicin the STEP'n'design
documentation. For more information on mounting products in InDesign, see Mounting Products in the
STEP'n'design documentation.

Specifying Local Table Formatting

When table formatting is changed locally on a table that has been defined on a product, classification, or product-
override node, any default formatting inherited from the table type in System Setup is overridden. Local changes to
formatting that applies to an entire table are made using the Change Table Settings dialog. Changing settings
locally will only affect the local table and will have no impact on the settings applied to the table type in System
Setup. To access this dialog and apply local formatting to a table, follow these steps.

1. Inthe Tree, click the relevant product, and then click the Tables tab.
2. Select atable, and then click the Definition tab.

3. Right-click inside any table cell, and then click Change Table Settings.
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Price Table 1 % |2 s |3
Mormal JNurmaI JNurmaI
[T Product Name [Jfm Prini
1 » Header (1T name Product Name Part No. J“T'EQE
2 *» Mormal (Cg Local
] Edit o
Span

Remowve Span(s)

Copy Cell Overrides
Paste Cell Overrides

Change Cell Settings
Copy Cell Settings
Paste Cell Settings

Change Table Settings

4. The Change Table Settings dialog displays. The settings in this dialog are identical to those in the Change
Defaults dialog that is accessed from the table type in System Setup.

32 Change Table Settings

Width 4.0| in | Table Type
Text Style Inherited: Mormal_L « | Table Type
Background Color  |Inherited: Light Blue « | Table Type
Rule Above Inherited: 1pt « | Table Type
Rule Below Inherited: 1pt « | Table Type
Rule Left Inherited: 1pt « | Table Type
Rule Right Inherited: 1pt « | Table Type
Vertical Alignment | Top o

Cell Rotation Inherited: 0 ~ | Table Type
Process Flag Not Defined o

Cell Story Direction | Inherited: Horizontal ~ | Table Type
Cell Image Scale Inherited: 20% Table Type

Cancel

5. The level from which the settings are inherited is displayed to the right of the options, which is Table Type in this
example.
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Width
Text Style
Backaground Color

4.0| in ~ | Table Type
Inherited: fNormal_L « | Table Type
Inherited: Light Blue « | Table Type

StiboSystems

6. When a setting is changed, the 'Inherited' label no longer displays, and nothing is listed to the right of the

options.

$2 Change Table Settings

Width 4.0 in w | Table Type
Text Style Bold_C e
Backaground Color  |Inherited: Light Blue « | Table Type

Note: When a table setting is changed locally, no gray triangles display anywhere within the table to indicate that
something inherited from System Setup has been overridden. A gray triangle does appear when the settings of a

columns, rows, or cell are overridden.
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Configuring Column Type Formatting

Settings and formatting definitions for column types are applied in System Setup. These formatting definitions
are global, meaning that they will inherit to the column type wherever itis used in STEP. Since case-by-case
exceptions to global formatting are sometimes needed, these definitions can be overridden locally, i.e., on the
column itself, when used in a table. Row formatting takes priority over column formatting in tables.

Note: Style tags, colors, and rules must be created in System Setup before they can be applied to column types.
For more information, see the Configuring Table Formatting in System Setup and InDesign topicin this
guide.

Column Type Defaults

To configure settings for column types in System Setup, follow the steps below.

1. Onthe Column Type tab, click the ellipsis button (...) in the Defaults field.

< Normal - Column Type =
MName »|» |Value 3
> D stibo. 1775454
» Mame Marmal
» Defaults rlertial Adjustment:Top
* Heading/Footer Mormal Row
* Publication Types Al
@ Legal for Table Types
MName »
» Price Table
| * |Add Table Type

2. The Change Defaults dialog displays.
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32 Change Defaults

Width | in w
Text Style Mot Defined o
Backaground Color Mot Defined o
Cell vertical Alignment | Top v
Rule Left Mot Defined v
Rule Right Mot Defined o
Cell Rotation Not Defined w
Process Flag Not Defined o
Cell Story Direction Not Defined o
Cell Image Scale
Cancel

3. Use the following settings to specify the formatting of the columns that will be created from the column type.

« Width: Sets the width of the column. Available units are inches, millimeters, picas, and points. Also included
in the dropdown is Proportional, which allows the option to specify proportionality to other columns in the
table.

Example: When Table X is mounted, then column type B will be twice as wide as column type A. The
proportionis 2to 1.

Table X

Column Type A | Proportional is setto 1

Column Type B | Proportional is setto 2

Proportional is set to 1 for Column Type A and Proportional is set to 2 for Column Type B. Column type B will
be twice as wide as column type A, as illustrated in this screenshot from the Preview tab in STEP:
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pefinition |l

Select version :MagaginﬂJS

column  |column type B column
type A type A

To prevent having to select a unit every time a width is set, a default unit can be set in System Settings. See
the Table Defaults section of the System Settings documentation for more information.

« Text Style: Sets the text style of the column. Contents of the dropdown list are populated by style tags
created in System Setup.

« Background Color: Sets the background color of the column. Contents of the dropdown list are populated
by table colors created in System Setup.

« Cell Vertical Alignment: Controls the alignment of the cell contents cell contents (text and images) within
the column as follows:

Alignment Description Example

Top Aligns contents to top Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Center Centers contents vertically

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Bottom Aligns contents to bottom

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Justify Aligns content evenly from top to bottom | | Purple & White Party Hat

Purple & White Party Hat

Purple & White Party Hat
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« Rule Left: Controls which line style is used as the left border of the column. Contents of the dropdown list
are populated by table rules created in System Setup.

« Rule Right: Controls which line style is used as the right border of the column. Contents of the dropdown list
are populated by table rules created in System Setup.

« Cell Rotation: Controls the orientation of cell contents (text or images) within the column. Cell contents can
be rotated 0, 90, 180, or 270 degrees as follows:

Cell Rotation Example

0 Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

90

1eH Aued

1eH Aped
8}IU '3 81dingd

ajuM g sjding
1eH Aued

SHUM ' Sjding

180

JeH Aped apyp @ 3jding
JeH Aped apyp @ 3jding
1eH Aped apypn @ apding

270

Purple & White

Party Hat
Party Hat

Purple & White

Party Hat
Purple & White

« Process Flag: Nothing is typically available in this dropdown list. This area is sometimes used to store
custom table settings.

« Cell Story Direction: Determines whether the contents of the cells in a column (text and images) are
displayed horizontally or vertically.
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Cell Story Direction Direction

Horizontal (default) Sets the text direction to horizontal:| ABCDE

Vertical

3a28v

Sets the text direction to vertical:

« Cell Image Scale: Controls the size of images linked into the cells within the column. Images may be scaled
from 25% to 500%.

By default, the Cell Image Scale field is blank. If this field is left blank, and a width or height has not been set
on the column or row containing the image, the image will mount at 100% (actual size). If a scale value is
entered, the image will mount at the specified size, even if a width or height has been set on the column or
row.

5. Click OK to close the Change Defaults dialog box.

Considerations and Limitations
The following cell settings are not visible in the STEP Tables Preview:

« Vertical Alignment
« Cell Rotation

o Cell Story Direction

To preview these settings in the table, you must either use the Proof View in the workbench or mount the table in
InDesign.

For more information on Proof View, see the Generating Proof Views topicin the STEP'n'design
documentation. For more information on mounting products in InDesign, see Mounting Products in the
STEP'n'design documentation.

Specifying Local Column Formatting

When column formatting is changed locally in a table that has been defined on a product, classification, or product-
override node, any default formatting inherited from the column type or table type in System Setup is overridden.
Local changes to column formatting are made using the Change Column Settings dialog. Changing settings
locally will only affect the local column and will have no impact on the settings applied to the column type in System
Setup. To access this dialog and apply local formatting to a column, follow these steps.
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1. Inthe Tree, click the relevant product, classification, or product-override, then click the Tables tab.
2. Select atable, and then click the Definition tab.

3. Selecta column, right-click, and then click Change Settings.

Price Table 1 I|2 y
“Normal Add Column Before | ©
1t er Add Column atEnd |
Copy Columns :
1 * Header (1T name Product N% e s
2 » MNormal qﬁ% Local Duplicate :

Remowve Column

Expand

Edit

Change Settings

4. The Change Column Settings dialog displays. The settings in this dialog are identical to those in the Change
Defaults dialog that is accessed from the column type in System Setup.

32 Change Column Settings

Width in ~

Text Style Inherited: Mormal_L « | Table Type

Backaground Color Inherited: Light Blue « | Table Type

Cell vertical alignment | Inherited: Top w | Column Type

Rule Left 0.5pt v

Rule Right 1pt ~

Cell Rotation Inherited: 0 « | Table Type

Process Flag Mot Defined I

Cell Story Direction Inherited: Horizontal « | Table Type

Cell Image Scale Inherited: 20% Table Type
Cancel

5. The level from which the settings are inherited is displayed to the right of the options, which is both Table Type
and Column Type in this example.
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$3 Change Column Settings

Width | in w
Text Style Inherited: Hormal _L e

Background Color Inherited: fight Blue e

Cell Vertical Alignmenf | Inherited: fop e

6. When a setting is changed, the 'Inherited' label no longer displays, and nothing is listed to the right of the
options.

32 Change Column Settings

Width in o
Text Style Bold_C e
Background Color Inherited: Light Blue « | Table Type
Cell Vertical Alignmen{ |Tenter [

7. Additionally, a gray triangle appears in the column type definition cell to indicate that the column has local
settings applied that override inherited settings.

1 > |;‘
Mormal *N brmal

[ Productiame ] D

Product Name Part Mo
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Configuring Row Type Formatting

Settings and formatting definitions for row types are applied in System Setup. These formatting definitions are
global, meaning that they will inherit to the row type wherever itis used in STEP. Since case-by-case exceptions to
global formatting are sometimes needed, these definitions can be overridden locally, i.e., on the row itself, when
used in a table. Row formatting takes priority over column formatting in tables.

Note: Style tags, colors, and rules must be created in System Setup before they can be applied to row types. For
more information, see the Configuring Table Formatting in System Setup and InDesign topic in this guide.

Row Type Defaults

To configure settings for row types in System Setup, follow these steps.

1. Onthe Row Type tab, click the ellipsis button (...) in the Defaults field.

< Header - Row Type . a
MName >| > |Value >
> D 244742
> Mame Header
» Defaults r«‘ertiml Adjustment:Top
» Heading/Footer Heading (1)
» Publication Types all
@ Legal for Table Types
Mame »
» Price Table
| * | Add Table Type

2. The Change Defaults dialog displays.
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32 Change Defaults

Height
Text Style Mot Defined
Background Color  |Not Defined

Vertical Alignment | Top

Rule Above Mot Defined
Rule Below Mot Defined
Cell Rotation Not Defined
Process Flag Mot Defined

Cell Story Direction | Not Defined
Cell Image Scale

[] Keep With Next

Cancel

StiboSystems

3. Use the following settings to specify the formatting of the rows that will be created from the row type:

« Height: Sets the height of the row. Available units are inches, millimeters, picas, and points.

To prevent having to select a unit every time a height is set, a default unit can be set in System Settings. See
the Table Defaults section of the System Settings documentation for more information.

« Text Style: Sets the text style of the row. Contents of the dropdown list are populated by style tags created

in System Setup.

« Background Color: Sets the background color of the row. Contents of the dropdown list are populated by

© Stibo Systems - Confidential - STEP Trailblazer 8.3

65



StiboSystems

table colors created in System Setup.

« Vertical Alignment: Controls the alignment of the cell contents (text and images) in the row as follows:

Alignment Description Example

Top Aligns contents to top Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Center Centers contents vertically
Purple & White Party Hat
Purple & White Party Hat

Purple & White Party Hat

Bottom Aligns contents to bottom

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Justify Aligns content evenly from top to bottom | | Purple & White Party Hat

Purple & White Party Hat

Purple & White Party Hat

« Rule Above: Controls which line style is used as the top border of the row. Contents of the dropdown list are
populated by table rules created in System Setup.

« Rule Below: Controls which line style is used as the bottom border of the row. Contents of the dropdown list
are populated by table rules created in System Setup.

« Cell Rotation: Controls the orientation of cell contents (text or images) in the row. Cell contents can be
rotated 0, 90, 180, or 270 degrees as follows:
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Cell Rotation Example

0 Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

90

1eH Aped

ajuM g sjding
1eH Aued

8juM g 8ding
1eH Aued

S}IU ' Sjding

180

1eH Aued anypp g 3jding
1eH Aued anypp g 3jding
1eH Aued apyp g 2(ding

270

Purple & White

Party Hat
Purple & White

Party Hat
Purple & White

Party Hat

« Process Flag: Nothing is typically available in this dropdown list. This area is sometimes used to store
custom table settings.

« Cell Story Direction: Determines whether the cell contents (text and images) in the row are displayed
horizontally or vertically.

Cell Story Direction Direction

Horizontal (default) Sets the text direction to horizontal:| ABCDE
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Cell Story Direction Direction

Vertical

3028V

Sets the text direction to vertical:

« Cell Image Scale: Controls the size of images linked into the row. Images may be scaled from 25% to
500%.

By default, the Cell Image Scale field is blank. If this field is left blank, and a width or height has not been set
on the column or row containing the image, the image will mount at 100% (actual size). If a scale value is
entered, the image will mount at the specified size, even if a width or height has been set on the column or
row.

« Keep With Next: Check this box if rows of the row type should remain with the next row in the table if the
mounted table splits across a column or page. (A table will split across a column or page if it is too large to
fully mount in a single column or page.) The row will be mounted onto the following column or page in order
to keep it with the next row.

5. Click OK to close the Change Defaults dialog box.

Considerations and Limitations
The following cell settings are not visible in the STEP Tables Preview:

« Vertical Alignment

« Cell Rotation

« Cell Story Direction
To preview these settings in the table, you must either use the Proof View in the workbench or mount the table in
InDesign.

For more information on Proof View, see the Generating Proof Views topicin the STEP'n'design
documentation. For more information on mounting products in InDesign, see Mounting Products in the
STEP'n'design documentation.

Specifying Local Row Formatting

When row formatting is changed locally, all inherited formatting is overridden. Local changes to row formatting are
made using the Change Row Settings dialog. To access this dialog and apply local formatting to a row, follow
these steps:

1. Inthe Tree, click the relevant product, and then click the Tables tab.

2. Select atable, and then click the Definition tab.
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3. Selectarow, right-click, and then click Change Settings.

Price Tahle 1
Mormal
[1f Product Nam:
i > Header 1T Mame Product Mame

Add Row Before

Add Row at End
Copy Rows
Paste Rows
Duplicate

Remowve Row

Change Settings

StiboSystems

4. The Change Row Settings dialog displays. The settings in this dialog are identical to those in the Change

Defaults dialog that is accessed from the row type in System Setup.

32 Change Row Settings

Height 0.3 in
Text Style bold
Background Color  |Inherited: Light Blue

Vertical Alignment | Inherited: Justify

Rule Above Mot Defined
Rule Below 2pt

Cell Rotation Inherited: O
Process Flag Not Defined

Cell Story Direction | Inherited: Horizontal
Cell Image Scale Inherited: 20%

[ keep with Mext

Table Type

Row Type

Table Type

Table Type
Table Type

Row Type

Cancel

5. The level from which the settings are inherited is displayed to the right of the options, which is both Table Type

and Row Type in this example.
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33 Change Row Settings

Height 0.3 in w

Text Style bold e
Background Color | |Inherited: ght Blue « [ Table Type
Vertical Alignment | |Inherited: Justify w (|Row Type

6. When a setting is changed, the 'Inherited' label no longer displays, and nothing is listed to the right of the
options.

32 Change Row Settings

Height 0.3 in e
Text Style bold e
Backaground Color | |Canary Yellow e
Vertical Alignment | |Center { e
Rule Above Mot Defined e

7. Additionally, a gray triangle appears in the row type definition cell to indicate that the row has local settings
applied that override inherited settings.

—

Header I Name

Mormal (Cg Local

[y
W

[
W
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Specifying Local Cell Formatting

When cell formatting is changed locally, all inherited formatting is overridden. Local changes to cell formatting are
made using the Change Cell Settings dialog. Cell formatting takes priority over all other formatting—table, row,
and column. To access this dialog and apply local formatting to a cell, follow these steps.

1. Inthe Tree, select the relevant product, classification, or product-override, then click the Tables tab.

2. Select atable, and then click the Definition tab.

3. Right-click inside of the relevant cell, then click Change Cell Settings.

Price Table 1 s |2 2 |3
Mormal Mormal Morr
(1T Product Mame (]I D i
1 » Header [T name Product Mame Part Mo. Trman
2 » Mormal [Cg Local |
Edit
Span

Remove Span(s)

Copy Cell Overrides

Paste Cell Overrides

Change Cell Settings
Copy Cell Settings

Paste Cell Settings
Change Table Settings

4. The Change Cell Settings dialog displays. The level from which the settings are inherited is displayed to the
right of the options, which include Table Type, Table, and Column Type in this example.
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32 Change Cell Settings

Text Style Inherited: Mormal_L « | Table Type

Background Color  |Inherited: Cherry Red « | Table

Vertical Alignment | Inherited: Top ~ | Column Type

Rule Above Mot Defined “

Rule Below Inherited: 1 pt « | Table Type

Rule Left Inherited: 1 pt « | Table Type

Rule Right Mot Defined v

Cell Rotation Inherited: 0 « | Table Type

Process Flag Mot Defined v

Cell Story Direction | Inherited: Horizontal « | Table Type

Cell Image Scale Inherited: 20% Table Type
Cancel

5. Adjust the formatting of the cell using the following settings:

« Text Style: Sets the text style of the cell. Contents of the dropdown list are populated by Style Tags created
in System Setup.

« Background Color: Sets the background color of the cell. Contents of the dropdown list are populated by
table colors created in System Setup.

« Vertical Alignment: Controls the vertical alignment of cell contents (text and images) as follows:

Alignment Description Example

Top Aligns contents to top Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Center Centers contents vertically

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat
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Alignment Description Example

Bottom Aligns contents to bottom

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Justify Aligns content evenly from top to bottom | | Purple & White Party Hat

Purple & White Party Hat

Purple & White Party Hat

Rule Above: Controls which line style is used as the top border of the cell. Contents of the dropdown list are
populated by table rules created in System Setup.

Rule Below: Controls which line style is used as the bottom border of the cell. Contents of the dropdown list
are populated by table rules created in System Setup.

Rule Left: Controls which line style is used as the left border of the cell. Contents of the dropdown list are
populated by table rules created in System Setup.

Rule Right: Controls which line style is used as the right border of the cell. Contents of the dropdown list are
populated by table rules created in System Setup.

Cell Rotation: Controls the orientation of cell contents (text or images). Cell contents can be rotated 0, 90,
180, or 270 degrees as follows:

Cell Rotation Example

0 Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat
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PRI
8 ® &
180
JeH Aped apyp @ 3jding
JeH Aped apyp @ 3jding
1eH Aped apypn @ apding
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O
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M0 3 M 3 @
ooododd
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« Process Flag: Nothing is typically available in this dropdown list. This area is sometimes used to store

custom table settings.

« Cell Story Direction: Determines whether the contents of the cell (text and images) are displayed

horizontally or vertically.

Cell Story Direction Direction
Horizontal (default) Sets the text direction to horizontal:| ABCDE
Vertical >
m
(2)
w)
m
Sets the text direction to vertical:

« Cell Image Scale: Controls the size of images linked into the cell. Images may be scaled from 25% to

500%.
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By default, the Cell Image Scale field is blank. If this field is left blank, and a width or height has not been set
on the column or row containing the image, the image will mount at 100% (actual size). If a scale value is
entered, the image will mount at the specified size, even if a width or height has been set on the column or
row.

5. Click OK when complete.
6. After acellis overridden, the 'Inherited' label no longer displays, and nothing is listed to the right of the options.

32 Change Cell Settings

Text Style Inherited: Mormal_L . | Table Type
Background Color  |Light Blue e
Vertical Alignment | Center Y
Rule Above Mot Defined "

7. Additionally, a gray triangle appears in the cell to indicate that the cell has local settings applied that override
inherited settings.

1 * |2
Mormal Mormal

[ ProductMame (]I ID

Product Name Part Mo

Considerations and Limitations
The following cell settings are not visible in the STEP Tables Preview:

« Vertical Alignment

« Cell Rotation

« Cell Story Direction
To preview these settings in the table, you must either use the Proof View in the workbench or mount the table in
InDesign.

For more information on Proof View, see the Generating Proof Views topicin the STEP'n'design
documentation. For more information on mounting products in InDesign, see Mounting Products in the
STEP'n'design documentation.
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Creating Tables

Tables are created in STEP on product, classification, or product-override objects, typically at a higher level of the
hierarchy where it can be inherited to lower levels. The first step in creating a table is to add a table type to the
relevant product, classification, or product-override object.

Prerequisites

This topic assumes the following:

« Atable type has already been created in System Setup

« You have determined the location in the product hierarchy where the table will be built. The creation point is
important because tables are inherited downwards in the hierarchy, unless overridden by a local variation of the
table. For more information on table inheritance, see the Table Inheritance topic in this guide.

Important: Though tables can be created on classifications, it is recommended to only create them in the product
hierarchy to simplify the maintenance of inherited tables.

Add a Table Type to a Product or Classification

1. Inthe Tree, navigate to the relevant product, classification, or product-override object, then select the Tables
tab.

2. Click Add Table Type to display the Select Table Type dialog.

< Level 2 rev.0.3 - Tables
Commercial |BLEHESS [ Proof View

Product || Sub Products (B« ESAFrm et 3 Type

Tables

*| Add Table Type * El--% Table Types
| Preview n % Pivot Tables
E}% Price Tables
e
- @-fff] sales Price Table
% Spedifications Tables

- Detailz

Select Cancel

Add Table Type can also be accessed from the STEP Edit menu.
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3. Browse or search for the relevant table type, then click Select.

4. The table type appears in the Tables list on the Tables tab.

Level 2 rev.0.3 - Tables

Commercial Proof View || Status | State Log || Tasks

Product Sub Products [ References " Referenced By ” Images & Documents ]

' Tables
N » |Defined At
¥ F'rice Table Mot Defined

PTTEGq Tane lype
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You can now create tables with the Create Table wizard or by starting with an empty table, then specifying the
contents and settings of the table. For more information, see the following topics: Using the Create Table

Wizard and Creating a New Empty Table.

Delete a Table

1. Right-click the table you want to delete, then click Delete Table.
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Product Product Variants ” Sub Products ” References ” Reference
' Tables
Mame » Defined At
* Price Table - ocal N
> | Add Table Type Copy
Price Table 7
Create Table —
Marr
Create Empty Table i
Create Table From Clipboard —
1 * Mormal abe Fre Delete Table ma
2 > Normal Par Suppress Table ‘man
Remove Table Type Ctrl+Minus
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2. Ifthe table was defined locally, but the local table overrode a table inherited from a higher level, the text under
the Defined At column changes from Local to the name of the node on which the table is built, and the table
type itself remains. Due to the inheritance, the table type cannot be deleted; only suppressed. See the Table
Inheritance and Suppression topic in this guide for more information on table suppression.

3. Ifthe table was defined locally and did not override a table built at a higher level, then Local changes to Not
Defined. The table type can then be deleted by right-clicking on the table type and selecting Remove Table

Type.

Commercial [ Proof View " Status " State Log ”E
Product Sub Products ” References ” Referenced By

3 Tables

L

Defined At

Defini io

Mot Defined n
Copy

Paste |

Create Table

Create Empty Table

Create Table From Clipboard
Delete Table

Suppress Table

Remove Table Type Ctrl+Minus

Remove Table Type can also be accessed from the STEP Edit menu.
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Using the Create Table Wizard

The Create Table wizard enables you to build a basic table through a two-step process that involves selecting the
products, then selecting the attributes that should appear in the table. This wizard enables the creation of two
basic types of tables—horizontal and vertical.

Most tables that are built with the Create Table wizard will need additional configurations once created, such as
the addition of plain text or images, dynamic content definitions, and transformations. However, using this wizard
gets the basic structure and content of the table in place. For information on how to add these more advanced
features, see the Content Definitions section of this guide.

Prerequisites
This topic assumes the following:

« Atable type has already been created and linked to the product, classification, or product-override where you
will be building the table

« The table type has at least one legal column type and one legal row type

« You have determined the location in the product hierarchy where the table will be built. The creation point is
important because tables are inherited downwards in the hierarchy, unless overridden by a local variation of the
table. For more information on table inheritance, see the Table Inheritance topic in this guide.

To Create a Basic Table
1. Inthe Tree, select the product, classification, or product-override object on which the table will be built.

2. Gotothe Tables tab, then select the relevant 'Not Defined' table type.
3. Right-click the table type and choose Create Table to display the Create Table wizard.
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Level 2 rev.0.4 - Tables

Commercial Proof Wiew || Status || State Log || Tasks
Praduct Sub Products [ References " Referenced By ” Images & Documents ]
' Tables
Mame » |Defined At »
> Price Table \ Mot Defined
> Table Tye Copy
Price T,
Create Table
Create Empty Table
Create Table From Clipboard
Delete Table
Suppress Table
Remove Table Type Ctrl+Minus
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In the Select Products step of the Create Table wizard, browse to or search for the product(s) that should be
included in the table. Products can be multi-selected by holding the Shift or Ctrl key while making selections. It
is possible to select products that are located at different levels in the hierarchy than where you are creating the

table.

Note: A common setup for tables is to place a product, product-override, or classification object with children
(e.g., a product family) into a single row, then apply a content definition to the row that will dynamically display
the child objects in additional rows of the table. See the Product Content Definitions topic for more

information.
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3 Create Table

Steps

Select Products

1. Select Products
2. Select Attributes

Search

H

(®) Products in rows

() Products in columns

[=[[T) Party Hats
[=-{I5] Paper Hats

E}i Balloon Hats

-\ Blue &Pink Owl Party Hat|
- |{™ Blue & Yellow Balloon Hat

P E Blue Wizard Balloon Hat
i Children's Hats
=il Pet Hats

----- ) Dog Party Hats Assortment

-m Pink & Blue Giraffe Party Hat
- |{™ Pink & Blue Owl Party Hat
[T Masks

[+-[[T] Streamers

[T Child Birthday Parties

-5 Alarms
Type |Mormal
Type | Mormal
Back Mext Finizh

Cancel

StiboSystems

5. Next, specify whether the table should be horizontal or vertical by choosing whether products appear in
rows or columns.

6.
7.

Select Products in rows to create a standard horizontal table where the information that relates to
specific products is placed across the table, in rows. In the Type dropdown list, choose the row type to use
for the product rows. The available row types are those that are legal for the table type.

Select Products in columns to create a vertical table where the information that relates to specific
products is placed from top to bottom in the table, in columns. In the Type dropdown list, choose the column
type to use for the product columns. The available column types are those that are legal for the table type.

After making the preferred selections, click 'Next' to proceed to the Select Attributes step.

On the Select Attributes screen, three options are available to choose the attributes for the table. You can
browse to or search for attributes in the attributes hierarchy, or you can choose Legal Attributes to limit the
list to the attributes that are valid for the products you selected in the previous step. In any of these methods,
multiple attributes can be selected. The below screenshot shows how the attributes tree displays on the
Browse tab.
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Note: Only individual attributes can be chosen in this step; entire attribute groups cannot. Even though the
system will let you choose attribute groups if you have already selected at least one individual attribute, only
the individual attributes will display in the finished table.

32 Create Table

Steps

Select Attributes

1. Select Products
2. select Attributes

[ Search ” Legal Attributes

--ID__I Category Spedific Attributes
-3 Color Attributes
b JI Available Colors

i-[]¥ Exterior Color

-0 Customer Cases
- £01 Customer Data

£
Type |Mormal

Back Mext Finish

~

Cancel

8. When Legal Attributes is selected, two options are available from the dropdown:

« Choose Linked Local to view all attributes that are linked locally to the selected products. In this option you
will not see any attributes inherited from a higher level. For more information on locally linked attributes, see
the Attribute Links section of the System Setup / Super User Guide documentation.

« Choose All Legal Attributes to view all attributes that are valid for the selected product(s). This includes
both inherited attributes and attributes that are linked locally. For more information on attribute validity, see
the Validity on Specification Attributes section of the System Setup / Super User Guide

documentation.
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43 Create Table

Steps Select Attributes

L. Select Products [ Browse ” Search l

2. Select Attributes
All Legal Attributes - Selected

Colar Linked Local '7‘. add
Description

Description Long Remowve
Exterior Color
Feature Bullet 2 Add Al
Feature Bullet &

Interior Color

IS0Date

Manufacturer Dual

Manufacturer Dual Mo Dim Dep

Manufacturer Mame

Mew Product

Planned Release Date

Primary Color

Product Family Title

Product Group Description 9
[Secondary Color

Remove All

Type |Mormal e

Back Mext Finish Cancel

9. Forthe Linked Local and All Legal Attributes options, select the desired attributes in the left window of the
dialog and choose Add to add them to the Selected window. Attributes may be multi-selected by holding the
Ctrl or Shift key while making selections. To add all of the attributes to Selected, click Add All. To remove a
selection of attributes from Selected, choose the relevant attributes, then click Remove. To remove all
attributes from Selected, click Remove All.
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4% Create Table

Steps Select Attributes
S A [ e Attributes |
2. Sselect Attributes
All Legal attributes - Selected
Color ~ Description Long

Manufacturer Mame
Prirmary Color

Description, Table
Description Long
Exterior Colar
Feature Bullet 2 Add
Feature Bullet &

Interior Color

I[S0Date

Manufacturer Dual
Manufacturer Dual Mo Dim Dep

Remove

ovglfAll

Mew Product

Flanned Release Date

Product Family Title
Product Group Description
Serondary Color v

Type | Mormal w

Badk Mext Finish Cancel

9. Inthe Type dropdown, select the column or row type that you want to use for the attributes. The available
options will be based on whether you selected 'Products in rows' or 'Products in columns' in the 'Select
Products' step of the wizard. If you chose 'Products in rows,' then the dropdown list will contain column types. If
you chose 'Products in columns,' the dropdown will contain row types.

Type |Mormal e

Price
Column Head

10. After selecting the relevant attributes, click Finish.

11. Atable is created with the selected products and attributes.
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| Images & Documents H Commercial ][ Proof View " Status ” State Log " Tasks ]

| Produck Sub Products References Referenced By
' Tables
Mame » |Defined At >
> Price Table Local
> | Add Table Type
Price Table i » (2 » (3 »
Marmal Maormal Maormal

(1T Description Long  |[JT Manufacturer Mame |[J Primary Color

1 > Normal h Blue & Pink Owl Party Hat

2 * Maormal h Dog Party Hats Assortment Bladk
3 * Mormal h Pink & Blue Giraffe Party Hat Green
4 * Mormal h Fink & Blue Owl Party Hat Gray
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Creating a New Empty Table

Instead of using the Create Table wizard, an alternate method of creating a new table is to create an empty table.
This method allows you to create a table without necessarily having to know beforehand what attributes and/or
products will be used, other than the product on which the table will be built. As with tables that are built with the
Create Table wizard, an empty table will also need additional configurations once created, such as the addition of
plain text or images, dynamic content definitions, and transformations. For information on how to add these more
advanced features, see the Content Definitions section of this guide.

This topic assumes the following:

« Atable type has already been created and linked to the product, classification, or product-override where you
will be building the table

« Thetable type has at least one legal column type and one legal row type

« You have determined the location in the product hierarchy where the table will be built. The creation point is
important because tables are inherited downwards in the hierarchy, unless overridden by a local variation of the
table. For more information on table inheritance, see the Table Inheritance topic in this guide.

To Create an Empty Table
1. Inthe Tree, select the product, classification, or product-override object on which the table will be built.

2. Gotothe Tables tab, then select the relevant 'Not Defined' table type.
3. Right-click the table type and choose Create Empty Table.

Level 2 rev.0.4 - Tables
Commercial Proof Wiew || Status || State Log || Tasks

Product Sub Products [ References ” Referenced By ” Images & Documents ]
' Tables

Mame » |Defined At »
> Price Table _ Not Defined

> | Add Table Thge Copy
Price\
Create Table

Create Empty Table
Create Table From Clipboard

Delete Table |Create Emptj.-'TabIel
Suppress Table
Remove Table Type Ctrl+Minus
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4. Anempty table grid with one free text cell is created. The cell is composed of one row and one column. The

row type and column type used are the ones chosen as default row / column types when the table type was
created in System Setup.

Level 2 rev.0.4 - Tables

Commercial Proof View || Status || State Log || Tasks
Product Sub Products [ References " Referenced By " Images & Documents ]
¥ Tables
Mame » |Defined At >
> Price Table Local
> | Add Table Type
Price Table 1 y
Marmal
abe Free Text
|1 > r‘dnrmal abe Free Text | |

5. Next, define the column and row Content Definitions of the table. For instructions, see the Adding and
Removing Content Definitions section of this guide.
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Creating Tables From the Clipboard

To create a table based on tabular data from an external application such as Excel or Word, you can copy and
paste the information directly from the source document into STEP. This creates a table composed entirely of free
text rows and columns, i.e., the data is pasted exactly as-is from the source document. The system will build the
table using the specified default row types and column types.

Note: All content contained in a pasted table is free text and has no relation to attribute values in STEP, making
the table non-dynamic. Also note that the pasted content ignores any styling from the source document.

Prerequisites
This topic assumes the following:

» Atable type has already been created and linked to the product, classification, or product-override where you
will be building the table

« The table type has at least one legal column type and one legal row type. If the table type uses more than one
row type or column type, a default type must be specified for each.

3 Legal Row Types

Default * |[Name
@) Header
> (@) Mormal

* |Add Row Type

? Legal Column Types
Default * |[Name

> (@) Mormal
@) Price
* |Add Column Type

« You have a spreadsheet or Word document ready that contains the tabular data that will be copied and pasted

« You have determined the location in the product hierarchy where the table will be built. The creation point is
important because tables are inherited downwards in the hierarchy, unless overridden by a local variation of the
table. For more information on table inheritance, see the Table Inheritance topic in this guide.

Creating a Table From a Spreadsheet

1. On your spreadsheet, highlight and copy the cells from which you would like to create the table.
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A B C
1 [Model No. Color Country of Origin
2 [2574489-A Red United States
3 §2574477-A  Blue Mexico
4 12574522-A  Yellow  Argentina
5 J2574490-B Orange  Mexico
6 [964817-Y Black United States
7 §SB487B0-X  White Canada
8 §564815-X Gray Vietnam
9 1564815-X Black India
Elal
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2. Inthe Tree, select the product, classification, or product-override object on which the table will be built.

3. Gotothe Tables tab, then select the relevant 'Not Defined' table type.
4. Right-click the table type and choose Create Table From Clipboard.

Level 2 rev.0.4 - Tables

m Proof Wiew || Status || State Log || Tasks
Product S

ub Products " References " Referenced By "_
@ Tables
Mame » |Defined At
> Price Table % Mot Defined N
> | Add Table Typ Copy

Price Tabh

\ Create Table
Create Empty Table

Create Table From Clipboard

Delete Table
Suppress Table

Remowve Table Type Ctrl+Minus

5. The content from the clipboard is pasted into the table. The row types and column types are those set as the
default row and column type on the table type.
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Level 2 rev.0.4 - Tables

CUITIITIEI mal Proof Wiew || Status || State Log || Tasks
Praduct Sub Products " References " Referenced By ” Images & Documents ]
' Tables
Mame » |Defined At >
> Pri::e Table Local
> | Add Table Type
Price Tahle 1 s |2 s [3 N
Mormal Mormal Mormal
abe Free Text abe Free Text abe Free Text
1 + Mormal abe Free Text Model Mo, Color Country of Origin
2 » Maormal abe Free Text 2574439-A Fed |Inited States
3 » Mormal abe Free Text 2374477-A Blue Mexico
4 > Nurmal abe Free Text 2574522-A YE"QW F'JgEf‘Itiﬂa
5 » Maormal abe Free Text 2574490-B COrange Mexico
5 » Maormal abe Free Text Lod4317-Y Black |Inited States
7 » Normal ab¢ Free Text 5643730-% White Canada
g > MNormal abe Free Text a64815-X Gray Viegtnam
9 * Mormal abe Free Text 564815-X Black India

Creating a Table From a Word Document

The same steps are used as those for creating the table from Excel, except the table is copied and pasted from a
Word document.

+
Country of
Model No. | Color Origin
2574489-A | Red United States
2574477-A | Blue Mexico

2574522-A | Yellow Argentina
2574450-B | Orange | Mexico
564817-Y Black United States
5648780-X | White Canada
564815-X Gray Vietnam
564815-X Black India
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Copy and Paste Tables, Rows, Columns, and Cells

This topic explains how to copy and paste tables from one node to another, as well as how to copy and paste
columns, rows, and cells within the same table or from one table to another table.

Copy and Paste Tables

Tables can be copied and pasted from one node to another. When a table has already been built, it can often be
much simpler to copy and paste it onto another node than to build a new table from scratch. Then, adjustments can
be made to the pasted table, as needed. Also, a table can be pasted over an existing table, which has already
been defined, to override a table definition that is inherited from a higher node.

Tables can be copied and pasted from different object types (i.e. from an item object to a family object) as well as
from product / product-override objects to classification objects (and vice versa). The copied table type does not
have to be of the same table type as the target table type, though it is typically recommended that the tables are of
the same type, since the pasted rows and columns may use row types and column types that are not legal for the
target table.

The following steps assume that at least one source table has been created and defined on a product,
classification, or product-override object, and that at least one table or table type exists on the target product,
classification, or product-override object.

1. Navigate to the Tables tab of the product or classification object on which the source table has been built.
2. Right-click on the table, then select Copy.

"1__=I Displays L Commercial [ Categary Prafile ” Proaof Wiew " Skakus ” Skate Log ” Tasks ]
-3 Furniture Product || Product Variants ” sub Products ” References ” Referenced By ” Images & [

EI{'_=| Party Supplies ® Tabi
El——=| Party Hats Mame » Defined At
E|F_=| Paper Hats - Price Table — L
[+l Balloon Hats ——
i Children's Hats * Sales Price Table Iﬂl
i Past
=il Pet Hats > | Add Table Type aste

E Dog Party Hats | Preview Create Table
| Pink & Blue Gira . -

G Pink & Elue Owl Price Table Create Empty Table

[#-[[T) Masks Create Table From Clipboard
[T Streamers

[T Child Birthday Parties S P
-5 Alarms - Suppress Table
-5 Electronics 1 > Header (1T Mame
-5 Wedding 2 MNarmal "'lm Local Remove Table Type Ctrl+Minus
[+ 7= Frnd

3. Navigate to the Tables tab of the product, classification, or product-override object on which the target table or
table type has been added. The table does not have to say 'Not Defined'; if a table already exists, it can be
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pasted over.

4. Right-click on the table, then select Paste.

{7 Assets

r_=| Classifications

r_=| Configurations

--@ Index Words

E|r_=| Merchandising Hierarchy
|j Apparel

L—‘_}Fj Automotive

=[] Tires

tfla] 7130-03FR
| 8225012

[~ Beverages
H-[—| Footwear
[~ Games

H-[—] Office Products
H-[—] Office Supplies

| O e O o O e |

- {{™ Blue Flashlight

StiboSystems

~ | Images & Documents

[ Skatus " Skate Log ” Tasks ]

| Classification ] Sub Products References Referenced
@ Tables
Mame * |Defined At
» Price Table e
> | Add Table Typ Copy
-
Prics
Create Table Pasta
Create Empty Table
Create Table From Clipboard
Delete Table
Suppress Table
Remove Table Type Ctrl+Minus

Note: The table does not have to be of the same table type, but if the column and row types from the source table
are not valid for the target table type, the column type / row type cells will be highlighted red to alert you that the

types are not valid.

Price Table 1 3 |2 s |3 > |4 »
(I PartMumber ]I short Item De... ]I Size (1T Product weight
1 * Header ‘DI Mame Part Mumber Short Item Descri... Size Product Weight
2 » MNormal [Cg Local

Copy and Paste Rows, Columns, and Cells

Rows, columns, and cells may be copied and pasted within the same table or from one table to another table.

1. Select the row, column, or cell that you would like to copy, then right-click and select the applicable option from

the menu:

o CopyRows

o Copy Columns

« Copy Cell Overrides
« Copy Cell Settings
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2. Selectarow, column, or cell in the destination location, then right-click and select the applicable option from the
menu:

« Paste Rows
« Paste Columns
« Paste Cell Overrides
» Paste Cell Settings
3. The copied row is pasted beneath the destination row. The copied column is pasted to the right of the

destination column. The copied cell overrides or cell settings are pasted directly into the destination cell and
overwrite the destination cell.

To multi-select rows or columns, click on the content definition cell of the row or column and hold the Shift or
Ctrl key while making selections.

Freview
Price Table 1 s |2 s [3 s[4 >
Mormal ormal ‘Nurmal ‘Price
T Product Mame ]I ID "/ Primary Prod... &5 Price
1 *|Header ST name Product Name h
2 *|Normal ‘Eﬁ Local b h h

Considerations for Copying and Pasting From One Table to Another
When copying and pasting rows, columns, and cells from one table to another, keep in mind the following:

« Any formatting settings (text, color, rules, etc.) applied to the source row, column, or cell will be copied along
with it to the destination table

« Ifthe pasted row or column uses a row type or column type thatis not valid in the destination table type,
the row type / column type will display in red, as seen in the below screenshot. In this instance, either the
column type must be changed in the destination table to a column type that is valid for the destination table
type, or the column type itself must be made valid for the destination table type.

% Tables

Name » |Defined At >
* |Price Table Local
* Specification Table_Dim Dep Local

* |Add Table Type

Specification Table_Dim Dep i s [2 s |3 >
Spec Column ‘_Spec Column b

o [1f Product Mame  Z5 Price
1 *|SpecRow  |sk Free Text| |Heading text h
h

2  »|SpecRow |k Free Text| |Subheading text
3 *|Spec Row ‘Eﬁ Local
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Table Inheritance and Suppression

This section contains information about table inheritance, how to create and remove local overrides for tables, and
how to suppress and unsuppress tables.

STEP tables are based on the principle of inheritance. Just like product attributes set at a higher level in the
product hierarchy are inherited by products lower in the hierarchy, tables that are linked or defined at higher levels
in the product or classification hierarchy are then inherited by lower levels.

You can override the table definitions at lower levels if you need to create local variations of a table. This means
that you can create a table with a default look that applies to an entire publication. You can then override that table
style with a different style for specific a section of that catalog. That section can, in turn, contain a third variation of
the table, and so on.

Inheritance also applies to table formatting and table transformations. See the Configuring Table Formatting
and Table Transformations topics in this guide for more information.

Table Inheritance

Before creating a table, you should consider carefully where in the product hierarchy it should be built. The
creation point is important because tables are inherited downwards in the hierarchy, unless overridden by a local
variation of the table.

If you plan to use your table on a large number of products, it should be defined close to the root of your product
hierarchy. If you are creating a table that will only be used on a small number of product families, or only one, then
select a definition point close to or on the actual product family level.

Making a Local Override

The following modifications result in an override of the inherited table style.

« Adding, changing and removing columns and rows

« Spanning or overriding cells

« Changing the graphical settings for columns, rows or cells
« Adding, changing or removing transformations

« Changing the contents of a free text type cell

Note: If you modify the layout of a table in InDesign, it does not create a local override of the table in STEP.

Overriding a table at a lower level

The following example shows a table that is created at a high level in the hierarchy, and then overridden at a lower
level.
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In this example, the Price Table and Sales Price Table have been created at the Products level. When you have
selected the node on which the table is defined, Local displays in the Defined Atcolumn.

Tree L4 Products rev.0.58 - Tables o complere (IS
B[] Product Overrides Commercial Category Profile || Proof View || Status || State Log || Tasks
Product Sub Products l References ” Referenced By ” Images & Documents ]
1] AUTomotve
Building Products MName e — x Defined At >
{7] Electrical and Electronics s Price Table 2o o
{7] Food and Beverage
= Kitchen > Sales Price Table Local
5 Apparel ﬂAdd Table Type
{7] Footwear Preview
7] Safety
[+-{5 Hardware
--1‘_‘=| Displays
(-5 Furniture
--{'_‘=| Party Supplies
(£ Alarms
"i__=l Bicirarics Mo table is selected
--i‘_‘=| Wedding
--i'_'=| Food

On lower levels in the hierarchy, the Defined At column displays where the tables are defined. In this example,
the 'Apparel' node is selected, and 'Products' displays in Defined At.

Tree
-7 Product Qverrides

J 5 o

Apparel rev.0.39 - Tables

Ll Commercial Category Profile || Proof View |§tatus Skate Log | Tasks

‘_-__ Product Sub Products " References " Referenced By " Images & Documents ]

e s || >
: * Price Table Products
" ;’Eales Price Table Products
> | Add Table Type

+-[T] Party Supplies
[ Alarms

--1'_'=| Electronics
--1'_=| Wedding
--1‘_‘=| Food

Mo table is selected

When an inherited table is changed at a lower level, a local override of the table is created. In this example, if
changes are made to the table contents at the Apparel level, the table still has the same name, but the table
definition is now different than the table defined at the Products level. Local is again displayed in the Defined At
column, and, in turn, all products below the current level will now inherit the new table definition.

Note: Products at sibling levels still inherit the table definition from the higher level in the hierarchy.
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In this example, changes have been made to the Price Table on the 'Apparel’ level. Defined At now displays as
Local.

Tree

Apparel rev.0.40 - Tables
[#-[Z] Product Overrides ~ ||| Commercial Category Profile || Proof View || Status || State Log || Tasks

E‘E Products Product Sub Products [ References ” Referenced By H Images & Documents
[+ Automotive @ Tables '
Building Products Naic ) Defined At >
Electrical and Electronics Y Frioa Table / Local
Food and Beverage
s M Products

> | Add Table Type

Head Wear

Subsequently, the nodes below Apparel now inherit the version of the table built on Apparel.

Tree < Upper Body Wear rev.0.6 - Tables ot compiete [ 21

E Product Overrides ” Cateqgary Profile || Proof View | Status || Skate Log | Tasks
Elj Products _ Referenced By ” Images & Documents [ Commercial ]
"1__=I Automotive Produck ” Product Variants ” Sub Products ” References
[#-I7) Building Products
i . ) D Tables
[+#-I7] Electrical and Electronics
: Mame F |Defined At >
[+-[IZ) Food and Beverage - o :
H &
__1__=| Kitchen FFICE Table Appare
: i Products

# | Add Table Type

: T Head Wear
[#-{5] Footwear
(-9 Safety

Removing a Local Table Override

A local instance of a table can be removed if you wish to return to the definition of the table inherited from a higher
level. This deletion only removes the instance of the table defined at the local level; the table from the higher level
remains.

1. Right-click on the Local table type that you want to delete, then select Delete Table.
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Commercial [ Category Profile ” Proof View " Skakus ” State Log ” Tas
Product Product Variants ” Sub Products ” References ”

Reference
@ Tables
Mame * |Defined At
* Price Table Local
* | Add Table Type \ Copy
Price Table o
Create Table
Harr
Create Empty Table -
| e
Create Table From Clipboard
1 > Mormal Wabe Fre Delete Table ma
2 3 Narmal ‘i Par Suppress Table ma
Remove Table Type Ctrl+Minus

StiboSystems

2. Ifthe table was defined locally, but the local table overrode a table inherited from a higher level, the text under
the Defined At column changes from Local to the name of the node on which the table is built. Due to the

inheritance, the table itself cannot be deleted; only suppressed.

Suppressing Tables

Inherited tables cannot be deleted, only suppressed. Conversely, tables that are created locally cannot be
suppressed, only deleted. See the Creating Tables topic for information on how to delete tables altogether.

A table is suppressed to keep it from being output when mounted to InDesign. For example, you have created an
InDesign template that has text frames for two table types and you have two tables defined on a selection of
products in STEP. Not all products will need both tables included on the mounted page. Suppress the one you do

not need for each product so that it will not be output to InDesign.

1. Right-click on the inherited table that you want to suppress, then click Suppress Table.
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Apparel rev.0.40 - Tables

iz} Boards * ||| _Commercial Category Profile || Proof view || Status || State Log || Tasks |
! i i roduc ub Products eferences eferenced By mages & Documents
£+ Discontinued Products Product || Sub Products || Ref Referenced B I &0 t
[+ External Products & Tabl
"E Fashion Endard Mame > |Defined At »
-] GOSM P cts
& = _m ! * Price Table Products
B[l Packaging
e+-[5] Product Overrides > Sales Price T Copy
=HT) Products ﬂﬁxdd Table T Paste
ey octinion ]
--1'_‘=| Building Products Create Table
..r_=| Electrical and Electronics Create Empty Table js
-'1__:' Food and Beverage Create Table From Clipboard Al ormal
' Delete Table P Prima
4 {2 Apparel
+-[] Upper Body Wear 1  Header Suppress Table o —
([T Head Wear
-5 Footwear 2 * Mormal Remove Table Type Ctrl+Minus

2. Suppressed now displays in the Defined At column. The table can also no longer be defined or previewed;
nothing will display on either the Definition or Preview tab when a suppressed table is selected.

Tree

Apparel rev.0.40 - Tables

-\ Boards Commercial Category Profile | Proof View || Status | State Log || Tasks
: {3 Discontinued Products Product Sub Products [ References " Referenced By ” Images & Documents ]
[+ [BF| External Products ® Tables
Fashion Board Name Defined At S

E Il GOSN Products > P Ep—
- Packaging i
&[] Product Overrides » Sales Price Table Toou
E}|__=| Products ﬂﬁdﬂ Table Type

&8 Automotive Preview

--1'_=| Building Products

i Price Table
--1‘_‘=| Electrical and Electronics

{15 Food and Beverage
--i‘_‘=| Kitchen

. [T Upper Body Wear
i [#-[[7) Head Wear
--r_‘=| Footwear

Unsuppress Tables
To unsuppress a table, right-click on the suppressed table and click Remove Suppression.
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” Proof View ” Skatus ” State Log H_

Commercial Category Profile
Praoduct Sub Products [ References ” Referenced By

Images & Docun

' Tables

MName

W

Defined At

» Price Table

Suppressed

» Bales Price Table

> | Add Table Type

Price Table

Copy
Paste

Create Tabl

Create Empgy Table

Create Tablg From Clipboard
Delete Tab

Remowve Suppression

Remove Table Type

Ctrl+Minus
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Previewing Tables

The table Preview shows a rough estimation of what your table currently looks like. The preview displays the text,
colors, and lines based on how they are defined in System Setup. It does not exactly match what the table will look
like when mounted onto the InDesign page; this is determined by the InDesign settings in the publication template.
So, while the formatting options enable you to assign graphical attributes such as bold, italic, or color to your
tables, it is not a true rendering of the final output.

To Preview a Table

Before you can preview a table, you have to select a specific publication version, since the table can include row
types and column types that are only valid in specific publication types. Additionally, if the table has a row or
column with a Commercial Data content definition, the publication version is important because commercial data is
tied to publication versions.

The table preview only shows the columns and rows that are valid in the selected publication and filters away any
other tables and rows. Likewise, commercial data is specified for a specific publication version, and is therefore
only displayed in the table if the relevant publication version is selected.

The attribute values, references, and images that are displayed in the preview depend on the selected context.

1. Inthe Tree, navigate to the relevant product, classification, or product-override object, then click the Tables
tab.

2. Select the table that you want to preview, then click the Preview tab.

3. Inthe Select Version list, select the preferred publication version. If you cannot see the relevant version, click
Other, and search or browse for the relevant publication in the Select Publication Version window.
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References

* |Add Table Type

Preview

Referenced By ” Images & Documents ” Commercial ]
Product ” Product Variants Sub Products ”
' Tables
Mame » |Defined At
* Price Table Local
» Sales Price Table Party Supplies
» Gpecification Table Local

Select version | Acme Party Supplies/English LS «w Select Preview Mode | Current Mode -

C] Ny . .
ﬁ;ﬁ:m P Acme Party Supplies/French FR. pescription Price
Spring Wedding Catalog/FR_CA .
Dog Party |12 Acme Party Supplies/English US Rurple, goid, blue, pink |319.93
::1:' Hment Spring Wedding Catalog/English US ppecify small, medium
primen Acme Party Supplies/French FR.
Pink & Blue |120spring Wedding Catalog/English US  + [pr giraffe's birthday — |32.49
Giraffe X yyith this pioll and blue |:Hart'_.rhﬂ1:'T
Party Hat L 34
Pink & Blue |121218-A Celebrate your owl's birthday with |34.79
Ol Party é this pink and blue party hat
Hat
I Dog pary treatz zold E:E-;':.vE.*.l"n*l’Ehl’_}-'.*—IA Giraffe not included. = Owd not included.
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Note: The Select Version text is displayed in red if the version points to a different context and workspace
than the ones selected in the toolbar. In this case, you have to change the context and workspace in the
toolbar to match the context and workspace defined on the version.

Previewing Transformations

The Preview tab is also where all local table transformations are assigned to the table that you are previewing. The
table transformations added are only added locally and do not override the table transformations on the table type.
For information about adding table transformations, see the Table Transformations section of this guide.
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Content Definitions

Content definitions determine what content appears in table rows, columns, and cells. The following content
definitions are available for all tables. The below table gives a brief overview of each content definition and a link to
more details in following sections of the Tables documentation.

Content Definition Description Related
Online Help
Topic
Attribute Displays an attribute value for the selected object.The Attribute
Name and ID of an object is also considered an attribute. Content
Definitions

Attribute Group Attributes Extracts all attributes in a group.

Meta Data Attribute Functions like the Attribute content definition except it can
display an attribute that is defined on a reference. This will
only display the value on a reference when the opposing
row or column is using the Node Reference content
definition (as opposed to the Referenced Node content

definition).
Legal Attributes Dynamically resolves legal attributes of the extracted
products.
Current Object Extracts or resolves an object based on where the tableis | Product
extracted. Content
Definitions
First Subproduct, Dynamically returns information from the first child
Classification (subproduct) of a selected classification. This can, for

example, be used to create a header in a table.

First SubProduct, Family Similar to 'First Subproduct, Classification.' Dynamically
returns information from the first child (subproduct) of a
selected product family.

Node Reference Extracts values from a referenced product, classification,
or asset where the reference is owned by a configured
product, classification, or asset.
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Description

Related
Online Help
Topic

Parent

Extracts the parent product up a specified number of
levels in the product hierarchy.

Parent Name

Displays the name of the parent product of the product
that is inserted in the table.

Product/Classification/Asset

Enables you to select a specific product, classification or
asset.

Referenced Node

Extracts values from a referenced product, classification
or asset.

Sub-classifications,
Classification

Extracts classifications that are children of the current
classification or a configured classification.

Subproducts, Classification

Extracts product families manually by pointing to any level
in the classification hierarchy or dynamically from the level
where the table is defined.

Subproducts, Family

Extracts products by pointing to any level in the product
hierarchy or dynamically from the level where the table is
defined.

Asset Points to a specific image or asset. Asset
Content

Asset Reference Inserts an image or asset based on the selected asset Definitions
type.

Free Text Enables you to enter free text content directly in table cells. | Creating
Free text is used where no suitable attribute exists, or Table Types.
where you need to enter some ad hoc data. Free text cells | Free text cells
take priority over any selections made at the row or can be
column level, meaning that the free text will appear translated if
regardless of what content definition has been chosen for | the table type
the other row or column. is language

dependent.
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Content Definition Description Related
Online Help
Topic

Commercial Data Includes terms from a commercial list. Commercial
Data Content

Commercial Data Aspect Includes a date aspect from the data field of a commercial | Definitions

list.

Date Spread Commercial Uses commercial data from a publication dynamically.

Data

Blank Inserts a blank row or column. N/A; No
additional
documentation
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Adding, Editing, and Overriding Content
Definitions

This topic explains how to add, remove, and override content definitions them within rows, columns, and cells in
tables.

Add or Edit Content Definitions for Rows and Columns

1. Inthe Tree, locate the table that you want to edit, then click on the Definition tab.

2. Right-click in the content definition cell on the column or row that you would like to edit, then click Edit. In the
following screenshot, the content definition cell has a preexisting content definition of abe Free Text.

Commercial Proof Wiew " Skatus ” Skate Log ” Tasks ]
Praduct Sub Products [ References ” Referenced By ” Images & Documents

' Tables
Mame * Defined At »
* Price Table Local
> | Add Table Type
Price Table 1 3
Mormal
ab: Free Tewt
[ Y —
Add Column Before
|1 > r\lnrmal abe Free Text Add Column at End :I

Copy Columns
Paste Columns
Duplicate

Remove Column
Expand

Edit
Change Settings

3. Inthe Row/Column Type & Content Definition dialog, choose the relevant content definition from the
dropdown list. For most content definitions, a new dialog will display, requiring you to make additional
configurations.
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$2 Row/Column Type & Content Definition

Column/Row Content definition | Free Text e
Blank S
Commerdial Data

Commerdal data aspect

Current Object

Date Spread Commerdal data

First Subproduct, Classification

First SubProduct, Family

4. See the Content Definitions section of this documentation for next steps on how to choose and configure the
desired content definition.

Override Content Definitions — Override Cell

In some instances, it may be necessary to overwrite the content definition of a row and/or column at the cell level.
One use case is when using the Asset content definition. If applied to an entire column or row, an identical image
will appear in every cell across the row or column. For this reason, the Asset content definition is typically applied

at the cell level.

1. With your table open on the Definition tab, right-click inside the cell(s) that you want to edit, then choose Edit.
Cells may be multi-selected by holding Ctrl or Shift while making selections.

2. Inthe Override Cell dialog, you can choose to override the content definition of the row, column, or both.

32 Override Cell
Row Type Column Type
Col Content definition |¥ree Text |
olumn/Row Content definition |Free Text | v Column/Row Content definition | None w
0K Cancel

3. Select the preferred content definition, then click OK. The dialog changes according to the content definition
you have selected.

To Remove Cell Overrides

1. Follow step 1 above to access the Override Cell dialog.
2. Choose None from the desired Column/Row Content definition dropdown list, then click OK.
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Attribute Content Definitions

Attribute content definitions insert attributes for the selected object(s) in the table. Due to table inheritance, the
attributes chosen for the table do not actually have to be valid on the object on which the table is built, if the table
will be built dynamically using child objects. This would be the case, for example, when building a horizontally read
table that uses attribute content definitions in the columns and a product content definition such as 'Subproducts,
Family' or 'Subproducts, Classification' in the rows.

Attribute content definitions can be applied for individual attributes (both specification and description) as well as
for attribute groups. The available attribute content definitions are:

« Attribute

o Attribute Group Attributes

« Meta Data Attribute

« Legal Attributes

Attribute

The Attribute content definition inserts an attribute for the selected object in the table. The Name and ID of an
object is also considered an attribute.

Note: Only individual attributes can be chosen when using the Attribute content definition; entire attribute groups
cannot. To select attribute groups, the Attribute Group Attributes definition must be chosen. See the 'Attribute
Group Attributes Content Definition' subsection of this topic below for more information.

1. Follow the steps in the Adding, Editing, and Overriding Content Definitions topic to open the
Row/Column Type & Content Definition dialog for your row or column.

2. Inthe Column/Row Content definition dropdown list, select Attribute.
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3 Row/Column Type & Content Definition

Column/Row Content definition | Attribute e
() Name
O
(®) Attribute | Value & Unit w
[ Search ” Legal Attributes
=51 Attribute Groups Py

[+-(20 Address Attribute Group
--E Asset Export Configuration
--I‘:‘_"l Attribute Group

--I‘:‘_"l Autopage Attributes
-5 Auto Test Attribute Group

--I‘:‘_"l Board Essential Attributes W
£ >
- Details
Default Attribute
Transformation
K, Cancel

3. Select Name to insert the object names in the table. If Name is inserted in a column, and the row extracts a
product, then the name of the product is inserted in the table.

4. SelectID toinsert the object IDs in the table. If ID is applied to a column, and the row extracts a product, then
the ID of the product is inserted in the table.

5. Select Attribute to insert a specific attribute in the table. Three tabs are available for locating the attribute:

Browse, Search, and Legal Attributes.The screenshot below shows the dialog with the Browse tab
selected.

Note: In any of these methods, multiple attributes can be selected by pressing Ctrl or Shift while making
selections, but a new row will be created in the table for each attribute selected.
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3 Row/Column Type & Content Definition

Column/Row Content definiion | Attribute e

() Name
OD

(®) Attribute | Value & Unit w

[ Search ” Legal Attributes

--I‘:'_'l Description Attributes ~
=51 Dimensions

-3 Display
B1-E31 Email Attribute Group
-7 Entity Data Container Types v

- Details

Default Attribute

Transformation

QK Cancel

6. When Legal Attributes is selected, two options are available from the dropdown:

« Linked Local - Select this to view all attributes that are linked locally to the selected products. In this option
you will not see any attributes inherited from a higher level. For more information on locally linked attributes,
see the Attribute Links section of the System Setup / Super User Guide documentation.

« All Legal Attributes - Select this to view all attributes that are valid for the selected product. This includes
both inherited attributes and attributes that are linked locally. For more information on attribute validity, see
the Validity on Specification Attributes section of the System Setup / Super User Guide

documentation.
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lBruwse e l| Legal Attributes

All Legal Attributes - Selected

Colar Linked Local - add

Description Long Remowe
Exterior Color
Feature Bullet 2 Add Al
Feature Bullet 6

Interior Color

I50Date

Manufacturer Dual

Manufacturer Dual Mo Dim Dep

Manufacturer Mame

Mew Product

Planned Release Date

Primary Color

Product Family Title

Product Group Description 9
\Secondary Color

Remove All

7. Forthe Linked Local and All Legal Attributes options, select the desired attributes in the left window of the
dialog and choose Add to add them to the Selected window. Attributes may be multi-selected by holding the
Ctrl or Shift key while making selections. To add all of the attributes to Selected, click Add All. To remove a
selection of attributes from Selected, choose the relevant attributes, then click Remove. To remove all
attributes from Selected, click Remove All.

ECT T <o hivives |

All Legal Attributes - Selected

Colar S
Description, Table

Description Long

Exterior Color

Feature Bullet 2

Feature Bullet &

Interior Color

I50Date

Manufacturer Dual
Manufacturer Dual No Dim Dep

Description Long
Manufacturer Mame
Primary Color

Mew Product
Flanned Release Date

Product Family Tite
Product Group Description
Serondary Color ¥
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Resolving the Attribute
The following options are available in the dropdown list for resolving the attribute.

3 Row/Column Type & Content Definition

Column/Row Content definition | Attribute e

() Name

Om

(@) Attribute| | Value & Unit w

B -
TOWSE I it & Value

Value
Linit

&= advancel [FOV Value ID
Convert To Base Value

1. Value & Unit - Attribute values and units are resolved with values (1, below) resolved before units (2, below).

Part Number Item Weight
F-245573 20000

F-245680 20000 W
F-245531 4kg N
F-245682 2kg 9
F-245533 0.5 kg

F-245534 0.75 kg

F-245535 0.25 kg

F-245536 1.25kg

2. Unit & Value - Attribute values and units are resolved with units (1, below) resolved before values (2, below).

Part Number ltem Weight
F-245673 ] £ |
F-245680 a 2000W,
F-245681 of ka 4 \9
F-245652 kg 2

F-245633 kg 0.5
F-245654 kg 0.75
F-245635 kg 0.25
F-245636 kg 1.25

3. Value - Only values are resolved. If the values also have a unit, the unit will not be resolved.
Unit - Only units are resolved. Attribute values will not be resolved.
5. LOV Value ID - The IDs of the LOVs will be resolved.
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Example before LOV value ID resolve:

Part Item ltem Weight ltem Primary |Sound
Humber WWeight Discount |Color
Price

F-245678 g 200 3.99 Green Cinema
F-245680 2000 & Green Compressed

: —p .ﬁ.udiE
F-245681 kg 4000 7 Green Custom
F-245632 kg 2000 2 Green Dyniarmic
F-245683 kg 500.0 10 Green Garme
F-245634 kg 750.00 11 Green Sparts
F-245685 kg 250.00 7 Green Sparts
F-245686 kg 1250.00 10 Green ;'gimi

Example after LOV value ID resolve:

Part Item Item Item Primary Sound
Humber Weight (Weight Discount |Color
Price

IF—2456?8 a 200 3.99 Green 2
IF—24EEEED a 2000 & Green &
IF—245681 kg 4000 7 Green 3
IF—245682 kg 2000 2 Green 7
IF—245683 kg 500.0 10 Green 5
IF—245684 kg 750,00 |11 Green 3
IF—245685 kg 250,00 |7 Green 3
E45686 kg 1250.00 10 Green 12

Convert To Base Value - This will resolve and give the result of the base value. In the below example, two
value units—g (gram) and kg (kilogram)—are used in the Item Weight column. When using the Convert to
Base Value option, the values will be converted to grams.

Example before Convert to Base Value resolve:

Part Humber ltem Weight
F-245678 200 g
F-245530 2000 g
F-245631 4 kg
F-245532 2 kg
F-245633 0.5 kg
F-245534 0.75 kg
F-245635 0,25 kg
F-245636 1,25 kg

Example after Convert to Base Value resolve:
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Part Humber
F-245575
F-245580
F-245581
F-245682
F-2456583
F-245684
F-245585
F-2455865

ltem Weight
200

2000

4000

2000

500.0

750,00
250,00
1250.00

Default Attribute

StiboSystems

Bu using the inheritance feature of STEP, you can link an attribute higher up in the Tree to make it valid at the
appropriate points in the hierarchy / on particular object types. Insert the 'Default Value' at the top level and let it
inherit down. Then, if you need to change this value on some of the children, you can simply change the value. If

later you remove the overridden value, the default value will again populate.

To add a default attribute:

1. Click the ellipsis button (...)to launch the Select Default Attribute dialog.
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3 Row/Celumn Type & Content Definition

(I
(@) Attr

Column/Row Content definiion | Attribute

() Name

ibute | Value & Unit

[ Search ” Legal Atkributes

E

--|°_=I Description Attributes
=51 Dimensions

- [E71 Display

E

Default Attribute

- (251 Entity Data Container Types

@ Details

Transformation

\

Ok

Cancel

StiboSystems

2. Locate the default attribute using either the Browse, Search, or Legal Attributes tab, then click OK. If an
attribute has previously been chosen and you want to remove it, click Select None.
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3 Select Default Attribute

() Name
OD

(@) Attribute | Value & Unit

l Search " Legal Attributes

- 51 CASS Attribute Group
--I‘:'_=“| Category Spedfic Attributes
=71 Color Attributes

B-[E01 Customer Cases
[+-[E0) Customer Data

- Details

Select Mane QK

Cancel

Transformation

StiboSystems

There are numerous reasons to apply a transformation to an attribute in a table. One example would be if the
attribute is multivalued. You can then apply a transformation that specifies how to separate the values.

1. Toapply an attribute transformation to the selected attribute, click the ellipsis button (...) under

Transformation.

2. Select the relevant transformation in from the Select Transformation dialog, then click OK.

3 Select Transformation

MewProductf™

Country Of Origin_Lowercase
ExdusiveYN

IICM Print

IUnited States to USA

Select Mane Cancel
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For more information about applying attribute transformations to tables, including initial setup, see the
Applying Attribute Transformations to Tables section of the STEP Tables documentation.

Legal Attributes Content Definition

The Legal Attributes content definition limits the number of available attributes to attributes that are legal on the
selected object. It also enables additional limitation and sorting options.

1.

o > 0N

In the Column/Row Content definition list, select Legal Attributes.

3 Row/Column Type & Content Definition

Column/Row Content definitiory | Legal Attributes e

[ ] Indude Attributes from Classifications
Only non empty Rows,/Columns

Maximum number of Rows/Columns

Sort on: |Atiribute Name { e Exdude if empty

K Cancel

Select Include Attributes from Classifications to include attributes from classifications.
Select Only non empty Rows/Columns to resolve only attributes with values.
In the Maximum number of Rows/Columns field, enter the maximum number of attributes to be resolved.

From the Sort on list, select the relevant sorting attribute, or leave the default selection of Attribute Name to
sort the rows / columns alphabetically by attribute name. The list is composed of all description attributes in the
system that have been made valid on the Attribute object type and have a validation base type of Number.
The below screenshot shows a representative sample; the attributes will vary from system to system.

Sort on: | Attribute Name w | [] Exdude if empty
Attribute Name

Attribute Display Sequence o Cancel

Completeness Score

Print Display Sequence

Check Exclude if empty to include only attributes that have a sorting sequence entered. In other words, any
attributes (even if they have values entered) without a value in the selected sorting sequence metadata
attribute will NOT be displayed. If this box is not selected, the attributes without a value for the sorting sequence
attribute will be included at the end in alphabetical order.

Click OK when configurations are complete.
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The Attribute Group Attributes definition enables you to select an entire group of attributes and add them to a
table in one operation. Each attribute will appear in its own column / row. For example, if you assign a column to an
attribute group that contains six individual attributes, six columns will be created in the table, unless limiting options

are applied; see the steps below for more information.

The Attribute Group Attributes content definition extracts all attributes in a group dynamically. Therefore, if new
attributes are added to the attribute group in System Setup after the table has been created, new columns or rows

for these attributes will be created dynamically.

1. Inthe Column/Row Content definition list, select Attribute Group Attributes.

3 Row/Column Type & Content Definition

Column/Row Content definitior] | Attribute Group Attributes

Pull Value & Unit

Search

=5 Item Description Information
----- (1T Base Unit of Measure

----- (1T Description Source

----- (I3 Description Target

----- (13 Primary Color

----- (1T secondary Color

----- (I3 short Item Description
----- [T Exdusive?

----- (1T Family Description

..... (1T Long Ttem Description

= Details
Transformation

[ ] Apply Recursively
[ ] Limit Attributes (bo only legal attributes and...)

Indude Attributes from Classifications
Only non empty rowfcolumns

Maximum number of rows/columns

Ok

Sorton |MName Exdude if empty

Cancel
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2. Inthe Pull dropdown list, select what content should be displayed for each attribute. Available options are:
o Value & Unit
o Unit& Value
« Value
o Unit
o LOV Value D
« Convertto Base Value

See the 'Resolving the Attribute' subsection in this topic, above, for explanations of these options.

4. Browse or search for the relevant attribute group using the Browse or Search tab.

5. Toapply an attribute transformation, click the ellipsis button (...) next to the Transformation field and choose
the relevant transformation from the Select Transformation dialog.

32 Select Transformation

MewProducty™

Country Of Origin_Lowercase
ExdusiveYM

IIOM Print

United States to USA

Select Mane Cancel

Only one attribute transformation can be applied to the group. But, a single attribute transformation can contain
multiple transformations, so it is possible to apply all of the transformations that you might require.

Note: The attribute transformation applied to the attribute group in this step should not have previously been
made valid on any attribute or attribute group, including the group to which it is being applied in the table. If the
transformation is valid on any attribute or attribute group, it will not appear in the Select Transformation dialog.

For more information about applying attribute transformations, see the Applying Attribute
Transformations to Tables section of this guide.

6. Check Apply Recursively to apply the transformation.

7. Select Limit Attributes (to only Legal attributes and...) so that only attributes that have been made legal
for the specific products included in the table will be included as columns / rows in the table. Selecting this also
makes more limitations available.

8. SelectInclude Attributes from Classifications to include specification attributes that are inherited from
classifications.

9. Select Only non empty rows/columns so attributes values will not be included as columns / rows in the
table.
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11.

12.

13.
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In the Maximum number of rows/columns field, enter the maximum number of rows / columns to include. A
number is required; if this left blank, rows / columns will be created in the table for all attributes in the group
(unless otherwise limited, e.g., if 'Only non empty row/dolumns is ticked," empty rows / columns will not be
included regardless).

From the Sort on list, select the relevant sorting attribute, or leave the default selection of Name to sort the
rows / columns alphabetically by attribute name. The list is composed of all description attributes in the system
that have been made valid on the Attribute object type and have a validation base type of Number. The below
screenshot shows a representative sample; the attributes will vary from system to system.

Sort on: | Attribute Name w | [] Exdude if empty
Attribute Name

Attribute Display Sequence o Cancel

Completeness Score

Print Display Sequence

The best practice for this option is to create a special 'table sort' attribute that is exclusively used for sorting
rows and/or columns created using the Attribute Group Attributes content definition. For more information, see
the Controlling the Attribute Order in 'Attribute Group Attributes' Within Tables section of the Tables
documentation.

Check Exclude if empty to include only attributes that have a sorting sequence entered. In other words, any
attributes (even if they have values entered) without a value in the selected sorting sequence metadata
attribute will NOT be displayed. If this box is not selected, the attributes without a value for the sorting sequence
attribute will be included at the end in alphabetical order.

Click OK. The Attribute Group Attributes definition is added.

2 3
Mormal Y

Gl Color Attributes
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Controlling the Attribute Order in 'Attribute Group
Attributes’ Within Tables

Understanding the control mechanisms available for the Attribute Group Attributes content definition in tables
will help explain why you need to create a special 'table sort' description attribute to control the order of rows
and/or columns created dynamically from an attribute group.

Though a standard 'attribute display sequence’ attribute can be used to sort table rows and columns created from
an attribute group, this approach is not ideal when different attribute sequencing is needed for different product
categories. Due to this, a special 'table sort' attribute should be created to control the sequencing.

| Images & Documents ” Commercial ]l Category Profile ” Proof Bl Row/Column Type & Content Definition
| Product “ Produck Variants ” Sub P
@ Tables
Name > Defined At Column/Row Content definitiory | Attribute Group Attributes I
> Price Table Local v
» Sales Price Table Products
> | Add Table Type
Price Table =
L E
Mormal
[l Item Description Information
A\
1 » Header (1T Table He... \
2 > Mormal (5 Local \ Transformation

] Apply Recursively
[+] Limit Attributes (to only legal attributes and...)

[Jindude Attributes from Classifications
Only non empty row fcolumns

Maximum number of rows/columns |10

Sort on | Table Sort Order « | [] Exdude if empty

OK Cancel

The steps in this topic assume the following:

« You have created a table type and legalized it

« You have created a table and are creating a column / row content definition of Attribute Group Attributes
(see the Attribute Content Definitions topic in this guide for more information)

« You have an understanding of how to create and populate attributes
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Creating a Table Sort Description Attribute

1.

In System Setup, navigate to the attribute group in which you would like to create the new description attribute,
then right click and select New Attribute.

In the Create Attribute dialog, give the attribute an ID and Name (for example, 'Table Sort Order'), then select
Number for Validation Base Type and No for Multi Valued.

3. Select Description, then click Next.

4. Click Next two more times to bypass the screens for steps 3 and 4 of the wizard. (No validation rules or units

are needed for this attribute.)

In step 5 (Valid For), expand the Valid for Link Types flipper and tick the Product attribute validation box.
(Also tick Classification attribute validation if you intend to link any of your attribute group attributes to a
classification.) Click Next two more times to skip to step 7 (Link to Hierarchy).

3% Create Attribute

Steps Valid For
1, Select Attrbute Graup @ Valid for Product Types Cnd
2. Enter ID and Name @=Valid for Classification Types
3. Enter Validation Rule @=Valid for Asset Types
4. Select Unit(s) = Valid for Entity Types
5. Valid For @ Valid for Publication Types
&. Apply Dimension Dependencies | @ yalid for Version Types
7. Link to Hierarchy @ valid for E-Catalog Types
@ valid for Link Types
[Jan
[ Classification attribute validation
Product attribute validatior:
@ valid for Product Reference Types
@ valid for Classification Reference Types "
Back Next Finish Cancel

6. Linktothe Primary Product Hierarchy, then click Finish.

Populating Values for the Table Sort Attribute

Before the 'table sort' attribute can be used in your table, it must contain values. There are three ways to populate
values for this attribute:

1.

Manually enter values on the References tab of the relevant specification attributes within the attribute group
that is being used in the table

Manually enter values on the References tab of the product(s) used in the table (values may be entered at a
higher level of the product hierarchy in order to inherit to products below)

Import values using a STEPXML file
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Note: Because the 'table sort' attribute is not valid for the Attribute object type (unlike a standard 'display
sequence' attribute used to sort attributes in the workbench), the table sort attribute cannot be modified from the
Attribute tab of the attributes that are being used in the table.

Itis recommended to initially set a sequence by using 10, 20, 30, and so forth. To add attributes in between later,
you can then use 15, 25, 35, etc.

Editing from the Attribute Group

1. In System Setup, navigate to the attribute group that you intend to use in your table, then select the attribute
inside the group that you would like to edit. (Note: Only one attribute at a time can be edited using this method.)

2. Onthe References tab, expand the Valid in Products flipper.

3. Enter values for the table sort attribute. Values may be different for the different levels of the product hierarchy
to which the attribute is linked.

m Base Unit of Measure - References ]
-1 Dimensions = ||| atribute Attribute Transformation || Validity || Profile || Log || State Log || Tasks

% Valid in Classifications

Display

{71 Discontinued Product Maintenance = |
#-£3 Image and Document Maintenanc D * |Name ’
EI £3 Item Maintenance > |Link to Classification Source from Attribute

l -3 Ttem Brand Information ® valid in Products
E E Item Description Information D * [Name » |Completeness Score  * Product Variant Prior. * Table Sort Order | *
1 Base Unit of Measure .
T Description Source > 121166 Party Supplies 10
T Description Target * ProductsRoot Products 20
I3 Exclusive? T || > |Link to Product Source fram Attribute

i ' || inAftribiite Groups

Editing from the Product Hierarchy

1. Inthe Tree, navigate to the level (node) of the product hierarchy where you would like to populate the table sort
attribute.

2. Onthe References tab, expand the Linked Attributes from Product Hierarchy flipper.

3. Insert the relevant values for the table sort attributes. Multiple attributes can be populated at once from this
view.
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Party Supplies rev.0.3 - References

~ Tree

LS
Images & Documents

#-[[0) Promotions o Commercial || Tables || Category Profile |m. |M |m. '
=@ Publications | Product H Sub Products | References Referenced By
Erj Primary Product Hierarchy & Index Words !
E"[[?-Eoi::t;rel © -

[ Footwear || % Linked Attributes from Product Hierarchy

-7 Safaty DisplaySequence *(ID * [Name * |Completeness Score  * Product Variant Prio... {|{Table Sort Order

{7 Hardware ¥ AirTransportationRest... Air Transportation Restr

-7 Displays

- Furniture ¥ AnnualSalesForecast... [Annual Sales Forecast,

&3 Automotive = AnnualSalesForecast,... [Annual Sales Forecast, I

-7 Building Products - i i

H

[#-[7] Electrical and Electronic AttributeA Attribute A

&[5 Food and Beverage o AttributeB Attribute B

- Kitchen —

[]__g Wedding ¥ Attributel Attribute C

=[] Party Supplies 4 Attribute Z Attribute Z

-] Party Hat:
EJ E-rg?ap:rsHats 75 » AvailabilityEnd Availability End
: --- Paper Hats vl - [AvailabilityStart Availability Start 4
Il Balloon Hats * 1 - [BaseUnitOfMeasure  |Base Unit of Measure 10
[+l Pet Hats v

4 m | b 715 - [BrandName Brand Name

If all tables in a particular product category (node) should contain the same column / row sequencing, then values
for the 'table sort' attribute should be populated at the highest level of the category in order to inherit to objects
below. However, inherited values for the 'table sort' attribute cannot be overridden at a lower level of the hierarchy
unless the attribute group attributes are linked to the lower level or values for the table sort attribute are imported
through a STEPXML import. For more information on linking attributes to nodes within the product hierarchy, see
the Linking Specification Attributes section of the System Setup / Super User Guide documentation.

Editing by STEPXML Import

When the attribute group attributes are linked to a higher level (node) of the product hierarchy, the field for the sort
attribute on the References tab is yellow on lower levels of the product hierarchy. This means that the table sort
order cannot be edited from this lower level, as shown in the following screenshot.

P Linked Attributes from Product Hierarchy

DisplaySequence *|ID * |Mame * |Completeness Score  * |Product Variant Prio... {[Table Sort Order
¥ AttrDescid (AttrDescid)
x AirTransportationRest... Air Transportation Restr

“

AnnualSalesForecast...

Annual Sales Forecast, B

“

AnnualSalesForecast,...

Annual Sales Forecast, B

“

AttributeA

Attribute A

¥ AttributeB Attribute B
¥ Attributel Attribute C
¥ Attribute Z Attribute Z
x ~ |AvailabilityEnd Availability End

“

AvailabilityStart

Availability Start

BaseUnitOfMeasure

Base Unit of Measure

10
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The field can become editable if the relevant specification attributes are linked to the level of the hierarchy where
you need to set the value of the table sort attribute. However, if this is not possible or not practical, a STEPXML
load will allow you to edit the table sort attribute value on all object(s) where the specification attributes are valid,
whether that was where they were linked or where the link has inherited to. In other words, this STEPXML load
will allow you to enter values into the yellow fields without having to manually relink the specification attributes to
various locations throughout a product hierarchy.

The following is sample XML that could be used to import a value into a metadata 'table sort order' attribute. The
ID of the table sort attribute in the following example is TableSortOrder.

<?xml version="1.0" encoding="utf-8"?>

<STEP-ProductInformation ImportContext="English US" ContextID="Contextl"
WorkspaceID="Main" UseContextLocale="false">

<Products RejectNewProducts="true">

<Product ID="121168" UserTypelD="Level2" ParentID="121166"> <!--Sample node in
the product hierarchy-->

<Name>Party Hats</Name>

<AttributelLink AttributeID="BaseUnitOfMeasure"> <!--Category-specific
specification attribute linked to the node in the hierarchy-->

<MetaData>

<Value AttributeID="TableSortOrder">100</Value> <!--Table sort description
attribute with value of 100-->

</MetaData>
</AttributeLink>
</Product>
</Products>

</STEP-ProductInformation>
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Product Content Definitions

Most content definitions used in tables are Product content definitions. A common table setup (for a horizontally
read table) uses attribute content definitions for columns and product content definitions for rows.

Product content definitions can be applied to pull information from individual products or classifications, from the
children or parents of these products / product-overrides / classifications, and more. The available product content
definitions are:

o Current Object

« First Subproduct, Classification

« First SubProduct, Family

« Node Reference

« Parent

o ParentName

« Product/Classification/Asset

« Subproducts, Classification

« Subproducts, Family

Note: Any content definition that applies to products also applies to product-overrides.

Current Object

The Current Object content definition resolves to the object on which the table is extracted. You cannot point a
current object row to a specific object. If you, for example, mount a table on the product 123-123 in InDesign, the
current object resolves to 123-123.

In a horizontally read table, a current object row type is typically used with Attribute or Asset Reference column
types to display selected attributes for the products in the rows.

32 Row/Column Type & Content Definition

Column/Row Content definition || Current Object [

Resolves to the object on which the table is extracted.

K. Cancel
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First Subproduct, Classification

The First Subproduct, Classification content definition will extract the first product or product family from either
a specified classification node or dynamically from where the table is defined.

$2 Row/Column Type & Content Definition

Column/Row Content definitior] | First Subproduct, Classification e

(®) Local Classification
() Spedify

Browse m

Search

& advanced =
[ MName

oK Cancel

1. Select Local Classification to pull the information dynamically from the node on which the table is resolved.

2. Select Specify to choose a specific node in the classification hierarchy. This makes the content definition static,
i.e., information from the specified classification will be pulled regardless of the node on which the table is
resolved.

3. If Specify is chosen, use the Browse or Search tab to either browse to or search for the relevant classification.

4. Click OK to add the definition.

Example

5. Thefirst screenshot below shows how the content definition looks on the table on the Definition tab. The
second screenshot shows the table on the Preview tab, which is only pulling the first subproduct.
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- Price Table 1
EHj Full Catalog

----- E Dog Party Hats Assortment

-\ Pirk & Blue Giraffe Party Hat
-\ Pirk & Blue Owl Party Hat
-] Marketing Postcards

~[7] Sales Flyers

[ Spedality Catalog

F#-{[] Company Hierarchy Data Root
F#-{[] Customer Root

[+~ Entity Root

ormal ormal rice

Di ID Primary ... E Price
Mame Product Name

Part Mo, [Image etail Price
1.E5T
(5 Local

Marmal

(13 Product Name

[y
W

Header

=]
W

Marmal

H-[=) UNSPSC-CODE
=[] Web Sites US

| efinition |

Select version | Acme Party Supplies/English US

«w Select Preview Node

- ™ Dog Party Hats Assortment Product Name |Part No. Image Retail Price
-\ Pink & Blue Giraffe Party Hat Dog Party Hats  |[121190-A . S19.99

- - |f™ pink & Blue Owl Party Hat Assortment PO

|j Marketing Postcards

|j Sales Flyers

First SubProduct, Family

The First Subproduct, Family definition will insert the first child product under the family into the table. If you are
already on the lowest level in the node, no product will show up in the table.

You are allowed to indicate at which level the products should be extracted and also if the intermediate levels
should be included. You can also specify which Object Types should be extracted.
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Column/Row Content definitior] | First SubProduct, Family

(®) Local Product
() Specify

Browse m

Search

Marme

Level 1

[ Indude Intermediate Levels

QK Cancel

@ sdvanced m=

Object Type | All Types e
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1. Select Local Product to pull the information dynamically from the node on which the table is resolved.

2. Select Specify to choose a specific node in the product hierarchy. This makes the content definition static, i.e.,
information from this specified product will be pulled regardless of the node on which the table is resolved.

3. If Specify is chosen, use the Browse or Search tab to either browse to or search for the relevant product.

4. Inthe Level field, enter specify the level from where the products should be extracted. For example, if you
select a product group with three levels below, you can specify 1 - 4 depending on how many levels you want to

see.

5. Toalsoinclude the intermediate levels, tick the Include Intermediate Levels box.

6. If you only want the first subproduct of a particular object type to appear, select the object type from the Object

Type dropdown list.
7. Click OK to add the definition.

Example

The first screenshot below shows how the content definition looks on the table on the Definition tab. The second
screenshot shows the table on the Preview tab, which is only pulling the first subproduct.
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-3 Furniture Preview

[T Party Supplies
5[ Party Hats Price Table i jz j3 jq_ j
(=-{17] Paper Hats Mormal Mormal  “Mormal Frice

- Balloon Hats

- Children's Hats 1 Productiame (| 1D Primary ... & Price

=il PetHats —
,a Dog Party Hats Assortment 1 > Header Product Mame PartMo. [mage etail Price
E Pink & Blue Giraffe Party Hat 2 > Normal

----- ™ Pink &Blue Owl Party Hat

EH[IT) Party Hats _[ﬁ iy m
- Definition
=-[IT] Paper Hats
il Balloon Hats Select version | Acme Party Supplies/English US - Select Preview Node
-l Children's Hats -
; = PELF:::: 2 Product Name |Part No. Image Price
: 121180 19.99
: E Dog Party Hats Assortment iii::::r:ats ;ﬂ.ﬁg i
- |{™ Pink & Blue Giraffe Party Hat
™ Pink & Blue Owl Party Hat

Node Reference

The Node Reference will insert a row or column in the table that resolves a reference for a product, classification,
or asset.
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3 Row/Column Type & Content Definition

Column/Row Content definitior] | Mode Reference e
Resolve

Product w
Select Reference Type

Accessory Optional e

Reference number

Browse m

| Search
&= advanced =
[ Mame

oK Cancel

1. For Resolve, choose Product, Classification, or Asset from the dropdown list.

2. Based on the selection you made from the Resolve drop down list, choose a reference type from the Select
Reference Type dropdown.

3. Enter a Reference number to determine how many of the references to show. This field is only relevant if
there is more than one object referenced with the selected reference type. To resolve all references, either
leave the field empty or enter 0.

4. Browse or Search for the object from which you want to extract the reference(s), then click OK.

Parent

Pulls information from a Parent object. Enter a number in the Level field to determine how many levels up in the
hierarchy to go to locate the parent.
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3 Row/Column Type & Content Definition

Column/Row Content definition | Parent [

Level |1

K. Cancel

Parent Name

The Parent Name content definition extracts the name of the parent product of the selected product.

32 Row/Column Type & Content Definition

Column/Row Content definitior] | Parent Name [

Transformation

K. Cancel

The parent name that is displayed comes either from the product or the classification hierarchy. Because product
can be linked to both a product hierarchy and a classification hierarchy, the parent name depends on whether the
product was inserted as a classification or a product.

To apply a transformation to the parent name value, click the ellipsis button (...) in the Transformation field. For
more information about applying attribute transformations to data in tables, see the Applying Attribute
Transformations to Tables topic.

Example

The first screenshot below shows the table on the Definition tab, with the Parent Name content definition applied
in the last column. The second screenshot shows how the table looks resolved, on the Preview tab. The object
name is extracted in the first column (1), and the names of the objects' parents are extracted in the fourth column

2).
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=
Price Table 1 3 (2 3|3 » |4 N
EI‘ Cotton T-shirts Marmal Mormal Mormal Marmal
E 18210M8B [If mame T erand Qwner (| Short Item Des...Parent Name
| 182121 B
- |{® 18213M 0 |
E 187161 0 1 » Header 1F mame Current Brand Owner Short Item Descgpf,, [Current
ﬁ Mew Shirt 2 *» Mormal (5 Local /
(- Pelo T-shirt
[#-[[) T-Shirts Sales Items & Row/Column Type & Content Definition
[#H[[T] Head Wear
[T Footwear
-] Safety
[HE Hardware Transformation
[+-[[7] Displays
[+-{{7] Furniture
[+-{7] Automotive
= o ()4 Cancel
[+ Building Products
[#-{17] Electrical & Electronics
FUDICETONS
Definiti |
Primary Product Hierarchy =rinition m
[[] Products Selensiun Spring Wedding Catalog/English US 9
=I-[I5) Apparel
: T-shirts Items Brand Cwner Short Ttem Description T-shirts
[T Upper Body Wear : -
: ] 12-GGKTI T-shirt, Acme, blue, T-shirts Items
=-[T] T-shirts ; ; >
&= E T-shirts Items [Cotton Tshirts | Acme Brands T-shirts Ttems
l o] 12-GGKTS 18210M B Acme Brands T-shirt, short sleeve, Beefy-T, JCotton T-shirts
E'i Cotton T-shirts Mens M, Royal Blue
E 18210 M B 18212LE Acme Brands T-shirt, short sleeve, Beefy-T, JCotton T-shirts
,E 18212 LE Mens L, Royal Blue
E 182131 M0 18213 MO Acme Brands T-shirt, short sleeve, Beefy-T, JCotton T-shirts
E 18716 L O I"-"Ienls M, Orange .
ﬁ Mew Shirt 18216L 0 Acme Brands T-shirt, short sleeve, Beefy-T, [Cotton T-shirts
B |r. Mens L, Orange
(.- Jill Polo T-shirt Iew shirt Tshirts Ttems
[+-[[5) T-Shirts Sales Items [Polo T-shirt T-shirts Items
(+-[[T) Head Wear |polo & Polo T-shirt
[+ 7= Fanhusar ——

Product/Classification/Asset

The Product/Classification/Asset content definition enables you to select a specific product, classification, or asset.
This selection is not dynamic; the content selection remains the same regardless of where the table is resolved.

In a horizontally read table, a Product/Classification/Asset row type is typically used with Attribute column types.
For example, if you want to display the name of the object or selected attributes on the object.
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If you select an asset, the asset itself (e.g., image) is not displayed in the target cells. However, if using the
Attribute content definition for the column, you can display the name or the ID of the asset in the cell(s). Likewise,
if you select a classification, you can let the target cells display the name or ID of the classification.

1. Inthe 'Column/Row Content definition' list, select Product/Classification/Asset.

2. Browse to or search for the relevant product, classification or asset, then click OK. Multiple objects can be
selected by holding Ctrl or Shift while making selections. Individual rows / columns will be created for each
selected object.

¥ Row/Column Type & Content Definition

Column/Row Content definitior]  Product/ClassificationfAsset | -«

orowse |2

--1‘_‘=| Electrical and Electronics A
--i‘_‘=| Food and Beverage
-5 Kitchen
--i'_'=| Apparel
EH'_=| Footwear
: E}Fj Shoes
E|r_=| Pumps
=} il Pumps Items
. Eli Heels - High: 3" ar higher
>E Red Pumps W

- Details

Ok Cancel

3. The following is an example of a product object in a row, with Attribute content definitions in the columns pulling
the Name and ID of the product.

Frice Table 1 jj
Maormal armal

(1T Mame B

[y
W

Header + Red Pumps Red Pumps 20695-A

Referenced Node

The Referenced Node content definition extracts values from a referenced product, classification or asset.
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If the product that you have created the table on has a product reference to another product, adding a Referenced
Node row type enables you to extract values from the referenced product. For example, a product 'AAA-100' has
a product reference to another product, '"AAA-200."' The reference type is 'Accessory Optional.' Creating a table on
'AAA-100" with a row type 'Referenced Node' will allow you to extract values from 'AAA-200."

Note: Using Reference node in tables will only bring you the referenced products from the current node. You will
not be able to fetch the subproduct(s) referenced products using this functionality.

32 Row/Column Type & Content Definition

Column/Row Content definitior] | Referenced Mode P
Resolve

Product w
Select Reference Type

Accessory Optional e

Reference number (D=All)

oK Cancel

1. Select the relevant object type from the Resolve list. The available options are Product, Classification, and
Asset.

2. Fromthe Select Reference Type list, select the relevant reference type.

3. Inthe Reference Number field, specify the number of the reference type to resolve. This field is only relevant if
there is more than one object referenced with the selected reference type. To resolve all references, either
leave the field empty or enter 0.

Example

In the below example, the table will be resolved on the 'Heels - High: 3" or higher' product object. On the
References tab, three products are linked from a different folder using the 'Accessory Optional' reference type.
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L:-H__=| Apparel ™ | Commercial " Tables ” Category Profile ” Proof Wiew || Status
(+-[[T] Upper Body Wear | Produck ” Product Variants ” Sub Products ] References |
=[] Head Wear | =F Discontinued Product Maintenance

[=-f77] Hats and Caps @5 t Ref
" @ Image References
2= [tem References, Classification
ZF Reference Attributes
. - Sales Item References, Classification
r_=| Hats and Caps Sales Item ¥ Sales Item References, Product

EH__=I Footwear Reference Type w| » [Target > |Th

[T Shoes
El Pumps )
Dn @ =
}E 20714 * |Accessory Optional + \‘Hﬁ 233438
| 20714
[ 207148 -
>E Red Pump-Ca
... 20714D w

A very simple table has been built that will pull the name of the objects that are linked using the Accessory Optional
content definition.

-l Pumps Items

/- il Heels - High: 3" or higher Price Table 1 >
E Red Pumps Mormal
- ™ 20714
M
-\ 207144 [T name
- ™ 207148
™ Red Pump-Ca 1 »Header Nabe Free Text Mame
E 20714-D 2 > Mormal HE-/ Accessory Optional
- 20714€ L

The resolved table lists the names of the referenced objects.

pefinition | il

Select version | Acme Par

Name

233437
233438
233439
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Sub-classifications, Classification

The Sub-classifications, Classification content definition works identically to the 'Subproducts, Classification'
definition, except this definition displays sub-classifications instead of subproducts. See the following subsection,
'Subproducts, Classification' for more information.

$2 Row/Column Type & Content Definition

Column/Row Content deﬁnitiunl Sub-dassifications, Classification | -

(®) Local Classification
(O spedfy

Browse m

| Search
& advanced =
| Mame

oK Cancel

Subproducts, Classification

The Subproducts, Classification content definition extracts all products that are children within a specific
classification, either manually from a specific level in the classification hierarchy, or dynamically from where the
table is defined.

When you have selected a level in a classification, a row is inserted in the table for each product that the
classification contains. So, if a classification contains three products, three rows are added to the table, unless
filtering options such as object type are applied (see steps below for more information).

In a horizontally read table, a Subproducts, Classification row type is typically used with Attribute or Asset
Reference column types. You can, for example, use the Attribute column type to display selected attributes for the
products in the rows.
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Column/Row Content definition

Subproducts, Classification |-

(®) Local Classification
(O Specify

Browse m

&= Advanced

Search

[ Mame

K. Cancel

StiboSystems

1. Select Local Classification to extract the product families dynamically. The subproducts are added to the
table depending on where the table is extracted.

2. Select Specify to choose a specific classification from where to extract the product families. This selection is
static, and remains the same regardless of where the table is extracted.

3. Search or Browse for the relevant classification, then click OK.

Example

The first screenshot below shows the Subproducts, Classification content definition on the Definition tab. The
second screenshot shows the resolved table on the Preview tab, with one subproduct per row.

4[] UNSPSC-CODE
=[] Web Sites US
=) Full Catalog
ﬁ Dog Party Hats Assortment
™ Pink & Blue Giraffe Party Hat
| Pink & Blue Owl Party Hat
-] Marketing Postcards

~[[T] Sales Flyers

~[7] Spedality Catalog

EEI--@ Company Hierarchy Data Root
{7 Customer Foot

[+ Entity Root

Price Table

1

Mormal

ormal ormal rice

(I3 Product Name

DI D Primary ... E Price

=
L

Product Mame

]
W

Header Mame
Maormal o Local

Part Mo, 4\mage $E1ﬁi| Price q
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-] UNSPSC-CODE pefinition |l
El"%-wéb;teﬂsai Select version | Acme Party Supplies/English US — « Select Preview Mode
E Dog Party Hats Assortment Product Name |Part No. Image Retail Price
E Pink & Blue Giraffe Party Hat Dog Party Hats  |121190-A i 51959
| pink & Blue Owl Party Hat Assortment dr i
~[C] Marketing Postcards Pink & Blue 121183-A b 52.49
~[T] Sales Flyers Giraffe Party Hat X
~[] Spedality Catalog b
[-{[] Company Hierarchy Data Root Pink & Blue Owl  [121218-A 479
[+-{[] Customer Root Party Hat é
[+]--F= Entity Root

Subproducts, Family

Use this when you want to extract all products contained within the selected level in the product hierarchy.

The Subproducts, Family content definition extracts product families either manually from a specific level in the
product hierarchy or dynamically from where the table is defined.

When you have selected a level in the product hierarchy, a row is inserted in the table for each product that the
product level contains. So if a product level (family) contains three products, three rows are added to the table,
unless filtering options such as object type are applied (see steps below for more information).

In a horizontally read table, a SubProducts, Family row type is typically used with Attribute or Asset Reference
column types, for example, if you want to display selected attributes or images for the products in the rows.
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3 Row/Column Type & Content Definition

Column/Row Content definitior] | SubProducts, Family e

(®) Local Product
(O Specify

Browse m

|
&= Advanced =

[ Mame

Search

Level 1
[] Indude Intermediate Levels

Object Type | All Types e

K Cancel

1. Select Local Product to extract the product families dynamically. The subproducts are added to the table
depending on where the table is extracted.

2. Select Specify to select a specific product level from where to extract the product families. This selection is
static, and remains the same regardless of where the table is extracted.

3. Optionally, enter the Level from where you want the products to be extracted. This refers to the number of
nested subfolders downward in the hierarchy. For example, if 2 is entered for Level, then the objects mounted
in the table will be pulled from two levels below where the table is built.
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1T Products + Price Table
=-{15) Apparel ﬂ’ﬂ‘dd Table Type 3% Row/Column Type & Content Definition
E}Fj Upper Body Wear Preview
= Price Table Column/Row Content definition | SubProducts, Family w

(®) Local Product
=-Jjill Cotton T-shirts

| 13210MB () Specify

- 182121 B |

i 1 » Head M, -

E 15213M 0 =aner DI ame Browse m

™ 18216L O 2 > Normal (Cf Local —
E Mew Product 123

E Mew Shirt @ Advanced =

[#-[[T] T-Shirts Sales Items
(-7 Head Wear

(-7 Footwear [ Name
-] safety
[-[7) Hardware
[T Displays Level 2
F=-{I) Furniture [] Indude Intermediate Levels
-7 Automotive
[+-{I5) Building Products Object Type | Al Types i
(-7 Electrical & Electronics
[H-[T] Food and Beverage oK cancel
-] Kitchen
=) Apparel Definition m
=0 Upper Body Wear Select version | Spring Wedding Catalog/English US
T-shirts Items Brand Owner Short Item Description
18210 M B Acme Brands T-shirt, short sleeve,
Beefy-T, Mens M, Rovyal
Blue
18212LE Acme Brands T-shirt, short sleeve,
Beefy-T, Mens L, Rovyal
Blue
18213 M0 Acme Brands T-shirt, short sleeve,
- New Product 1234 Beefy-T, Mens M,
| New Shirt Orange
fi}- [ T-Shirts Sales Ttems 18216 L O Acrne Brands T-shirt, short sleeve,
Beefy-T, Mens L,
[T Head Wear Orange

4. If you want the intermediate levels to be included as well, click the Include Intermediate Levels checkbox.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 141



I_I FrouucLs

L——_Ir_=| Apparel
E]|j Lipper Body Wear
=I5 Tshirts

pefinition |l

StiboSystems

Select version | Spring Wedding Catalog/English US

E—}-.ﬁ T-shirts Items

- |f™ 18210MB

™ 132121 B

™ 18213M O
a New Product

[T T-Shirts Sales Items
BT Head Wear

+-{[T] Footwear

{17 Safety

{17 Hardware

£

-

+|-[[T] Displays

+..I5= Fornihire

n Mew Shirt

T-shirts Items Brand Owner Short Item Description |

12-GGKT9 T-shirt, Acme, blue,
cotton/polyester

Cotton T-shirts Acme Brands

18210 M B Acme Brands T-shirt, short sleeve,
Beefy-T, Mens M, Rovyal
Blue

18212LEB Acme Brands T-shirt, short sleeve,
Beefy-T, Mens L, Rovyal
Blue

18213M 0O Acme Brands T-shirt, short sleeve,
Beefy-T, Mens M,
Orange

18216L 0 Acme Brands T-shirt, short sleeve,
Beefy-T, Mens L,
Orange

Mew Product

Mew Shirt

5. Optionally, select an object type from the Object Type list, to limit the number of extracted productsto a

specific object type.

Additional Example

The first screenshot below shows the Subproducts, Family content definition on the Definition tab. The second
screenshot shows the resolved table on the Preview tab, with one subproduct per row.

-0 Party Supplies

=15 Party Hats

E|r_=| Paper Hats
- Balloon Hats
- Children's Hats
= il Pet Hats

----- E Dog Party Hats Assortment

Price Tahle

1

Marmal

armal armal rice

(1% Product Name [T 1D

Primary b Price

-\ Pirk & Blue Giraffe Party Hat

W

Header

Mame Product Name

W

Mormal 5 Local

Part Mo. 4\mage {rice q
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[0 Party Supplies

[=}[I5) Party Hats

E|r_=| Paper Hats
[+ i Balloon Hats
‘ Children's Hats
C- i PetHats

ﬁ Dog Party Hats Assortment
™ Pink &Blue Giraffe Party Hat
™ Pink &Blue Owl Party Hat
[H[[T] Masks

[T Streamers

BT Child Birthday Parties

| pefinition |t

StiboSystems

Select version | Acme Party Supplies/English LS

w Select Preview Mode

Product Name (Part No. Image Price
Dog Party Hats  [121180-4 44 515.99
Assortment i
Pink & Blue 121183-A b 52,45
(Giraffe Party Hat )

15
Fink & Blue 0wl [121218-A .79
Party Hat é
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Asset Content Definitions

Two content definitions are used to display assets in STEP Tables: Asset and Asset Reference. In most cases,
assets that are displayed in tables are images.

Asset

Use the Asset content definition to point to a specific asset. This is not a dynamic content type.

The Asset definition is most often used at the cell level in combination with the Cell Override setting. This is
because, if applied to an entire column or row, an identical image will appear in every cell across the row or
column. Asset cells take priority over any selection that has been made at the row or column level with the
exception of Free Text. For more information on the Cell Override setting, see the Adding, Editing, and
Overriding Content Definitions topicin this guide.

Applying the Asset Content Definition to a STEP Table Row or Column

1. With your table open on the Definition tab, Right-click in the content definition cell on the column or row that

you would like to edit, then click Edit. (In the following screenshot, the content definition cell has a preexisting
content definition Of abe Free Text ).

¢ Tables

MName > \Defined At
> |Price Table Local
> AAd Tahbla "ype

Price Table 1 s |2 s |3

Mormal ormal Nnormal

abe Free Text  ||IT Product Na... [|T ID
Add Column Befare
Add Column at End
Copy Columns
Paste Columns
Duplicate

1 *Header NIT name
2 »|Normal ‘Eﬁ Local

Remaove Column

Expand
Edit
Change Settings

2. Inthe'Row/Column Type & Content Definition dialog,' select Asset from the Column/Row Content definition
list.
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33 Row/Column Type & Content Definition

Column/Row Content definiion | Free Text

ference
Attribute
Attribute Group Attributes

Blank

Commerdial Data
Commercial data aspect
Current Object

32 Row/Column Type & Content Definition

Column/Row Content definition | Asset I

Search

{7 Assets

: E}Fj Icons

o &) BlueTruckicon

Ja] Ew!

E Product

E Trucklcon

[ Tustrations

rj Installation Manuals v

® Details
. 1 %] TruckIcon
“-.L D = 157813

OK Cancel

Price Table 1 jz
Mormal Mormal
[ TruckIcon o
1 *|Header 1 name JF’EFT Mo.
2 *|Normal & Local |
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3. Browse or search for the preferred asset, and then click OK. Only one asset may be selected.

4. The Content Definition of the row or column is now set to Asset. The STEP Name of the asset (e.g.,
Trucklcon) appears in the Content Definition cell on the Definition tab.

5. The selected asset is visible in the table, both on the Definition tab and the Preview tab.
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Definition m

Select version iAcme Part

Part No.
121184-A

|l
!
|l
|l

!

121177-A

121171-4A

1211593-4

121182-A

Asset Reference

The Asset Reference content definition is also typically used to insertimages into table cells. However, unlike the
Asset content definition, which only allows the selection of a specific asset, the Asset Reference content
definition is a dynamic content type.

The Asset Reference content definition is used to insert assets that are linked to products, classifications, or
product-overrides by an asset Reference Type.

In a horizontally read table, the Asset Reference content definition is typically used in a table column in
conjunction with one or more table rows that use one of the following content definitions:

o Current Object

o SubProducts, Classification

o SubProducts, Family

o Product/Classification/Asset

Applying the Asset Reference Content Definition to a STEP Table Row or Column

1. With your table open on the Definition tab, right-click in the content definition cell on the column or row that
you would like to edit, then click Edit. (In the following screenshot, the content definition cell has a preexisting
content definition of ate Free Text )
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@ Tables
Marme > |Defined At
> Price Table Local
> |add Tahls Type
Price Table 1 > |2 >3
Mormal ormal Mormal
ae Free Text  ||T Product Na... [IT ID

[y
W

Header qI:II Mame

Mormal i Local

(%]
W

Add Column Befaore
Add Column at End
Copy Columns
Paste Columns
Duplicate

Remove Column

Expand
Edit
Change Settings

Sty

boSystems

In the Row/Column Type & Content Definition dialog, select Asset Reference from the Column/Row Content

definition list.

32 Row/Column Type & Content Definition

Select Reference Type

Column/Row Content definition | Asset Reference

Primary Product Image

[] Extractal

oK

Cancel

Select the relevant reference type from the Select Reference Type list, (for example, Primary Product

Check Extract All to extract all referenced images of the selected type. This is only relevant if the product,
classification, or product-override object has multiple images referenced using the same Reference Type. If
there are multiple images referenced, all of the images will be inserted into the same table cell.

3.

Image).
4.
5. Click OK.

6. The content definition of the row or column is now set to Asset Reference. The STEP Name of the asset

reference type (e.g., Primary Product Image) appears in the content definition cell on the Definition tab.
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Price Table

1 #2
MNormal Normal

Primary Product Image |II Product Mame

W

Header qI]I Marme

2 *|Normal i Local

4Product Name

7. Thereferenced images / assets appear in the table on the Preview tab.

Definition m

Select version ihcme Party Supplies_comr

Product Name

Christmas Party Hat

Cosmic Party Hat

Pink & Green Party Hat

Pink & Green Pom-Pom Hat

Political Party Hat

B S e > &

Purple & White Party Hat
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Commercial Data content definitions enable you to reference commercial data from a publication version in a

table. Three content definitions are available for commercial data:

« Commercial Data

o Commercial Data Aspect

« Date Spread Commercial Data

Commercial Data

The Commercial Data content definition is used to extract values from commercial terms lists.

1. Inthe 'Column/Row Content definition' list, select Commercial Data.

£ Row/Column Type & Content Definition

Commercial Data

Column/Fow Content definition

Price
Break-point Mo

i) Name

O

() Price

i) Minimum Quantity
() Start Date

() Unit Name

i) Lead Time

(") Lot Size

Transformation

() Maximum Quantity
(") End Date

() Unit ID

Ok

2. From the next dropdown list, select the commercial list that you want to include in the table.
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3 Row/Column Type & Content Definition

Column/Row Content definition | Commerdal Data e
Price w~
Catalog Spedific Price s

Copy Percent Complete
Cover Design Due
Cover Photo Shot Due
Front Cover Ttem (/M)
On Hand

SalesPrices W

3. Inthe Break-point No field, enter the value of the break-point number of the term that you want to reference.

4. Select the relevant term type from the available types (Name, ID, Price, etc.).

5. To apply an attribute transformation to the resolved commercial data, click the ellipsis button (...). in the
Transformation field. A common transformation for commercial data is to add a currency symbol before the

prices, e.g., $or €.

For more information about adding attribute transformations to data in tables, see the Applying Attribute
Transformations to Tables topic.

Example
The following table has a Commercial Data content definition in the last column.

Price Table 1 j’j jz
Mormal ormal ormal rice

[If Productvame (]I ID Primary Produ} . 35 Price
Header 1 Mame Product Mame PartMo. cme Brands rice
Mormal & Local

The resolved table displays the pricing values.

L
L

=
L

[
W
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[+-{£5] Furniture
[l]r_=| Party Supplies
=) Party Hats
=-{IT] Paper Hats
- Balloon Hats
- Children's Hats
=il PetHats
- |f™ Dog Party Hats Assortment
----- E Fink & Blue Giraffe Party Hat
----- E Pink: & Blue Owl Party Hat
[T Masks
[-[[T] Streamers
[+ Child Rirthdav Parties

pefinition |l
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Select version | Acme Party Supplies/English LS

«w Select Previe

Product Name |Part No. Acme Brands | |Price
Dog Party Hats  [121190 519.99
Assortment "j" B
Pink & Blue 121183 ‘b" 52.49
Giraffe Party Hat b,

€
Pink & Blue Owl [121218 3479
Party Hat é

The three products mounted in the table pull their values from the 'Acme Party Winter Retail Pricing' list.

T [

¥-{[] Promotions

1]@ Publications

@ Templates

@ AutoPage Publications

@ Standard Publications

E}@ Flatplanner Publications

-- Christmas Catalog

=] il Acme Party Supplies

=1-{[& Commerdal Data

~[&] Acme Party Winter Retail Pricing
-85 Availability

-85 Back Cover Ttem (¥/M)
45 Catalog Case Price
’ Catalog Spedific Price
-85 Copy Percent Complete
451 Cover Design Due
~45) Cover Photo Shot Due
-[&Z] French Prices

-85 French Prices

-85 Front Cover Ttem (¥/N)
-8 On Hand

t-[=] Party Hats

-5 Party Favors

r+-L=] Paper Hats_Mounted Table

mm

51

L]

 rce ot T
& E . I-

¥ Content of Price
Product

Showing 13 terms. There are terms for 13 differer

W

Product Value

>

* Pink & Green Party Hat

* Mardi Gras Mask - Green

» Mardi Gras Mask - Gold

* Cosmic Party Hat

* Purple & \White Party Hat

* [ellow & Pink Party Hat

» Blue & Yellow Balloon Hat

* Blue Wizard Balloon Hat

Pink & Blue Giraffe Party Hat|$2.49

Dog Party Hats Assortment 1$19.99

> Politics Party Hats |$1?.?‘E

>_Pigk & Green Pom-Pom Hat_ 152,93

. Pink & Blue Owl Party Hat |$4.:r'9

*> | Add Product

This list is connected to the English US Version of the Acme Party Supplies catalog.
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@ Templates ”

[+ [ AutoPage Publications
[+l Standard Publications
=} Flatplanner Publications
-- Christmas Catalog /
1[0 Acme Party Supplies
-- Commerdal Data
-3 Party Hats
--ﬁ Party Favors

AutoPage Publication Planner

StiboSystems

Acme Party Supplies - Version

| Publication ” Milestone Dates

Pagination Rules || Page Inspector
" Plan ] [

Skatus || State Log || Tasks
Notes || Fi

Pages ” Publication Planner " Flan

& Viersion Descript

D 1 [Mame » [(Context * [Workspace *|Price >
* (128525 English U5 English U5 Main cme Party Winter Retail Pricing
» 204372 French FR. French France Main French Prices
* 204373 zerman DE Germany German  Main
|* | Add version

-5 Paper Hats_Mount

The pricing is viewed in the resolved table by selecting the Acme Party Supplies/English US version from the
'Select version' dropdown list on the tables Preview tab.

pefinition |l

[+-{5] Furniture

EI{'_=| Party Supplies

=) Party Hats

E|r_=| Paper Hats
- Ealloon Hats
- Children's Hats
=i PetHats

[T Masks
BT Streamers
[+ Child Rirthdaw Parties

-a Dog Party Hats Assortment
----- N Pink & Blue Giraffe Party Hat
----- N pink & Blue Owl Party Hat

Commercial Data Aspect

The Commercial Data Aspect content definition is used to extract a value from a terms list that is not in the Value

field. The following aspects can be extracted:

« Start Date
« EndDate
o Minimum Quantity

o Maximum Quantity

Select version

Acme Party Supplies/English US

w Select Previe

Product Name |Part No. Acme Brands |Price
Dog Party Hats (121180 44 519.99
Assortment e
Pink & Blue 121183 A 22.49
(Giraffe Party Hat b

€
Pink & Blue Owl [121218 $4.79
Party Hat é
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< Cover Design Due - Price List
[Price st [
o

' Content of Cover Design Due

Product Search
Showing 2 terms. There are terms for 2 different prodycts
Product » [Value * [Min Quantity  * Max Quantity  * |Start Date » [End Date >
* Pink & Green Party Hat Spring Catalog 1 o 2025-02-26 13:10:15  [2025-05-26 13:11:40
» Dog Party Hats Assortment Spring Catalog 1 o 2025-03-01 131210 [2025-06-30 13:12:25
| * |Add Product

When pulling a date, this definition can display, for instance, the name of a weekday without having to store this
weekday explicitly in STEP.

Important: For the Commercial Data Aspect content definition to work, you must apply the 'Date Spread
Commercial data' content definition in an opposite row or column.

$2 Row/Column Type & Content Definition

Column/Row Content definitior] | Commerdal data aspect Y

Value To Extract Start Date w

Date Aspect MM-DD-¥YYY v
K. Cancel

1. Inthe 'Column/Row Content definition' list, select Commercial Data Aspect.

2. Inthe Value To Extract list, choose 'Start Date' or 'End Date' to pull a date value. Choose 'Minimum Quantity'
or 'Maximum Quantity' to pull a quantity value.

£ Row/Ceolumn Type & Content Definition

Column/Row Content definition | Commerdal data aspect e

Value To Extract Start Date e

Date Aspect
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3. Ifyou chose Start Date or End Date in the Value to Extract list, select the relevant aspect from the Date
Aspect dropdown. This is not relevant if you selected Minimum Quantity or Maximum Quantity.

32 Row/Column Type & Content Definition

Column/Row Content definiion | Commerdal data aspect e

Value To Extract Start Date e

Date Aspect MM-DD-YYYY [
Day
Month
Month Mame =
Short Month Mame
Weekday

Short Weekday
Year

Date aspects resolve as follows:

Date Aspect Renders

MM-DD-YYYY 06-11-2025

Day 6
Month 11
Month Name November

Short Month Name | Nov

Weekday Thursday

Short Weekday Thu

Year 2025
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Date Spread Commercial Data

The Date Spread Commercial data content definition enables you to pull multiple commercial data values from a
single product. For example, if a single product has multiple prices for different time periods, a corresponding

number of rows with these prices can be created dynamically.

For each product in a table, Date Spread Commercial data pulls all values (typically prices) from the commercial
list and sorts them by time periods. For each time period, a row is created dynamically.

Important: Itis not possible to make Date Spread Commercial data rows and columns non-dynamic.

1. From the 'Column/Row Content definition' list, select Date Spread Commercial data.

82 Row/Column Type & Content Definition

Column/Row Content definiion Date Spread Commerdial data e

Price Y

K Cancel

2. Select the commercial list that contains the terms you want to include in the table, then click OK.

32 Row/Column Type & Content Definition

Column/Row Content definition | Date Spread Commerdal data e

Price L
Catalog Spedific Price Y
Copy Percent Complete

Cover Design Due

—|Cowver Phota Shot Due

Front Cover ITtem (¥ /M)

On Hand

SalesPrices W
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Modifying Tables

This topic explains how to make changes to cells, rows, and columns in a table. Also described is how to add,
delete, and resequence columns and rows; copy and paste columns, rows, and cells; and how to span or merge
multiple table cells.

This topic assumes that you have already built your table and have it open with the Definition tab selected.

Add Rows and Columns

You can create columns and rows before the current column or row or as the final (end) row or column of the
table.

Add Row Before

1. Right-click inside of the content definition cell ('Local,' in the below example) or the number of the row (2, in the
below example) that you would like to add a new row before, then click Add Row Before.

| Referenced By H Images & Documents ] [ Skatus H Skate Loc
Classification Sub Products
' Tables
Mame * Defined At
> Pri::e Table Local
> | Add Table Type
Price Table 1 j’j
Maormal armal

[If Productiame | D

[y
b

Header qDI Mame Product Mame Part Mo,

z » Mormal Cq Local
\ Add Row Before

Add Row at End

Copy Rows
Paste Rows
Duplicate

Remowve Row
Expand

Edit

Change Settings
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2. The Row/Column Type & Content Definition dialog displays.

33 Row/Column Type & Content Definition

Column/Row Type Header
s

Column/Row Content definiion | Asset

Browse m
Search

@ Advanced

[ Mame

0K Cancel

In the Column/Row Type list, select the relevant row type.
In the Column/Row Content definition list, select the relevant content definition.

3.
4,
5. Click OK to add the row. In the below example, a row type of Normal and a content definition of Free Text was
chosen.
Price Table 1 j’j
Mormal ormal
DI Product Mame DI 1D
1 * Header ‘ﬂf Mame Product Mame Part Mo,
2 » Marmal ab: Free Text
3 » Maormal 1@ Local

Add Row at End
Right-click inside of the content definition cell or the number of any row in the table, then click Add Row at

1.
End.

157
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| Referenced By ” Images & Documents ] [ Skatus " Skate Log
| Classification Sub Products
' Tables
Mame * Defined At
> Fri::e Table Local
> | Add Table Type
Frice Table 1 ji
Marmal armal
1T Product Name (] D
1 > Mame Product Mame Part No.

Header i
2 Normal g Local

N

Add Row Before
| AddRowatEnd |
Copy Rows

Paste Rows
Duplicate

Remove Row
Expand

Edit

Change Settings

2. Follow steps 2 - 5in the previous section to add the row.

Price Table 1 j’i
Mormal ormal
[If ProductName |[JT D
1 » Header 1T Mame Product Name PartNo.
2 > Mormal Local
3 |> Mormal abe Free Text
L

Add Column Before

1.

StiboSystems

Right-click inside of the content definition cell or the number of the column where you would like to add a new
column before, then click Add Column Before.
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Price Table 1 j’i NE s |4
Mormal ormal ormal ric
DI Product Mame Di D ‘M
olurmn Before
™A | Add Column Bef

1 * Header (1T Mame Product Mame Part No. Add Column at End  Prio

2 > Mormal [Cg Local Copy Celumns

3 » Mormal abe: Free Text Paste Columns

Duplicate

Remowve Column
Expand

Edit

Change Settings

2. Follow steps 2 - 5 from the 'Add Row Before' section above to add the column.

Price Table 1 s |2 s [3
Mormal armal Mormal
(1T Product Name | |abe Free Text I o
1 » Header (1T Mame Product Name Part Mo.
2 > Mormal e Local
3 * Mormal abe Free Text

Add Column at End

1. Right-click inside of the content definition cell or the number of any column in the table, then click Add Column

at End.
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Price Table 1 ji jj » (4
Mormal ormal ormal ric

[T Productvame  ||f ID 751 i O ﬁ
\\ Add Column Before |

i > Header (1T Mame Product Mame Part No. Add Column at End || Pric
2 > Mormal [Cg Local Copy Celumns N
3 * Mormal abe Free Text Paste Columns B

Duplicate B

Remowve Column
Expand

Edit

Change Settings

2. Follow steps 2 - 5 from the 'Add Row Before' section above to add the column.

Price Table 1 > |2 > |3 > |4 1 >
Mormal JNurmaI JNurmaI ¢rice ormal
[T ProductMame (]I D Primary Produ... b Price abe Free Text
1 » Header 1T Mame Product Name Part Mo. JI”"E-‘QE J?rice n
2 * Mormal g Locl
* Mormal abe Free Text

Duplicate Rows and Columns

1. Right-click inside of the content definition cell or the number of the column where you would like to add a new
column before, then click Add Column Before and select Duplicate.
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Price Table

1

Mormal

[T Product Name

Header

[y
W

|]I Mame

Product Mame

Mormal

]
W

(Cg Local

L

Add
Add

Copy Rows

Paste Rows

ahe Frag Taxt

Row Before
Row at End

Dupl

icate

Rem

Expa
Edit

Change Settings

ove Row

nd

StiboSystems

2. A duplicate of the row or column appears directly beneath the source row / to the right of the source column.

Frice Table

4 » Mormal

abe Free Text

1 j’i ¥ |3

Mormal armal o

(1T Product Mame  (|T D L
1 » Header JDI Mame Product Name Part No. Im
2 * Mormal & Local Y
3 * Mormal abe Free Text

Remove Rows and Columns

Right-click inside of the content definition cell or the number of the row / column that you want to remove, then
select Remove Row or Remove Column.
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Price Table

Price Table

1

.
ormal

[y
W

W

Mormal

[IIfmmctﬂane I B
Add Column Before |

Prodd

Header JDI MName

Add Row Before
Add Row at End
Copy Rows
Paste Rows

Duplicate

Remowve Row

Expand
Edit
Change Settings

2 » Mormal [Cg Local * Mormal [Cg Local
3 » Mormal abe Free Text * Mormal abe Free Text
4 Rrrrnl ahi Free Text * Mormal abe Free Text

Add Colurmn at End
Copy Columns
Paste Columns

Duplicate

Expand Rows and Columns

This option only applies to rows or columns with the following dynamic content definitions:

« Subproducts, Classification

« SubProducts, Family

« Attribute Group Attributes

Remowve Column

Expand
Edit
Change Settings

When you expand a column or row, the column or row is no longer dynamic. The content of the column or row

remains as it is even if more products are added to the product family.

Note: You cannot expand dynamic rows created using the 'Date Spread Commercial data' content definition.

Right-click inside of the content definition cell or the number of the row / column that you want to expand, then
select Expand.
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Price Table 1 3
- 1
Mormal

(1T Product Name

-
W

(]
W

Mormal

Header 1T Mame Product Name
Cai Lgd

Add Row Before |
Add Row at End
Copy Rows
Paste Rows
Duplicate

Remowve Row

Expand
Edit
Change Settings

2. Click Ok in the 'Expand row' / 'Expand column' dialog.

83 Expand row

i:': Expanding this row cannot be undane

Cancel

3. The dynamic row / column is expanded into individual non-dynamic rows. The below example shows a table
defined on a product family object with three child objects. Once expanded, the table contains three individual
rows for each child product. If another product is added to the family, a new row will not be automatically
created.
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r_=| Jeans
7] Safety
-5 Hardware
7] Displays
=] Furniture
= Party Supplies
=[[T) Party Hats
=-{1=) Paper Hats
- Balloon Hats
- Children's Hats

StiboSystems

Dog Party Hats Assortment
- {™ Pink &Blue Giraffe Party Hat
~ ™ Pink &Blue Owl Party Hat

[T Masks
[T Streamers

Price Table 1 ji ji
Mormal ormal ormal
(I ProductMame (] Primary
1 * Header ‘Ez bz Product Name Part No.
2 » Maormal Ml Dog Party... || |Dog Party Hats A, [121190-A
3 * Marmal A Fink &Blu... || |Pink & Blue Giraff... |121183-A
4 » Mormal r Pink &Blu... Pink & Blue Owl P... |121215-A

Change the Sequence of Columns and Rows

Columns and rows can be resequenced within a table using drag and drop.

1. Sselect the column or row that you want to move by clicking on its number.
Price Table -2 jg ' S
Normal Mormal Normal Price
(13 Product name (]I ID Primary Prod... E Price
1 *Header 1T Mame Product Name
2 *|Normal i Local

2. Drag the column or row to its new location.

Price Table 1 jj . 4
Mormal ormal rice
I Primary Produ...||T Product Mame b Price
1 * Header 1T Mame PartNo. mage Product Mame Price
2 > Mormal [Cg Local
Span Cells

Two or more cells may be merged into one by using the span option. When cells are spanned, the cell in the upper
left corner will span the full area and overwrite content in all other cells in the spanned area.
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1. Select the cells that you want to span, either by holding your left mouse button and dragging your cursor across
the cells, or by holding Ctrl or Shift while clicking on the cells.

2. Right-click, and then select Span.

Price Table 1 ji jz » |4
Mormal armal ormal I
(13 Product Name s Primary Product Im... E
1 * Header WDI Mame Product Name Part No. Image Pr
2 * Mormal h Dog Party... Dog Party Hats Assort,.. |121190-A 1&&;‘ I
edit
3 » Mormal A Firk &Elu... Pink & Blue Giraffe Part. Span ¢
Remove Span(s)
4 * M I Fink &Blu. .. Pink & Blue Owl P Hz
erma r n . n ue Owl Party Copy Cell Overrides &
Paste Cell Overrides
Change Cell Settings
Copy Cell Settings
Paste Cell Settings
Change Table Settings
3. The cells are now spanned.
Price Table 1 j’i jj > |4
Mormal ormal ormal rice
(1T Product Name s Primary Product Im... b I
1 » Header WDI Mame Product Name Part No. Image Price
2 * Mormal h Dog Party... Dog Party Hats Assortment k19,
[ ; " -
Remove Spans
Right-click anywhere within the spanned area, then click Remove Span(s).
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Price Table 1 ji jj » (4

Marmal ormal ormal rit

[T Product Name I Primary Product Im. .. E

1 * Header WDI Mame Prodyct Mame Part No. Image Pri

1 1

2 » Mormal h Dog Party... |-Dog Party Hats Assortment b1

it =

3 * Mormal Ml Fink &Blu... Fink & Blue Giraffe Part. .. Span 2
Remowve Span(s)

4 » Mormal F Pink &Blu... Pink 8 Blue Owl Party Hat 1212 Copy Cell Overrides £4
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Applying Attribute Transformations to Tables

An attribute transformation performs a task on an attribute such as inserting a prefix or converting periods to
commas. There are numerous reasons to apply a transformation to an attribute in a table, but some additional use
cases include removing a space between numbers and units and specifying how to separate values if there are
multivalued attributes in the selected attribute group.

Transformations can be applied to rows / columns / cells that use any of the following content definitions:

« Attribute
« Attribute Group Attributes
« Commercial Data

« ParentName

This topic explains how to apply preexisting attribute transformations to data in tables. For more information on
how to create and configure an attribute transformation, see the Attribute Transformations section of the
System Setup / Super User Guide documentation.

To Apply Attribute Transformations

1. Follow the steps in the Adding, Editing, and Overriding Content Definitions topic to open the
Row/Column Type & Content Definition dialog for your row or column.

2. Inthe'Column/Row Content Definition' dropdown list, select either Attribute, Attribute Group Attributes, or
Commercial Data. For this example, Attribute has been selected.
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3 Row/Column Type & Content Definition

Column/Row Content definition | Attribute

() Name
OD

(®) Attribute | Value & Unit

[ Search ” Legal Attributes

=51 Attribute Groups
-5 Address Attribute Group

--I‘:'_='] Asset Export Configuration

[0 Attribute Group
-7 Autopage Attributes
[+-(0 Auto Test Attribute Group

--I‘:'_=“| Board Essential Attributes

£
2= Details

Default Attribute

Transformation

Ok

Cancel

StiboSystems

In the Transformation field, click the ellipsis button (...). The Select Transformation dialog appears.

32 Select Transformation

MewProducty™

Country Of Origin_Lowercase
ExdusiveYM

IIOM Print

United States to LUSA

Select Mane Cancel

Note: Only attribute transformations that have nothing selected under the 'Applies To' flipper on the Attribute
Transformation tab will appear in this list. Having no options selected allows them to be global and not limited

in where they can be used.
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Mame ¥ > |Value
*> D |InitedStatesTolISA
* Mame |nited States to USA

% Transformations

]
%F‘.Eplace UNITED STATES |with |LUISA

Add Transformation

Multivalue Separator

% Applies To
[ ] MName

[]m

D * [Mams »

| # | Add Attribute

[]an
[ ] Availability
[ ] Back Caver Item (¥ M)
[] Catalog Case Price
[] Catalog Master Price
[] Catalog Spedfic Price
[] Copy Percent Complete
[ ] Caver Design Due
[ ] Caver Photo Shot Due
[ ] Front Caver Item (/M)
[ ]OnHand
] Price

[] salesPrices

selected attribute.
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In the 'Select Transformation' dialog, click Select None.
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4. Selectthe relevant attribute transformation from the list, then click OK. The transformation is applied to the
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3 Select Transformation

MewProductt™

Country Of Crigin_Lowercase
ExdusiveM

IJOM Print

Inited States to USA

[oc | selctrione || conce

Basic Attribute Transformation Example for a Table Column

This example uses an attribute transformation that appends a text value of -A to the STEP ID.

32 Row/Column Type & Content Definition

Column/Row Content definition | Attribute [

() Name
ov] R e ]
—

() Attribute | Wi Frice Table 1 Ji jr s[4
| Browse Maormal ormal ormal rice
(1T Product Name | ([T D Primary F‘rudu...b Price |
& Advanced 1 Header (1T name Product Mame Part No. age rice

2 Mormal (Z5 Local /

arme /

Default Attribute

W

W

W

Transformation

Append -A

QK Cancel

The attribute transformation has been applied to the ID in System Setup.
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System Setup

-0 Attribute Groups

E]@ Attribute Transformations

@ ObjectTransformations

E}@ Publishing Transformations
----- i

----- 41 country of

----- BT Exdusiveyn

----- HT 1tem Code

----- 4T NewLogo

----- BT NewProductyN

..... 4T United States to USA

----- HT uoM Print

-] Action Sets

§|-- Contexts

]ﬁ InDesign Queue

-§|-- Lists of Values /[ LOVs

L I e B |

igin_Lowercase

L] Attribute Transformation

Mame » | » |Value
> ID Append-A
» Mame Append -&

D Transformations

=
%.ﬁ.ppend A,

[wzhin

Add Transformation

Multivalue Separator

7 Applies To
[ ] MName

[ ]

Because the transformation has been specifically applied to something (in this case, ID), the transformation
appears in the upper half of the Select Transformation dialog, and not at the bottom with the global

transformations.

lect Transformation

MewProductyM

Country Of Origin_Lowerkase
JOM Print

Exdusive™

|Inited States to USA

Select Mone

| Transformation

Table before applying the transformation:
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pefinition |l

Select version | Acme Party Supplies/English US  «+ Select Preview Mode
Product Name| [Part No. Image Price
Dog Party Hats [ [121190 i4 519.99
Assortment Ll
Pink & Blue 121183 A =2.49
Giraffe Party Hat ;n‘r

=

Pink & Blue Owl ||{121218 54.79
Party Hat é

Table after applying the transformation:

Definition |l

Select version | Acme Party Supplies/English US - Select Preview Mode

Product Namd |Part No. Image Price
Dog Party Hats | [121190-A 4 $19.99
Aszsortment W B
Pink & Blue 121183-A A 2249
Giraffe Party Hal ;;r

L
Pink & Blue Owl| [121218-A 2470
Party Hat é

Advanced Attribute Transformation Example for a Table Column

The following example shows a more advanced attribute transformation that can be applied to a table column to
change all codes (STEP IDs) that start with the letter 'D' to all caps and a red text color. This example combines
the following STEP functionalities:

« A STEP style tag that utilizes an InDesign character tag in its output formatting. For more information, see
the Publication Template Layout, Formatting, and Styles topic in the STEP Publisher/ STEP'n'design
documentation.

« Aregular expression. For more information, see the Regular Expression section of the System Setup /
Super User Guide documentation.
Sample Setup

1. First, create a style tag in System Setup that is configured to output red text. The tag in this example
corresponds to a character style in the publication template named 'red,' which is called out in the output
formatting within the InDesign tag <CharStyle:red>.
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Style Tag

=+ Style Tags ?
Eg--% Table Styles _Name >| > |value -
..... &3] bold
. Mame red
..... E baolditalic Edited By
..... ] BoldRed Tag red
..... ] bullet Rendering The Quick Brown Fox Jumps Over The Lazy Dog
----- 7 bulleﬁ.ist Show Style Yes
----- [« Funch.unHLl Keyboard Shortout
..... [&3] FunctionHL2 List Tag Mo

----- [2] FunctionHL3

----- [&3] FunctionHL4 9

_____ E FunctionHL5 Format > *» |Formatting Stop >
----- E italic * InDesign | <CharStylesred > < CharStyle: =

""" E El | * |Add Formatting

Attribute Transformation

Mame *| » |Value

> D ItemCode

* Mame Ttem Code
i
]

% Change t::IiUpper s | Case

Add Transformation

Multivalue Separator |

3. Click Add Transformation to add a second transformation using 'Replace substrings of the value using a
regular expression.'

4. Configure this second transformation as follows:

« Replace first match of
e (D.%)
o with <red>$1</red>
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[tem Code - Attribute Transformation

Attribute Transformation

Mame » | » |Value
» ID TtemCode
» Mame Item Code
2 Transformations
g Change to |Upper W |CAse
=)
% Replace |frstmatch of | [(D.4) with ::red:b$l<fred:=-|

Add Transformation

4. Apply this transformation to a table column that contains STEP IDs, following the steps outlined in the first
section of this topic.
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Table Header Attributes - Best Practice

Creating a description attribute that is valid on attributes—and exclusively used for creating table header values—
is a best practice when generating table headers. Using this type of attribute is a more flexible and dynamic way to
generate table headers instead of using non-dynamic free text or cumbersome transformations to change an
attribute name into a value suitable for a table header. Free text is too easily removed or edited by a workbench
user, and language translation is difficult to set up and maintain.

In addition, such an attribute can be used in product templates if table headers must be placed onto the template
instead.

The instructions in this topic assume the following:

¢ You have created a table and understand how to define content definitions.

« You have an understanding of how to create and populate attributes.

Example Table Using a Table Header Attribute

In this basic example, the table has four columns containing specification attributes, each with a content definition
of Attribute. The header row is using a content definition of Meta Data Attribute.

Price Table 1 jz jg > g N
Mormal Mormal Mormal MNormal
[T Product nvame || Primary Color (1T Short Ttem Description  [1¥ Long tem Description
1 *|Header (1 Table Header Name Color Summary Details
2 *|Normal & Local

The values in the header ron—Name, Color, Summary, and Details—are populated by the values of a description
attribute named 'Table Header.' This attribute is valid on the Attribute object type.

If attribute '"Name' were used instead of 'Table Header' for the header row's content definition, then the names of
the attributes would be pulled for the values instead—Product Name, Primary Color, Short Iltem Description, and
Long Item Description. In all likelihood, these would not be the preferred values for the column headers.

Creating a Table Header Description Attribute

1. In System Setup, navigate to the attribute group in which you would like to create your attribute, then right-click
and select New Attribute.

2. Inthe Create Attribute dialog, give the attribute an ID and Name (for example, 'Table Header'), then select
Text for Validation Base Type and No for Multi Valued. Click Next.
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3. Provide a Maximum Length that aligns with the typical number of characters currently used as a column header
in step 3 (Enter Validation Rule). This will probably be around 30 or 40 characters rather than the default 100.

4. Click Next two more times to bypass the screens for steps 4 and 5 of the wizard. (As this attribute will only be
valid on attributes, there is no need to make it valid on product types. However, you may later make it valid on
additional objects if a need arises.)

5. Instep 6 (Apply Dimension Dependencies), choose Country and/or Language if you want the values of this
attribute to be translatable.

6. Click Finish. No additional steps are needed, as this is a description attribute valid only on attributes.

Applying Attribute Validity to the Table Header Attribute

1. Next, navigate to the Attribute object type, located in System Setup > Object Types & Structures > Basic
Object Types > Attribute Group > Attribute.

2. Onthe Object Type tab, expand the 'Valid Attributes' flipper, then click Add Attribute.

3. Inthe 'Please Select Attribute' dialog that displays, browse to or search for the table header attribute that you
just created, then click Select.

4. The table header attribute is now valid on attributes.
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< Attribute - Object Type
- References || Log

§ Description
Mame * [Value
* 1D stibo.normalattribute
* IName Attribute
—|| * Last edited by 2016-05-02 15:08:25 by USER
* |Name Pattern
> ID Pattern
> |Ican

W

Dimension Dependencies

Language;

W

Attribute Description

abi:

W

Attribute Help Text

abi:

W

Completeness Score

il

W

Condition

W

Display Name

abi:

W

DisplaySequence

123

111
W

Furpose

abi:

W

Table Header

abi:

W

Translate Item Data

123

7 Valid Attributes
D > |Name
» |AttributeHelpText Attribute Help Text

W

TranslateftemData

Translate Ttem Data

W

Completeness Score

Completeness Score

* DisplayName Display Name
* [ConditionAttribute Condition
> [TableHeader Table Header

--{Z Inbound Integration Endpoint Type

W

@

DisplaySequence

DisplaySequence

W

Attribute Description

Attribute Description

W

Furpose

Furpose

W

2 B

Add Attribute

Populating Values for the Table Header Attribute

Now that the table header attribute is valid on attributes, you will see it appear under the Description flipper on all
attributes.

In System Setup, navigate to the specification attributes that you will be using in your table.

Locate your table header description attribute, then enter the value that you would like to appear as the table

header for this attribute.

In the following screenshot, a value of 'Summary' has been entered as the value for "Table Header' on the
attribute named 'Short Item Description.'
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Short Item Description - Attribute

g BINEN | References || Attribute Transformation || Walidity || Profile [_

" Iname > > |Value
> ID ShortltemDescription
* Mame Short Ttem Description

> |Last edited by

2016-05-02 15:09:40 by USER

> [Full Text Indexable

Mo

» |Externally Maintained No
Hierarchical Filtering None
Calculated Mo
Type Specification
Dimension Dependenc...,  |Language;
Mandatory MNo

Cryptographic Key

<Mo Encryption=

Attribute Help Text ab:

Completeness Score  |i1

>
>
>
>
>
>
* |Attribute Description ab:
>
>
>
>
>
>

Condition

Display Mame ab:
DisplaySequence 123 2
Purpose abe:

Table Header abe |SUMMary
Translate Item Data 1231

© Aftribute Validation

SliboSystems

4. Now, onthe table, the value of 'Summary' appears as the header for the 'Short Iltem Description' column.

DI | Preview
Price Table i jz jg > |4 >
Normal Normal Normal Normal
[I¥ Product Mame (1 Primary Color | [T Short tem Description T Long Ttem Description
1 *Header ‘I]I Table Header Mame Color Summary etails
2 »|Normal & Local ;
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Table Transformations

You can use table transformations to manipulate the content and appearance of a table. A table transformation
can perform operations on an entire table or part of a table, such as applying color to certain rows or merging cells
with equal values. Transformations are added and configured on the tables Preview tab, allowing their effects on
the table to be viewed in real-time.

For a list of all available transformations, see the List of Transformations topic.

General Transformation Information

When you use transformations, be aware of the following:

« Most transformations are applied in a two-step process: First you add the transformation, then you modify the
parameters.

« Transformations are cumulative, which means that you can add a range of transformations to your table. The
transformations are executed in the sequence they are listed, and a transformation takes effect upon the result
of the previous transformation. To change the sequence of transformations, you can drag and drop a
transformation row to a new location.

« Transformations can impact the table formatting such as the text style or background color of a row or column.
In some cases, you may have to set the formatting on the transformation as well.

Adding Transformations

You can apply table transformations locally in the product or classification hierarchy of the Tree, and/or globally
in System Setup. Any transformation added globally can be overridden later at the local level

« Local transformations are added on the Preview tab of the selected table on the Table tab.
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pefinition |l

Select version | Acme Party Supplies/English LIS w Select Preview Mode | C

----- ﬁ Pink % Blue Girz

E Pink &8glue Ow

[*H[[T] Masks
BH[[T] Streamers
[T Child Birthday Parties
-5 Alarms

[+-[T] Electronics

-{F) Wedding

-5 Food

Collections

eCatalogs

Recyde Bin

Derived Events
[+-(& Object Types & Structures
% Tags
- Units
% Users & Groups
--E».‘ Reference Types
211 Workspaces
Elﬁ Table
- & Colors
4;3' Rules
=) Table Types
% Pivot Tables
El% Price Tables
=i
i ﬂjj Sales Price Table
% Spedfications Tables
- Table Row Types
E}-ﬁ Table Column Types
[+-{am Keys

Product Part No. Image Long Item Description A
Name

Dog Party  [121180-A "'ﬂu. Set of five. Purple, gold, blue, pink
Hats LS and greeen. Specify small, medium

Assortment o Iarge.‘

Pink & Blue |121183-4 A Celebrate your giraffe's birthday
Giraffe ) with this pink and blue party hat'
Party Hat w

Pink & Blue |121218-4 ! Celebrate your owr's birthday with
0wl Parte thim mimls mmd bhs e che bl <
< > |

P

W

Parameters >
Color 1 rows "Whit...

» | » [Tranzformation
> EH Alternate Row Colors

» 1 Footnote Transformation

> b gmoyve Empoty RowsColumns
ﬂ Add Transfoermation

Footnote Tag: Fo...

Femove Rows Re...

« Global transformations are added in the Default Transformations area on the Table Type tab.

System Setup <

Price Table - Table Type ~pi

Table Type

Mame *| > Malue >
*> D stibo, 1776444
* Mame Price Table
» Edited by 2017-10-18 12:55:58 by USER4

» Defaults Style:Mormal_L Background:Light Blue ...

» Dimension Dependencies

* Pagination Plugin Header Repeating Pagination Plugin

- Legal Row Types
2= | eqal Column Types
' Default Transformations

*
: ‘Add Transformation I

- Resolvable for Product Types

@ Resolvable for Classification Tvoes

Important: You can only change the sequence of table transformations on a table type from the table type itself
in System Setup. When you change the sequence of transformations on the table type, it affects all tables that are
based on the table type.
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Add a Transformation to a Table or Table Type

The following steps describe how to add transformations to an individual table. However, the process for adding
transformations to a table type is similar, except that you add the transformation on the table type in System Setup.

1. With the relevant table open on the Preview tab, click Add Transformation.

2. Inthe Select Transformation dialog, select the preferred transformation, then click OK.

Commercial [ Category Profile ” Proof View " Skakus ” State Log ” Tasks ]
Praoduct Product Variants ” _ i :
32 Select Transformation

© Tables
Mame
-
s |&ales Price Tahle =-E30 Layout Transformations
» Spedfication Table g :Jterni:iim;v Colors B
epea ule F
> | Add Table Type -[]T Rule When Different
Definition m =31 Sortings E_
Select version | Acme Party Supplies/B v Standard Sorting
- [=-[£51 Formatting -
Product (PartNo. |Image -[IT attribute Formatting
Name ~[13 Row/Column Text Formatting
Dog Party  [121190-A T ~[]§ Tab Formatting
Hats L ~[I¥ Cell Formatting
Assortment -3 Transformations
Pink & Blug [121183-A A - [[% Merge Equal Cells
Giraffe é’r - [% Merge Over Empty Cells
Party Hat -] Remove Attribute Rows/Columns in Group
Pink & Blue [121218-A -] Make Header Row from Column
E:;'I Party --[EH Remove Empty Rows/Columns
. = ~[]§ Merge Rows/Columns
Dog pary treatz zold zeparately. = Gi DI Suppress F‘.uwstqumns

-x ~[1§ remove Rows/Columns E
» | » [Transformation [ Fold Table

» [ [ ltemate Row Colorg/” [ Horizontal Fold Table ou
3 I Footnote Trangf%atinn - [EH Horizontal Wrap Table =
> I ows/Cold -] Footnote Transformation -
-[EEH Pivot Transformation E

R JAEI::I Transformation

(2= Details

Cancel
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3. For most transformations, additional parameters will need to be configured. These additional parameters are
described in the following sections of this documentation topic.

Modify Transformation Parameters

1. Return to the Preview tab and locate the transformation that you want to configure.

2. Clickinside of the Parameters field to display the ellipsis button.

pefinition |t

Select version | Acme Party Supplies/English LS + Select Preview Mode | Current Mode e
Product Part No. Image Long Item Description Price
Name
Dog Party  |121180-4 i4 Set of five. Purple, gold, blue, pink  [$19.99
Hats el and greeen. Specify small, medium
Assortment or large. 1
Pink & Blue [121133-A b Celebrate your giraffe's birthday 52.49
Giraffe b with this pink and blue party hat i
Party Hat o
Pink & Blue [121218-A Celebrate your owTs birthday with  |34.79
Owl Party é this pink and blue party hati@:
Hat

> »  [Transformation * |Parameters >

> EH Alternate Row Colors Color 1 rows "White®™ then 1 "Light Blue™, Resta...
» [EH Remove Empty Rows/Columns Remaove Rows Remove Columns Heading Rows ...
» [1T Footnote Transformation Footnote Tag: ™, Footnote Marker: ™
ﬂ Add Transformation

3. Make the desired changes, and then click OK. Parameters are different for every transformation, and are
described in detail in the following topics of this documentation section.

Remove a Transformation

1. Click the arrow in front of the transformation that you want to remove, then click Remove Transformation.
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.

* | » [Transformation »
> EH Alternate Row Colors

» [/ I Footnote Transformation
> B E3 Remove Empty Rows/Columns
> Hide
Show All Rows
Rotate Table
Add Transformation Ctrl+Plus

Remowve Transformation Ctrl+Minus

Copy Transformation Ctrl+Shift+C
Paste Transformation Ctrl+5hift+V

Copy and Paste a Transformation

To save effort, transformations can be copied and pasted. To copy and paste to a different table means that the
transformation does not have to be created again from scratch. To copy and paste within the same table could also
be useful since transformations are applied accumulatively and sequentially. For example, a Remove Empty
Rows/Columns transformation might be applied to remove empty rows or columns, then another transformation
applied later removes additional values that create new empty rows or columns. So, the Remove Empty
Rows/Columns transformation would need to be applied again, below the transformation that created new empty
rows / columns.

1. Click the arrow in front of the transformation that you want to remove, then click Copy Transformation.

* | » [Transformation »
> A |Alternate Row Colors

» /] 1T Footnote Transformation
> B E3 Remove Empty Rows/Columns
> Hide
Show All Rows
Rotate Table
Add Transformation Ctrl+Plus

Remowve Transformation Ctrl+Minus

Copy Transformation Ctrl+Shift+C

Paste Transformation Ctrl+5hift+V

2. Click on an arrow by a different transformation, either on the same table or a different table, then click Paste
Transformation.

Note: To paste a transformation to a different table, at least one transformation must already exist on the
target table.
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Hat - Red
Cosmic Party Hat 121177
‘I"';n-ni.n. Flmrd e s 4200

¥ | * [Transformation
U T Rew/Column Text Formattina
Hide
Show All Rows
Rotate Table
Add Transformation Ctrl+Plus

Remove Transformation Ctrl+Minus
Copy Transformation Ctrl+5Shift+C
I Paste Transformation Ctrl+5Shift+V I

3. The pasted transformation will be placed adjacent to the transformation where you clicked to paste.

'Hat - Red
Cosmic Party Hat  |121177 i $3.99

M mmemion Fleebe e A L0
.

W

> » [Transformation Parameters

(3 Row/Column TextFormatting _ For ™ do:

v
[ Remove Empty Rows/Columns Remove Rows Remove (

500 [ransrormancn
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List of Transformations

The below tables list the available transformations available in STEP for tables. Each transformation is described
in further detail in the related online help topic referenced below.

Layout Transformations

Transformation

Description

StiboSystems

Related Online Help

Topic

Apply Alternate Row
Colors

Shades alternate rows according to a specified
frequency.

Table Layout
Transformations

Repeated Rule

Inserts specified rule styles as top and bottom
borders of a row.

Rule When Different

Inserts a specific rule style for a specific type of
content.

Sorting Transformations

Transformation Description

Related Online Help Topic

Sortings Sorts the rows in a table according to the specified

settings.

Table Sorting
Transformations

Formatting Transformations

Transformation Description

Related Online
Help Topic

Attribute Applies a transformation to a specific attribute.

Formatting
Transformations

Table
Formatting
Transformations
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Description

Related Online

Help Topic

Row/Column
Text Formatting

Applies text formatting to a specific column or row. The
transformation also calculates, replaces, and applies prefixes and
suffixes to values.

Tab Formatting

Inserts a tab stop in a row or column.

Cell Formatting

Formats cells with specific content.

General Transformations

Transformation Description Related Online
Help Topic
Merge Equal Merges adjacent cells with identical values. The transformation Merge Equal
Cells merges equal cells in the entire table or in specific rows or columns. Cells
Both horizontally and vertically adjacent cells are merged.
Merge Over Merges row or column contents with empty cells. Use this Merge Over
Empty Cells transformation when you want to span dynamically created cell Empty Cells
content.
Remove Removes all attributes that belong to a specific attribute group. Remove
Attribute Attribute
Rows/Columns Rows/Columns
in Group in Group

Make Header
Row from
Column

Transforms column content into subheadings.

Make Header
Row from
Column

Remove Empty
Rows/Columns

Removes empty rows or columns. The entire row or column must be
empty.

Remove Empty
Rows/Columns

Merge
Rows/Columns

Merges the content of the specified rows or columns.

Merge
Rows/Columns
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Transformation Description Related Online
Help Topic

Suppress Suppresses a row or column if a specified string matches a value in Suppress

Rows/Columns | the selected column or row. Rows/Columns

Remove Removes a specific row or column. Remove

Rows/Columns Rows/Columns

Fold Table Divides a table into two or more side-by-side tables where the content | Fold Table

flows across the tables.

Horizontal Fold | Splits a wide table into two or more vertical 'folds' based on a Horizontal Fold

Table designated number of folds. Table

Horizontal Splits a wide table into two or more vertical 'wraps' based on a Horizontal Wrap

Wrap Table specified column type. Table

Footnote Controls how footnotes are displayed in a table. Footnote

Transformation Transformation

Pivot Creates a pivot table that allows you to summarize and analyze the Pivot Table

Transformation | data in your table independent of the original data layout of your table. | Transformations
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Layout Transformations

When you add a transformation, you typically need to specify parameters for the transformation to work. The
following layout transformations are available and are defined in the sections below:

« Apply Alternate Row Colors

» Repeated Rule

« Rule When Different

3% Select Transformation

Browse

E---ID:I Layout Transformations
: --[E Alternate Row Colors
- [FH Repeated Rule
DI Fule When Different
Sortings
Ic'_:'l Formatting
[+-£31 Transformations

== Details

Cancel

Prerequisites

The instructions in the following subsections assume that you have already added the specified transformations to
your table by following the instructions in the Add a Transformation to a Table or Table Type subsection of the
Table Transformations topic.

Alternate Row Colors

The Alternate Row Colors transformation alternates the background shading of rows at a specified frequency; for
example, every other row, every two rows, etc.

Example

In this example, every other row is shaded Light Blue.
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pefinition |l

StiboSystems

Select version | Acme Party Supplies/English LS

w Gelect Preview Mode

Product Name SKU Color Material Neck Style |Size |Country of |Price
origin (U.5.)
Zeta Beefy-T short sleeve T-shirt  |18213-A Orange 100% Cotton Crew Neck |5 CHINA 999 %
Acme Beefy-T short sleeve T-shirt  |179916-A Red pohyester/cotton blend (30070} [Crew Neck |S CHINA, 1059 %
Acme Beefy-T short sleeve T-shirt  |179926-A  |Blue polyester/cotton blend (30/70) |V-Neck 5 VIETNAM 6995
Zeta Beefy-T short sleeve 179927-A Kely Green |polyester/cotton blend (30470} [W-Neck 5 CHINA, 999 5%
Acme Beefy-T short sleeve T-shirt  |242727-A [Plum 100% Cotton W-Neck S CHINA 9599 5
7eta Beefy-T short sleeve T-shirt  [100812-4  [Plum Polyester Crew Neck (M CHINA 5995
Acme Beefy-T short sleeve T-shirt  [18216-4 Royal Blue |100% Cotton Crew Neck (M WIET NAK 1099 %
Zeta Beefy-T short sleeve MT18404-A |Red Pohyester W-Neck M MEXICO 099 %
Acme Beefy-T short sleeve T-shirt  |179528-A  |Red polyester/cotton blend (30/70) [Crew Neck |M CHINA 1095 %
Acme Beefy-T short sleeve T-shirt  [238317-4  [Plum 100% Cotton W-Neck M CHIMA, 6.09 5
Acme Beefy-T short sleeve T-shirt  [181931-4  [Kely Green |100% Cotton Crew Meck (L MEXICO 1099 %
Acme Beefy-T short sleeve T-shirt  |MT18400-A |Black Polyester W-Neck L CHINA, 14595
Beta Beefy-T short sleeve T-shirt  |100703-A  [Black Polyester Crew Neck |L BRAZIL 799 %
Acme Beefy-T short sleeve T-shirt  [MT18403-A  [White Polyester Crew Meck |L CHINA 6.99 5
Beta Beefy-T short sleeve T-shit  |182522-A  [Red Polyester Crew Neck |L BRAZIL 14995
Acme Beefy-T short sleeve T-shirt |236408-A  |Blue 100% Cotton W-Neck XL WIET MAM 14595

.

7H alternate Row Colors

> » [Transformation > [Parameters
¥ Ji Fow/Column Text Formatting For 7" do: Replace the whaole value Replace the whole value Replace the whole value Repl
> v Standard Sorting Sorting on Column 7
» 1T Remove RowsfColumns Remove Column® 7
» I Remove Rows/Columns Femowe Column® Long Item Description”™
* [] 1 Make Header Row from Column Column Size Heading rows1

Color 1rows "Light Blue™ then 1 "White®, Restart count after Headings 1,

Agd TransTormation

Steps

1. After adding the transformation, under Parameters, click the ellipsis button (...). The Alternate Row Colors
dialog displays.
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3 Alternate Row Colors

Restart count after Headings | Ignore Headings P

[ ]Ignore Footers

Mormal Colored Rows 1
Alternate Colored Rows 1
Mormal Color White w
Alternate Color Light Blue e

In the Restart count after Headings list, select either Ignore Headings, 1, or 2. Selecting 'Ignore Headings
will actually include headings in the row shading. For example, if the Normal Color is blue and the Alternate
Color is white, then the header row will be shaded blue if 'Ignore Headings' is selected.

pefinition |l
Select version | Acme Party Supplies/English Us
Product Name SKU Color Material Neck Style |Size
[Z&ta DeeTy-1 ShoM SIeeve 1-8NIT [ 1821 Orange 0% Loton CrEw e |
Acme Beefy-T short sleeve T-shirt |179916-A  [Red polyester/cotton blend (30/70) |Crew Meck (S
Acme Beefy-T short sleeve T-shirt  |179826-A  [Blus pohyester/cotton blend (30/70) |W-Neck 5
Zeta Beefv-T short sleeve 1795927-A  |Kelly Green [polyester/cotton blend (30470% [W-Neck S

Selecting 1 will cause the row shading to start with the normal row(s) that appear directly below Heading (1)
rows. Selecting 2 will cause the row shading to start with the normal row(s) that appear directly beneath Sub
Heading (2) rows.

Check Ignore Footers to prevent row colors from being applied to Footer rows.

Inthe Normal Colored Rows field, enter the number of rows to shade in the Normal Color before shading
rows with the Alternate Color.

In the Alternate Colored Rows field, enter the number of rows to shade in Alternate Color before shading
rows with the Normal Color again.

In the table example shown at the beginning of this topic, 1 has been selected for both the Normal and
Alternate options.

5. Inthe Normal Color list, select the relevant color.

6. Inthe Alternate Color list, select the relevant color.
7. Click OK.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 190



StiboSystems

Note: For a more complex level of control over the appearance of alternate-colored rows in lengthy, split tables
with multiple repeated headers, the Alternating row colors settings available in the Header Repeating

Pagination Plugin may be a better option than using the Alternate Colored Rows transformation. For more

information, see the Header Repeating Pagination Plugin topic.

Repeated Rule

The Repeated Rule transformation inserts a specified line style based on table rules; for example, arule line of a
certain width is added at a specified frequency.

Example

In the below example, a 2 pt rule line is added every two rows.

Definition |

Select version | Acme Party Supplies /English US

w Select Preview Node | Current Node

Product Name SKU Color Material Neck Style |Size  |[Country of (Price
Origin (U.5.)
7eta Beefy-T short sleeve T-shit  [18213-4 Orange 100% Cotton Crew Meck (5 CHINA 599 %
Acme Beefy-T short slegve T-shit  |179918-A Red pohvester/cotton blend (30/70) |Crew Neck (S CHINA 1099 %
Acme Beefy-T short sleeve T-shirt  [175926-A  [Blue pohyester/cotton blend (30/70) [V-Meck s WIET MAM (605 E
Zeta Beefy-T short sleeve 179527-A  [Kelly Green |pohlyester/cotion blend (30/70) [V-Neck g CHINA GO0 %
Acme Beefy-T short sleeve T-shit  [242727-A [Plum 100% Cotton W-Neck 5 CHINA, 5.59 5
7eta Beefy-T short sleeve T-shit  |100812-A  [Plum Polyester Cresw Neck |M CHINA 55995
Acme Beefy-T short sleeve T-shirt  |18218-A Royal Blue  [100% Cotton Crew Meck (M VIET MAM (10995
Zeta Beefy-T short sleeve MT18404-A (Red Pohyester W-Neck | WEXICO 599 5
Acme Beefy-T short sleeve T-shit | 179928-A Red pohvester/cotton blend (30470) |Crew Neck (M CHINA, 10599 5
Acme Beefy-T short sleeve T-shit  [£239317-A  [Plum 100% Cotton W-Neck M CHINA 599 5
Acme Beefy-T short sleeve T-shirt  [181951-A  |Kelly Green |100% Catton Crew Meck (L WMEXICO 1099 %
Acme Beefy-T short sleeve T-shirt  |MT13400-A |Black Pohyester W-Neck L CHINA, 1480 %
Beta Beefy-T short sleeve T-shit  [100703-A  |Black Pohyester Crew Meck (L BRAZIL 7995
Acme Beefy-T short sleeve T-shirt  [MT18403-A |White Pohyester Crew Meck (L CHINA 6.99 5

Steps

1. After adding the transformation, under Parameters, click the ellipsis button (...). The Repeated Rule dialog

displays.
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33 Repeated Rule

Restart Heading Level [iL

[] Restart when other rule found
Add rule per rows 2
Rule Above Mone

Rule Below 2pt

StiboSystems

2. Fromthe Restart Heading Level list, choose either None, 1, or 2. The default setting is None, meaning that
no line style is inserted at the heading level. When you select 1 or 2, the line style is applied again after each

header row of the specified level number.

N o o kW

Click OK.

Rule When Different

Check Restart when other rule found to reset the count when another line style is found in the table.
Inthe Add rule per rows field, enter a relevant number of rows to putin a line style.

From the Rule Above list, select the relevant line style to be used as the top border of the row.

From the Rule Below list, select the relevant line style to be used as the bottom border of the row.

The Rule When Different transformation will automatically inserts a rule style when column contents are changed.

Example

In this example, a 3 ptrule line is added every time a value in the Size column changes, so a 3 pt rule surrounds all
size S rows, all size M rows, etc. This is how the table looks before the transformation:
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Select version | Acme Party Supplies/English LS

w Select Preview Mode

Product Name SKU Color Material Neck Style |Size  |Country of |Price
Origin {U.5.)
Zeta Beefy-T short sleeve T-shit  [18213-A Orange 10 Cotton Crew Meck (S CHINA, 9.99 5
Acme Beefy-T short sleeve T-shirt |179915-4  |Red pohvester/cotton blend (3070} |Crew Meck (S CHINA 1059 %
Acme Beefy-T short sleeve T-shirt  |179926-A  [Blue pohyester/cotton blend (3070 [V-Neck 5 VIETMAM |699%
Zeta Beefy-T short sleeve 179927-A  |Kely Green (polyester/cotton blend (30/70) |V-Neck 5 CHINA 9995
Acme Beefy-T short sleeve T-shirt  |242727-A  |Plum 100% Cotton W-Neck 5 CHINA, 0.09 5
Zeta Beefy-T short sleeve T-shit  |[100812-4  [Plum Polyester Crew Meck (M CHINA, 0,09 5
Acme Beefy-T short sleeve T-shirt  [18216-A Royal Blue [100% Cotton Crew Neck |M WIET NAM 1099 %
Zeta Beefy-T short sleeve MT18404-A |Red Pohyester W-Neck M WMEXICO 0,00 %
Acme Beefy-T short sleeve T-shirt  |179523-4  |Red pohvester/cotton blend (3070} |[Crew Meck (M CHINA 1059 %
Acme Beefy-T short sleeve T-shirt  |238317-A  |Plum 100% Cotton W-Neck M CHINA, 6.99 5
Acme Beefy-T short sleeve T-shirt  |181951-A  [Kelly Green [100% Cotton Crew Neck |L MEXICO 1099 %
Acme Beefy-T short sleeve T-shirt  [MT18400-4A |Black Pohyester W-Neck L CHINA 14899 %
Beta Beefy-T short sleeve T-shit  |100703-A  [Black Polyester Crew Meck |L BRAZIL TOOE
Acme Beefy-T short sleeve T-shirt  [MT18403-A |White Polyester Crew Meck (L CHINA, 6.99 5
Beta Beefy-T short sleeve T-ghirt 182022-4 Red Polyester Crew Neck |L BRAZIL 1499 %
Acme Beefy-T short sleeve T-shirt  |235408-A  |Blue 100% Cotton W-Neck ML WIET MAM  |14.59 %
Acme Beefy-T short sleeve T-shirt  |179524-A  |White Polyester W-Neck XL MEXICO 14595
Acme Beefy-T short sleeve T-shirt  [18210-A Gray 100% Cotton W-Neck HOKL CHINA, 7995
Zeta Beefy-T short sleeve 1759925-A  |Kely Green (polyester/cotton blend (30/70) |Crew Neck (3L CHINA 7995
Acme Beefy-T short sleeve T-shirt  [18212-A Royal Blue |100% Cotton W-Neck ML (VIETNAKM (6593
Acme Beefy-T short sleeve T-shirt  [181951L8-4 |Gray 100% Cotton Crew Neck POXKL  [MEXICO TOOE
After the transformation:
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Select version | Acme Party Supplies/English US

w Select Preview Mode

Product Name SKU Color Material Neck Style |Size  [Country of |Price
Origin (U.5.)
Zeta Beefy-T short sleeve T-shit  |18213-A Orange 100% Cotton Crew Meck |S CHINA, 599 %
Acme Beefy-T short sleeve T-shirt  [179916-A  |Red pohvester/icotton blend (30/70) |Crew Meck |5 CHINA, 1099 %
Acme Beefy-T short sleeve T-shirt  [179926-A  |Blue pohvester/cotton blend (300570} |W-Neck 5 VIETHAM 6595
Zeta Beefy-T short sleeve 179927-A  |Kely Green |polvester/cotton blend (30070} |W-Neck 5 CHINA 999 %
Acme Beefy-T short sleeve T-shirt  [242727-4  |Plum 100% Cotton W-Neck S CHINA 9505
Zeta Beefy-T short sleeve T-ghirt 100812-A Plum Pohyester Crew Meck |M CHIMA 5992
Acme Beefy-T short sleeve T-shirt  |18216-A Royal Blue |100% Cotton Crew Neck |M WIET MAM  [10599 %
Zeta Beefy-T short sleeve MT18404-A |Red Polyester W-Heck M MEXICO 5595
Acme Beefy-T short sleeve T-shirt  [179928-A  |Red pohvester/cotton blend (30070} |Crew Neck M CHINA 1099 %
Acme Beefy-T short sleeve T-shirt  |239317-4  |Plum 100% Cotton W-Neck M CHINA 6.99 5
Acme Beefy-T short sleeve T-shirt |181951-A  |Kelly Green (100% Cotton Crew Neck |L MEXICO 1099 %
Acme Beefy-T short sleeve T-shirt  |MT18400-A |Black Polyester W-Neck L CHINA, 14599 %
Beta Beefy-T short sleeve T-shit  [100703-A  |Black Polyester Crew Neck |[L BRAZIL T99%
Acme Beefy-T short sleeve T-shirt  [MT18403-A [White Polyester Crew Neck |L CHINA 6.99 5
Beta Beefy-T short sleeve T-shirt  [182922-4  |Red Polyester Crew Neck |[L BRAFIL 1489 %
Acme Beefy-T short sleeve T-shirt  |238408-A  |Blue 100% Cotton W-Neck KL WIET MAM  [14500 %
Acme Beefy-T short sleeve T-shirt  [179824-A  [White Polyester W-Meck KL MEXICO 14599 %
Acme Beefy-T short sleeve T-shirt  |18210-A Gray 100% Cotton W-Neck WKL CHINA 700%
Zeta Beefy-T short sleeve 179925-A |Kely Green |pohvester/cotton blend (30070} |Crew Neck [XO{L CHINA TH9 8
Acme Beefy-T short sleeve T-shirt  |18212-A Royal Blue |100% Cotton W-Heck XL WETNAM [6.595

. W

¥ * [Transformation * |Parameters
» Ji FowfColumn Text Formatting For “7" do: Replace the whole value Replace the whole value Replace the whaole value Repla
» v  Standard Sorting Sorting on Column 7
» I Remove Rows/Columns Remove Column®™ 7°
» I Remove Rows/Columns Remove Column® Long Item Description”
» [] |[Jf Make Header Row from Column Column Size Heading rows 1
* ] Alternate Fow Colors Color 2 rows "Light Blue™ then 2 "White®™, Restart count after Headings 1,
» [l Rule when Different On Column Size Add Rule Below "3 pt”™ Ignore Headings

| A&00 Transiormancn

Steps

1. After adding the transformation, under Parameters, click the ellipsis button (...). The Rule When Different
dialog displays.
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2 Rule When Different

fanc
Colurnn -
Rule Below |Mone e

Cancel

2. Checkthe Ignore Headings check box if you do not want the transformation to consider contents in Heading
columns types.

3. Inthe Column field,click the ellipsis button (...) to display the Select Column dialog.

32 Select Column

() Product/Classification/Asset

(") Heading

() Type Column Head v
(") Mumber

() Group Setup

Cancel

« Select Attribute to apply the transformation to the column that contains the specified attribute. Click the
ellipsis button (...) to search or browse for the relevant attribute.

« Select Product/Classification/Asset to apply the transformation to the column that contains the specified
object. Click the ellipsis button (...) to search or browse for the relevant object.

« Select Heading to identify the column by typing the header text of the relevant column.
« Select Type to choose a specific column type from the dropdown list.

« Select Number to identify the column by entering the sequence number of the relevant column. For
example, to apply the transformation the second column, then type 2.

« Select Group to apply the transformation to multiple columns. Click the Setup button, then click Add in the
Select Row/Columns to be grouped window that displays.
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3 Select Row/Columns to be grouped

K Cancel

« After clicking Add, an Undefined field displays. Click the ellipsis button (...) to launch another Select
Column dialog. This is identical to the previous 'Select Column' dialog, except without the Group

option.
3 Select Column
E! JElECt how/Lolumns to be groupe () Product/Classification/Asset
Undefined |Z| Remave (") Heading
Add ) Type Column Head w
Ok Cancel O Number
=

« Click Add again to repeat the previous steps and add more columns to the group. Click OK when
done.

32 Select Row/Columns to be grouped

Colurmn Column Head Remove

Add

oK Cancel

5. Fromthe Rule Below list, click the relevant Line Style to be used as the bottom border of the row.

6. Click OK.
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Sorting Transformation

Only one sorting transformation, Standard Sorting, exists for tables. The Standard Sorting transformation
enables you to sort the rows in your table according to the contents of one or more columns.

3% Select Transformation

d Vo
Ell‘:'_“l Sortings
. v Standard Sorting
Formationg

-3 Transformations

= Details

Cancel

Example

In this example, the table includes a listing of T-shirt sizesin S, M, L, XL, XXL, and XXXL. Two Size columns are
present. One lists the T-shirt sizes, and the second contains numbers that correspond to the sizes—1 for S, 2 for
M, etc. This is so an ascending sort can be applied to sort the T-shirts from smallest to largest size (S, M, L, XL,
etc.) instead of alphabetically (M, L, S, XL, etc.)
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Definition | i
Select version | Acme Party Supplies English US « Select Preview Mode | Current Mc
Product Name SKU Color Material Neck Styld Size |Size |[Country of [Price
origin (U.5.)
Zeta Beefy-T short sleeve T-shit  |100812-A  |Plum Polyester Crew Meck | |M 2 CHINA 905 %
Acme Beefy-T short sleeve T-shirt  |181951-A  |Kelly Green [100% Cotton Crew Neck | (L 3 MEXICO 10,89 5
Acme Beefy-T short sleeve T-shit  [236408-4  [Blue 100% Cotton W-Neck KL 4 WIET MAK (1459 %
Acme Beefy-T short sleeve T-shit  |18210-A Gray 100% Cotton W-Neck L 3 CHINA 7.99 %
Acme Beefy-T short sleeve T-shirt  |18212-A Royal Blue [100% Cotton W-Neck oL |6 WVIET NAKM  |6599 5
Zeta Beefy-T short sleeve T-shit  |18213-A Orange 100% Cotton Crew Meck | |5 1 CHIMNA D008
Acme Beefy-T short sleeve T-ghit  [18216-A Royal Blug  [100% Cotton Crew Neck | [M 2 IET NAK (10995
Acme Beefy-T short sleeve T-shirt  [MT13400-4 |Black Polyester W-Neck 3 CHINA, 14995
Beta Beefy-T short sleeve T-shit  |100703-A  |Black Polyester Crew Meck 3 BRAZIL o955
Acme Beefy-T short sleeve T-shit  |MT18403-4 (White Polyester Crew Meck 3 CHINA, 6.99 5
Zeta Beefy-T short sleeve MT18404-4 |Red Polyester W-Meck M 2 MEXICO 9.99 5
Acme Beefy-T short sleeve T-shit  [179916-4  [Red potvester/cotton blend (30470} |Crew Neck | |5 1 CHINA 10995
Acme Beefy-T short sleeve T-shit  |179924-A  (White Polyester W-Neck XL 4 MEXICO 1459 %
Zeta Beefy-T short sleeve 179925-4  [Kelly Green |polyester/cotton blend (30470} |Crew Neck J [20{L 5 CHINA TH9E
Acme Beefy-T short sleeve T-shirt  |179926-A  |Blue polyester/cotton blend (30/70) [V-Neck s 1 0IET NAK (6998
Zeta Beefy-T short sleeve 175927-A  |Kelly Green |polyester/cotton blend (30770} [V-Neck g 1 CHINA 0008
Acme Beefy-T short sleeve T-shit |179528-A  [Red polyester/cotton blend (30/70) [Crew Neck | (M 2 CHINA 10995
Beta Beefy-T short sleeve T-shit  [182822-A  [Red Polyester Crew Meck | |L 3 BRAZIL 1459 %
Acme Beefy-T short sleeve T-shit  |181951L6-A |Gray 100% Cotton Crew Neck | [}XXL (6 MEXICO 7.99 %
Acme Beefy-T short sleeve T-shit  |239317-A  |Plum 100% Cotton W-Neck M 2 CHINA 6.99 3
Acme Beefy-T short sleeve T-shitt  |242727-A |Plum 100% Cotton W-Neck 5 1 CHINA 9.99 3
¥ | * [Transformation * |Parameters

The Standard Sorting transformation is added to the second Size column (in this example, column 7) to sort the
rows by ascending numbers.
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Definition ||
Select version | Acme Party Supplies English US « Select Preview Mode | Current
| |
Product Name SKU Color Material Neck Styll Size |Size  |Qountry of |Price
@rigin {U.5.)
Zeta Beefy-T short sleeve T-shit  |18213-A Orange 100% Cotton Crew Neu:lq = 1 QHIMA 009%
Acme Beefy-T short sleeve T-shit  [179916-4  [Red polyester/cotton blend (30070} |Crew Necl{l s 1 QHMA 1099 %
Acme Beefy-T short sleeve T-shit  |[179926-4  |Blue polyester/cotton blend (30/70) |W-Meck S 1 YIET NAKM (6993
Zeta Beefy-T short sleeve 179927-A  |Kely Green |polvester/cotton blend (30570) [V-Neck 1 1 QHMA 999%
Acme Beefy-T short sleeve T-shit  [242727-4  [Plum 100% Cotton W-Neck 5 1 QHINA 99035
Zeta Beefy-T short sleeye T-=hirt 100812-A  |Plum Polyester Crew Necky [N 2 FHIMNA 999 %
. 38 Standard Sorting o NecH W 2 YETNAM  [10.99S
Zeta ck M 2 WEXICO 599 %
Acme Heading Rows | 1] Trailing Rows |0 Necky |M 2 JHINA 10553
ACmE ck W 2 QHINA 6.99%
acma Column (7., Ascending (@) Alphabetic () Numeric () Fraction Remove NecH |L 3 KExaco 10995
ACmE Add Sorting Raw/Column ck L 3 QHINA 145993
Beta —] L 3 qrazl  [7e9s
Acme F'y Neck [L 3 qHINA 6995
Beta e Necg L 3 frAazIL 14995
Acme BEETY-T SNOM SEEVE [-EMIMT_ [Z30305-A)  [OWE T 75 OO v-meck XL 4 WIET NAM (14555
Acme Beefy-T short sleeve T-shirt  [179524-A8  (White Polyester W-Neck KL 4 WEXICO 1490 %
Acme Beefy-T short sleeve T-shit | 18210-4 Gray 100% Cotton W-Meck oKL 5 QHINA TO99%
Zeta Beefy-T short sleeve 179925-A)  [Kely Green |polyvester/cotton blend (30470) |Crew Neck] [XXL 5 QHMA 7993
Acme Beefy-T short sleeve T-shit  |18212-4 Foyal Blue [100% Cotton W-Neck KXXL (6 WET NAKM |699%
AAEme Beefy-T short sleeve T-shit [181931LERA (Gray 100% Cotton Crew I"-IEI:I-:I KXXL (6 I'EKICD TO99%
Transformation » |Parameters : :
Fow /Column Text Formatting For “7" do: Replace the whole value Replace the whole value Replace the whole value Replace the wl
Standard Sorting Sorting on Column 7

To finish the look of the table, a Remove Rows/Columns transformation is added to remove the sort column, so
the finished table has the rows sorted by S, M, L, etc. See the Remove Rows/Columns topic for more
information on this transformation.
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pefinition |
Select version | Acme Party Supplies/English LIS w Select Preview Node
| |
Product Name SKU Color Material Neck Stylel Size JCountry of |Price
Origin {U.5.)
Zeta Beefy-T short slegve T-shit  [18213-A Orange 100% Cotton Crews Neck] [S CHINA 999 %
Acme Beefy-T short sleeve T-shirt  [179916-4 Red polvester/cotton blend (3070} |[Crew MNeck ] (S CHINA 1099 %
Acme Beefy-T short sleeve T-shirt  [179925-4 Blue polyester/cotton blend (3070} |V-Neck 5 WIET NAK 6.99 5
Zeta Beefy-T zhort sleeve 17992T-A Kely Green |polyester/cotton blend (30670) |V-Meck 5 CHINA 999 %
Arcme Beefy-T short sleeve T-shirt  [242727-4  [Plum 100% Cotton W-Neck g CHINA 0905
Zeta Beefy-T short sleeve T-shit  |100812-A |Plum Polyester Crew Neck ] M CHINA 0.00 %
Acme Beefy-T short sleeve T-shirt  |18216-4A Royal Blue |100% Cotton Crew Meck ) |M WIET MAK 1099 %
Zeta Beefy-T short sleeve MT12404-A |Red Polyester W-Meck M MEXICO 000 %
Acme Beefy-T short sleeve T-shirt  [179928-A Red polvester/cotton blend (3070} |[Crew Meck | (M CHINA, 1099 %
Acme Beefy-T short sleeve T-shirt  [238317-4  |Plum 100% Cotton W-Neck M CHINA 6.99 5
Acme Beefy-T short sleeve T-shirt  [181951-4  [Kelly Green [100% Cotton Crews Neck | (L MEXICO 10995
Acme Beefy-T short sleeve T-shirt  |MT13400-A |Black Polyester W-Meck L CHINA, 14589 5
Beta Beefy-T short slegve T-shit  [100703-4  |Black Polyester Crewe Neck | |L BRAZIL TO0 %
Acme Beefy-T short sleeve T-shirt  |MT18403-A |White Polyester Crewe Neck | |L CHINA 6.99 %
Beta Beefy-T short slesve T-zhirt 182022-A Red Polyester Crew Meck| |L BRAZIL 1499 %
Acme Beefy-T short sleeve T-shirt  |235408-A  |Blue 100% Cotton W-Meck ML WIEET MAM  |1488 8
Acme Beefy-T short sleeve T-shirt  [1795924-4  [White Polyester W-Neck ML MEXICO 14599 %
Acme Beefy-T short sleeve T-shirt  [18210-A Gray 100% Cotton W-Neck ML CHINA 799 %
Zeta Beefy-T zhort slesve 1795925-A Kely Green |polyester/cotton blend (30470) |Crew Neck | [3KL CHINA 7995
Acme Beefy-T short sleeve T-shirt  [18212-A Royal Blue |100% Cotton W-Neck ML PVIET NAM  |699 5
Arcme Beefy-T short sleeve T-shirt  [181951LB-A |Gray 100% Cotton Crew Neck | [OXL  MEXICO 7O00%
# | * [Transformation * |Parameters
» Ji Row/Column Text Formatting For 7" do: Replace the whole value Replace the whale value Replace the whole value Repl:
> v Standard Sorting Sarting on Column 7
]I Remove Rows/Columns Remaove Column®™ 7"

Steps

1. After adding the transformation, under Parameters, click the ellipsis button (...). The Standard Sorting
dialog displays.

32 Standard Sorting

Heading Rows [J| Trailing Rows [

Add Sorting Fow,/Column

Cancel

2. Click Add Sorting Row/Column to display the sorting priority options.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 200



StiboSystems

33 Standard Sorting

Heading Rows |0 Trailing Rows |0
Undefined || ... [~]Ascending (@) Alphabetic () Mumeric () Fraction Remove

Add Sorting Fow,/Column

Cancel

. Inthe Heading Rows field, enter the number of heading rows that you want to exclude from the sorting
transformation.

. Inthe Trailing Rows field, enter the number of trailing rows that you want to exclude from the sorting
transformation.

. In Undefined, click the ellipsis button (...). The Select Row/Column dialog displays.

3 Select Row/Column

@ Rowe () Column

() Attribute

() Product/Classification /Asset

(") Heading

(O Type Footer -

() Mumber

Cancel

« Select Row or Column to specify whether the transformation applies to a row or a column.

« Select Attribute to apply the transformation to the row or column that contains the specified attribute. Click
the ellipsis button (...) to search or browse for the relevant attribute.

« Select Product/Classification/Asset to apply the transformation to the column that contains the specified
object. Click the ellipsis button (...) to search or browse for the relevant object.

» Select Heading to identify a column or row by typing the header text of the relevant column or row.
« Select Type to identify the column or row by selecting Column Type or Row Type.

« Select Number to identify the column or row by entering the sequence number of the relevant column or
row. For example, if you want to apply the transformation the second column, then type 2.

« Click OK.
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7. Check Ascending to sort the rows in ascending order.
8. Select Alphabetic, Numeric, or Fraction to specify the sorting type.

StiboSystems

9. Click Add Sorting Row/Column again to add another row or column to sort on, if needed.

3 standard Sorting

Heading Rows |1 Trailing Rows |0

Colurmn 7.

Undefined

Add Sorting Row/Column

oK Cancel

Ascending (@) Alphabetic () Mumeric () Fraction Remove

Ascending () Alphabetic (@) Numeric () Fraction Remove

10. Click OK.
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Formatting Transformations

Formatting transformations enable you to apply transformations to attribute values, rows, column, tabs, and cells.
The following formatting transformations are available and are defined in the sections below:

« Attribute Formatting Transformations

o Row/Column Text Formatting

« Tab Formatting

o Cell Formatting

3t select Transformation

Browse

I‘:'_“| Layout Transformations
w9 Sortings
=51 Formatting
: ~[|T attribute Formatting
- [IT row/Column Text Formatting
>|:|I Tab Formatting
-[|T cell Formatting
Transtarmatons

- Details

Cancel

Prequisites

The instructions in the following subsections assume that you have already added the specified transformations to
your table by following the instructions in the Add a Transformation to a Table or Table Type subsection of the
Table Transformations topic.

Attribute Formatting

The Attribute Formatting transformation allows you to apply an attribute transformation to any selected attribute in
the table. These transformations perform tasks on an attribute such as calculating or replacing a value, or applying
a prefix or a suffix.
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The below column samples show how attribute values look before applying the transformation (left) and how they
look after (right). The applied attribute transformation inserts the text 'Made of' before the attribute values for

'Material.'
Material Material
100% Cotton Made |:|f|1IZIEI".-'E Cotton

pohyester/cotton blend (30070}

polvester/cotton blend (30070}

Ir.'lad& nfl}ur'_.rest&r.fcnttun blend

(30/70)

pohlyester/cotton blend (30070}

100% Cotton

Made nfl}ur'_.rester.fu:nt'tun blend

(30/70)

Polyester

100% Cotton

Made of polvester/cotion blend
(30470}

Polyester

|Made offji00% Cotton

pohyester/cotton blend (30/70)

Ir.'lad& ofPolvester

[made offi00% Cotton

100% Cotton — Ir.'lade ofPotyester

100% Caotton Made of polyester/cotton blend
Polyester (30470)

Polyester |made offi00% Cotton
Polyester Ir.'lade offl00% Cotton
Pohyester Ir.'lad& of Polyester

100% Cotton IMEdE of Polyester

Polyester Ir.'lade of Polyester

100% Cotton Ir.'lad& of Polyester

polvester/cotton blend (30070}

[made offoo% Cotton

100% Cotton

Ir.'lad& ofPolvester

100% Cotton

[Made offi00% Cotton

Steps

1. After adding the transformation, under Parameters, click the ellipsis button (...). The Attribute Formatting

dialog displays.
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33 Attribute Formatting

Browse m Legal Attributes |

| Search
& pdvanced =
[ Mame

Attribute Formatting

Add Transformation

Cancel

2. Search or browse for the attribute to which you want to apply a transformation. Alternatively, click on the
Legal Attributes tab to access the attributes that are linked locally to the product / classification node on which
your table is built.

3. Click Add Transformation to launch the Select Transformation dialog. Select the relevant transformation,
and then click OK.

The list of transformations is identical to those that are available when creating an attribute transformation in
System Setup. For more information on the attribute transformations and what they do, See the Attribute
Transformation Options topicin the System Setup / Super User Guide documentation.
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Browse m Legal Attributes

Material (Material)
&= Advanced

Mame
| Material D = Materiz

Search

#% Select Transformation

Append text ~

Change case

Choose hash function

Convert fractions to parsable tags

Extract characters after a given textin the value

Extract characters at position

Extract characters before a given textin the value

Extract characters between two pieces of textin the value v

QK Cancel

Attribute Formatting

|

Add Transformation

QK

Cancel

Row/Column Text Formatting

The Row/Column Text Formatting transformation enables you to transform data in specific columns or rows.
You can calculate or replace values or apply prefixes and suffixes to values in entire columns and rows in one
operation. Where the Attribute Formatting transformation is applied to a specific attribute, the Row/Column Text
Formatting transformation enables you to transform data in columns and tables of your own choice.

1. After adding the transformation, under Parameters, click the ellipsis button (...). The Row/Column Text
Formatting dialog displays.

33 Row/Column Text Formatting

RuowfColumn Text Formatting

Add Transformation

Cancel
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2. Select Ignore Headings if you want the transformation to ignore contents in header column types.
3. Click the ellipsis button (...) to launch the Select Row/Column dialog.

3 Select Row/Column

@ Rowe () Column

() Atiribute

() Product/Classification/Asset

(") Heading

(O Type Footer v
() Mumber

() Group Setup

Cancel

« Select Row or Column to specify whether the transformation applies to a row or a column.

« Select Attributes to apply the transformation to the column that contains the specified attribute. Click the
ellipsis button (...) to search or browse for the relevant attribute.

« Select Product/Classification/Asset to apply the transformation to the column that contains the specified
object. Click the ellipsis button (...) to search or browse for the relevant object.

« Select Heading to identify a column or row by typing the header text of the relevant column or row.
« Select Type to identify the column or row by selecting Column Type or Row Type.

« Select Number to identify the column or row by entering the sequence number of the relevant column or
row. For example, if you want to apply the transformation the second column, then type 2.

« Select Group to apply the transformation to multiple columns. For more information, see the instructions
provided for the Rule When Different transformation in the Layout Transformations topic.

4. Click Add Transformation to launch the Select Transformation dialog.

The list of transformations is identical to those that are available when creating an attribute transformation in
System Setup. For more information on the attribute transformations and what they do, See the Attribute
Transformation Options topicin the System Setup / Super User Guide documentation.
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3 Select Transformation

Append text ~
~ [Change case
E] Row,/Column Text Formatting | [Cheose hash function
Convert fractions to parsable tags
Ignore Headings Extract characters after a given textin the value
Extract characters at position
|1 Extract characters before a given textin the value
Row/Column Text Form g Extract characters between two pieces of textin the value v
[
Add Transformation oK e

Cancel

5. Select the relevant transformation, then click OK.

Tab Formatting
The Tab Formatting transformation inserts a tabulator in a row or column, which indents the text in the row or
column with a tab.

Example

The below screenshot shows how a column looks before (left) and after (right) applying the transformation, which
in this example inserts a tab before the values in the 'Color' column.
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Color Color

Crange Orange
Red Red

Blue Blue

Kely Green Kely Green
Plum Plum

Plum Plum

Roval Blue Roval Blue
Red Red

Red Red

Plum Plum

Kely Green Kely Green
Black Black

Black Black
White White

Red Red

Blue Blue

White White

Gray Gray
Steps

1. After adding the transformation, under Parameters, click the ellipsis button (
displays.

$2 Tab Formatting

row types.

...). The Tab Formatting dialog

Select Ignore Headings if you want the transformation to ignore contents in header column types or header

Click the ellipsis button (...) to launch the Select Row/Column dialog. The options available in this dialog have

already been explained in this topic in the Row/Column Text Formatting section above; refer to that section
for more information.
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3 Select Row/Column

@ Rowe () Column

() Attribute
() Product/Classification /Asset
(") Heading

() Type Footer ~

() Mumber

() Group Setup

Cancel

4. Click OK.

Cell Formatting

The Cell Formatting transformation allows you to narrow down formatting to individual cells in a table.

Example

This example uses two Cell Formatting transformations—one to change cells containing the word 'Blue' to have a
light blue background and bold text, and the second to change cells containing the text 'Royal Blue' to a darker
blue color, retaining the bold text applied in the first Cell Formatting transformation.
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pefinition |l
Select version | Acme Party Supplies English US
Zeta Beefy-T short sleeve T-shirt 18213-A Crange Made of 100% Cotton
Acme Beefy-T short sleeve T-shirt  [179916-4  [Red Made of polvester/cotton bler
30/70)
Acme Beefy-T short sleeve T-shirt  |179826-A | (Blue ade of polyester/cotton bler
30470}
Zeta Beefy-T short sleeve 179927-4 | [Kely Green ade of polyester/cotton bler
30/70)
Acme Beefy-T short sleeve T-shirt  |242727-4 | [Plum ade of 100% Cotton
Zeta Beefy-T short sleeve T-shirt  |100812-4 | [Plum ade of Polyester
Acme Beefy-T short sleeve T-shirt  |18216-A ade of 100% Cotton
Zeta Beefy-T short sleeve MT128404-A] (Red ade of Polyester
Acme Beefy-T short sleeve T-shirt  |[179828-A | [Red ade of polyester/cotton bler
30470}
Acme Beefy-T short sleeve T-shirt  |238317-A | [Plum ade of 100% Cotton
Acme Beefy-T short sleeve T-shirt |181951-A | [Kelly Green ade of 100% Cotton
Acme Beefy-T short sleeve T-shirt  |MT138400-A (Black ade of Polyester
Beta Beefy-T short sleeve T-shirt  |100703-4 | [Black ade of Polyester
Acme Beefy-T short sleeve T-shirt  |MT18403-A [White ade of Polyester
Beta Beefy-T short sleeve T-shint  |182922-A | |Red ade of Polyester
Acme Beefy-T short sleeve T-shirt  |236408-A | [Blue ade of 100% Cotton
Acme Beefy-T short sleeve T-shirt  |179524-4 | [White ade of Polyester
Acme Beefy-T short sleeve T-shirt  |18210-A Gray ade of 100% Cotton
Zeta Beefy-T short sleeve 179925-A | |[Kelly Green (Made of polyester/cotton bler
30/70)
Acme Beefy-T short sleeve T-shirt  |18212-4 ade of 100% Cotton
Acme Beefy-T short sleeve T-shirt  |181951LB-4 ade of 100% Cotton
*» | » [Transformation Parameters
DI Row Column Text Formatting For *7" do: Replace the whole value Rep
v Standard Sorting Sorting on Column 7
I Remove Rows/Columns Remove Column® 7°
I Remove Rows/Columns Femove Column® Lang Item Description™
[] |If Make Header Row from Column Column Size Heading rows1
[] E3 Alternate Row Colors Color 2 rows "Light Blue™ then 2 "White™,
Attribute Formatting For atiribute "Material” do: Insert text b
» I (cell Formatting Find Blue Color Light Blue Style bold
» I el Formatting Find Royal Blue Color Blue

# Add!rrﬂn =formation

Steps

1. After adding the transformation, under Parameters, click the ellipsis button (

displays.
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33 Cell Formatting

Search Expression |

Only for rows/fcolumns [ |

Color to apply Do not change background color -

Style to apply Do not change text style e

Cancel

. InSearch Expression, enter a regular expression to find specific cells. This option is case sensitive. For
example:

« Enter the search expression 'Blue.' The value Blue is searched in the entire table and, if the value matches,
the specified style will be applied to the cell.

« Enter the search expression as [A-Z]. The characters A to Z will be searched and, if any matches are found,
the specified style will be applied to the cell.

. Check the Only for rows/columns box if you want the formatting to apply only for cells in specific rows or
columns.

« Click the ellipsis button (...) to launch the Select Row/Column dialog. The options available in this dialog
have already been explained in this topic in the Row/Column Text Formatting section above; refer to that
section for more information.

3% Select Row/Column

@ Rowt (O Column

() Attribute

() Product/Classification/Asset

() Heading

) Type Footer w
() Number

() Group Setup

Cancel
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. Inthe Color to apply list, select the color you want to apply to the cells, or leave the default option of 'Do not
change background color.'

. Inthe Style to apply list, select the style that you want to apply to the cells, or leave the default option of 'Do
not change text style.'

. Click OK.
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General Table Transformations

The general table transformations are defined in detail in the following topics in this documentation section.

$2 Select Transformation

Browse

F-£3 Layout Transformations
Ifl Sortings
[+ 251 Formatting
=9 Transformations
- [0 Merge Equal Cells
- 0% Merge Over Empty Cells
~[]f remove Attribute Rows/Columns in Group
~[]f Make Header Row from Column
- Remove Empty Rows/Columns
-[]E Merge Rows/Columns
-[If Suppress Rows/Columns
~[]T remove Rows/Columns
--[EH Fold Table
-[EH Horizontal Feld Table
-[EH Horizontal Wrap Table
(] Footnate Transformation
-[EH Pivot Transformation

@ Details

Cancel

« Merge Equal Cells

« Merge Over Empty Cells

o Remove Attribute Rows/Columns in Group
» Make Header Row from Column

o Remove Empty Rows/Columns

« Merge Rows/Columns

o Suppress Rows/Columns

« Remove Rows/Columns

» Fold Table

» Horizontal Fold Table
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« Horizontal Wrap Table
o Footnote Transformation

« Pivot Transformation
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Merge Equal Cells

The Merge Equal Cells transformation merges adjacent cells that contain identical / equal values. It can be applied
to merge equal cells in the entire table or in specific rows or columns. Both horizontally and vertically adjacent cells
can be merged. The transformation also merges adjacent spanned cells that contain identical values.

If two equal cells appear from merging other cells, they are also merged. The transformation repeats the merging
process until there are no more cells to merge.

Note: The cells must be adjacent to one another in the table before they can be merged. This means that
additional transformations, such as Standard Sorting, may need to be applied to position the cells next to each
other so they can be merged.

Prequisites

The instructions in this topic assume that you have already added the Merge Equal Cells transformation to your
table by following the instructions in the Add a Transformation to a Table or Table Type subsection of the
Table Transformations topic.

Example

Before

This is how the table appears before applying the Merge Equal Cells transformation:
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Product Name SKU Color Material Neck Style (Size  |[Country of |Price
origin (U.5.)
Zeta Beefy-T short sleeve T-shit  |[18213-4 Orange 100% Cotton Crew Meck (S CHINA 5995
Acme Beefy-T short sleeve T-shirt  |179916-A  [Red pohrester/cotton blend (30070} [Crew Meck [S CHINA 10595
Acme Beefy-T short sleeve T-shirt  [179926-A  [Blue potyester/cotton blend (30/70) |W-Neck s WIET MAM (S0 S
Zeta Beefy-T short sleeve 179527-4  |Kelly Green |pohyester/cotton blend (30/70) [V-Neck g CHINA 5908
Acme Beefy-T short sleeve T-shirt [242727-A  [Plum 100% Cotton W-Neck 5 CHINA, 500 5
Zeta Beefy-T short sleeve T-shit  |100812-A [Plum Polyester Crew Meck (M CHINA 999 %
Acme Beefy-T short sleeve T-shirt  [18216-A Royal Blue |100% Cotton Crew Neck |M WIET NAM 10595
Zeta Beefy-T short sleeve MT1&404-4 (Red Polyester W-Meck M WEXICO 999 5
Acme Beefy-T short sleeve T-shint  |179928-A  |Red pohvester/cotton blend (30070} [Crew Meck [M CHINA 10599 5%
Acme Beefy-T short sleeve T-shirt  |238317-A  [Plum 100% Cotton W-Neck M CHINA, 6.00 5
Acme Beefy-T short sleeve T-shirt  [181951-A  [Kelly Green [100% Cotton Crew MNeck |L WMEXICO 1099 %
Acme Beefy-T short sleeve T-shirt  |MT18400-4 |Black Polyester W-Neck L CHINA, 14590 %
Beta Beefy-T short sleeve T-shit  [100703-A  [Black Polyester Crew Meck |[L BRAFIL 799 %
Acme Beefy-T short sleeve T-shirt  |MT18403-A  [White Polyester Crew Meck |[L CHINA 6.99 5
Beta Beefy-T short sleeve T-shit  |[182822-A  |Red Polyester Crew Meck |[L BRAZIL 145895
Acme Beefy-T short sleeve T-shit  |236408-A  [Blue 100% Cotton W-Neck ML WIET NAK 14595
Acme Beefy-T short sleeve T-shint  |179924-A  [White Polyester W-Neck ML MEXICO 1489 %
Acme Beefy-T short sleeve T-shirt  [18210-4 Gray 100% Cotton W-Neck oL CHINA TO0%
Zeta Beefy-T short sleeve 179925-4  |Kely Green |pohvester/cotton blend (30/70) [Crew Meck [30XL CHINA TH9 5
Acme Beefy-T short sleeve T-shirt  |13212-A Royal Blue |100% Cotton W-Neck oL [VIETHNAM (BODS
Acme Beefy-T short sleeve T-shirt  |181851LB-A |Gray 100% Cotton Crew Neck POOL  [MEXICO 7005
After
This is how the table looks after.
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Product Name SKU Color Material Neck Style |Size |Country of |Price
origin {U.5.)
Zeta Beefy-T short sleeve T-shirt  [18213-4 Orange 100% Cotton Crew Meck (S CHINA 0905
Acme Beefy-T short sleeve T-shirt |179916-A  [Red polyester/cotton blend (30070} 1059 %
170926-A  |Blue W-Neck WIET MAM |E590 S
Zeta Beefy-T short sleeve 179527-A  [Kelly Green CHINA 08995
Acme Beefy-T short sleeve T-shirt  |242727-A [Plum 100% Cotton
Zeta Beefy-T short slesve T-shirt  [100812-4 Pohyester Crew Neck (M
Acme Beefy-T short sleeve T-shirt  [18216-4 Royal Blue |100% Cotton WIET MAK 10599 %
Zeta Beefy-T short sleeve MT18404-4 |Red Pohyester W-Neck MEXICO 999 %
Acme Beefy-T short sleeve T-shirt  [179528-4 polyester/cotton blend (30/70) |Crew Neck CHINA, 10599 %
239317-A  [Plum 100% Cotton W-Neck 5.00 8
181951-A |Kelly Green Crew Meck |L WEXICO 1090 &
MT12400-A |Black Pohyester W-Neck CHIMNA, 1480 8
Beta Beefy-T short sleeve T-shirt  [100703-4 Crew Neck BRAZIL TO0%
Acme Beefy-T short sleeve T-shirt  |MT18403-A [White CHIMA, 6.090 5
Beta Beefy-T short sleeve T-shit  |182522-A  |Red BRAZIL 14008
Acme Beefy-T short sleeve T-shit  |235408-4  [Blue 100% Cotton W-MNeck WL WIET MAK
179924-A  |White Polyester WEXICO
18210-A Gray 100% Cotton L CHINA, 7995
Zeta Beefy-T short sleeve 179925-A |Kelly Green |pohvester/cotton blend (3070} |Crew Meck
Acme Beefy-T short sleeve T-shirt  [18212-A Royal Blue |100% Cotton W-Neck WL [VIETMAKM |6595
181951LB-4 |Gray Crew Neck WEXICO 7995

Steps

1. After adding the transformation, the identical cells that are adjacent to one another will automatically merge.

2. Ifyou want to limit the cells that are merged to specific rows or columns, click the ellipsis button (...) under
Parameters to launch the Merge Equal Cells dialog.

32 Merge Equal Cells

Cancel

3. Check Limit to row/column to apply the transformation to a specific row or column only, then click the ellipsis
button (...) to launch the Select Row/Column dialog.

The options available in this dialog have already been explained in the Row/Column Text Formatting

section of the Formatting Transformations topic; refer to that topic for more information.
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3 Select Row/Column

@ Rowe () Column

() Attribute

() Product/Classification /Asset

(") Heading

() Type Footer ~
() Mumber

() Group Setup

4. Click OK when complete.
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Merge Over Empty Cells

The Merge Over Empty Cells transformation merges row or column contents over empty cells. This
transformation is useful when you want to span cells with dynamically created content where you can not use the
Span Cells functionality.

Note: This transformation also merges equal spanned cells.

Prequisites

The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the Add a Transformation to a Table or Table Type subsection of the Table Transformations
topic.

Example

The below screenshots show three examples of the same column, before and after the application of the Merge
Over Empty Cells transformation.

1. Thefirstis the original column, with individual empty cells.

2. The second is how the column appears after applying the transformation. Cells are merged from top to bottom.

3. The third is how the column appears after applying the transformation and checking the Reverse Direction
boxin the Merge Over Empty Cells dialog (more information is provided in the steps below). Cells are
merged from bottom to top.
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Material

Material 9

Material e

100% Cotton

100% Cotton

100% Cotton

pohyester/cotton blend (30070}

pohyester/cotton blend (30070}

pohyester/cotton blend (30470)

pohyester/cotton blend (30/70)

pohyester/cotton blend (30070}

pohvester/cotton blend (30070}

pohyester/cotton blend (30/70)

polyester/cotton blend (30/70)

pohyester/cotton blend (30570}

100% Cotton

_1IIIIII".-'E. Cotton

100% Cotton

100% Cotton

_1IZIIZI“.-'E| Cotton

_1IZIIZI“.-'E| Cotton

pohyester/cotton blend (30070}

pohvester/cotton blend (30070}

|po ester/cotton blend (30470)

100% Cotton 100% Cotton 100% Cotton
100% Cotton 100% Cotton 100% Cotton
1 |100% Cotton
100% Cotton 100% Cotton
1 100% Cotton
100% Cotton 100% Cotton 1

pohyester/cotton blend (30/70)

pohyester/cotton blend (30070}

pohvester/cotton blend (30070}

100% Cotton

100% Cotton

100% Cotton

100% Cotton

100% Cotton

100% Cotton

StiboSystems

Steps

1. After adding the transformation, under Parameters, click the ellipsis button (...). The Merge Over Empty
Cells dialog displays.

$3 Merge Over Empty Cells

Row/column to span:

[ ] Reverse Direction

QK. Cancel

2. Click the ellipsis (...) button to launch the Select Row/Column dialog.

The options available in this dialog have already been explained in the Row/Column Text Formatting
section of the Formatting Transformations topic; refer to that topic for more information.
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3 Select Row/Column

@ Rowe () Column

() Attribute

() Product/Classification /Asset
(") Heading

(O Type

() Mumber

() Group

Footer

Setup

Cancel

StiboSystems

3. Checkthe Reverse Direction box to merge over the empty cells from bottom to top instead of top to bottom.

See the example given at the beginning of this topic for an illustration.

4. Click OK when done.
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Remove Attribute Rows/Columns in Group

The Remove Attribute Rows/Columns in Group transformation enables you to remove all attributes from the
table that belongs to an attribute group. This transformation is useful, for example, when you want to ensure that a
specific set of attributes do not appear in the table.

Prequisites

The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the Add a Transformation to a Table or Table Type subsection of the Table Transformations
topic.

Example

Before

The below table contains five columns built from attributes that appear in the same attribute group
(DataVisualization). this is how the table looks before the transformation is applied.

pefintion ||
Select version | Acme Party Supplies/English US « Select Preview Node
Product Name SKU Color Material Neck Style |Size  [Country of jPrice
Origin {U.5.)
|Zcta Bechiil short sieeve T-shit 1821 &Ams CHINA _ayr 0008
Acme Ee:ﬁT short sleeve T-shirt [179518- Red po ryestwun blend (30/70) |Crew Neck |5 1099 %
Acme Eleefg,r-t shorfelasua T ohid | - Alue. po er/cotton blend (30070) [W-Neck WIETNAM  |6899 3
Zeta Beefy-T &IDI‘t =8 Lreen ester/cotton blend (30070} |V-Hec] 5 CHINA, 000 %
Acme Beefy-T 4o = - of Measure 100% Cotton eck 5 CHINA, 0005
Zeta Beefy-T shh't ’ Polyester Crew Neck (M CHINA, 999 %
Acme Beefy-Tshiy] = Description, Web Blue  |100% Cotton Crew Neck |M VETHAM [10993
Zeta Beefy-TshorY = ' Long Ttem Dgefription Pobye: -Neck M MEXICO 0995
acme Beefy-T sho U1 Material ester/cotton blend (30/70) [Crew Neck |M CHINA, 10985
acme Beefy Tshod§ (U Neck Style 100% Cotton V-Neck W CHINA 5995
Acme Beefy-T shor] X New Product Ereen [100% Cotton Crew Neck |L MEXICO 10895
Acme Beefy-T =hor] -1 Price (U.5.) Polyester _Neck L CHINA 14995
Beta Beefy-T short o Primary Color Polyester Crew Meck |L BRAZIL 7995
Acme BeefyTshor] . Y- Product Diameter Polyester Crew Neck |L CHINA 5.00%
Beta Beefy-T short \ul] Product Height Polyester Crew Neck |L BRAZIL 1490 §
Acme BeefyTshor] . LT Product Name 100% Cotton V-Neck  |XL  |VETNAM [1499%
scme Beefy-Tshor] | Product Status Polyester V-Neck HL MEXICO 14995
Acme Beefy-Tshor] . 3 Product weight 100% Cotton V-Neck  |XXL  |CHINA 7995
1 1
After

This is how the table looks after the transformation is applied. The five columns are removed.
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Select version | Acme Party Supplies)t

SKU Size  |Country of

Origin
18213-A 5 CHIMA,
179916-A 5 CHIMA,
1795926-A 5 WIET NAK
179027-A 5 CHIMA,
242T2T-A 5 CHIMA,
100812-A M CHIMA,
18216-A M WIET NAK
MT12404-A (M MEXICO
1795923-A M CHIMA,
238317-A M CHIMA,
181951-A L MEXICO
MT123400-A |L CHIMA,
100703-A L BRAZIL
MT123403-A |L CHIMA,
182022-A L BRAZIL
236408-A  [XL WIET NAK
179024-A  |¥L MEXICO
18210-4A KL CHIMA,
179025-A  [3O{L CHIMA,
18212-A 0L [VIET NAM
181951LB-A 0L |MEXICO

Steps

StiboSystems

1. After adding the transformation, under Parameters, click the ellipsis button (...). The Remove Attribute

Rows/Columns in Group dialog displays.

$3 Remove Attribute Rows/Columns in Group

Browse m

& advanced

Search

[ Mame
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2. Search or browse for the relevant attribute group, then click OK.

3. When you have selected an attribute group, the transformation is applied to all attributes in the table that
belong to the Attribute Group.
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Make Header Row from Column

The Make Header Row from Column transformation enables you to transform the contents of a selected
column to header rows. This is useful, for example, if you want to save space or enhance readability by removing a
column, and instead have the contents of that column display as header rows in the table.

In the following example, the Size column is transformed into header rows.

Before the Make Header Row from Column transformation is applied, the table is sorted on the Size column by
S-M-L-XL-XXL-XXXL.

Definition m
Select version | Acme Party Supplies/English US ~ Select Preview Mode | Current Mode
Product Name SKU Color Material Neck Stylg]|Size  [Country of |Price
Drigin (U.S.)
(Zeta Beefy-T short sleeve T-shirt 18213-A Orange 100% Cotton Crew Neck |[S CHINA 9.99 5
\Acme Beefy-T short sleeve T-shirt |179918-A  |Red polyester/cotion blend (30/70) |Crew Neck |[S CHINA 10.99 %
\Acme Beefy-T short sleeve T-shirt |179928-A  |Blue polyestericotion blend (3070} [V-Neck S [ETNAK |6.995
[ Zeta Beefy-T short sleeve 179927-A  |Kelly Green |polyester/cotton blend (30/70) [W-Neck S CHINA 999 5
\Acme Beefy-T short sleeve T-shirt  |242727-A  |Pum 100% Cotton [V-Neck S CHINA 999 5
[Zeta Beefy-T short sleeve T-shit  |100812-A4  |Plum Polyester Crew Neck ||M CHINA 9.99 5
\Acme Beefy-T short sleeve T-shirt | 18216-A Royal Blue  |100% Cotton Crew Neck ||M ETNAK  |10.998
Zeta Beefy-T short sleeve MT18404-A |Red Polyester [V-Neck M MEXICO 9.99 5
\Acme Beefy-T short sleeve T-shirt |179928-A  |Red polyestericotion blend (3070} [Crew Meck | [M CHINA 10.99 §
\Acme Beefy-T short sleeve T-shirt |238317-A Plum 100% Cotton [V-Neck il CHINA 699 S
\Acme Beefy-T short sleeve T-shirt  |181951-A Kelly Green |100% Cotton Crew Neck ||L MEXICO 1099 S
\Acme Beefy-T short sleeve T-shirt |MT18400-A |Black Polyester [V-Neck L CHINA 14.99 §
Beta Beefy-T short sleeve T-shit  |100703-A  |Black Polyester Crew Neck ||L PRAZIL 7.99 5
|Acme Beefy-T short sleeve T-shirt  |MT18403-A  |White Polyester Crew Neck ||L CHINA 6.99 5
Beta Beefy-T short sleeve T-shirt 182922-A Red Polyester Crew Neck ||L BRAZIL 14.99 %
\Acme Beefy-T short sleeve T-shirt |236408-A  |Blue 100% Cotton [V-Heck L ET NAK (14598
\Acme Beefy-T short sleeve T-shirt |[179924-4  [White Polyester [V-Neck XL MEXICO 14995
\Acme Beefy-T short sleeve T-shirt |18210-A (Gray 100% Cotton [V-Neck oKL CHINA 7998
[Zeta Beefy-T short sleeve 179925-A  |Kelly Green |polyester/cotton blend (30/70) [Crew Meck f XL CHINA 7955
\Acme Beefy-T short sleeve T-shirt  |18212-A Royal Blue  |100% Cotton [V-Neck POOL ETNAK  |6.995
\Acme Beefy-T short sleeve T-shirt |181951LB-A |Gray 100% Cotton Crew Neck XL MEXICO 7995
> | » [Transformation * |Parameters
> JI Row/Column Text Formatting For *7" do: Replace the whole value Replace the whole value Replace the whole value Repli
> v  Standard Sorting Sorting on Column 7
> [ Remove Rows/Columns Remove Column™ 7°
> JI Remove Rows/Columns Remove Column™ Long Item Description™
> [0 [} Make Header Row from Column Column Size Heading rows 1
* | Add Transformation

After applying the transformation, the Size column has been removed and header rows have been created based
on the contents of the Size column. A new header row is created every time the value changes, for example, from
Mto L. The rows in this example also have had styling applied within the transformation, including a background
shading of light blue and an italic text style.
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Definition m

Select version | Acme Party Supplies/English US

~ Select Preview Node | Current Node

Product Name |SKU ‘Color ‘Material Neck Style [Country of [Price
Origin (u.s)
s]
|Zeta Beefy-T short sleeve T-shirt 18213-A Orange 100% Cotton Crew Neck |CHINA 9998
|Acme Beefy-T short sleeve T-shirt |179916-A  |Red polyester/cotton blend (30/70) |Crew Neck |CHINA 1099 §
|Acme Beefy-T short sleeve T-ghirt |179926-A  |Blue polyester/cotton blend (30/70) |V-Neck [VIETNAM (6995
|Zeta Beefy-T short sleeve 179927-A  |Kelly Green |polyester/cotton blend (30470} [W-Neck CHINA 19995
s ce Beefy-T short sleeve T-shit_|242727-A__|Pum 100% Cotton v-Neck CHINA 998
|
'Zﬂa Beefy-T short sleeve T-shirt 100812-A Plum Polyester Crew Neck |CHINA 999§
|Acme Beefy-T short sleeve T-shirt |182168-A Royal Blue  |100% Cotton Crew Neck |VIET NAM 10998
[Zeta Beefy-T short skeeve 1MT18404-A |Red Polyester [v-Neck MEXICO  [989%
|Acme Beefy-T short sleeve T-shirt |179528-A  |Red polyester/cotton blend (30/70) |Crew Neck |CHINA 1099 §
lame Beefy-T short sleeve T-shirt [239317-A  [Plum 100% Cotton [v-Neck CHINA 699s
[
Ptme Beefy-T short sleeve T-shirt [181951-A  |Kelly Green |100% Cotton Crew Neck |MEXICO 10998
|Acme Beefy-T short sleeve T-shit |MT18400-4 |Black Polyester V-Neck CHINA 14998
Beta Beefy-T short sleeve T-shirt 100703-A Black Polyester Crew Neck |BRAZIL 799§
|Acme Beefy-T short sleeve T-shirt |MT13403-A |White Polyester Crew Neck |CHINA 699§
[Bety Beefy-T short sleeve T-shirt 182922-A Red Polyester Crew Neck |BRAZIL 14998
XL
[Ecme Beefy-T shart sleeve T-shit_|236408-A  [Blue [100% Cotton [V-Neck  [VETHAM [1499
Beefy-T short sleeve T-shit_|179924-A  |White |Polyester [v-neck  [wExco  J14sss
o
[Acme Beety-T short sleeve T-shit_[18210-A  [Gray [100% Cotton [v-Heck  [cHma [7e9s
alaBeey-T short sleeve [179925-A  [Kelly Green [polyester/catton blend (30/70) [Crew Neck [CHINA 795
|XXXL
[Acme Beefy-T short sleeve T-shit_|18212-4  [Royal Blue _[100% Cotton [v-Neck  [VETNAM [6.9898
|Acme Beefy-T short sleeve T-shirt |181951LB-A [Gray [100% Cotton |crew Neck [MExICO  [7.898

[Transformation

* |Parameters

DI Row/Caolumn Text Formatting

Far "7" do: Replace the whole value Replace the whale value Replace the whale v

v  Standard Sorting

Sorting on Column 7

[If Remove Rows/Columns

Remove Column™ 7*

[I¥ Remove Rows/Columns

Remove Column®Long Item Description™

I Make Header Row from

Column Column Size Heading rows1

* |Add Transformation

StiboSystems

Adding the Make Header Row from Column Transformation

1. With your table open on the Preview tab, click 'Add Transformation' to launch the Select Transformation

dialog.

2. Expand the 'Transformations' folder and select Make Header Row from Column, then click OK.
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» Price Table _ _ :
3 Select Transformation
» Sales Price Table
» Spedfication Table
* | Add Table Type |
2 — #-E0 Layout Transformations
Cefinition m 4 £ Sortings L
Select version | Acme Party Supp 31 Formatting
— | @[5 Transformations v
E;Ol::m Part No. imag E&- Merge Equal Cells
- [[§ Merge Over Empty Cells
Dog Party  [121190-4 jﬁ ) in Group
Hat=s
[ — : |]I Make Header Row from Column
Pink & Blue [121133-A N
Giraffe ~[]¥ Merge Rows/Columns
Party Hat ~[]¥ suppress Rows/Columns
Pink & Blue [121218-4& |]I Remove Rows/Columns
Cwil Party --[EE Fold Table
Hat -[EH Horizontal Fold Table
- Horizontal Wrap Table
> | > [ransformation / (] Footnote Transformation j
% R |Alternate Row Iurs| - Pivot Transformation E
> EH Remove Emleuwsl k=
= s
ﬂﬁu:ld Transformation ¥ ==
cance

3. The transformation is added. Click inside of the Parameters field to display the ellipsis button.
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pefinition |

Select version | Acme Party Supplies/English LIS «w Select Preview Node | Current Mode -
Product Part No. Image Long Item Description Price
Name
Dog Party  |121180-4 i Set of five. Purple, gold, blug, pink  [$19.99
Hats el and greeen. Specify small, medium
Assortment or large. @
Pink & Blue [121183-A b Celebrate your giraffe's birthday 3249
Giraffe b with this pink and blue party hat i}
Party Hat w
Pink & Blue [121218-A Celebrate your owls birthday with |34.79
0wl Party é this pink and blue party hat @
Hat

> * [Transformation * |Parameters &

=[] DI Make Header Row from Column F:olurnn Heading rows0
» ] |1 Footnote Transformation Footnote Tag: "Footnote™, Footnote M...

ﬂ Add Transformation

4. Click the ellipsis button (...) to launch the Make Header Row from Column dialog.

32 Make Header Row frem Colurmn

Heading rows 0

Caolumn |

Row Type Footer -

Text Style Mot Defined e

Background Color | Mot Defined e
Rule Above Mot Defined e

Rule Below Mot Defined e

5. Inthe Heading rows field, Enter 1 to ignore 'Heading (1)' rows. Enter 2 to ignore 'Sub Heading (2)' rows.
Enter 0 to include all heading rows.

6. Bythe Columns field, click the ellipsis (...) button to launch the Select Column dialog. This is where you
specify which column to convert to header rows.
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11.

12.

13.
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3 Select Column

() Attribute

() Product/Classification/Asset

(") Heading
() Type Colurmn Head e

() Mumber

Ok Cancel

« Select Attribute to apply the transformation to the column that contains the specified attribute. Click the
ellipsis button (...) to search or browse for the relevant attribute.

« Select Product/Classification/Asset to apply the transformation to the column that contains the specified
object. Click the ellipsis button (...) to search or browse for the relevant object.

» Select Heading to identify a column by typing the header text of the relevant column.
« Select Type to identify the column or row by selecting Column Type.

« Select Number to identify the column by entering the sequence number of the relevant column. For
example, if you want to apply the transformation the second column, then type 2.

« Click OK to close the dialog.
Inthe Row Type list, select the row type that will be used for the converted column.
For the remaining options, leaving them as 'Not Defined' will cause the formatting to be inherited from the

specified row type. To override the inherited settings, make a selection.

Inthe Text style list, select text style that will be used in the header rows that are created by the
transformation.

In the Background Color list, select the background color you want to use for the header rows that are
created by the transformation.

In the Rule Above list, select the line style you want to use as the top border of the header rows created by the
transformation.

From the Rule Below list, select the line style you want to use as the bottom border of the header rows created
by the transformation.

Click OK.
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Remove Empty Rows/Columns

The Remove Empty Rows/Columns transformation removes empty rows or columns from a table. This is
useful, for example, if several product ranges use the same table definitions but some attribute columns only apply
to a few of the actual tables. Another example is if another transformation is applied to the table that ends up
leaving an empty row or column. Removing the row or column helps to de-clutter the table.

Prequisites

The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the Add a Transformation to a Table or Table Type subsection of the Table Transformations
topic.

Example

Before

This is how the table appears before applying the Remove Empty Rows/Columns transformation. The Country of
Origin column is blank, though note that it still has a header.
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Select version | Acme Party Supplies English US

«w Select Preview Mode

Product Name SKU Color Material Neck Style |Size | |Country of LPnce
origin U.5.)
Zeta Beefy-T short sleeve T-zhirt 18213-A Orange 100% Cotton Crew Meck |5 looss
Acme Beefy-T short sleeve T-shirt  [179916-4A Red pohyester/cotton blend (30/70) |Crew Meck |S 10599 5
Acme Beefy-T short sleeve T-shirt | 179926-4 Blue pohvester/cotton blend (30/70) [V-Neck S fgoos
Zeta Beefy-T short sleeve 179927-A Kely Green |polyester/cotton blend (30/70) |V-Meck 5 IEEE! 3
Acme Beefy-T short sleeve T-shirt  |242727-A 100% Cotton W-Meck 5 lBB’EI‘ 3
Zeta Beefy-T short sleeve T-shit  |100812-A Crew Neck [M lssss
Acme Beefy-T short sleeve T-shirt  [18218-A Royal Blue [100% Cotton Crew Neck M 10,099 5
Zeta Beefy-T short sleeve MT18404-A |Red W-Meck M 10995
Acme Beefy-T short sleeve T-shirt  [179928-4  |Red pohyester/cotton blend (30770} |Crew Meck [M 10.595 %
Acme Beefy-T short sleeve T-shirt  [238317-4A 100% Cotton W-Meck M SO s
Acme Beefy-T short sleeve T-shirt  [181931-4  |Kelly Green |100% Cotton Crew MNeck |L 10.9% 5
Acme Beefy-T short sleeve T-shirt  |[MT12400-4 |Black W-MNeck L 14595 %
Beta Beefy-T short sleeve T-shit  [100703-4  |Black Crew MNeck |L 799 %
Acme Beefy-T short sleeve T-shirt  [MT18403-4 |White Crew Meck |L 595
Beta Beefy-T short slegve T-shit  [182922-4  |Red Crew Neck |L 1400 %
Acme Beefy-T short sleeve T-shirt  [236408-4  |Blue 100% Cotton W-Meck KL 1409 5
Acme Beefy-T short sleeve T-shirt  [179924-A  |White W-Meck L 1499 %
Acme Beefy-T short sleeve T-shirt  [18210-A Gray 100% Cotton W-Meck WKL 7005
Zeta Beefy-T short sleeve 179925-A Kely Green |polyester/cotton blend (30/70) |Crew Meck [3XL To90%
Acme Beefy-T short sleeve T-shirt  [18212-A Royal Blue [100% Cotton W-Meck RO K995
Acme Beefy-T short sleeve T-shirt  [1819531LB-A |Gray 100% Cotton Crew Neck [XOOKL 799 %

After

This is how the table looks after the transformation is applied. The column is removed even though there was a
value for the header. This is because 1 was entered in the Heading Rows field of the Remove Empty
Rows/Columns dialog and the Remove Columns box was checked. See the below steps for more information.
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| pefinition |t
Select version | Acme Party Supplies/English LS we Select|
Product Name SKU Color Material Neck Style (Size  |Price
(U.5.)
Zeta Beefy-T short slesve T-ghirt 18213-A Orange 100% Cotton Crew Meck |5 R
Acme Beefy-T short sleeve T-shirt  [179916-4  [Red pohyester/cotton blend (30/70) |Crew Neck |3 10.99 %
Acme Beefy-T short sleeve T-shirt  [179925-4 Blue polvester/cotton blend (30/70) |V-Neck 5 6.99 5
Zeta Beefy-T short sleeve 1TSEET-A Kely Green |polyester/cotton blend (30570) [V-Neck 5 9995
Acme Beefy-T short sleeve T-shirt  [242727-4 100% Cotton W-Neck 3 9995
Zeta Beefy-T short sleeve T-shirt  [100812-4 Crew Neck |M 0,99 %
Acme Beefy-T short sleeve T-shirt  |18216-A Royal Blue  [100% Cotton Crew Neck |M 10995
Zeta Beefy-T short sleeve MT18404-4 |Red W-Meck M 0.00 5
Acme Beefy-T short sleeve T-shirt  |179928-A Red polyester/cotton blend (30070} [Crew Neck |M 1059 %
Acme Beefy-T short sleeve T-shirt  [239317-4 100% Cotton W-Neck M 6.99 5
Acme Beefy-T short sleeve T-shirt  [181931-4  [Kelly Green |100% Cotton Crew Neck (L 10995
Acme Beefy-T short sleeve T-shirt  [MT18400-4 |Black W-Neck L 14599 %
Beta Beefy-T short sleeve T-shirt  [100703-4  |Black Crew Neck |L TO99 5
Acme Beefy-T short sleeve T-shirt  [MT13403-A [White Crew Neck |L 6.90 5
Beta Beefy-T short sleeve T-shit  |182922-A  |Red Crew MNeck (L 1459 5
Acme Beefy-T short sleeve T-shirt  |235403-4  |Blue 100% Cotton W-MNeck ML 14508
Acme Beefy-T short sleeve T-shit  |[179824-4  |White W-Neck ML 1459 5
Acme Beefy-T short sleeve T-shirt  [18210-A Gray 100% Cotton W-Neck ML 799 %
Zeta Beefy-T short sleeve 1TSE25-A Kely Green |polyester/cotton blend (30470) |Crew Neck [RKL 7995
Acme Beefy-T short sleeve T-shirt |18212-A Royal Blue [100% Cotton W-Meck HHKL |659935
Arcme Beefy-T short sleeve T-shirt  [181951L8-A |Gray 100% Cotton Crew Meck [XxML |7T995
Steps

1. After adding the transformation, under Parameters, click the ellipsis button (...). The Remove Empty
Rows/Columns dialog displays.

32 Remove Empty Rows/Columns

Heading Rows i}
Heading Columns i}
Remove Rows

Remove Columns

Cancel

2. Inthe Heading Rows field, enter the number of header and sub-header rows to be removed even if they
contain data. Enter 0 to ignore headers, enter 1 to ignore Header (1) rows, and enter 2 to ignore Sub-Header
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(2) rows.

. Inthe Heading Columns field, enter the number of header and sub-header columns to be removed even if
they contain data. Enter 0 to ignore headers, enter 1 to ignore Header (1) columns, and enter 2 to ignore Sub-
Header (2) columns.

. Select Remove Rows to remove empty rows. If this box is checked, rows will be removed if they are empty. If
not checked, then rows will be skipped even though they are empty.

. Select Remove Columns to remove empty columns. If this box is checked, columns will be removed if they
are empty. If not checked, then columns will be skipped even though they are empty.

. Click OK.
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Merge Rows/Columns

The Merge Rows and Columns transformation enables you to merge two rows or two columns into one.

When you merge columns or row,s the values of both rows or columns are retained. After the merge, it will look as
if two attributes are placed in the same column.

Prequisites

The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the Add a Transformation to a Table or Table Type subsection of the Table Transformations
topic.

Example

In the following example, the Neck Style and Material columns are merged.

Before the merge, the Neck Style and Material attributes are maintained in two separate columns.
Definition m
Select version | Acme Party Supplies/English US
Product Name SKU [Color Neck Style [Material Size
[Zeta Beefy-T short sleeve T-shit  [18213-A Orange Crew Meck |100% Cotton 5
\Acme Beefy-T short sleeve T-ghirt [179916-A  |Red Crew Meck |polyester/cotton blend (30/70) |5
\Acme Beefy-T short sleeve T-shirt [179926-A  |Blue V-Neck polyester/cotton blend (30/70) |5
\Zeta Beefy-T short sleeve 179927-A  [Kelly Green| |V-Neck polyester/cotton blend (30/70) |S
\Acme Beefy-T short sleeve T-shirt [242727-A  [Plum V-Neck 100% Cotton s
(Zeta Beefy-T short sleeve T-shit  [100812-A  |Plum Crew Meck |Polyester M
\Acme Beefy-T short sleeve T-ghirt [18216-A Royal Blue | (Crew Neck |100% Cotton M
[Zeta Beefy-T short sleeve MT18404-A [Red V-Neck Polyester M
\Acme Beefy-T short sleeve T-shirt [179928-A  |Red Crew Meck |polyester/cotton blend (30/70) M

After the merge, the contents of the two columns are now merged into one column. In this example, a hyphen is
used as separator.
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Definition m
Select version | Acme Party Supplies/English US
Product Name SKU IColor Neck Style - Material Size
Zeta Beefy-T short sleeve T-shirt  |18213-A Orange Crew MNeck - 100% Cotton S
|Acme Beefy-T short sleeve T-shirt  |179916-A  |Red Crew Neck - polyestericotion blend (30/70) S
[Acme Beefy-T short sleeve T-shit |179926-A  |Blue [V-Meck - polyester/cotton blend (30/70) S
| Zeta Beefy-T short sleeve 179927-A  |Kelly Green| [V-Neck - polyester/cotton blend (30/70) S
Acme Beefy-T short sleeve T-ghirt  [242727-A [Plum IV-Meck - 100% Cotton 5
Zeta Beefy-T short sleeve T-shirt  [100812-A  |Plum Crew Meck - Polyester M
Acme Beefy-T short sleeve T-shirt |18216-A Royal Blue | |Crew Neck - 100% Cotton M
Zeta Beefy-T short skeeve WT18404-A [Red [V-Neck - Polyester W
|Acme Beefy-T short sleeve T-shirt [179928-A  [Red Crew Neck - polyester/cotton blend (30/70) M

> | » [Transformation > |Parameters
> DI Row/Column Text Formatting For “7" do: Replace the vhole value Replace the whole value Replz
> v Standard Sorting Sorting on Column 7
> 1T Remove Rows/Columns Remove Column™ 7°
> DI Remove Rows/Columns Remove Column™ Long ftem Description™
» [] EA Alternate Row Colors Color 2 rows "Light Blug™ then 2 "White™, Restart count after Head
| DI Row/Column Text Formatting For "Country of Origir§ Color:Material: " do: Replace the whole value
' DI Merge Rows/Columns erge columns Neck Style - Material I

Steps

The Merge Rows and Columns transformation is set up in a three-step wizard.

1. After adding the transformation, under Parameters, click the ellipsis button (...). The Merge Rows/Columns
wizard displays.

2. Inthe Orientation step, specify whether you want to merge columns or rows. Click Next.

¥ Merge Rows/Columns

Steps Orientation

1. Orientation
2. Rows/Columns
3- Rﬂjt .....................................

() Merge Rows

Back Mext Finish Cancel

3. Inthe Rows/Columns step, click the ellipsis buttons (...) to choose the rows or columns that you want to
merge.
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Steps Rows/Columns

1. Crientation
2. Rows/Columns Merge Columns

3. Result
]

Ead{ Next A1 o
+ O Attribute
() Product/Classification/Asset
() Heading
() Type Column Head e
() Mumber
Cancel

4. Inthe Result step, specify the row or column type to use for the merged column or row. In addition to the legal
column / row types available to the table, you can also choose to keep the same style of the first merged column

/ row in the table.

¥ Merge Rows/Columns

Steps Result
1. Orientation
2. Rows/Columns Column Type

3. Result

Back Mext Finish Cancel

« Inthis step, you can also specify a separator to be inserted between the attribute values of the merged
columns or rows.
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3% Merge Rows/Columns

Steps Result
1. Orientation
2. Rows/Columns Column Type | Mormal e
3. Result
Separator -

@ Always insert separator
i) Do not insert separator if only one value is empty

() Do not insert separator if both values are empty

Badk Mext Finish Cancel

2. Click Finish.
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Suppress Rows/Columns

The Suppress Rows/Columns transformation suppresses a row or a column if a value in the selected column or
row matches a specified string of text.

Prequisites

The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the Add a Transformation to a Table or Table Type subsection of the Table Transformations
topic.

Example

In the following example, any rows that contain the Color value of Kelly Green will be suppressed. A sample use
case could be that this color is only available for spring, but the summer catalog is about to publish. So, shirts of this
color will be suppressed in the table so they do not appear in the summer catalog. They can be unsuppressed later
for next spring's catalog.

Before
This is how the table appears before the suppression of the Kelly Green shirt rows.
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pefinition | R
Select version | Acme Party Supplies /English LIS «w Select Preview Mode
Product Name SKU Color Neck Style |Material Size  |Country of |Price
origin {U.5.)
Zeta Beefy-T short sleeve T-shit  |18213-A Orange Crew Meck [100% Cotton 5 CHINA, 0999 %
Acme Beefy-T short slesve T-shit |179916-4  |Red Crew Meck |pohlvester/cotton blend (30470} |S CHINA, 10.99 %
Acme Beefy-T short sleeve T-shirt | 179926-4 W-Neck potvester/cotton blend (3070 (S WIET AWM (6595
Zeta Beefy-T short slesve 179527-4  [|Kelly Green [W-Neck polyester/cotton blend (30570} (S CHINA 999 %
Acme Beefy-T short slegve T-shit  |242727-4  |Plum W-Meck 100% Cotton 3 CHINA 9995
Zeta Beefy-T short slegve T-shirt  |100812-4  |Plum Crew Meck |Polyester I CHINA 099 %
Acme Beefy-T short sleeve T-shirt  [18216-A Royal Blue  |Crew Neck |[100% Cotton W WIET MAM  |10.99 %
Zeta Beefy-T short sleeve MT18404-A |(Red W-Neck Polyester K MEXICO 999 5
Acme Beefy-T short sleeve T-shirt  |179828-4  |Red Crew Meck |polyester/cotton blend (30570} (M CHINA 1055 %
Acme Beefy-T short slegve T-shirt  |239317-A W-Meck 100% Cotton M CHINA 6.99 5
Acme Beefy-T short sleeve T-shit |181951-A  |Kelly Green [Crew Neck |[100% Cotton L MEXICO 1095 5
Acme Beefy-T short sleeve T-shirt  |MT18400-4 |Black W-Neck Polyester L CHINA. 1459 %
Beta Beefy-T short sleeve T-shit  |100703-4  |Black Crew Meck |Polyester L BRAZIL TO99 %
Acme Beefy-T short slegve T-shirt  |MT128403-4 |White Crew Meck |Polyester L CHIMA 5.99 %
Beta Beefy-T short sleeve T-shirt  [1825822-A  |Red Crew Neck (Polyester L BRAZIL 1499 %
Acme Beefy-T short sleeve T-shirt  [235403-4  |Blue W-Neck 100% Cotton ML WIET MAM  |1480 %
Acme Beefy-T short sleeve T-shirt  [179824-A  |White W-Neck Pohyester KL MEXICO 1480 %
Acme Beefy-T short sleeve T-shit  |[18210-A Gray W-Meck 100% Cotton ML CHINA 7995
Zeta Beefy-T short sleeve 179525-A  |Kelly Green |Crew Neck [|polvester/cotton blend (30470) |XHL CHINA 7995
Acme Beefy-T short sleeve T-shit  |18212-A oyal Blue  [v-Neck 100% Cotton ML [WIETNAM (69592
Acme Beefy-T short sleeve T-shirt  |181951L8-A |Gray Crew Neck [100% Cotton HOOL |MEXICO 799 S
After
This is how the table appears after. The Kelly Green T-Shirts no longer appear.
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Select version | Acme Party Supplies/English US

« Gelect Preview Mode

Product Name SKU Color Heck Style |Material Size  |Country of |Price
origin (U.5.)
Zeta Beefy-T short sleeve T-shit  |18213-A Orange Crew Neck [100% Cotton S CHINA 999 %
Acme Beefy-T short sleeve T-shirt  |175%16-4 | |Red Crew Neck (polyester/cotton blend (3070} |5 CHINA 10585 %
Acme Beefy-T short sleeve T-shirt  [179926-A | |Blue -Meck polyester/icotton blend (3070} |5 VIET MAM  |6.99 %
Acme Beefy-T short sleeve T-shirt  [242727-A | |Plum -Neck 100% Cotton S CHINA 999 %
Zeta Beefy-T short sleeve T-shit  [100812-4 | |Plum Crewy Meck |Polvester M CHINA 9995
Acme Beefy-T short sleeve T-shirt  |18216-A Royal Blue  |fFrew Neck [100% Cotton M WIET NAM 1055 %
Zeta Beefy-T =hort sleeve MT12404-A) |Red -Neck Polyester M MEXICO 999 %
Acme Beefy-T short sleeve T-shirt  |175928-4 | |Red Crewy Meck |pohlvester/cotton blend (30070 (M CHINA 10595
Acme Beefy-T short sleeve T-shirt  |239317-A | |Plum V-Neck 100% Cotton M CHINA, 6.00 %
Acme Beefy-T short sleeve T-shirt  |MT18400-A] |Black V-Neck Polyester L CHINA 1489 5
Beta Beefy-T short sleeve T-ghit  [100703-A | |Black Crewy Meck |Polyester L BRAZIL T.00%
Acme Beefy-T short sleeve T-shirt  [MT18403-A] [White Crewy Meck |Polvester L CHINA 69935
Beta Beefy-T short sleeve T-shit  |[182922-A | [Red Crew Neck (Polyester L BRAFIL 14589 %
Acme Beefy-T short sleeve T-shirt  [Z36408-A | |Blue -Neck 100% Cotton KL WIET NAK 1489 %
Acme Beefy-T short sleeve T-shirt  [179924-A | [White -Neck Polyester HL MEXICO 1459 5
Acme Beefy-T short sleeve T-shirt |18210-A Gray /-Neck 100% Cotton KL CHINA. 799 %
Acme Beefy-T short sleeve T-shirt  |18212-A Royal Blue  [}-Neck 100% Cotton ML [VIETNAM (BOO0S
Acme Beefy-T short sleeve T-shit  |181951LEB-4 |Gray Crewy Neck |100% Cotton HOL [MEXICO 7.00%

= * | » [Transformation » |Parameters
> JI Row/Column Text Formatting For “7" do: Replace the whole value Replace the whole value Replace the whole value Replad
» v Standard Sorting Sorting on Column 7
> ]I Remove Rows/Columns Remove Column” 7
> [] EA Alternate Row Colors Color 2 rows "Light Blug™ then 2 "White®™, Restart count after Headings 1,
=[] JI Row/Column Text Formatting For "Country of Origin:Color:Material:™ do: Replace the whole value Replace the whole value
> [ 1 Merge Rows/Columns Merge columns Medk Style - Material
JI Suppress Rows/Columns Suppress Row where Column Color is Kelly Green
Steps

1. After adding the transformation, under Parameters, click the ellipsis button (...). The Suppress
Rows/Columns dialog displays.
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$3 Suppress Rows/Columns

Suppress Rows,Columns 7

Where

Undefined | .| (W)is

(Jisn't

Cancel

StiboSystems

2. SelectIgnore Headings if you do not want to apply the transformation to headings.

3. Inthe Undefined field, click the ellipsis button (...) to display the Select Row/Column dialog.

The options available in this dialog have already been explained in the Row/Column Text Formatting
section of the Formatting Transformations topic; refer to that topic for more information.

32 Select Row/Column

(® Row () Column

() Attribute

() Product/Classification/Asset
(") Heading

(O Type

() Mumber

() Group

Footer

Setup

Cancel

8. After making the selections from the Select Row/Column dialog, select is or isn't and enter a string to be

matched with a value in the selected column or row, then click OK.
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Remove Rows/Columns

The Remove Rows/Columns transformation enables you to remove specified rows and/or columns from the table,
whether or not they are empty. For example, when you want to remove an unused row or column from the table,
then this transformation can be used.

Prequisites

StiboSystems

The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the Add a Transformation to a Table or Table Type subsection of the Table Transformations

topic.

Example

Before

Before the transformation is applied, the 'Country of Origin' column is present.

Defintion |l

Select version | Acme Party Supplies/English LS

w Gelect Preview Mode

Product Name SKU Color Material Neck Style |Size | |Country of |Price
origin U.5.)
Zeta Beefy-T short sleeve T-shirt  |18213-A Orange 100% Cotton Crew Neck (S CHINA 99 %
Acme Beefy-T short sleeve T-shirt  |179916-A Red pohyester/cotton blend (30070} [Crew Neck |S CHINA, 099 %
Acme Beefy-T short sleeve T-shirt  [179926-4 Blue polyester/cotton blend (30/70) |V-Neck s WIET MAM 993
Zeta Beefy-T short sleeve 179927-A Kely Green |polyester/cotton blend (30470} [W-Neck 5 CHINA, 8993
Acme Beefy-T short sleeve T-shirt  [242727-4  [Plum 100% Cotton W-Neck S CHINA 995
7eta Beefy-T short sleeve T-shirt  [100812-4  [Plum Polyester Crew Meck (M CHINA 895
Acme Beefy-T short sleeve T-shirt  |18216-A Royal Blue [100% Cotton Crew Neck |M WIET MAK 059%
Zeta Beefy-T short sleeve MT12404-A |Red Pohyester W-Neck M MEXICO G99 s
Acme Beefy-T short sleeve T-shirt  |173928-A Red pohyester/cotton blend (30070} [Crew Neck |M CHINA, 099 %
Acme Beefy-T short sleeve T-shirt  [238317-4  [Plum 100% Cotton W-Neck M CHIMA, 903
Acme Besfy-T short sleeve T-shirt  [181931-4  [Kely Green |100% Cotton Crew Neck |L MEXICO 099 %
Acme Beefy-T short sleeve T-shirt  |MT18400-A |Black Polyester W-Neck L CHINA, 4595
Beta Beefy-T short sleeve T-shirt  [100703-4  [Black Polyester Crew Neck |L BRAFIL 8958
Acme Beefy-T short sleeve T-shirt  [MT18403-A  [White Polyester Crew Meck |L CHINA 893
Beta Beefy-T short sleeve T-shirt  [182522-4  |Red Pohyester Crew Neck |L BRAZIL 4905
Acme Beefy-T short sleeve T-shirt  |236408-A  |Blue 100% Cotton W-Neck XL WIET MAK 4005
Acme Beefy-T short sleeve T-shit  [1795824-A  [White Polyester W-Neck XL MEXICO 400%
Acme Beefy-T short sleeve T-shirt  |18210-A Gray 100% Cotton W-Neck ML CHIMA, 903
Zeta Beefy-T short sleeve 179925-A Kely Green |polyester/cotton blend (30470}  [Crew Neck |[XKL CHINA, 893
Acme Beefy-T short sleeve T-shirt  |18212-A Royal Blue  [100% Cotton W-Neck HoEL | VIET MAM 995
Acme Beefy-T short sleeve T-shirt  [1819531L8-A |Gray 100% Cotton Crew Neck [33XL || [MEXICO 9595
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After applying the transformation, the 'Country of Origin' column is gone.

pefinition |l

Select version | Acme Party Supplies English US w Select
Product Name SKU Color Material Neck Style (Size  |Price
(U.5.)
Zeta Beefy-T short sleeve T-shirt  |18213-A Orange 100% Cotton Crew MNeck (S 999 %
Acme Beefy-T short sleeve T-shirt |179916-A  |Red polyester/cotton blend (30/70) |Crew Neck [5 1059 %
Acme Beefy-T short sleeve T-shirt  [179528-4  [Blue pohlvester/cotton blend (30/70) |WV-Neck 5 6.99 %
Zeta Beefy-T short sleeve 179927-A  |Kelly Green (pohlvester/cotton blend (30/70) [WV-Neck 5 999 %
Acme Beefy-T short sleeve T-shirt  |242727-4  [Plum 100% Cotton W-Neck g 0o90 %
Zeta Beefy-T short sleeve T-shirt  |100812-A [Plum Polyester Crew Neck |M 099 %
Acme Beefy-T short sleeve T-shirt  |18216-A Royal Blue [100% Cotton Crew Neck |M 10.99 5
Zeta Beefy-T short sleeve MT12404-A |Red Pohyester W-Meck M 0008
Acme Beefy-T short sleeve T-shirt  |179528-4A  |Red polyester/cotton blend (30/70) |Crew MNeck (M 10599 %
Acme Beefy-T short sleeve T-shirt  |239317-4  [Plum 100% Cotton W-Neck M 6.99 §
Acme Beefy-T short sleeve T-shirt  [181951-4  [Kelly Green |100% Cotton Crew Neck (L 1099 5
Acme Beefy-T short sleeve T-shirt  |[MT18400-A [Black Polyester W-Neck L 14585 %
Beta Beefy-T short sleeve T-shirt  [100703-4  [Black Polyester Crew Neck |L TOOS
Acme Beefy-T short sleeve T-shirt  |MT128403-A [White Polyester Crew Neck (L 6.09 5
Beta Beefy-T short sleeve T-shit  |182522-A  [Red Polyester Crew Neck |L 1455 %
Acme Beefy-T short sleeve T-shirt  [235408-A4  [Blue 100% Cotton W-Meck WL 1480 &
Acme Beefy-T short sleeve T-shirt  |179524-4A  [White Polyester W-Neck XL 1455 %
Acme Beefy-T short sleeve T-shirt  |18210-A Gray 100% Cotton W-Neck KL To99 %
Zeta Beefy-T short sleeve 179925-A  |Kelly Green |pohvester/cotton blend (30070 |Crew Meck |3CxL TO99 %
Acme Beefy-T short sleeve T-shirt  |18212-A Royal Blue [100% Cotton W-Neck oKL |699%
Acme Beefy-T short sleeve T-shirt  [181951LB-4 (Gray 100% Cotton Crew Neck [XOXXL (7005

S » [Transformation

> e

I Rremove Rows/Columns

Standard Sorting

I Remove Rows/Columns

Alternate Row Colors

> [

I Row/Column Text Formatting

> I Ruwjgnlumn Text Furma_ttinq

* [Parameters

For *7" do: Replace the whole value Replace the whole value Replace the whn

Sorting on Column 7

Femowve Column®™ 7°

Remove Column® Long Item Description™

Color 2 rows "Light Blue™ then 2 "White®", Restart count after Headings 1,

For "Country of Origin: Color:Material:" do: Replace the whole value Replace 1

P I Rremove Rows/Columns

Femowve Column®™ Country of Qrigin®

* | Add Transformation

See the Sorting Transformation topic for a more complex example which incorporates both a sorting
transformation and a row removal transformation.
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Steps

1. After adding the transformation, under Parameters, click the ellipsis button (...). The Remove
Rows/Columns dialog displays.

32 Remove Rows/Columns

Ok Cancel

2. Click the ellipsis button (...) to launch the Select Row/Column dialog.

The options available in this dialog have already been explained in the Row/Column Text Formatting
section of the Formatting Transformations topic; refer to that topic for more information.

¥ sSelect Row/Column

wi () Column

() Attribute

() Product/Classification/Asset

(") Heading

() Type Footer w

(") Mumber

() Group Setup

Cancel

7. Click OK.
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Fold Table

The Fold Table transformation enables you to split a table into two or more equal table columns. The
transformation breaks the table so that the content flows from one column to the next. This is useful if you have a
very tall table and would like to convert it to a shorter, more horizontally defined table.

Important: Rows in the table align over the folded table and space in between rows is divided evenly. If the
number of rows does not divide fully with the number of folds, empty rows are added at the end of the last fold.
This means that if there is an uneven number of rows, Fold 2 will have one less row than Fold 1.

Prequisites

The instructions in this topic assume that you have already added the transformation to your table by following the
instructions in the Add a Transformation to a Table or Table Type subsection of the Table Transformations
topic.

Example

Before

Before the Fold transformation is applied, the table is very tall and vertically oriented.
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Select version | Acme Party Supplies/English LS
SKU Color Neck Style |Material Size  |[Country of (Price
Origin (U.5.)
18213-A Orange Crews Neck |100% Cotton 5 CHINA 599 %
245304-A [Orange Crews Neck |100% Cotton 5 CHINA 599 %
179%16-A  |Red Crews Neck |polyester/cotton blend (30/70) |5 CHINA 1095 %
245311-A  |Red Crews Neck |polyester/cotton blend (30/70) |5 CHINA 1095 %
1759525-A  |Blue V-Neck pohyester/cotton blend (30070} |S WVIET NAM (6555
245314-A  |Blue V-Neck pohyester/cotton blend (30070} |S WVIET NAM (6555
179527-A |Kelly Green [V-Meck pohyester/cotton blend (30070} |S CHINA 599 %
245315-A [Kelly Green [V-Neck pohyester/cotton blend (30070} |S CHINA 599 %
242727-A |Plum W-Neck 100% Cotton s CHINA 5.99 5
245322-A  |Plum W-Neck 100% Cotton s CHINA 5.99 5
100812-A |Plum Crew Neck |Polyester M CHINA 599 %
245307-A  [Plum Crew Neck |Polyester M CHINA 599 %
18216-A Royal Blue |Crew Neck |100% Cotton M WIET MAN 1095 %
245305-A  |Royal Blue  [Crew Neck |[100% Cotton K WIET NAM  [10.895 5
245310-A |Red W-Neck Polyester K WEXICO 5.99 5
MT13404-A |Red W-Neck Polyester K WEXICO 5.99 5
1759528-A |Red Crews Neck |polyester/cotton blend (30/70) [M CHINA 1095 %
245316-A |Red Crews Neck |polyester/cotton blend (30/70) [M CHINA 1095 %
239317-A  [Plum W-Neck 100% Cotton K CHINA 6.99 5
245321-A  |Plum W-Neck 100% Cotton K CHINA 6.99 5
1815851-A  |Kelly Green [Crew Meck [100% Colton L MEXICO 1095 %
245317-A  [Kely Green |Crew Meck [100% Cotton L MEXICO 1095 %
245308-A  [Black W-Neck Polyester L CHINA 1459 5
MT12400-A |Black W-Neck Polyester L CHINA 1459 5
100703-A  |Black Crew Neck |Polyester L BRAZIL 799 %
245306-A  [Black Crew Neck |Polyester L BRAZIL 799 %
245309-A [White Crew Neck |Polyester L CHINA 599 %
MT18403-A |White Crew Neck |Polyester L CHINA 599 %
182522-A |Red Crew Neck |Polyester L BRAZIL 145858
245318-A |Red Crew Neck |Polyester L BRAZIL 145858
235408-A  |Blue W-Neck 100% Cotton KL WIET NAN  [1455 5
245320-A  |Blue W-Neck 100% Cotton KL WIET NAN  [1455 5
179924-A  |White W-Neck Polyester KL WEXICO 1459 5
245312-A  |White W-Neck Polyester KL WEXICO 1459 5
18210-A Gray W-Neck 100% Cotton L CHINA 7.99 5%
245302-A |Gray W-Neck 100% Cotton L CHINA 7.99 5%
1759525-A |Kelly Green |Crew Meck |polyester/cotton blend (30670} XML CHINA 799 %
245313-A  |Kelly Green |Crew Meck |polyester/cotton blend (30670} XKL CHINA 799 %
18212-A Royal Blue |V-Neck 100% Cotton HL |WVIETNAM  |6.59 5
245303-A  |Royal Blue  [V-Neck 100% Cotton HL |WVIETNAM  |6.59 5
181951LB-4 |Gray Crew Meck |100% Colton oL |MEXICO 7.99 5%
2453189-A  [Gray Crew Meck |100% Colton oL |MEXICO 7.99 5%
After

After the Fold transformation is applied, the table is horizontally oriented, with two folds.
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Select version | Aame Party Supplies/English L3 + Select Preview Node | Current Node
SKU Color Neck Style [Material Size  |Country of |Price sku Color Neck Style [Material Size  |Country of |Price
Origin (U.5) Origin (U.5)
18213-A  |Orange Crew Neck |100% Cofton ] CHINA 9995 |P45MT-A  |Kely Green [Crew Neck |100% Cotton L MEXICO 105998
245304-A  |Orange Crew Neck |100% Cofton ] CHINA 9995 |P45308-A  |Black V-Neck Polyester L CHINA 14598
179916-A  |Red Crew Neck |polyester/cotton blend (30/70) |5 CHINA 10.99 5| MT18400-A |Black V-Neck Polyester L CHINA 14598
245311-A  |Red Crew Neck |polyester/cotton blend (30/70) |5 CHINA 10.99 8| [100703-A  |Black Crew Neck |Polyester L BRAZIL  |7958%
179926-A  |Blue V-Neck polyester/cotton blend (30/70) |5 VETNAM |5.99% |[R45305-A  |Black Crew Neck |Polyester L BRAZIL  |7958%
245314-A  |Blue V-Neck polyester/cotton blend (30/70) |5 VETNAM |5.99% |R45308-A  [White Crew Neck |Polyester L CHINA 6.99 %
179927-A  |Kely Green |V-Neck polyester/cotton blend (30/70) |5 CHINA 9995 |MT18403-A |White Crew Neck |Polyester L CHINA 6.99 %
245315-A  |Kely Green |V-Neck polyester/cotton blend (30/70) |5 CHINA 9995 |H82922-A  |Red Crew Neck |Polyester L BRAZIL 14598
242727-A  |Pum V-Neck 100% Catton 8 CHINA 0.99% |P45313-A  |Red Crew Neck |Polyester L BRAZIL  |14.99%
245322-A  |Pum V-Neck 100% Catton 8 CHINA 0995 |P36403-A  |Blue V-Neck  |100% Cotton KL [VETNAM |1499%
100812-A  |Pum Crew Neck |Polyester ] CHINA 0.99% | P45320-A  |Blue V-Neck  |100% Cotton KL [VETNAM |1499%
245307-A  |Pum Crew Neck |Polyester ] CHINA 0995 |[179924-A  |White V-Neck  |Polyester KL MEXICO  |14.99%
18216-A  |Royal Blue |Crew Neck |100% Cotton ] VIET NAM  |10.99 8JR45312-A  |White V-Neck  |Polyester KL MEXICO  |14.99%
245305-A  |RoyalBlue |Crew Neck [100% Cotton ] VIET NAM  |[10.99 8J[18210-A  |Gray V-Neck  |100% Cotton WKL |[CHINA 799%
245310-A  |Red V-Neck Polyester ] MEXICO  |9.99 5 |P45302-A  |Gray V-Neck  |100% Cotton WKL |[CHINA 799%
MT18404-A |Red V-Neck Polyester M MEXICO  |9.99% ||179925-A  |Kelly Green |Crew Meck |polyester/cotton blend (30/70) [XXL  |[CHNA 7998
179928-A  |Red Crew Neck |polyester/cotton blend (30/70) (M CHINA 10.99 8| P45313-A  [Kelly Green |Crew Neck (polyester/cotton blend (30/70) [XXL  |CHINA 7595
245316-A  |Red Crew Neck |polyester/cotton blend (30/70) (M CHINA 10.99 8| 18212-A yal Blue  [V-Neck 100% Cotton WOl [VETNAN  |659%
239317-A  |Pum V-Neck 100% Catton ] CHIN ; | srmne gl RoyalBlue [V-Neck  [100% Cotton WL [VETNAM |699%
245321-A  |Pum V-Neck 100% Catton ] E‘MA 6.99% |[181951LB-A |Gray Crew Neck |100% Catton WL [MEXICO  |799%
181951-A  |Kelly Green |Crew Neck |100% Cotton L erIE‘.O 10.99 5| P45318-A  |Gray Crew Neck |100% Cotton WOl [MEXICD |7959%
¥

Steps

1. After adding the transformation, under Parameters, click the ellipsis button (...). The Fold Table dialog
displays.

£ Fold Table

] Repeat Al Heading 1's at top.

[ ] Repeat Last Heading 2
|:| Protect against orphans.

Orphans to move

Folds 1

Cancel

2. SelectRepeat All Heading 1's at top and/or Repeat Last Heading 2 depending on whether one or two table
headings need to be repeated in the next fold.
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3. Protect against orphans. and Orphans to Move: 'Orphan' is a typographical term that refersto a
paragraph-opening line that appears by itself at the bottom of a page or column, thus separated from the rest of
the text. The same concept applies to 'orphaned' rows in folded tables. Sometimes a 'Normal' (non-header)
row end up by itself on a fold when the headers are repeated, causing it to be orphaned.

Check 'Protect against orphans' to move any orphaned rows, and in the 'Orphans to move' field, enter the
number of orphans that should be moved.

4. Inthe Folds field, enter the desired number of folds, and then click OK. The minimum number of folds is 2.
5. Click OK.
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Horizontal Fold Table

The Horizontal Fold Table transformation is used to 'fold’ wide tables that contain a large number of columns
into a taller, vertically oriented table. Users may have a need for the Horizontal Fold Table transformation if the
table is so wide that it either cannot fit within a single InDesign page column or page, or if a vertical layout is
desired.

This transformation works similarly to the 'Horizontal Wrap Table' transformation (documented in the Table
Transformation: Horizontal Wrap Table topic), as both facilitate the ability to 'fold' a wide table into multiple
table sections ('folds' or 'wraps') that stack on top of one another. However, unlike the Horizontal Wrap Table
transformation, a table folded using the Horizontal Fold Table transformation is folded based on a designated
number of folds, not on particular column types. This transformation is also similar to the Fold Table
transformation (documented in the Table Transformation: Fold Table topic), except the Fold Table
transformation takes a table that is very tall and folds it over into a horizontally oriented table.

Though there are many combinations of configurations that can be applied within the transformation, the following
two screenshots show a sample 'before' and 'after' of a table (as previewed within the workbench) after applying
the Horizontal Fold Table transformation.

Example

Before:
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e It Bithday 10103 - Tables
ij Safety A (| Product || SubProducts || References || Referenced By || Images & Documents || Commercial Categary Profie || Proof View || Status

rj Hardware 9 Tebles -
; ) Nameg » |Defined At
[+-[7) Displays
E Furniture » Price Table Products
r_=| Automotive » Sales Price Table Local
rj Budng Products » Bpedfication Table Party Supplies
[ 7] Blectrical and Electronics
ij Food and Beverage » Table Guide Mot Defined
i [ Kitchen > | Add Tae Tupe
) Party Supples ey || Preview |
E Party Hats Select version | Acme Party Supplies/English US « Select Preview Node | Current Node
E Masks
--ﬁ Streamers Part Number |Short ltem Description Size Product Weight |Product Width |Product Height |List Price | Sale Price
=[] Chid Birthday Parties 123456 1st Birthday Boy Blue Cupcake Kit [N/A 2b 12in 5in 49,99 $7.99
-] IstBirthday 789112 istBirthday Boy Cupcake kit N/ 2 12in Sin 49,99 £7.99
rj Sweet 16 543216 1st Brthday Boy Party Hat Al Sizes |5 4in 3in £4.99 £3.99
[+ 7] Wedding 957416 1st Birthday Boy Paper Plates  [NJA 1 12in 12in £5.99 44,99
#-[5) Alarms 301897 1st Birthday Boy Party Banner ~ |NJ/A 2b ¥in 24in §12.99 49,99
- Alarm Clocks 5522836 1st Birthday Girl Cake Kit NJA 3k 12in 3in £12.99 $9.99
e[ Bectronics 1144885 1st Birthday Gil Cupcake kit /A 3b 12in 3in §299 3.9
[ Discontinued Products 541531 1stBirthday Girl Paper Plates  |Assorted  |1lb 8in ain £7.99 45,99
[ Product Overrides 4421255 1st Birthday Girl Party Invitation |Assorted  |1lb 10in 5in £14.99 49,99
i Packaing 44416 1st Birthday Girl Tiara OneSize 2 8in 3in £24,99 £14.99

After (preview only pictured):
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Select version | Acme Party Supplies/English LIS

Part Number |Short tem Description Size Product Weight
123456 1st Birthday Boy BElue Cupcake Kit  |N/A 2lb
789112 1st Birthday Boy Cupcake Kit M/A 2lb
543216 1st Birthday Boy Party Hat All Sizes Slb
957416 1st Birthday Boy Paper Plates M/A 1lb
301897 1st Birthday Boy Party Banner M/A 2lb
5522886 1st Birthday Girl Cake Kit M/A 3k
1144885 1st Birthday Girl Cupcake Kit M/A 3lb
541531 1st Birthday Girl Paper Plates Assorted 1lb
4421255 1st Birthday Girl Party Invitation Assorted 1lb
4646416 1st Birthday Girl Tiara One Size 2lb
Part Number |Short tem Description Product Width |Product Height
123456 1st Birthday Boy Blue Cupcake Kit 12in 5in
739112 1st Birthday Boy Cupcake Kit 12in 5in
543216 1st Birthday Boy Party Hat 4in ain
A57416 1st Birthday Boy Paper Flates 12in 12in
301897 1st Birthday Boy Party Banner 36 in 24in
5522586 1st Birthday Girl Cake Kit 12in 3in
1144585 1st Birthday Girl Cupcake Kit 12in 3in
541531 1st Birthday Girl Paper Plates &in & in
4421255 1st Birthday Girl Party Invitation 10in 5in
4546416 1st Birthday Girl Tiara ain 3in
Part Humber |Short ltem Description List Price Sale Price
123456 1st Birthday Boy Blue Cupcake Kit 3,93 5 7.99
739112 1st Birthday Boy Cupcake Kit 3,93 5 7.99
543216 1st Birthday Boy Party Hat 4,93 5 3.99
a57416 1st Birthday Boy Paper Flates 599 5 4,99
301897 1st Birthday Boy Party Banner 12,99 8 9,99
5522886 1st Birthday Girl Cake Kit 12,99 % .99
1144585 1st Birthday Girl Cupcake Kit 12,99 8 9,99
541531 1st Birthday Girl Paper Plates 7.93 5 5.99
4421755 1st Birthday Girl Party Invitation 1499 5 9,99
4546416 1st Birthday Girl Tiara 24,99 5 14.99
Prerequisites

StiboSystems

In order to take full advantage of this transformation, the table should meet these conditions:

Required:

« The table has a minimum of three columns

Optional:

« Though not required to use the transformation, tables using the Horizontal Fold Table transformation typically
use at least one column type of Heading (1) and/or Sub Heading (2).
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System Setup < Header Column - Column Type
ol o z
% Pivot Tables
E]% Price Tables Mame >| > |value
- -] Price Table > Name Header Column
=] sales Price Table > Defaults Vertical Adjustment:T
...... i i T
______ % , ead Headng (1
...... i Part Mumber * Publication Types Al

€ Subheader Column - Column Typ

=[] Sales Price Table Column Type
m Dimensions
~{fif] Header Column Mame >| > |value
m Part Mumber * Mame Subheader Column
~[ff] Price Before > Defaults Vertical Adjustment:
~{flf] Price NOW B
) e Cal] e 2000/ | pibredng @)
B Eaae — =
[ weight » Publication Types All
™ Head
[ Header & Legal for Table Types
~T] Mormal

This topic assumes the following:

« You have already built the table to which you will be applying the Horizontal Fold Table transformation.
Instructions on how to build the table itself are not provided in this topic; see the Creating Tables
documentation for more information.

« You have already designated which columns should be used as the header(s) and/or subheader(s). This topic
does not describe how to designate columns as such; for information, see the Creating Column Types topic.

Applying and Configuring the Horizontal Fold Table Transformation

For this topic, the example table has eight columns, two of which are headers (a header column and subheader
column), and the remainder of which are 'Normal Row' columns. (Even though the setting is Normal 'Row,’ this
setting applies to both rows and columns and simply means that the column / row is not used as a header, a
subheader, or a footnote column/row.)

Preview

Sales Price Table 1 32 33 > 14 3 (5 ' 57 » 18 >

Header Column  Subheader Column  Dimensions  Weight Dimensions Dimensions Price Before  Price NOW

|f Parthumber  |Jf Short Ttem De...| | Size (1§ Product weight [Jf Product width ] Product Height ] ListPrice || Sale Price

Header ‘ﬂi Mame | |Part Number Short Item Desri... |3i

—_
W

e Product Weight  |Product Width ProductHeight  |List Price Sale Price

2 Normal (£ Local
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The Preview of the table looks like this before any transformations are applied:

Select version | Acme Party Supplies/English U3 + Select Preview Node | Current Mode
Part Number  |Short ltem Description Size Product Weight |Product Width  |Product Height |List Price Sale Price
[123456 1st Birthday Boy Blue Cupcake  |M/A 2lb 12in 5in §9.99 £7.99
Kit

739112 1st Birthday Boy Cupcake Kit ~ [N/A 2lb 12in 5in £9.99 §7.99
543215 1st Birthday Boy Party Hat All Sizes Sl 4in Bin §4.99 §3.99
357415 1st Birthday Boy Paper Plates  [N/A 1b 12in 12in §5.99 §4.99
301897 1st Birthday Boy Party Banner  [N/A 2lb 36 in 24in §12.99 §3.99
5522886 1st Birthday Girl Cake Kit H/A 3lb 12in 3in £12,99 £9.99
[1144885 1st Birthday Girl Cupcake Kit  [N/A 3lb 12in 3in £12,99 £9.99
541531 1st Birthday Girl Paper Plates  |Assorted 1b gin &in §7.99 §5.99
|4421255 1st Birthday Girl Party Invitation |Assorted 1b 101in 5in §14.99 §3.99
“4p4e416 1st Birthday Girl Tiara One Size 2lb gin 3in §24.99 §14.99

To apply the Horizontal Fold Table transformation:

1. Inthe Tree, navigate to the product, classification, or product-override object that contains the table to which
you would like to apply the transformation, then click the Tables tab.
Select the table type to which you would like to apply the transformation, then click the Preview tab.
Beneath the table preview, click 'Add Transformation' to display the Select Transformation dialog.

Select the Horizontal Fold Table transformation, then click OK to apply the transformation.
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el 32 Select Transformation
543216
957416 ist Bil
Browse
301397 ist Bif -
iiﬁag E: :Ii -3 Layout Transformations
541531 1st E:‘ ﬁ Sortings
4421255 1stp| | 23 Formatting
4546416 stEl | =3 Transformations

IZ‘;F Merge Equal Cells

- [[§ Merge Over Empty Cells

|]I Remove Attribute Fows/Columns in Group
|]I Make Header Row from Column
- Remove Empty Rows/Columns
~[]¥ Merge Rows/Columns

~[1¥ suppress Rows/Columns

ﬂi Femove Rows/Columns

--[EEH Fold Table

-EH Horizontal Fold Ta_bIE.rI

- [ Horizontal Wrap Table

|]I Footnote Transformation

- Pivot Transformation

- W

» | » [Transformat
] EH Remove Emp
> 1T RowjcColumn| f @ seesi
> 1 Row/Colum
ﬂ Add Transformation Cancel

Next, the transformation itself must be configured. Click the ellipsis on the transformation to launch the
Horizontal Fold Table configuration dialog.

541531 1st Birthday 3% Horizontal Fold Table 5in £7.99 £5.99
Paper Plates
4471755 1st Birthday — , 5in $14.99 £9.99
Party Invitai ] Repeat Al Heading 1's at left.
4546416 1st Birthday []Repeat Last Heading 2 3in £24,99 214,99
Tiara "\.
[ ] Protect against orphans.
ax Orphans to move
¥ | ¥ [Transformation .
» [Ed Remove Empty R Folds 1 mns Heading Rows 0 Hea olumns 0
» I Row/Column Tex] Cancel e unit from value Insert text befor
» 13 Row/Column Tex] ext before
> [ Horizontal Fold Table [Fulds 1Repeat All Heading 1's at left. “false™ Repeat Last Heading 2 "false™ _IZ'
ﬂ Add Transformation
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6. The options within the Horizontal Wrap Table transformation dialog and their functions are as follows. The

options are described in the logical order in which they are typically selected.

« Folds: Inthe Folds field, enter a number to designate how many times the table should be folded. The

pefinition |l

following screenshot shows a preview of the table with (3) entered in this field.

Select version | Acme Party Supplies/English US . Select Preview Node | Current Mo

Part Number Short ltem Description Size
123456 1st Birthday Boy Elue Cupcake Kit M fA
789112 1st Birthday Boy Cupcake Kit M fA
543216 1st Birthday Boy Party Hat All Sizes
957416 1zt Birthday Boy Paper Plates M fA
301897 1st Birthday Boy Party Banner M fA
5522886 1st Birthday Girl Cake Kit M fA
1144885 1st Birthday Girl Cupcake Kit M fA
541531 1zt Birthday Girl Paper Plates Assorted
4421255 1st Birthday Girl Party Invitation Assorted
4546416 1st Birthday Girl Tiara One Size
Product Weight Product Width Product Height
2lb 12im 5in

2lb 12im 5in

Sl 4in 2in

1lb 12im 12in
2lb 35in 24in
3lb 12im 3in

3lb 12im 3in

1lb ain Gin

1lb 10im 5in

2lb ain 3in

List Price Sale Price

£9.99 £7.99

£9.99 £7.99

£4.99 £3.99

£2.99 £4.99

£12.99 £9.99

£12.99 £9.99

£12.99 £9.99

57.99 £2.99

£14.99 £9.99

£24.99 £14.99
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Repeat All Heading 1's at left.: Check this box to repeat all Heading (1) columns at the beginning of each
wrap. The below example shows how this table looks with the settings configured as follows:
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3% Horizontal Wrap Table

Repeat All Heading 1's at left.

[] Repeat Last Heading 2

Wrap on column type |Dimensions o |

Repeats |2 |

[k || cancel |

Preview

StiboSystems

Sales Price Table 1 3 (2 3 (3 4 3|5 & (7 3
eader Column | Subheader Column  [imensions  Weight Dimensions Dimensions Price Before  Price NOW
1§ Parttumber  |]F shortttemDe...[]f Sizz []T Product weight [T Product width |]f Product Height |]f Ustrice || Sale Price
1 »Header ‘HI Name | |Part Number Short Item Desari... Size Product Weight  Product Width ProductHeight  [List Price Sale Price
2 > Normal 5 Local
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Select version | Acme Party Supplies/English US  « Select Preview Mode | Current Mode

| Short tem Description Size Product Weight
123456 1st Birthday Boy Blue Cupcake Kit  |N/A 2lb
789112 1st Birthday Boy Cupcake Kit M/A 2lb
543216 1st Birthday Boy Party Hat all Sizes Sl
957416 1st Birthday Boy Paper Plates M/A 1l
301897 1st Birthday Boy Party Banner M/A 2lb
5522836 1st Birthday Girl Cake Kit M/A 3lb
1144885 1st Birthday Girl Cupcake Kit M/A 3lb
541531 1st Birthday Girl Paper Plates Assorted 1l
4421255 1st Birthday Girl Party Invitation Assorted 1l
4596415 1st Birthday Girl Tiara One Size 2lb
| Product Width Product Height List Price
123456 12in Sin £9.99
739112 12in Sin £9.99
543216 4in ain £4.99
957416 12in 12in £5.99
301897 36in 24in £12.99
5522886 12in 3in £12.99
1144885 12in 3in £12.99
541531 3in Gin £7.99
4421255 10in Sin £14.99
4546416 3in 3in £24.99
| Sale Price
123456 £7.99
739112 £7.99
543216 £3.99
957416 £4.99
301897 £9.99
5522886 £9.99
1144885 £9.99
541531 £5.99
4421255 £9.99
4540416 £14.99

» Repeat Last Heading 2: Tick this box to repeat the last subheader column at the beginning of each wrap. A
typical setup includes only one header and one subheader column. The below example shows how this table
looks with the settings configured as follows:

© Stibo Systems - Confidential - STEP Trailblazer 8.3

258



StiboSystems

3! Horizontal Fold Table

Repeat All Heading 1's at left.

Fepeat Last Heading 2

[] Protect against orphans.

Orphans to move | |

Folds |3 |

| ok || cancel |

Preview

Salles Price Table i 3 (2 |3 ¥ |4 ¥ (5 > (6 |7 > (8

Header Column  Subheader Column [Dimensions  Weight Dimensions Dimensions Price Before  Price NOW

T Parthumber |[3, Short ltem De...||] Size | Product weight |§ Product Width || Product Height |3 ListPrice [T Sale Price

Header ‘UI Name | |Part Number Shart Item Desdri... Size Product Weight  [Product Width ProductHeight  |List Price Sale Price

=y
w

2 »Normal (g Local
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STl Preview |
Select wersion | Acme Party Supplies/English US w Select Previ
IPart Number |Short ltem Description | Size Product Weight

123456 1st Birthday Boy Blue Cupcake Kit  |N/A 2lb
739112 1st Birthday Boy Cupcake Kit M/A 2lb
543216 1st Birthday Boy Party Hat all Sizes Slb
957416 1st Birthday Boy Paper Plates M/A 1lb
301897 1st Birthday Boy Party Banner M/A 2lb
5522856 1st Birthday Girl Cake Kit M/A 3lb
1144335 1st Birthday Girl Cupcake Kit M/A 3lb
541531 1st Birthday Girl Paper Plates Assorted 1lb
4421255 1st Birthday Girl Party Invitation Assorted 1lb
4546416 1st Birthday Girl Tiara One Size 2lb
Part Number |Short ltem Description Product Width |Product Height
123456 1st Birthday Boy Blue Cupcake Kit  |12in 5in
789112 1st Birthday Boy Cupcake Kit 12in 5in
543216 1st Birthday Boy Party Hat 4in ain
957416 1st Birthday Boy Faper Plates 12in 12in
301897 1st Birthday Boy Party Banner 36 in 24in
5522886 1st Birthday Girl Cake Kit 12in 3in
1144885 1st Birthday Girl Cupcake Kit 12in 3in
541531 1st Birthday Girl Paper Plates ain G in
4421255 1st Birthday Girl Party Invitation 10in 5in
4546416 1zt Bi i ain 3in
Part Number |Short ltem Description List Price Sale Price
123456 1st Birthday Boy Blue Cupcake Kit 59,99 £7.99
739112 1st Birthday Boy Cupcake Kit £9.99 £7.99
543216 1st Birthday Boy Party Hat £4.99 £3.99
957416 1st Birthday Boy Paper Plates £5.99 £4.99
301897 1st Birthday Boy Party Banner £12.99 £9.99
55228586 1st Birthday Girl Cake Kit £12.99 £9.99
1144885 1st Birthday Girl Cupcake Kit £12.99 £9.99
541531 1st Birthday Girl Paper Plates £7.99 £5.99
4421255 1st Birthday Girl Party Invitation £14.99 £9.99
4546416 1st Birthday Girl Tiara £24.99 £14.99

« Protect against orphans. and Orphans to Move: 'Orphan'is a typographical term that refersto a
paragraph-opening line that appears by itself at the bottom of a page or column, thus separated from the rest
of the text. The same concept applies to 'orphaned’ columns in folded tables.

Sometimes a'Normal' (non-header) column can end up by itself on a fold when the headers are repeated,

causing it to be 'orphaned,' as such:
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Definition | Rl

Select version | Acme Party Supplies/English IS « Gelect Preview MNode | Current Mode

Part Number Short tem Description Size Product Weight Product Width
123456 1st Birthday Boy Blue Cupcake Kit A 2lb 12in
739112 1st Birthday Boy Cupcake Kit A 2lb 12in
543216 1st Birthday Boy Party Hat Al Sizes Sl 4in
957416 1st Birthday Boy Paper Plates A 1lb 12in
301897 1st Birthday Boy Party Banner A 2lb 36in
5522830 1st Birthday Girl Cake Kit A 3lb 12in
1144885 1st Birthday Girl Cupcake Kit A 3lb 12in
541531 1st Birthday Girl Paper Plates Assorted 1lb gin
4421255 1st Birthday Girl Party Invitation Assorted 1lb 10in
4546416 1st Birthday Girl Tiara One Size 2lb gin
Part Number Short ltem Description Product Width Product Height List Price
123456 15t Birthday Boy Blue Cupcake Kit 12in 5in £9,99
739112 15t Birthday Boy Cupcake Kit 12in 5in £9,99
543216 15t Birthday Boy Party Hat 4in ain £4,99
857416 15t Birthday Boy Paper Flates 12in 12in £5.99
301397 15t Birthday Boy Party Banner 36in 24in £12,99
5527886 15t Birthday Girl Cake Kit 12in 3in £12.99
1144385 15t Birthday Girl Cupcake Kit 12in 3in £12,99
541531 15t Birthday Girl Paper Plates 3in G6in £7.99
4421255 1st Birthday Girl Party Invitation 10in 5in £14.99
4646416 15t Birthday Girl Tiara 2in 3in £24,99
Part Number Short ltem Description Sale Price

123456 1st Birthday Boy Blue Cupcake Kit £7.99

789112 1st Birthday Boy Cupcake Kit £7.99

543216 1st Birthday Boy Party Hat £3.99

857416 1st Birthday Boy Paper Plates £4.99

301897 1st Birthday Boy Party Banner £9.99

5527886 1st Birthday Girl Cake Kit £9.99

1144885 1st Birthday Girl Cupcake Kit £9.99
541531 1st Birthday Girl Paper Plates 40,99

Note: Number of folds takes precedence over orphan protection, so this option is more of a 'protect if possible'
option. In addition, this option only works when Sub Heading (2) columns are repeated; it will not work if only
Heading (1) level columns are repeated.

For the table pictured in the previous screenshot, ticking 'protect against orphans' will move the orphaned
column (Sale Price) up to the previous fold so it is no longer by itself. For this configuration, (1) has been
entered for Orphans to move.
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3! Horizontal Fold Table

Repeat All Heading 1's at left.

Fepeat Last Heading 2

Protect against orphans.

Orphans to move |1

Folds 3

Cancel

The 'orphan' Sale Price column is now moved to the previous fold:

Definition |l

Select version | Acme Party Supplies/English US + Select Preview Mode | Current Node

Part Number Short ltem Description Size Product Weight Product Width

123456 1st Birthday Boy Blue Cupcake Kit A 2lb 12in

789112 1st Birthday Boy Cupcake Kit A 2lb 12in

543216 1st Birthday Boy Party Hat All Sizes Sl 4in

357416 1st Birthday Boy Paper Plates A ilb 12in

301897 1st Birthday Boy Party Banner A 2lb 36in

5522886 1st Birthday Girl Cake Kit A 3lb 12in

1144885 1st Birthday Girl Cupcake Kit A 3lb 12in

541531 1st Birthday Girl Paper Plates Assorted ilb 3in

4421255 1st Birthday Girl Party Invitation Assorted ilb 10in

4646416 1st Birthday Girl Tiara One Size 2lb 3in

Part Number Short tem Description Product Width Product Height List Price Sale Price
123456 1st Birthday Boy Blue Cupcake Kit 12in 5in £9.99 57.99
789112 1st Birthday Boy Cupcake Kit 12in 5in £9.99 57.99
543216 1st Birthday Boy Party Hat 4in ain 4,99 £3.99
957416 1st Birthday Boy Paper Plates 12in 12in £5.99 24,99
301897 1st Birthday Boy Party Banner 36in 24in 512,99 53,99
5522886 1st Birthday Girl Cake Kit 12in 3in £12.99 £9.99
1144885 1st Birthday Girl Cupcake Kit 12in 3in £12.99 £9.99
541531 1st Birthday Girl Paper Plates ain 6in £7.99 £5.99
4421255 1st Birthday Girl Party Invitation 10in 5in 514,99 53,99
4546416 1st Birthday Girl Tiara ain 3in £24.99 £14.99
Part Number

'123456

789112

543216

957416

301897

5522886

1144385
A5-1:1531
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Orphaned Header Columns

As illustrated in the preceding section, moving an orphaned 'Normal' column can sometimes create an orphaned
header. In this example, it is the 'Part Number' Heading (1) column that has been orphaned and now appears by
itself on the last fold. Removing it will require a separate table transformation. (It is not unusual, however, to have
multiple transformations stacked on one another, as this is common with tables in order to manipulate them to their
final form.)

To remove this 'empty' header, the 'Remove Empty Rows/Columns' transformation must be added after the
Horizontal Fold Table transformation. Full instructions on how to configure this transformation are described in the
Table Transformation: Remove Empty Rows/Columns topic. But, to illustrate the configuration for this
example, a value of '1' is entered in the 'Heading Columns' field and the 'Remove Rows' box is ticked.

$2 Remove Empty Rows/Columns

Heading Rows 0|

Heading Columns 1

Remave Rows

[ ] Remove Columns

Cancel

The table now looks like this:
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Select version | Acme Party Supplies /English US

« Select Preview Mode | Current Mode

Part Humber Short ltem Description Size Product Weight Product Width

123456 1st Birthday Boy Blue Cupcake Kit A 2b 12in

739112 1st Birthday Boy Cupcake Kit /A 2b 12in

543216 1st Birthday Boy Party Hat all Sizes Sl 4in

957416 1st Birthday Boy Paper Plates /A 1lb 12in

301857 1st Birthday Boy Party Banner /A 2b 36 in

55228560 1st Birthday Girl Cake Kit /A 3lb 12in

1144885 1st Birthday Girl Cupcake Kit /A 3lb 12in

541531 1st Birthday Girl Paper Plates Assorted 1lb gin

4421255 1st Birthday Girl Party Invitation Assorted 1lb 10in

4646416 1st Birthday Girl Tiara One Size 2lb gin

Part Number Short ltem Description Product Width Product Height List Price Sale Price

123456 1st Birthday Boy Blue Cupcake Kit 12in 5in 9.99% 7.99

739112 1st Birthday Boy Cupcake Kit 12in 5in 9.99% 7.99

543216 1st Birthday Boy Party Hat 4in ain 4995 3.99

957416 1st Birthday Boy Paper Flates 12in 12in 5.99% 4,99

301897 1st Birthday Boy Party Banner 36 in 24in 12,99 % 9,99

5522386 1st Birthday Girl Cake Kit 12in 3in 12,99 % 9.99

11443585 1st Birthday Girl Cupcake Kit 12in 3in 12,99 % 9.99

541531 1st Birthday Girl Paper Plates ain Gin 7.99% 5,99

4421255 1st Birthday Girl Party Invitation 10in 5in 14,99 % 9,99

4546416 1st Birthday Girl Tiara 3in 3in 24995 14,99
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Horizontal Wrap Table

The Horizontal Wrap Table transformation is used to 'wrap' wide tables that contain a large number of columns
into a taller, vertically oriented table. Users may have a need for the Horizontal Wrap Table transformation if the
table is so wide that it either cannot fit within a single InDesign page column or page, or if a vertical layout is
desired.

This transformation works similarly to the 'Horizontal Fold Table' transformation (documented in the Table
Transformation: Horizontal Fold Table topic), as both facilitate the ability to 'fold' a wide table into multiple
table sections ('folds' or 'wraps') that stack on top of one another. However, unlike the Horizontal Fold Table
transformation, a table folded using the Horizontal Wrap Table transformation is not folded based on a designated
number of folds, but rather on particular column types, providing control over where these particular column types
land within the folds.

Though there are many combinations of configurations that can be applied within the transformation, the following
two screenshots show a sample 'before' and 'after’ of a table (as previewed within the workbench) after applying
the Horizontal Wrap Table transformation.

Before:

1st Birthday rev.0.3 - Tables

Product || SubProducts || References || Referenced By || Images & Documents || Commercial Category Profile || Proof View || Status
D Tables
Mame » [Defined At
» Price Table Products
» Sales Price Table Local
: » Gpedfication Table Party Supplies
[+-[7] Electrical and Electronics
E Food and Beverage » Table Guide Mot Defined
) Kitchen > | Add Talle Type
£ Party Supplies e || Preview |
E Party Hats Select version | Acme Party Supplies/English US « Select Preview Node | Current Node
[H-[7] Masks
--m Streamers Part Number |Short ltem Description Size Product Weight |Product Width |Product Height |List Price | Sale Price
= ild Bi ' irthday Boy Blue Cupca in in : .
= E Child Birthday Parties 173456 1t Birthday Boy Blue Cupcake Kit [NJA 2l 12 5 9.9 §7.99
#- y irthday Boy Cupca in in . .
15t Birthda 739112 1st Birthday Boy Cupcake Kit NJA 2l 12i 5i £9.99 £7.99
1j Sweet 16 543216 1st Birthday Boy Party Hat Al Sizes  |.51b 4in 3in £4.99 £3.99
(-7 Weddin irthday Boy Paper Plates in in . :
dding 057416 1st Birthday Boy Paper Plate NJA 1lb 12i 12i £5.99 £4.99
5] Alarms 301897 1st Brthday Boy Party Banner ~ |N/A 2l Jin 24in £12.99 £9.99
i) Alarm Clodks 5522386 1st Birthday Girl Cake Kit NJA £l 12in 3in £12.99 49.99
[ Bctonics 1144385 IstBirthday Gil Cupcake kit |N/A 3b 12in 3in §1299 16999
[ Discontinued Products 541531 1st Brrthday Girl Paper Plates  |Assorted |1l Bin Bin £7.99 £5.99
. irthday Girl Party Invitation  |Assor in in : :
E Broduct Overrides 4471255 1st Birthday Girl Party Invitation |Assorted |1l 101 5i £14.99 £9.99
. 4646416 1st Birthday Girl Tiara OneSize 2l Bin 3in £24.99 £14.99
- Packaging

After (preview only pictured):
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Select version | Acme Party Supplies/English LIS w Select Preview Mode | Current M
Part Number |Short ltem Description Size Product Weight |Product Width
123456 1st Birthday Boy Blue Cupcake Kit  |N/A 2lb 12in
789112 1st Birthday Boy Cupcake Kit M/A 2lb 12in
543216 1st Birthday Boy Party Hat all Sizes Sl 4in
957416 1st Birthday Boy Paper Flates M/A 1lb 12in
301897 1st Birthday Boy Party Banner M/A 2lb 36in
5522886 1st Birthday Girl Cake Kit M/A 3lb 12in
1144885 1st Birthday Girl Cupcake Kit M/A 3lb 12in
541531 1st Birthday Girl Paper Plates Assorted 1lb 3in
4421255 1st Birthday Girl Party Invitation Assorted 1lb 10in
4546416 1st Birthday Girl Tiara one Size 2lb 3in
Part Humber |Short ltem Description Product Height  |List Price Sale Price
123456 1st Birthday Boy Blue Cupcake Kit  |5in 9,99 £7.99
739112 1st Birthday Boy Cupcake Kit 5in 9,99 £7.99
543216 1st Birthday Boy Party Hat 3in £4,99 £3.99
a57416 1st Birthday Boy Paper Flates 12in £5.99 £4,99
301897 1st Birthday Boy Party Banner 24in £12.99 £9.,99
5522886 1st Birthday Girl Cake Kit 3in £12.99 £9.,99
1144885 1st Birthday Girl Cupcake Kit 3in £12.99 £9.99
541531 1st Birthday Girl Faper Plates Gin £7.99 £5.99
4421755 1st Birthday Girl Party Invitation 5in £14.99 £9.,99
4546416 1st Birthday Girl Tiara 3in £74,99 £14,99

Preconditions

In order to take full advantage of this transformation, the table should meet these conditions:

Required:

« The table has a minimum of three columns

« The table uses the same column type in at least two places within the table. This is the column type on which the
table will be wrapped and must be a column type of 'Normal Row.'

Optional:

» Though not required to use the transformation, tables using the Horizontal Wrap Table transformation typically
use at least one column type of Heading (1) and/or Sub Heading (2).

System Setup Header Column - Column Type

Eﬁ Table Types Column Type
l Eﬁ Fivot Tables
Eﬁ Price Tables Mame *| > |value
: - ff] Price Table > Name Header Column
=[] sales Price Table » Defaults Vertical Adjustment:T

...... il Dimensions > Feadi —d' W
______ i Fe = eadin i eading
...... il Part Mumber ublication Types Al
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€ Subheader Column - Column Typ

=[] Sales Price Table s Column Type
m Dimensions
—{fff] Header Column Name > > |value
~{flf] Part Mumber * Mame Subheader Column
~{fi] Price Before » Defaults Vertical Adjustment:
] Price NOW |
i e b eadr @
Llpneades — -
| Weight * Publication Types All
A Head
T Header &= Laaal for Table T
E Nurmal

This topic assumes the following:

« You have already built the table to which you will be applying the Horizontal Wrap Table transformation.
Instructions on how to build the table itself are not provided in this topic; see the Creating Tables
documentation for more information.

« You have already designated which columns should be used as the header(s) and/or subheader(s). This topic
does not describe how to designate columns as such; for information, see the Creating Column Types topic.

Applying and Configuring the Horizontal Wrap Table Transformation

For this topic, the example table has eight columns, which includes the repeating column type of 'Dimensions.' The
Dimensions column is a 'Normal Row' column. (Even though the setting is Normal 'Row,’' this setting applies to
both rows and columns and simply means that the column/ row is not used as a header, a subheader, or a
footnote column / row.)

System Setup Dimensions - Column Type

El% Frice Tahles a1 Column Type

- [ff] Price Table . val

: > >

=[] 5ales Price Table Ame uE
P > Name Dimensions
] Pimensions| e _ |} > |
[l Header Column > Vertical Adjustment:Top
] Part Numb
i i ?r HmBEr * Heading/Footer Mormal Row
(] Price Befare
- i Price NOW * Publication Types Al

The 'Dimensions' column type is used in three places in the table. The attributes used for the 'Dimensions' column
are Size, Product Width, and Product Height.
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Preview

Sales Price Table { > [z 5 (3 3 |4 5[5 3l (7 > >

Header Column  Subheader Column | Dimensions | Weight Dimensions Dimensions Price Before  Price NOW

1f Parttumber || shortttemDe... ] Size  |[|T Product weight | [ Product Width [[] Product Height || ListPrice  []T Sale Price

1 »Header ‘JI Mame | [PartMumber Short Ttem Descri... |Size Product Weight  |Product Width ProductHeight  |List Price Sale Price
2 > Normal (5 Local

Before applying the transformation, the table looks like this in the Preview view (Dimensions columns types are
outlined):

Definition |

Select version | Acme Party Supplies/English US «w Select Preview Node | Current Mode

Part Humber |Short ltem Description |5i1e~ | Product Weight ||Product Width |Product Height | List Price | Sale Price
t

123456 1st Birthday Boy Blue Cupcake Ki 2lb TTZn 5N £9.99 £7.99
739112 1st Birthday Boy Cupcake Kit A 2b 12in 5in 29,99 £7.99
543216 1st Birthday Boy Party Hat All Sizes s 4in ain 24,99 £3.99
957416 1st Birthday Boy Paper Flates A 1b 12in 12in £5.99 24,99
301897 1st Birthday Boy Party Banner A 2b 36in 24in 212,99 29,99
5522886 1st Birthday Girl Cake Kit A ib 12in 3in $12.99 £9.99
1144885 1st Birthday Girl Cupcake Kit A ib 12in 3in $12.99 £9.99
541531 1st Birthday Girl Paper Flates Assorted  |1lb ain G in £7.99 £5.99
4421255 1st Birthday Girl Party Invitation |Assorted [1lb 10in 5in 214,99 29,99
4546416 1st Birthday Girl Tiara CneSize 2b ain 3in 274,99 214,99

To apply the Horizontal Wrap Table transformation:

1. Inthe Tree, navigate to the product, classification, or product-override object that contains the table to which
you would like to apply the transformation, then click the Tables tab.

Select the table type to which you would like to apply the transformation, then click the Preview tab.
Beneath the table preview, click 'Add Transformation' to display the Select Transformation dialog.

Select the Horizontal Wrap Table transformation, then click OK to apply the transformation.
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123456

f@9112

543216

957416

301897

5522580

1144685

541531

4421255

4046416

.

>

Transformai

}ﬂ

Remove Emg

>[4 13

Row/Calumn

>[4 |13

Row/Caolumn

ﬂ Add Transformation

31 Select Transformation

Browse

|‘:'_=“| Layout Transformations

I‘:'_°“| Sortings

-3 Formatting

-3 Transformations

D* Merge Equal Cells

- [ Merge Over Empty Cells

~[]3 Remove Attribute Rows/Columns in Groug
DI Make Header Row from Column
- Remowve Empty Rows/Columns
(1§ Merge Rows/Columns

~[]¥ suppress Rows/Columns

~[]¥ remove Rows/Columns

-[EEH Fold Table

--[EH Horizontal Fold Table

lﬁ Horizontal Wrap Table I

|_|_I_ Footnote Transformation

-[EH Pivot Transformation

®- Details

Cancel

StiboSystems

5. Next, the transformation itself must be configured. Click the ellipsis button (...) on the transformation to launch
the Horizontal Wrap Table configuration dialog.

11443885 1st Birtd 3in 512,99 $9.99
Cupcaks 3 Horizontal Wrap Table

541531 1st Birth & in £7.99 £5.99
Paper P| [ ] Repeat All Heading 1's at left.

4421255 1st Birth Sin £14.99 £3.99
Party I [ ] Repeat Last Heading 2

4545416 1st Birth 3in £24.,99 £14.99

P - Wrap on column type |Dimensions e

» | * [Transformati

> [E] Remove Emp| Repeats 2] Columns Heading Rows 0 Columns 0

» I Row/Column Cancel emove unit from value Insert text be

» I Row/Column ert text before

1
» [EH Horizontal Wrap Table |F.epeats 1Repeat All Heading 1 at left. “false™ Repeat Last Heading 2 “false”
ﬂﬁu:lu:l Transformation

6. The options on the Horizontal Wrap Table and their functions are as follows. The options are described in the

logical order in which they are typically applied.
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« Wrap on column type: Select the column type on which the table should be wrapped. This is a dropdown
list that contains all column types used in the table. For the example table in this topic, the Dimensions
column type is used.

« Repeats: Enter the number of times the chosen 'wrap on' column type should appear in each wrap (fold) of
the table. If (1) is entered, one 'Dimensions' column will appear on each table wrap:

pefinition | Il

Select version | Acme Party Supplies/English US
Part Number Short ltem Description | Sire | Product Weight
123456 1st Birthday Boy Blue Cupcake Kit Z2lb
789112 1st Birthday Boy Cupcake Kit M A Z2lb
543216 1st Birthday Boy Party Hat All Sizes Sl
957416 1st Birthday Boy Paper Flates M A 1lb
301897 1st Birthday Boy Party Banner M A Z2lb
5522886 1st Birthday Girl Cake Kit M A 3b
1144585 1st Birthday Girl Cupcake Kit M A 3b
541531 1st Birthday Girl Paper Flates Assorted 1lb
4421255 1st Birthday Girl Party Invitation Assorted 1lb
4546416 1st Birthday Girl Tiara One Size Z2lb
Product Width

in
12in
4in
12in
35in
12in
12in
3in
100in
3 in
List Price Sale Price

] 5£9.95 £7.99
Sin 5£9.95 £7.99
3in 54199 £3.99
12in 5£3.99 £4.99
24in 5£12.99 £9.99
3in 5£12.99 £9.99
3in 5£12.99 £9.99
Gin 57.99 £5.99
Sin 5£14.99 £9.99
3in 524.99 514,99

If (2) is entered, there will be two Dimensions columns on each 'wrap.' (Only one Dimensions column
appears on the second wrap in this example since there are only three Dimensions columns in the table.)
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pefinition |l

Select version | Acme Party Supplies/English LS « Select Preview Mode | Current Mode

Part Number Short tem Description Product Weight Product Width

123456 1st Birthday Boy Blue Cupcake Kit|N/A 2lb 12in
739112 1st Birthday Boy Cupcake Kit M/A 2lb 12in
543216 1st Birthday Boy Party Hat all Sizes Slb 4in
957416 1st Birthday Boy Paper Plates M/A 1lb 12in
301897 1st Birthday Boy Party Banner  |N/A 2lb 35 in
5522886 1st Birthday Girl Cake Kit M/A 3lb 12in
1144335 1st Birthday Girl Cupcake Kit M/A 3lb 12in
541531 1st Birthday Girl Paper Plates Assorted 1lb gin
4421255 1st Birthday Girl Party Invitation |Assorted 1lb 10in
4646416 1st Birthday Girl Tiara One Size 2lb gin
IProduct Height I List Price Sale Price

Sin £3.99 $7.99

Sin £3.99 $7.99

gin 54.99 £3.99

12in £3.99 $4.99

24in £12.99 $9.99

3in £12.99 $9.99

3in £12.99 $9.99

gin £7.99 £3.99

Sin £14.99 $9.99

3in £24.99 £14.99

» Repeat All Heading 1's at left.: Check this box to repeat all Heading (1) columns at the beginning of each
wrap. The below example shows how this table looks with the settings configured as follows:

32 Horizontal Wrap Table

Repeat All Heading 1's at left.

[ ] Repeat Last Heading 2

Wrap on column type | Dimensions w

Repeats 2

Cancel
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Preview

Sales Price Table 1 3 (2 3 (3 > 4 3 (5 3 (5 (7 3 (3
Header Column | Subheader Column  [imensions — Weight Dimensions Dimensions Price Before  Price NOW

1§ Parttumber  |[|f Short ttem De... | Size |f Product weight ||§ Product width |]§ Product Height |]f UstPrice || Sale Price

1 Header ‘E Name | PartMumber Short Item Descri... (Size Product Weight  Product Width ProductHeight  [List Price Sale Price
2 » Normal (G Local

| efinition |

Select version | Acme Party Supplies/English US « Select Preview Mode | Current Made
I Part Number I Short Item Description Sire Product Weight Product Width
1st Birthday Boy Blue Cupcake Kit |M/A 2lb 12in

|739112 1st Birthday Boy Cupcake Kit A 2lb 12in
|543216 1st Birthday Boy Party Hat All Sizes 1] 4in
|357416 1st Birthday Boy Paper Plates A 1lb 12in
|301897 1st Birthday Boy Party Banner  |M/A 2lb 36 in
|9522886 1st Birthday Girl Cake Kit A 3lb 12in
|1144855 1st Birthday Girl Cupcake Kit A 3lb 12in
|541531 1st Birthday Girl Paper Flates Assorted 1lb ain
|4421255 1st Birthday Girl Party Invitation |Assorted 1lb 10in

4640416 1st Birthday Girl Tiara One Size 2lb ain
Product Height List Price sale Price

| 456 Sin £9.99 £7.99

|789112 Sin £9.99 £7.99

|543216 8in £4.99 £3.99

1957416 12in £5.99 £4.99

|301897 24in £12.99 £9.99

|5522886 3in £12.99 £9.99

11144885 3in £12.99 £9.99

|541531 & in £7.99 £5.99

|4421255 Sin £14.99 £9.99

|4646416 3in £24.99 £14.99

« Repeat Last Heading 2: Check this box to repeat the last subheader column at the beginning of each wrap. A
typical setup includes only one header and one subheader column. The below example shows how this table
looks with the settings configured as follows:
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¥ Horizontal Wrap Table

Repeat All Heading 1's at left.

Repeat Last Heading 2

Wrap on column type | Dimensions o

Repeats 2

Cancel

Preview

Sales Price Table i s s |3 s |4 3|5 3 |6 37 5B
Header Column  Subheader Column [Dimensions  Weight Dimensions Dimensions Price Before  Price NOW
Part Number JI Shart Ttem De... | Size 1 Product weight |Jf Product width || Product Height || ListPrice [T Sale Price
1 »Header ‘JI Name | |Part Number Short Item Desri... [Size ProductWeight  [Product Width  |ProductHeight |List Price Sale Price
2 »Normal (5 Local

T | Preview |

Select version | Acme Party Supplies /English US « Select Preview Mode | Current Mode

Part Number Size Product Weight |Product Width
123456 1st Birthday Boy Blue Cupcake Kit |N/A 2l 12in
739112 1st Birthday Boy Cupcake Kit M A 2l 12in
543216 1st Birthday Boy Party Hat All Sizes 5lb 4in
957416 1st Birthday Boy Paper Plates M A 1lb 12in
301397 1st Birthday Boy Party Banner  |N/A 2l 3ain
5522886 1st Birthday Girl Cake Kit M A 3l 12in
11445885 1st Birthday Girl Cupcake Kit M A 3l 12in
541531 1st Birthday Girl Paper Plates Assorted 1lb gin
4421255 1st Birthday Girl Party Invitation |Assorted 1lb 10in
4545416 1st Birthday Girl Tiara One Size 2l gin
Short ltem Description Product Height __|List Price sale Price
123456 1st Birthday Boy Blue Cupcake Kit|5in £9.99 £7.99
739112 1st Birthday Boy Cupcake Kit 5in £9.99 £7.99
543216 1st Birthday Boy Party Hat 3in £4.99 £3.99
257416 1st Birthday Boy Paper Plates 12in £5.99 £4.99
301897 1st Birthday Boy Party Banner  |24in £12.99 £9.99
‘5522886 1st Birthday Girl Cake Kit 3in £12.99 £9.99
1144835 1st Birthday Girl Cupcake Kit 3in £12.99 £9.99
541531 1st Birthday Girl Paper Plates & in £7.99 £5.99
4421255 1st Birthday Girl Party Invitation |5in £14.99 £9.99
4545416 1st Birthday Girl Tiara 3in £24.99 £14.99
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The Footnote transformation enables you to control how footnotes are displayed in a table and create a specified
footer row for footnotes.

SR Preview |

Select version | Acme Party Supplies/English US - Select Preview Node | Current Node
Product Part No. Image Long [tem Description Price
Name
Dog Party  |121180-4A i Set of five. Purple, gold, blue, pink  |[$19.99
Hats ol and greeen. Specify small, medium
Assortment or |
Pink & Blue [121183-4A b lebrate yvour giraffe’s birthd 3249
Giraffe p with this pink and blue pa
Party Hat el
Fink & Blue |121
Ovwil Party é
Hat /
: og party treats sold separatetz.r.l-i&iraffe not included.

For tables with uncomplicated footnotes, a typical standard setup is to keep the footnotes in separate text boxes
below the table on the product template, driven by a regular footnote text attribute, as pictured below. This works
well when footnotes apply to the entire table in general. It may also be easier to set up and maintain.

|<5TEF’T.J’-\BLE TT="stibo. 2856060 />

QotnoeE

STEPREF A="Footnot=2” DA=T DBE=T"/>

However, the table footnote transformation is often a better option when there are multiple footnotes in a table.
The transformation also provides these advantages:

« Automatic superscripting for footnote markers (e.g. superscript 1 2).

« The setup is more dynamic; footnotes are embedded within attribute values and do not have to be stored in
separate footnote attributes.

« Footnote numbering is dynamic; users do not have to manually enter superscript numbers into attribute fields,
avoiding the possibility of numbers being missequenced.

« Footnotes may be added into a free text cell of a table, again avoiding the need for separate footnote attributes.

© Stibo Systems - Confidential - STEP Trailblazer 8.3

274



StiboSystems

« Footnotes are placed in a dedicated, spanned row at the bottom of the table, which is an advantage when using
folded tables.

Creating the Footnote Tag

If no footnote tag exists, you must create one in System Setup. For more detailed information on how to create
tags, see the Tags section of the System Setup / Super User Guide documentation.

Follow these steps to configure a footnote tag.
1. Goto Tags under system setup and select the Footnotes tag group. Right-click and create a new Footnote
tag.

The footnote tag should not have any output formatting. It is merely needed for the system to set up the
transformation. If the tag is not created, 'Insert Footnote' will be grayed out when you want to add a footnote to
an attribute value.

System Setup < footnote - Footnote Tag =
-[E| Derived Events "

-z Object Types & Structures § Spedial Character Definition
=M=
=] 5 Mame »| > |Value ’
-0 Style T
E oo ty"IE- ags Mame Footnote
-- Spedal Characters Edited By
=
Character Tags Tag Footnote
E} Footnotes @ Qutput Formatting
El Format * [Formatting Start ¥ [Formatting Stop ¥
-- Hyperlinks
. :
EEI---& Units Add Formatting

EEI--@ Users & Groups

2. Ifthe same long text is used many times throughout a catalog, you can create the footnote text as a character
tag that you can insert in all the places where you want to use the text. This tag will be created as a regular
character tag, not as a footnote tag, though it will be used in conjunction with the footnote tag (i.e., itis nota
replacement for the footnote tag). Creating the footnote text as a character tag will ensure that the text is
consistent (e.g., always spelled correctly).

Note: Itis not necessary to create a footnote text character tag if the text is different on all footnotes.

Add Footnote Texts to an Attribute Value

Before you can add the footnote transformation, you first have to add footnote text to an attribute value.

Note: Do not add footnotes to attributes that may later be extracted for a publication index, e.g., a part number
attribute.

1. Navigate to the product In the Tree that has the attribute to which you would like to add a footnote. This must be
a text-based attribute.
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2. Double-click the attribute value field to edit it, then place your cursor in the location where you want to add the
footnote.

3. Right-click and select Insert Footnote.

[ Fdr LY SUpIes -
=[5 Party Hats ¢
E'ifl Paper Hats Mame | » |Value *
- Balloon Hats » Base Unit of Measure CASE
[+l Children's Hats » Desciption, Web ahe
E- Pet Hats et of five, Purple, aold, blue, pink
- |f™ Dog Party Hats Assortment # Long Item Description abe fand g . Specify small, medium
I .
ﬁ PFink & Blue Giraffe Party Ha > New Product 2l arE
- |{™ Pink &Blue Owl Party Hat : :
* Primary Color i
[}-[[T] Masks Spellin
[ Streamers * Product Diameter
[T Child Birthday Parties * Product Height Y0 Undo cange value of 1S0Date’ Ctrl+Z
=) Alarms * Product Mame i Redo Ctrl+Sh
=) Electronics * Product Status
38 Cut Ctrl+ X
Copy Ctrl+C
[B Paste Ctrl+V
[E Paste angdMatch Style Ctrl+5h
Style
Characterflag
¥ Insert Spedial Character Ctrl+5h
Inzert Inlink Reference
Edit Inline Reference
I Insert Footnote I

4. Inthe Insert Footnote dialog, choose the relevant Footnote tag from the Footnote type dropdown list.
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3 Insert Footnote

spell Check| Style v| Character Tag v“ B 7 |@

Footnote

0K

Cancel

StiboSystems

In the Footnote field, enter the footnote text as either free text or as a character tag, then click OK. The

footnote text can also be styled in this dialog.

3 Insert Footnote

spell Che::k| Style v| Character Tag v“ B 7 |ﬁ

Footmote type |Footmote

Footnote

Dog party treats sold separately.

0K

Cancel

The footnote symbol (1) displays in the attribute field.

Get of five. Purple, gold, blue, pink

and agreeep, Spedfy small, medium
or Iargei

k-

* Long Item Description ab

Note: If the same free text footnote is used for different products in same table, the footnote symbols are the
same for all footnotes. If the text does not match a 100% , then different footnote symbols are displayed.

Repeat these steps for all attributes to which you would like to add a footnote.
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Edit or Remove a Footnote

1. If you need to edit the footnote, place your cursor before or after the footnote symbol in the attribute field, then
right-click and select Edit Footnote.

2. Todelete the footnote, simply delete the footnote symbol from the attribute field.

Setting Up the Table

1. Create afootnote row type for your table in System Setup. In this step you are only creating the row type; you
will not create the footnote row on the table itself. The footnote transformation will later 'fetch’ the row and
insert it for you as part of the transformation functionality. Then, you can apply styling to the row type if desired.

The row must be designated as Footer for the transformation to work properly.

Important: This row type must only be used for footnotes.

System Setup < Footer - Row Type ~pmi
-- ¥, Users & Groups Pl Row Type
--Bu.. Reference Types
__,‘Z ] Workspaces Mame ¥ * [Value >
=il Table > ID 245293
2, Colors » MName Footer
é& Rules : :
EJ--Eﬁ Table Types » Defaults Vertical Adjustment:Top
[_].EE Table Row Types * Heading,/Footer Footer
EE& Price Table Rows » Publication Types All
T Header 3 Legal for Table Types
] Normal Name >
- Spec Table Rows s Price Table
EJ--Eﬁ Table Column Types > | Add Table Type
[+ {5 Keys o

2. Navigate to the table in which you want to add the footnote, then view the table on the Preview tab.

3. Ifthe footnotes were added correctly in the attribute fields, you will see the footnote symbols in the table.
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Defintion |l

Select version | Acme Party Supplies/English US -+ Select Preview Mode | Current Mode
Product Part No. Image Long [tem Description Price
Name
Dog Party  [121180-4A i Set of five. Purple, gold, blue, pink  |$19.99
Hats e fie and gr Specify small, medium
Assortment or largg
Pink & Blue [1211383-4 b Celebrate your giraffe's birthda 5249
Giraffe " with thiz pink and blue party ha
Party Hat w
Pink & Blue [121218-4 Celebrate your owrs birthday with |34.79
Owl Party é thie pink and blue party ha
Hat

Adding the Footnote Transformation

1.

StiboSystems

With your table open on the Preview tab, click 'Add Transformation' to launch the Select Transformation

dialog.
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» Price Table

» Bales Price Table

» Spedfication Table

3t select Transformation

Browse

> | Add Table Type

Definition | Iiad

Select version | Acme Party Sup_p
= |

Product
Name

Part No. Imag

Dog Party
Hatz
Azzortment

121190-A

A

Pink & Blue
Giraffe
Party Hat

121183-A

.

Pink & Blue
Owl Party
Hat

1231218-A

€

.

> >

}ﬁ

Alternate Row Color

}ﬁ

ﬂﬁkdd Tranzformation *

Transformation
Remove ErnptM
&= Details

|fl Layout Transformations
Ifl Sortings

Ifl Formatting

=125 Transformations

- [ Merge Equal Cells
- [[& Merge Over Empty Cells

-] Remove Attribute Rows/Columns in Group
~[]F Make Header Row from Column

- [EH Remove Empty Rows/Columns

~[]¥ Merge Rows/Columns

(] suppress Rows/Columns

~[]f remove Rows/Columns

[ Fold Table

~[EH Horizontal Fold Table

-[If Footnote Transformation
Pivot Transformation

Cancel

StiboSystems

& TE]
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pefinition |l

Select version | Acme Party Supplies/English LS  Select Preview Mode | Current Mode e
Product Part No. Image Long Item Description Price
Name
Dog Party  [121180-A ig Set of five. Purple, gold, blue, pink  |$159.99
Hats e and greeen. Specify small, medium
Assortment or large. 4
Pink & Blue [121133-A b Celebrate your giraffe’s birthday 5249
Giraffe ;;r with this pink and blue party hat i
Party Hat L
Pink & Blue [121218-A Celebrate your owrs birthday with  |34.79
0wl Party é this pink and blue party hatiT:
Hat

> » [Transformation * |Parameters >

» [EH Alternate Row Colors Color 1 rows "White™ then 1 "Light Blue®, Resta...
» [0 Remove Empty Rows/Columns Remove Rows Remove Columns Heading Rows ...
> I Footote Transformation "=n|::tnnte Tag: ™, Footnote Marker: ™

* | Add Transformation

4. Click the ellipsis button (...) to launch the Footnote Transformation dialog.

¥ Footnote Transformation

Footnote Tag

Footnote Row Type | Footer -

s

Start below column 1=

Footnote Separator

Footnote Marker

Style Settings

Cancel

5. Select the Footnote Tag from the dropdown list. This must be the same footnote tag used when you added
the footnote text to the attribute value.

6. Select the relevant Footnote Row Type from the list.

7. Inthe Start below column field, specify the column where the footnote row should begin below. This is
typically column 1, then the row spans all columns.

8. Inthe Footnote separator field, specify the separator to be used in between multiple footnotes when
mounted in InDesign. This applies when different footnote texts with the same footnote tag are found in the
same table. In this example, the character tag <LineBreak/> tag is used, though any separator may be used.

Note: The field does not recognize the repeat separators that are used in InDesign, such as \n.
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! Footnote Transformation

Footnote Tag
Footnote Row Type m
Start below column llil
Footnote Separataor <LineBreak/=
Footnote Marker ﬁ:“

| Style Settings |

ok || cancel

Example:

« <LineBreak/> tagin System Setup:

€ LineBreak/ - Character Tag i

EI% Tags WMl Character Tag

% Style Tags
% Spedal Characters Mame »| > |value »
=+ ) Character Tags > Name LineBreak

----- BeforeLastDigitinMumerat > Edited By

""" emspace » Character Tag LineBreak

----- EndFraction * Rendering —

----- FractionBar % Yoz

..... ft y

""" gt 3

""" In o Farmat ¥ [Formatting ¥

----- IntegerToFractions

— >
_____ @I HTML3 <BR.=
..... [t » InDesign < 00004

« <LineBreak/> footnote separator in table preview:
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el Preview |

Select version | Acme Party Supplies/English LS

w Select Preview Mode | Current Mode

Product Part No. Image Long Item Description Price
Name

Dog Party  |121190-A T Set of five. Purple, gold, blue, pink  |$15.99
Hats il and greeen. Specify =mall, medium
Assortment o Iﬂrge.‘

Pink & Blue |121183-A A Celebrate your giraffe's birthday 52.45
Giraffe X with this pink and blue party hat®

Party Hat -

Pink & Blue |121218-A Celebrate your owls bithday with [34.79
Owl Party é this pink and blue party hat™

Hat

! Dog party treats sold separatehy « | Giraffe not include ] 0wl not included.

« Mounted footnote row in InDesign:

" Dogparty treats.sold separatelf -]
2 Giraffe not include
* 0wl -notincluded #

In the Footnote Marker field, specify how to mark the footnotes in the table; for example, 1, 2, 3, 4, 5. It does
not matter whether or not spaces are added after the commas. When all footnote markers have been used in
the same table, the numbers / characters start over from the beginning. These values display as superscript
characters by default, without needing to have styling applied.

Example:

« Footnote markers in table preview:

Definition |

Select version | Acme Party Supplies/English US - Select Preview Node | Current Mode
Product |PartNo. (Image Long Item Description Price
Name
Dog Party  |121180-A s Set of five. Purple, goid, blue, pink  [$19.99
Hats L and greeen. Specify small, medium
Azsortment or larg
Pink & Blue |121183-A b Celebrate your giraffe’s birthd 32.45
Giraffe 4 with this pink and blue part},rhE
Party Hat =
Pink & Blue |121218-A Celebrate your owls birtlmw'rth 34.75
Owl Party é this pink and blue party h
Hat e
: og party treats sold separater'_.r.l-i*iraff& not included.wl not included.
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"Dog party treats sold separately -
2 Giraffe not included -
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* POwil not included #

« Leaving the field blank will mount superscripted numbers with a closing parenthesis character after them,
which may not always be desirable.

Product Part No. Image Long Item Description Price
Name

Dog Party  |121180-A i Set of five. Purple, goid, blue, pink  [$19.99
Hats GBS ang gresen. Specify small, medium
Aszsortment ar Iargﬁ

Pink & Blue |121183-A b Celebrate your giraffe’s birthd 32.45
Giraffe 2 with this pink and blue part},rhE

Party Hat v

Pink & Blue |121218-A Celebrate your owls birtlﬁwith 34.75
Owl Party é thiz pink and blue party h

ﬁug party treats zold separateh_.r.iraffe not included.EIle not included.

7. Click the Style Settings button to specify a style for the footnote text and/or additional styling for the footnote
row, such as background color, alignment, borders and so forth. The following screenshot shows the result
when 'italic' is chosen as the footnote text style.
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© Tables

Marme

> Price Table

Text Style

italic

» Sales Price Table

» Gpedfication Table

> | Add Table Type

Definition |

Select version | Acme Party Supplies,."Er;

Product Part No. Image
Name

Dog Party  |121190-A i
Hats arlihe
Azzortment

Pink & Blue [121133-A b
Giraffe )
Party Hat e
Pink & Blue [121213-A

Oheel Party

Hat

Background Color

Cell Stonl Direction

Cell Imzhe Scale

Mot Defined
Top

Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined

Mot Defined

Commercial [ Category Profile ” Proof Wiew " Skakus ” State Log ” Tasks ]
Product Product Variants ” Sub
&

Cancel

qe

I ! Dog party treate zold zeparately. —? Giraffe not included. = Cwi not included.

Using Characters Other Than Digits as Footnote Markers

StiboSystems

If you wish to use characters other than digits as footnote markers, special characters or character tags may be
added by right-clicking inside of the Footnote Marker field of the Footnote Transformation dialog.

¥ Footnote Transformati...

Footnote Tag Footnote -

Footnote Row Type | Footer

s

Start below column 1=

Footnote Separator | <) ineBreak/=

Footnote Marker
Character Tag

¥ Insert Special Character Ctrl+Shift+E

Cancel

|
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Footnote markers for each desired symbol must be placed into the field. Multiple footnote markers must be placed
in this field if multiple footnotes are anticipated. If only one marker is placed in the box, it will only be used for
footnote 1, and subsequent footnotes will revert to the '2)' style.

32 Footnote Transformati...

Footnote Tag Footnote -

Footnote Row Type | Footer -

s

Start below column 1=

Footnote Separator |« ineBreak//>

Footnote Marker * 1% 1T

Style Settings

Cancel

Example:

Defintion |l

Select version | Acme Party Supplies/English LS

Product Part No. Image Long [tem Description Price
Name

Dog Party  [121190-4A i, Set of five. Purple, gold, blue, pink  |$15.95
Hats e By and greeen. Specify small, medium
Aszzortment or largds

Pink & Blue [121183-4A A Celebrate your giraffe’s birthda 52.49
Giraffe .4 with this pink and blue party n

Party Hat w

Pink & Blue |121218-A Celebrate your owls birthday with |$4.79
Owl Party é thiz pink and blue party haﬁ

Hat

) Dog parly treatz sold EEE-;:uEln.r':.*tﬁhtl.-'.-'—f Giraffe not included = Owl not included.

.

* » [Transformation * |Parameters
» [ lalternate Row Colors Color 1rows "White™ then 1 "Light Blue®™, Restart count after
» Di Footnote Transformation Footnote Tag: Footnote} Footnote Marker: ™%, 1,%%, 71
* [ Remove Empty Rows/Columns Remove Rows Remove Columns Heading Rows 0 Heading Col

ﬂﬁkdd Transformation

Footnotes Based on Calculated Attribute Values

You can use footnotes based on calculated attribute values to handle new symbols in front of order numbers and
generate footnote text below the tables that contain the new symbols.
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Create a calculated attribute using the following value template for the calculation. For information on how to
create a calculated attribute, see the Calculated Attributes section of the System Setup / Super User
Guide documentation.

if {exact (FRODVAL("Brand Name™), 'Acme pen3'), "Acme
pens<RegistrationFoot><FootnoteRegistration/»></RegistrationFoot>",
{kIFRODmL{"Brand Hame") )}

In this example, the calculation does the following:

If the brand name is Acme pens, then the attribute value is "Acme pens” with a footnote sign. The footnote sign
is defined as: <RegistrationFoot><FootnoteRegistration/></RegistrationFoot> where the tags are:

<RegistrationFoot> and </RegistrationFoot>: The footnote tag types. There is a start and an end tag.

<FootnoteRegistration/>: The character tag that defines the output of the footnote text.

Make the calculated attribute valid for the part of the product hierarchy where you want the calculated attribute
to result in table footnotes.
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Pivot Table Transformations

Pivot tables (sometimes referred to as Compact or Compacted Tables), are useful in print applications to display
product data in a compact manner. They allow more products and product data to be presented in a smaller
physical area than a non-compacted table. Not only does this type of table require less space on a printed page, it
also enables the reader to compare similar products. Although it is not always the case, pivot tables usually show
more than one product in a single row. In addition to the table's compactness, another purpose of this type of
presentation is to allow the reader to see both the common attribute values of similar products as well as their
differences.

Pivot tables in STEP are created using the Pivot Transformation. You can apply pivot transformations to any table.
However, this transformation does require a high degree of data accuracy and consistency. The following
approach is recommended when working with this transformation.

« Create a pivot table type in System Setup if it does not already exist. For more information, see Creating
Table Types in System Setup.

» Create atable on a product in the Tree based on the pivot table type.
« Apply a Pivot Transformation to the table, experimenting with different setups.

This initial approach to learning about pivot transformations should help in understanding the functionality of the
transformation. It is very likely that you will need to create new row types and/or column types during your initial
experiments, so creating these new row / column types on this new table type will be easier to implement, as
opposed to modifying an existing table type. After learning the features and capabilities of the transformation, then
you may decide to modify your existing table types accordingly.

Areas of a Pivot Table — Introducing the Table Guide

The following figure shows a pivot table that has been specifically created to show how a pivoted table is built. The
different areas of the pivot table are identified by the use of background colors. There are seven areas. This table
is the same as that which is displayed in the Pivot Transformation Wizard, and is called the Table Guide. As you
progress through each step of the Pivot Transformation Wizard, the Table Guide will help you visually by
highlighting the area that will be affected by the options you select.
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Acme Drill Co. PSV Co.

Titanium Carbide Tipped

One of the purposes for presenting information in this manner is to allow the reader to easily compare similar
products, viewing both their common specification values and their differences. For example, a reader looking at
the first part number in the table (8J5H1), can see that there are some similar products, (8J5F4 and 8J6S4). They
have the same specifications for Diameter, Length, # Flutes, Angle, and Grade, but have different specifications
for the Material and the Brand Name. Since there are differences between these three products, the Price will
usually reflect that by also having a different value.

The different background colors identify seven areas. Each of these areas has a separate setup screenin the
Pivot Transformation Wizard. The name and purpose of each of these different areas are defined as follows, in the
order that they are presented in the Wizard:

Diameter Length # Flutes
15 12 mm ]
2.0 16 mm
2.5 20 mm 3
3.0 24 mim
35 28 mm 2
4.0 30 mm

The yellow cells denote the Left Common Values area. You may define the attributes that are common to all the
products in the same row. The attributes will be located on the left side of the table. There is a similar capability to
define attributes that should be placed on the right side of the table (in the brown area). If within the Pivot
Transformation no attributes are defined in either of these areas (yellow or brown), then table compaction cannot
be accomplished. That is, there must be at least one attribute declared as being a ‘common value' attribute for the
transformation to function. In the Table Guide, the attributes used in this area are: Diameter, Length, and Number
of Flutes (# Flutes).

Acme Drill Co. PSV Co.
HSS | Titanium Carbide Tipped

The light blue cells denote the Top Pivotal Values area. In the Wizard you can identify the attributes that you wish
to be 'promoted' into one or more header rows and these header rows will be created and placed at the top of the
table. There is a similar ability to define one or more attributes to be located in an automatically generated row (or
rows) at the bottom of the table, (the dark pink area). For any Pivot Transformation to work, there must be at least
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one attribute declared as either a Top or Bottom Pivotal Value. In the Table Guide, the 'promoted' attributes in this
top area are: Brand and Material.

SKU Price SKU Price SKU Price
8J5H1 13.99 8J5F4 13.99 8l654 14.99
8I5H2 16.99 BI5F5 16.99 816585 17.99
8J5H3 18.99 8J5F6 18.99 81656 19.99
8J5H4 22.99 8ISFT 22.99 81657 23.99
BIS5HS 23.99 8I5F8 23.99 8]658 24.99
8J5HG 31.99 | 8J5F9 31.99 | 8J6s9 32.99

The greencells denote the Compacted Values area. In the transformation you can state which attributes should
be placed in this area and these attributes will be rearranged so that products with the same common values will
be placed on the same row, and that they will be placed in the appropriate column corresponding to the promoted
attributes in the header rows. In the Table Guide the attributes that will be used are the SKU and the Price.

Brand
Waterial
| Diameer | Length | #Fues | SKU | Price | SKU | Price | SKU | Price | Angle | Grade |

The dark blue cells denote the Column Heading area. In the Table Definition tab a standard setup will have one
header row that holds all the column headings for the attributes that are called out in each column. In the Pivot
Transformation you can declare certain attributes to use for the table compaction (the 'promoted' attributes), and
the system will generate the appropriate number of header rows at the top and/or bottom of the table. In our
example, the attributes Brand and Material were the promoted attributes (and Box Type was promoted to the
Bottom Pivotal Values area, not shown). Since the cells with the attribute names in the generated top and bottom
header rows originated from the first row in the table definition (the column headings row), they are still considered
as 'column headings', thus the reason for showing them in their dark blue color. It is easy to suppress these
attribute names from appearing.

hngle Grade
c7
a2e
Ca
ag=
(95

The brown cells denote the Right Common Values area. This is an identical setup to that of the Left Common
Values area. In any Pivot Transformation there must be a minimum of one attribute defined in either the Left
Common Values or the Right Column Values. If no attributes are defined in either of these areas, (yellow or
brown), table compaction cannot be accomplished. In the Table Guide, the attributes used in this area are: Angle
and Grade.

Pop-Open Plastic Wooden Case
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The dark pinkcells denote the Bottom Pivotal Values area. This is similar to the Top Pivotal values area, with the
exception that the system will generate an appropriate number of header rows at the bottom of the table
depending on the attributes selected. For any Pivot Transformation to work, there must be at least one attribute
declared as either a Top or Bottom Pivotal Value. In the Table Guide, the attribute in this bottom area is: Box Type.

The red cells denote the table's Corners area. These areas are really independent of one another and may be
used for a variety of purposes. You may enter free text into any of these areas, or you may access attribute values
or image references from the original defined table. In the Table Guide, the information in the top left, top right, and
bottom right corners are all free text. In the bottom left corner an attribute has been called out to display the
'Quantity per Package type' attribute.

Preparing Tables for Pivot Transformation

The contents of table cells may be free text, product attribute values, product Names or IDs, meta-data, product
references, or asset references. In order to simplify this documentation only product attributes and free text are
used for the cell contents. But the other cell content types are equally valid and may be used in the Pivot
Transformation.

Itis recommended that the tables that are going to be involved with pivot transformations are all constructed in a
similar manner. That is, products in rows and attributes in columns are shown in the following general example
that matches that shown in the Table Guide.

Pivot Table i 22 af3 ' 4 2[5 13 3] '8 2 10 » it (12 ;
RedBold ‘Bold Spec Column  Spec Column  Spec Column  Spec Column Spec Column  Spec Column  Spec Column  Spec Column Spec Column Spec Column
1fsu  |[3erice ] Dameter |fiength |[If #Futes [Jf BoxType |f Brand  [|f Material |[f EndType |Jf Ange  |f Grade  |T QuantityPerPack

> Cowmbead.., |f Name SKU Price  Diameter  Length #Fltes  BoxType  Brand Materidl  [EndType  |Angle Grade  [QuanbtyPerPack
2 Spec Row (g Loca

In the example shown, there is only one header row used for the Attribute Names. It is of no use to set up a Table
Definition with more than one header row, since it will conflict with the Pivot Transformation. The transformation
will create additional header rows according to the setup within the transformation. It will only accept one header
row in the original Table Definition.

In the above example, the elements are organized in the following way. The first two columns will be used in the
Compacted Values area, the next three columns will be used for the Left Common Values, columns 6, 7, and 8 will
be used to generate header rows at the top and bottom of the table, and columns 10 and 11 will be used for the
Right Common Values. Column 9 is included in the table definition (attribute = End Type), but if an attribute is not
'mentioned' in the Pivot Transformation then it will be ignored (filtered out) and will not appear anywhere in the
resultant transformed table. Thus column 9 is included only to demonstrate that it is not present in the transformed
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table, regardless of whether or not there are attribute values in that column. As far as the Table Guide is
concerned, column 9 is redundant. And as far as the Pivot Transformation is concerned, it does not exist. The
attribute in column 12 will be used in the bottom left corner of the pivoted table.

Notes

The product attributes are all called out individually in this table definition, and the content definition of 'Attribute
Groups Attributes' has not been used. That option may be used if it is desired that the table is more 'dynamic', and
to reduce the number of localized tables. However, the Pivot Transformation does require that you state exactly
which attributes are to be used in the different areas of the table, either by attribute, Column Number, or Column
Type. So if you do use the 'Attribute Group Attributes' method you must know beforehand which attributes in that
group you wish to include within the transformation. Empty attribute columns can be easily discarded either within
the Pivot Transformation or via the standard transformation that removes empty columns and rows.

The above setup does make use of the content definition 'SubProducts, Family', so that the number of rows that
initially make up the table is dynamically sized according to the number of child products in the product family. If a
successful table compaction is done, there will be fewer rows after the pivot transformation.

If you wish you may create different column types for the different 'areas' in which the attributes will be used. But
you should be aware that no matter what you set up in the table definition tab you will still need to declare the
different row and column types within the transformation, since during the transformation all the original row and
column types are basically 'discarded'. So for the Table Definition, whether or not you organize your tables with
different column types is a matter of personal choice. However, there is one major advantage to assigning the
column types to match their intended 'area’ in the pivoted table, and that will also be explained later in the Working
with the Pivot Transformation Wizard.
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Pivot Transformation Step 1 Left Common Values

Steps 1.5 mm 12 mm -
2.0 mm 16 mm
1 Left Common V. 2.5 mm 20 mm
2. Top Pivotal Values 3
3.0 mm 24 mm
3. Compacted Values
4, Column Headings 3.5 mm 28 mm 5
5. Right Common Values 4.0 mm 30 mm
5. Bottom ot Values __ Quantity = 100/Box__ Box Type]

In the Table Guide, the Left Common Values will be the attributes for Diameter, Length, and # Flutes.

Reminder: The contents of table cells may be free text, product attribute values, product Names or IDs, meta-
data, product references, or asset references. But for purposes of simplicity in this document the terms "attribute”
and "attributes values" are used when referring to a cell's content.

) Mone

(®) Column Selector | IZI

| Faormat |

In this step you choose the attributes whose values are common to all the products in the same row and that will be
positioned on the left hand side of the table. You have the following options:

« Select None if you do not want any attributes in this area. If you choose this option, you will need to define at
least one attribute in the Right Common Values area. Otherwise the transformation cannot be
accomplished.

« If you wish to choose one or more attributes to be placed on the left side of the table, select the button with
the ellipsis symbol (the three dots) to open up the window where you will choose those attributes. When you
hit the ellipsis button the Column Selector radio button will automatically set. You will be presented with the
following screen:
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8 sSelect Column

() Attribute

(") Product/Classification/Asset

(1 Heading

™ Type LCompact Part Column

() Mumber

() Group

The options in this dialog box should be familiar, they are used for identifying columns or rows of attributes in
several other table transformations. If you know that you will be defining more than one attribute in the Left
Common Values area then you should immediately select Group and continue with the options that are brought
up. If you know that you will only be defining one single attribute in the Left Common Values area, then you may
make your selection in the usual manner from the options provided.

(7) Attribute
() Product/ClassificationfAsset ct Row/Columns to be grouped
(") Heading

() Type Compact Part Column

| OK || Cancel

() Mumber

(%) Group Setup |

| Ok || Cancel |

Selecting the Group option will cause a new window to launch ('Select Row/Columns to be Grouped'). Define as
many attributes as you wish.
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32 Select Row/Columns to be grouped

Undefined

O Attribute

() Product/Classification/Asset
(") Heading

(O Type

() Mumber

(%) Group |

| Ok || Cancel |

Each time that you select the 'Add' button (top picture) you will be presented with the options for identifying the
attribute that you wish to appear on the left side of the table, (bottom picture). Note that the attributes will display in
the pivoted table in the same order they appear in this setup. So the order in which the columns appear in the
Table Definition is irrelevant. It is at this Wizard Step that you select order of the columns to be displayed.

$2 Select Row/Columns to be grouped

Colurmn Diameter |Z|
Colurmn Length E

Colurmn # Flutes

| oK || Cancel |

The selection of attributes that matches the Table Guide.

When you are finished with your selections, then hit OK to return to the main Wizard screen. Your selections will
appear in the Column Selector line, similar to the following:
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(") Mone

(®) Column Selector piameter:Lengﬂﬁ:# Flutes;

| Format |

The Format Button — Left Common Values

The Format Button is available in seven of the Wizard screens. The options within the Format window are very
similar.

After making your selections as to which attributes will be placed on the left side of the table you need to define
how the attribute values in the newly formed columns should be displayed. If you click the Format button, you can
control the assignation of all the required Column Types in this area.

2 Format

[ ]
Text Style Mot Defined s Column types to apply

L)
Background Color | Not Defined = Every Column 1 H Compact Specifications: w

Vertical Alignment | Center MNane

Fule Above Mot Defined None

Rule Below Mot Defined Mone

= = = =
3 3 3 =]
= = = E
7] %] %] 7]
1] 1] m m
(=8 (=8 (=8 (=9

Rule Left Mot Defined Mone

Fule Right Mot Defined
Cell Rotation Mot Defined
Process Flag Mot Defined
Cell Story Direction |Mot Defined

Cell Image Scale

| Ok || Cancel

The options and selections in this window are the same as those for the Right Common Values.

Note that although the selections in the Format window for the Left Common Values and Right Common Values
windows are exactly the same they are completely separate. So when you are in the Left Common Values area
you will only be establishing setups for that area and not for the Right Common Values area.

The window is divided into two distinct areas, indicated by the vertical dashed line in the above picture. Over on the
right hand side of the Format window you may apply column types to the attributes that you just selected.
However, no matter what setups are defined within those Column Types that you have specified, the settings in
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the area over on the left hand side of the Format window will override those settings. You can therefore consider
the settings on the left side to be 'global overrides'. For more information see the section on Priority of Formatting
Setups.

For example, in the above screenshot, if there is a Background Color of 'Mango' defined in the Column Type = LH
Compact Specification, it will only take effect if there is no Background Color specified on the left.

Summary: Any setting that is not defined in the 'global overrides' area will allow the setting from the Column Type
(specified on the right side) to take effect. However, there are some additional conditions that will influence this,
see the section on Priority of Formatting Setups.

Applying Column Types

Column types to apply

Every Calurmn v | |1H Compact Spedfications;
Unused w | |Mome W
Unused v | |Mone W
Unused v | |Mone W
Unused v | |Mone W

Up to five 'rules' may be applied when assigning column types. Each rule has the same selection of options.

There are different ways of assigning Column Types since the number of attributes selected in the Left Common
Values area may vary from table to table. You have up to five sets of options or "rules" that you can apply to the
assignation of the Column Types:

Column types to apply

Every Column W

Second Column =
ird Column

Fourth Column

Fifth Column

Every First of two Columns w

The available selections within each rule.

o Unused: No Column Type is defined.

» First Column: The specified Column Type will be assigned to the first column in the Left Common Values
area.

« Second Column: The specified Column Type will be assigned to the second column in the Left Common
Values area.
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Third Column: The specified Column Type will be assigned to the third column in the Left Common Values
area.

Fourth Column: The specified Column Type will be assigned to the fourth column in the Left Common
Values area.

Fifth Column: The specified Column Type will be assigned to the fifth column in the Left Common Values
area.

Every Column: Every column in the Left Common Values area will be assigned the specified Column Type.

Every First of Two Columns: Starting at the first column in the Left Common Values area, every alternate
column will be assigned the specified Column Type.

Every Second of Two Columns: Starting at the second column in the Left Common Values area, every
alternate column will be assigned the specified Column Type.

Every First of Three Columns: Starting at the first column in the Left Common Values area, every third
column will be assigned the specified Column Type.

Every Second of Three Columns: Starting at the second column in the Left Common Values area, every
third column will be assigned the specified Column Type.

Every Third of Three Columns: Starting at the third column in the Left Common Values area, every third
column will be assigned the specified Column Type.

Remaining Columns: All columns in the Left Common Values area following the ones affected by the
previous rules will be assigned the specified Column Type. For example, if rules have been applied to the
first three columns, then from column 4 onwards the specified Column Type will be assigned.

Last Column: The last column in the Left Common Values area will be assigned the specified Column

Type.

When column types are applied, the rules are applied in the order they are listed, thus a later rule overrides an
earlier rule. For example, if the first rule is 'Every Column' and the second rule is 'Third Column', then all columns
will be assigned the Column Type defined in the first rule, except the third column, which will be assigned the
Column Type defined in the second rule.

Note that as a result of these different options it is possible to achieve the same result in different ways. For

example, review the setups in the following picture — they accomplish the same thing:

Column types to apply Column types to apply

First Calumn Compact Spedfication W Every Columnn v | | Compact Specification Right

Remaining Columns Compact Specification Rightt First Column v | |Compact Specfication o

Unused MNone W Unused w | |Mone W

Unused Mone W Unused w | |Mone W

Unused Mone W Unused w | |Mone W
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Pivot Transformation Step 2 Top Pivotal Values

In this Step you choose the attributes that you want the system to promote into the table headers, creating as
many header rows as required. The procedure is very similar to Step 1 with the exception being the formatting
options, where instead of Column Types you define the Row Types for the attributes that have been promoted into
row headers.

Steps
1. Left Comman Values ’ R P e
2. Top Pivotal Values . : : :
3. Compacted Values = Titanium Carbide Tipped

4, Column Headings

5. Right Cammon Values
6. Bottom Pivotal Values
7. Corners

8. Sorting

9. Settings

In the Table Guide, the Top Pivotal Values will be the attributes for Brand and Material.

=
Colurmn Material |£|

| 0K || Cancel |

The method of selecting the attributes is identical to that in Step 1. The above selection of the attributes Brand and
Material correspond to the attributes shown in the Table Guide.

The Format Button

In Step 1 the functionality of the Format button was described in detail. You may refer back to that section for
further information. The only difference between the Format window presented and that in Step 1 is that you will
select the Row Types for the attributes that you chose to be promoted into header rows. And the options in the
'Row Types to apply' will reflect row numbers, not column numbers. See the following image for reference.
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$# Format
Text Style Not Defined Row types to apply Row types to apply
i ! | First Row
Backaround Color | Not Defined v First Row Compact Header Row 1 w W
. : Unused A
Vertical Algnment | Not Defined v Second Row Compact Header Row 2w
Unused Mone Second Row E
Rule Above Mot Defined Third Row
Rule Below Mot Defined v Unused None Fourth Row
Unused N Fifth Row
Rule Left Not Defined w use one Every Row
E First of two Fow A
Rule Right Mot Defined VEry TSt Of hwo Rows

Cell Rotation Mot Defined

Process Flag Mot Defined

Cell Story Direction | Mot Defined

Cell Image Scale

In the Table Guide example two different Row Types have been applied, corresponding to the two attributes
Brand and Material that were selected to be promoted into row headers. This would allow for different fonts, point
sizes, background colors, etc. to be applied to the attribute values in the header rows. If the two new header rows
will have thew exact same specifications, there is no real benefit in assigning two different row types. Note that the
row types that you specify may or may not be the same as that of the first row in the Table Definition, they could be
completely different row types.

oeintion [V
Pivot Table 1 |2 s |3 »
Compact PartMo Compact Price LH Compact Spedifica. ..
Di SEL DI Price DI Diameter
1 » Column Head... ] Name Sk Price Diameter
2 » Bpec Fow (Cg Local

A reminder that in our sample table, the row type used for the column headers is 'Column Header Row'. This may
or may not be the same row type that is desired for the additional header rows that are created by promoting
attributes into those new rows.

If the format specifications will be the same for all header rows, it is perfectly acceptable to apply the row type that
is used in the Table Definition (in this case, 'Column Header Row') to all rows in the Top Pivotal Values, thus:
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Row types to apply

First Row w | | Column Header Row W
Unused w | [ Mone Y
Unused w | |Mone W
Unused w | |Mone W
Unused w | |Mone W

Note that you could also apply setups in the 'global override' area of the Format window. But that does not mean
that you can leave the right side 'blank’, since as a minimum you do need to tell the system that the rows are
header rows and not normal rows. If the table is mounted to a page and the system needs to split the table, then it
needs to know what the header rows are so that the appropriate row(s) can be carried over to the next column or
page. So as a minimum you need to fill in at least one entry for the Row Types, and that Row Type should have its
Header / Footer option set to set to Heading (1). That would be the standard setup.

Note that the options for the Bottom Pivotal Values in step 6 of the Wizard is identical to this one.
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Pivot Transformation Step 3 Compacted Values

Steps

1, Left Common Values
2. Top Pivotal Values
3. Compacted Values
4, Column Headings

5. Right Commaon Values
6. Bottom Pivotal Values
7. Corners

8. Sorting

9. Settings

In Step 3, you choose which attributes you want to go into the compacted area. You must select at least one
attribute. The method of selecting the attributes is the same as in the prior steps.

Compacted Values
(® Column Selector b+
| Format | O Attribute
[ ] Horizontal Values 33 Select Row/Columns to be grouped
Value Row () Collapsq¥ Column |

Colurmn |

In the Table Guide example the column types of PartNo and Price were selected.

The Format screen dialog is similar to that shown in Step 1 and 2, except you can specify both Row and Column
Types.
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|mers |
Row types to apply

Text Style Mot Defined v | [Unused v | [None v
Background Color | Mot Defined v | [Unused v | [None -
Vertical Alignment | Mot Defined v | [lUnused v | [Mone v
Rule Above Mot Defined v | [Unused v | [None v
Rule Below Mot Defined v | [Unused v | [None v
Rule Left Mot Defined % | Column types to apply

Rule Right Mot Defined w | |Every First of two Columns w | |Compact Part Column W
Cell Rotation Mot Defined w | |Every Second of two Columns  w | |Compact Price Caolumn v
Process Flag Mot Defined w | |Unused w | [Mone W
Cell Story Direction | Mot Defined w | |Unused w | |Mone w
Cell Image Scale Unused w | |Mane "

| OK | | Cancel

In the above setup each group of compact values will alternatively be assigned the Column Types of Compact Part
Column and Compact Price Column. This matches the settings for the Table Guide, where the column types of
Part No and Price were defined.

Also, in this step, you determine whether the compacted values will display within that area in a left-to-right
manner (as shown in the Table Guide, Price columns next to the SKU columns) or whether the display will show in
a top-to-bottom manner (SKU numbers displayed in one row, prices displayed on the next row). You can request
the system to further compact this area if, say, all the prices in the first price column are the same as the prices in
the second price column. For example, in the Table Guide you can see that all the prices for the HSS and Titanium
products are the same, so further compaction is possible. This is accomplished by the Horizontal Values setting
and its attendant options.
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Steps Compacted Values

1, Left Common Values
2. Top Pivotal Values

3. Compacted Values
4, Column Headings
5, Right Common Values Horizontal Values
6. Bottom Pivotal Values

(@) Column Selector tSKJ_I:F'rice: D

Compacted Values Column |-+ | () Collapse left () Collapse Right

7. Corners
3. Sorting
3. Settings Update Preview | (® Show Guide () Show Preview () Show Original

8J5H1 | 13.89 | BJ5F4 | 14.99 | BleS4 | 16.99
8I5H2 | 16.99 | BI5F5 | 17.99 | Bl6S5 | 18.99
8J5H3 | 18.99 | 8I5Fc | 20.99 | 8656 | 21.99
8I5H4 | 22.99 | BISF7 | 22.99 | BleS7 | 22.99
8I5H5 | 23.89 | BI5F8 | 27.99 | BIGSB | 24.99
8I5He6 | 2599 | BI5F9 | 31.99 | Bl6S9 | 25.99

| Back H Mext H Finish H Cancel ‘

The Effect of the Horizontal Values Setting

This is best shown by pictures. The following picture shows the effect on the display of cell contents within the
Compacted Area as a result of selecting the Horizontal Values checkbox. Note that it matches the example of the
Table Guide:

SKU Price SKU Price SKU Price
8J5H1 13.99 | 2J5F4 13.99 | 8J654 14.99
8J5H2 16.99 | 8J5F5 16.99 | 8J655 17.99
8J5H3 18.99 | 8J5F6 18.99 | 8J656 19.99
8J5H4 22.99 | 8J5F7 2299 | 8J657 23.99
8.J5H5 23.99 | 8J5F8 2399 | 8J658 24.99
8.J5HE 31.99 | 8J5F9 3199 | 8J659 32.99
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The following picture shows the effect on the display of cell contents within the Compacted Area as a result of
deselecting the Horizontal Values checkbox:

SKU | 8J5H1 8J5F4 8J6S4
Price 1ﬂ.99 13.99 14.99
SKU | 8J5H2 8J5F5 8J6S5
Price | 16.99 16.99 17.99
SKU | 8J5H3 8J5F6 8J6S6
Price |18.99 18.99 19.99
SKU | 8J5H4 8J5F7 8J657
Price |22.99 22.99 23.99
SKU | 8J5HS 8J5F8 8J6S8
Price |23.99 23.99 24.99
SKU | 8JSHE 8J5F9 8J659
Price |31.99 31.99 32.99

Performing Further Consolidation within the Compacted Area

Consider the following:

SKU Price SKU Price SKU Price
8J5H1 13.99 | 8J5F4 13.99 | 8J654 14.99
8J5H2 16.99 | 8J5F5 16.99 | 8J655 17.99
8J5H3 18.99 | 8J5F6 18.99 | 8J656 19.99
8J5H4 22.99 | 8J5F7 2299 | 8J657 23.99
8J5H5 23.99 | 8J5F8 23.99 | 8J658 24.99
8J5H6 31.99 | 8J5F9 3199 | 8J659 32.99

Note that the prices are the same in the first two compacted price columns.

Now review the following setting:

i®) Column Selector

| Format

Horizontal Values

Compacted Values Column |2 w

In the Column Selector, the column that held the prices was defined as the second column to compact. By using
the setting for the Compacted Values Column (set to 2, referring to the Compact Price column), the transformation

can then further consolidate the data, thus:
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SKU SKU Price SKU Price
8J5H1 8J5F4 13.99 | 8J654 14.99
8J5H2 BJSFS 16.99 | BJESS 17.99
8J5H3 8J5FB 18.99 | 8JESE 19.99
8J5H4 BJSF7 2299 | BJBST 23.99
8J5HS 8J5F8 2399 | 8J6s8 24.99
8J5HE 8J5F9 31.99 | 8J659 32.99

StiboSystems

Note that in the setting, 'Collapse Right' was chosen. This indicates (in this case) that the column furthest to the
right after the compaction should be used. If in this example 'Collapse Left' had been chosen, the price column
would have been positioned between the column starting with part number 8J5H1 and the column starting with
part number 8J5F4, since that would be the 'left-most' of the compacted price columns.

Also note that if you have more than just two attributes in the Compacted Area, you can compact those additional
attribute values. As you enter a value for one Compacted Values Column the system will automatically add

another blank entry for you to make your additional selection. Example:

Compacted Values Column |2 w

Compacted Values Column |- w

() Collapse left

() Collapse Right

Note: Merging the column headings of 'SKU' into one cell may be done by a subsequent standard transformation.
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Pivot Transformation Step 4 Column Headings

3t Pivot Transformation

Steps

1, Left Common Values
2. Top Pivotal Values

&. Battom Pivotal Values
7. Corners

8. Sorting
9, Settngs

In this step you choose which row in the Table Definition is the one to use for the Column Headings. As usual, you
can select that row by specifying the Attribute, Product/Classification/Asset, Heading, Row Type or Row Number.
Itis expected that in the vast majority of cases the selection will be made either by Row Type or Row Number.

$ Select Row

() Attribute

(") Product/Classification/Asset
(") Heading
Column Header Row

() Mumber

() Group

Note that it is not at all common for there to be more than one Column Headings row set up in the Table Definition.
Usually, any multi-row table headers are made up of the original header row plus the new header rows that have
been generated as a result of promoting attributes into that area (in Step 2 above).

(") Mone

(® Row Selector Fulumn Header Row
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The setup that matches that for the Table Guide.
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Pivot Transformation Step 5 Right Common Values
] pivot Transtormatio

Steps

Angle Grade

1. Left Common Walues

2. Top Pivotal Values

3. Compacted Values

4. Column Headings

5. Right Common Values -l
6. Bottormn Pivotal Values

7. Corners

&. Sorting

4. Settings

In this step, you choose which attributes that you want to appear on the right hand side of the table, i.e. to the right
of the Compacted Values area. The setup method is essentially the same as that described in Step 1, which
defined the attributes to the left of the Compacted Values area. Refer to Step 1 for more details. Some screen
shots are included showing the setup that corresponds to the Table Guide.

Since any Pivot Transformation requires at least one attribute to be defined either in the Left Common Values area
or in the Right Common Values area, then if None was selected in Step 1, you will be required to make an entry at
this point because the None radio button option will be disabled.

() Mone

(®) Column Selector I;!\ngle:Grade: () Attribute |

32 Select Row/Columns to be g... © Product/Classification/A... |

() Heading

(2 Type

Cnlumn| Angle |u| Remaove |

Culumn| Grade |U| Remove |

) Mumber

(® Group

[ ok || candl |

The above picture shows the selection of attributes for the Right Common Values that match the Table Guide.
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¥ Format

Text Style Pot Defined Column types to apply

Background Color | Mot Defined Every Column RH Compact Specifcations
Vertical Alignment | Center Unused Mane

Rule Above Mot Defined Unused Mone

Rule Below Mot Defined Unused Mone

Rule Left Mot Defined Unused Mone

Rule Right Mot Defined

Cell Rotation Mot Defined

Process Flag Mot Defined

Cell Story Direction Mot Defined

Cell Image Scale

The above picture shows the Format screen with all columns being assigned the column type 'RH Compact
Specifications'.
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Pivot Transformation Step 6 Bottom Pivotal Values

In Step 6, you choose which columns to use for the bottom header rows. The procedure is the same as in Step 2.
Any new rows generated as a result of promoting an attribute will be placed at the bottom of the table. Please refer
to Step 2 for details, some screen shots are included to show the setup that corresponds to the Table Guide.

Pivot Tra nsformaﬁﬂ

Steps

1. Left Common Values
2, Top Pivatal Values

3, Compacted Valuss
4. Column Headings

5. Right Common Values
6. Bottom Pivotal Values " | Box Type | Pop-Open Plastic | Wooden Case |
7. Corners

8. Sorting

9 Settings

In the Table Guide example, the attribute Box Type is used to create a bottom header row.

i) Mone 32 Select Column

(® Column Selector  Box Type Box Type

Format () Product/Classification/Asset

() Heading

O Type

() Mumber

() Group Setup |

| oK || Cancel |

The above image shows the selection of the attribute Box Type. Since only one attribute will be promoted to the
Bottom Pivotal Values the group option was not necessary.
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¥ Format

Text Style |i"~lut Defined D | Row types to apply
v | |E':.r».=_'r1,-I Fow W | |Cumpact Bottom Row 1w |

Background Colar |Nnt Defined

Vertical Alignment |Nut Defined v | |Unused v | |N‘:'”E

- | |Unused W | |Nune

Rule Above |Nut Defined

Fule Below |I"~Iut Defined I | |Unused hd | |Nur‘|e

| Unused W | | Mone

Rule Left |Nnt Defined W |

Rule Right |Nut Defined

Cell Rotation | Mot Defined

Process Flag |I"~Iut Defined

Cell Story Direction |Nnt Defined

Cell Image Scale |

The above shows the setup that matches that for the Table Guide example.
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Pivot Transformation Step 7

In Step 7, you define the contents of the four corners of the pivot table.

3 Pivot Transformation

Steps

1. Left Common Values
2. Top Fivotal Values

3. Compacted Values

4, Column Headings

5, Right Common Values
6. Bottom Pivotal Values
7. Corners

8. Sorting

9, Settings

The information specified in each of the four corners are independent of each other.

Corners

Top Left Corner

() Empty () Take from cell at Row | Column | |

(® Value |Drdering Information | | Format

Top Right Corner

() Empty () Take from cell at Row | Column | |

(®) Value |I'~"Ic|re Sizes Available Online | | Format

Bottom Left Corner

() Empty (@ Take from cell at Row |2 | Column |11 |

() Walue |Mure Sizes Available Online | | Format

Bottom Right Corner

() Empty () Take from cell at Row | Colurmn | |

@ Value |??? Call Us | | Format
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The image above shows the setup that matches the Table Guide example. Note that in the example the top left,
top right, and bottom right corner cells will have free text values, and that the bottom left corner cell is set up to
reference a row/cell number in the original Table Definition, thus:

Table Guide ‘12 3

Dummy L
1T quantityPerPack i

mn Head... |[JT Mame
2 * Mormal Row g Local

For each corner cell, you have the following options:

« Leave the cell empty.

« Retrieve the contents of a specific cell in the original table by specifying the intersecting row and column
numbers. The row/column numbers refer to the original table before the Pivot Transformation, and the
contents of the cell in the Table Definition may be an attribute reference, asset reference or free text.

« Enter the value (including any STEP tags) as free text.

Click the Format button to define the formatting of the cell in each corner.

Text Style Mot Defined W
Background Color | Cherry Red W
Vertical Alignment | Mot Defined v
Fule Above Mot Defined W
Rule Below Mot Defined W
Fule Left Mot Defined W
Rule Right Mot Defined v
Cell Rotation Mot Defined W
Process Flag Mot Defined W
Cell Story Direction |Mot Defined W
Cell Image Scale
| Ok | | Cancel

The above picture reflects the setup for the top left corner cell of the Table Guide example.
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The format of the cells in the corners does not have anything to do with any row or column type formatting. Thus
each of the four Format windows allows a different format style to be applied to the four corner cells.
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Pivot Transformation Step 8

In Step 8, click the Add Sorting Option button to define the sorting of the information in the Top or Bottom Pivotal
Values area and/or information in the Left or Right Common Values areas.

The sorting mechanism is similar to that of the Table Sorting Options, except that instead of specifying the sort
criteria by row / column type or attribute, instead you specify the column number in the Left or Right Common
values, or by row number for the columns that are in the Compacted Values area.

Example 1, sorting via the Left Common Values area:

Sorting

Comman Values Sorting

Left Side v | [ Ascending

| Add Sorting Option |

The above setup specifies that you wish to sort the 'body' rows of the table (i.e. the non-header rows) according to
the values in the second column in the Left Common Values Area, and in descending order. In the Table Guide
example the second column is the 'Length'. With this setup, if you have a table that matches the sample Table
Guide, it would look like this:

Brand ~ AcmeDrill Co. PSVCo. |
' Material HSS Titanium Carbide Tipped |

Diameter | Length | #Flutes | SKU | Price | SKU Price SKU | Price | Angle | Grade
4.0 30 mm 2 8J5H6 31.99 | 8J5F9 3199 | 8J659 32.99
3.5 28 mm 8JSHS 23.99 | 8JSF8 2399 | 8J658 24.99
3.0 24 mm p 8JSH4 | 22,99 | 8J5F7 2299 |8J6s7 | 2399
25 20 mm 8JSH3 18.99 | 8J5F6 18.99 | 8J656 19.99
2.0 16 mm 2 8J5H2 16.99 | 8J5F5 16.99 | 8J655 17.99
15 12 mm BJSH1 13.99 | 8J5F4 13.99 | 8J654 14.99

Note that the rows are now sorted according to the descending values of the Length.

Example 2, adding more sort criteria :
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Sorting

Comman Values Sorting

Left Side w3 w | [] Ascending

Left Side w2 [ Ascending

| Add Sorting Option

The above setup specifies that you wish to sort the 'body' rows, first according to the values in the third column in
the Left Common Values Area, then second according to the values in the second column. Both are sorted by
ascending values. The third column is '# Flutes', and the second column is the 'Length'. With this setup a table that
matches the Table Guide would look like this.

Brand ~ AcmeDrill Co. PSV Co.
| Material HSS Titanium Carbide Tipped |

Diameter Length | # Flutes SKU | Price SKU Price SKU | Price | Angle | Grade
1.5 12 mm 8J5H1 13.99 | 8J5F4 13.99 | 8J654 14.99
2.0 16 mm 5 8J5H2 16.99 | 8J5F5 16.99 | 8J655 17.99
3.5 28 mm 8J5H5 23.99 | 8JSF8 2399 | 8J658 24.99
4.0 30 mm 8J5H6 3199 | 8J5F9 31.99 | 8J659 32.99
2.5 20 mm 3 8J5H3 18.99 | 8J5F6 18.99 | 8J656 19.99
3.0 24 mm 8J5H4 22.99 | 8JSF7 2299 | 8J657 23.99

INCHREO0BGR oxType | Pop-Open Plasic Woodon Case_ [EEBCIE

You may also sort on the Right Side Common Values area, instead of selecting 'Left Side' in the dropdown you
would select 'Right Side'. You may specify the desired sorting of the body rows by combining left side and right
side sorting options respectively

The Common Values Sorting setup in essence specifies the order in which the rows are displayed in the pivoted
table. If you wish to also specify the order that the columns are displayed in the Compacted Area then you set that
up using the 'Compacted Columns Sorting'. So if, for example, you wanted the columns that have the headings
'Acme Drill Co." and 'PSV Co.' to display in reverse alphabetical order, and if you then wanted the columns 'HSS'
and 'Titanium' to occur in reverse alphabetical order, then the setup would look like this:
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[Sorting

Common Values Sorting

Left Side w1 w | [w] Ascending

Add Sorting Option

Compacted Columns Sorting

Top Pivotal Values w1 w | [w] Ascending

Top Pivotal Values w| |2 1wl [« Ascending

Add Sorting Option

StiboSystems

And the resultant table that matches the Table Guide would look like this:

Brand PSV Co. Acme Drill Co.
Material Carbide Tipped Titanium HSS ‘
Diameter | Length | #Flutes | SKU = Price = SKU Price | SKU | Price | Angle | Grade
15 12 mm 2 8J654 14.99 | 8J5F4 13.99 | 8J5H1 13.99
2.0 16 mm 8J6S5 1799 | 8J5F5 16.99 | 8J5H2 16.99
25 20 mm 9 8J6S6 = 19.99  8J5F6 1899 | 8J5H3 = 1899
3.0 24 rim 8J657 2399 | BJSF7 22.99 | 8J5H4 22.99
35 28 mm 2 8J6S8 2499 | B8JS5F8 23.99 | 8J5HS 23.99
4.0 30 mm 8J6S9 3299 | BJ5F9 31.99 | 8J5H6 31.99
ﬁ Box Type Wooden Case | Pop-Open Plastic _I

You may also sort on the Bottom Pivotal Values in a similar manner to sorting on the Top Pivotal Values. Instead of
selecting 'Top Pivotal Values' in the dropdown you would select 'Bottom Pivotal Values'.

The above examples used only the ascending and descending option (Alphabetic). But you also may also sort on

Numeric, and Fraction, thus:

1 w | [« Ascending (@) Alphabetic (C) Mumeric  (C) Fraction
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Pivot Transformation Step 9

In Step 9 you define some general settings.

Settings

Merge Equal Cells in the Left Common Values Rows
Merge Equal Cells in the Right Comman Values Rows
Merge Equal Cells in the Top Pivotal Values Columns
Merge Equal Cells in the Bottom Pivotal Values Columns
Remove Empty Value Rows

Remove Empty Value Columns

Allow More Than One Product in Each Pivot Value

A number of these options can be explained by referring to the Table Guide:

Brand PSV Co. | ~ AcmeDrill Co.
| Material | Carbide Tipped Titanium HSS |

Diameter | Length | # Flutes | SKU | Price = SKU | Price | SKU | Price | Angle | Grade
15 12 mm 2 8J654 14.99 | 8J5F4 13.99 | 8J5H1 13.99
2.0 16 mm 8J6S5 1799 | 8J5F5 16.99 | 8J5H2 16.99
25 20 mm 9 8J6S6 = 1999 8JSF6 = 1899 | 8J5H3 = 1899
3.0 24 rmm 8J6S7 2399 | 8J5F7 22.99 | 8J5H4 22.99
3.5 28 mm 2 8J658 2499 | 8J5F8 23.99 | 8J5HS 23.99
4.0 30 mm 8J6S9 3299 | 8J5F9 31.99 | 8J5HE 31.99
ﬁ Box Type Wooden Case | ' Pnp-Opdn Plastic _I

These options are explained as follows:

« Merge Equal Cells in the Left Common Values Rows: The Table Guide shows the effect of this setting.
The values in the '# Flutes' column have been merged when consecutive cells have an equal value.

« Merge Equal Cells in the Right Common Values Rows The Table Guide shows the effect of this
setting. The values in the cells of the 'Angle' and 'Grade' columns have been merged when consecutive cells
have equal values

« Merge Equal Cells in the Top Pivotal Values Columns: The Table Guide shows the effect of this
setting. The attribute value 'Acme Drill Co." was merged since consecutive cells had the same value.
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« Merge Equal Cells in the Bottom Pivotal Values Columns: The Table Guide shows the effect of this
setting. The attribute value 'Pop-Open Plastic' was merged since consecutive cells had the same value.

« Remove Empty Rows in the Compacted Values Area: Removes any row in the Compacted Area
where all the cells have empty values. This would only take effect if you had deselected the 'Horizontal
Values' checkbox in Step 3.

« Remove Empty Columns in the Compacted Values Area: Removes any column in the Compacted
Area where all the cells have empty values. This would only take effect if you had deselected the 'Horizontal
Values' checkbox in Step 3. So referring to the Table Guide, if in the Compacted Values Area all the Prices
were missing for the PSV Co. products, that column would be removed. Thus:

a v

Brand PSV Co. Acme Drill Co.
Material Carbide Tipped Titanium HSS
Diameter | Length # Flutes SKU SKU Price SKU Price | Angle | Grade
15 12 mm 2 8J654 8J5F4 13.99 | 8J5H1 13.99
2.0 16 mm 8J6S5 8J5F5 16.99 | 8J5H2 16.99
25 20 mm p 8J656 8J5F6 18.99 | 8J5H3 18.99
3.0 24 mm 8J657 8J5F7 2299 | 8J5H4 2299
a5 28 mm 2 8J6S3 8J5F8 2399 | 8J5H5 2399
4.0 30 mm 8J6s9 8J5F9 31.99 | BJSHE 31.99
_ Box Type Wooden Case Pop-Open Plastic _

« Allow More Than One Value in Cells in the Compacted Values Area: Consider the following table:

Brand PSV Co. Acme Drill Co.
Material Carbide Tipped Titanium HSS

Diameter Length # Flutes | SKU Price SKU Price SKU Price | Angle | Grade
20 16 mm 2 8J654 14.99 | 8J5F4 13.99 | 8J5H1 13.99
8J6S5 1799 | 8J5F5 16.99 | 8J5H2 16.99
25 20 mm 9 8J6S6 19.99 | 8J5F6 18.99 | 8J5H3 18.99
3.0 24 mm 8J657 23.99 | 8J5F7 22,99 | 8J5H4 22.99
35 28 mm 2 8J6S8 2499 | 8J5F8 23.99 | 8J5HS 23.99
4.0 30 mm 8J659 3299 | 8J5F9 31.99 | 8J5H6 31.99

_ Box Type Wooden Case Pop-Open Plastic _

Note that in the first 'body' row there are cells with two part numbers and prices. However, there is no data in that
row or column that distinguishes one product from the other. In other words the reader cannot see any difference
between part number 8J6S4 and 8J6S5. The price is different, but there is no supporting data to differentiate
between the two products. So all that a reader would see is that part numbers 8J6S4 and 8J6S5 have identical
specifications, but one is more expensive than the other. Thus any normal customer would always order the less
expensive item. Or they would have to investigate by some other method the difference between the products.
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This situation usually occurs when either a) the Table Definition is missing an attribute that would indicate the
difference in the products, or b) the data that does distinguish the two products is present in the Table Definition
but has not been accounted for in the Pivot Transformation, or c) the actual data is incorrect.

If you were to disable the checkbox 'Allow More Than One Value in the Compacted Area' then only the first entry
would be displayed (i.e. 8J6S4). But if the checkbox is selected, (i.e. it is OK to allow more than one product or
value in a cell), then the system will place a Return code between each entry in the cell.
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Pivot Transformation - Finish

Finishing the Transformation

When you have made all your selections, click the Finish button to return to the Table Preview. You could check
what the Table Preview would show before you exit the transformation, using the option '‘Show Preview', and
updating that preview each time you make a change. However, the preview within the transformation will take all
transformations that are applied within the table, even if one or more of them were temporarily disabled by
deselecting the check box for that transformation. If you wish to see the Table Preview with just the
transformations that you have selected, you need to exit the Pivot Transformation and view the preview as you
would normally.

Adding Subsequent Transformations

The Pivot Transformation is reasonably tolerant of working together with subsequent transformations, such as
creating table subheads from a column, or applying alternate tints on rows, etc. However, because the table has
essentially been rebuilt you will not be able to refer to a column by its attribute. The only practical way to refer to a
column, for example, is to refer to it either by its subtype or by its column number after the Pivot Transformation.
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Throughout the various Steps of the Pivot Transformation Wizard you are presented with options to specify the
formatting of the table cells. However, formatting can also be applied via the rows or column subtypes specified in
the Table Definition tab, as well as individual cell settings being applied. It is possible to create a setup that would
cause a conflict in determining which formatting values to use. Thus the Pivot Transformation uses a strict order of
prioritization. This priority is not always easy to determine, so an example is presented as a guide to help with

trouble-shooting any formatting "conflicts".

Determining how a table cell's background color is selected when

there are several conflicting setups in place

Note that this example of Format Priority is valid for all the following setups:

Text Style

Background Color

Vertical Alignment

Rule Above
Rule Below
Rule Left
Rule Right
Cell Rotation

Process Flag

Cell Story Direction

In the Table Guide, consider the cells that hold the values for the attribute Length. That attribute resides in the Left
Common Values area of the table.

In the Table Definition, assume that there are several setups in effect, as follows:
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Pivot Table 3 s |4 5|5 »
LH Compact Specifica. .. LH Compact SpedﬁeLH Compact Specifica. ..
[1T Diameter [T Length 1T #Flutes
1 » Column Head... (] Name Diamneter Length # Flutes
2 * Mormal F'.nwo [Cg Local a

1. Assume that the row type Normal Row has a default BG Color assigned to it (Cyan) and that the BG Color is
overridden in the Table Definition on that row with a color of Leaf Green. Refer to the following picture.

Row Type

Mame ¥ > |Value
* Mame Mormal Row
» Defaults badﬁgruund:Cyan"

Height in
! » Column Head... [T Name Text Style Mot Defined
2 * Mormal Row Ce Local

Background Color  |Leaf Green

L

W

The row type Normal Row has a BG Color of Cyan, but is overridden in the Table Definition with a BG Color of

Leaf Green.

2. Further assume that the column type LH Compact Specifications has a BG Color assigned to it and that it also
has an override BG Color of Orange applied in the Table Definition on the column holding the attribute Length.

Column Type
Mame > > Value
* Mame LH Compact Specifications
» Defaults Style: CompactSpedficationLeft Background:Canary Yellow
4
Compact Spedifica... Width Proportional W
% Length
Text Style Inherited: CompactSpedficationLeft W
Length Background Colar Drange Y

The column type LH Compact Specifications has a BG Color of Canary Yellow, but is overridden in the Table
Definition with a BG Color of Orange.

3. Last, assume that there is a BG Color override applied at the cell level.
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— 32 Change Cell Settings
,
Text Style Inherited: ColumnHeader—CompactSpedificationLeft w
Background Color | Sandy Beach Y,

Now consider the Format setup within the Pivot Transformation, and the effect that it has on the output.

First Priority

This setting takes the highest priority for cell formatting—the Global Override setup in the Pivot Transformation.
But be aware that this Global Override affects all cells in the Left Common Values area, not just the ones for the
cells with the attribute values for Length.

Text Style Mot Defined w | Column types to apply

Background Golor  |Mud Yellow / Every Calurmn v | [LH Compact Specifications  w

Vertical Alignment | Center ' d . Unused v | |Mone W
Diameter Length

Second Priority

If there is no Global Override for the BG Color, then the next priority goes to the Cell Settings override, thus:

Length 3% Change Cell Settings
Text Style Inherited: CompactSpedficationLeft o
Background Color | Sandy Beach W

Diameter Length # Flutes

15 12 mm 2

2.5 20 mm 3

35 28 mm 2

3.0 24 mm 3

4.0 30 mm 2

2.0 16 mm

Note that this setup affects only the cells with the attribute value of Length.
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Third Priority

If there is no Cell Settings override, then the next priority goes to any localized setting on the row type. Soin this
case, if a Row Settings override was applied to the Normal Row, the result would be similar to the following:

Pivot Table 1 s |7 » |3 >

LH Compact Spedifica... LH Compact Spedfica... LH Compact Spedifica. ..
[T Diameter [I3 Lenath 1T #Flutes

32 Change Row Settings

1 > Column Head... [T Name

2 * Mormal Row sy Local Height | in W
Text Style Mot Defined "
Background Color | Leaf Green W
Diameter  |Length # Flutes EL Price Skl Price Skl Price |
1.5 12 mm 2 BJEH1 £13.99 8.J5F4 £13.99 8654 $14.99
2.5 20 mm 3 BJ5H3 518.99 B.J5F6 518.99 BJESE $19.99
3.5 28 mm 2 BJSHS £23.99 8.JEF8 £23.99 B.JE58 £24.99
3.0 24 mm 3 8J5H4 $22.99 BJ5FT $22.99 BJEST $23.99
4.0 30 mm 2 BJ5HE £31.99 B8.J5F9 £31.99 B.J659 £32.99
.0 18 mm BJ5H2 %£16.99 BJ5F5 %£16.99 BJESE £17.99 |

Note that the row setting may well affect other cells in the table, not just the ones in the Left Common Values area.

Fourth Priority

If there is no Row Settings override, then the next priority goes to the default setting on the row type. So in this
case, if a default setting was applied to the Normal Row, the result would be similar to the following:

Mame ¥ > |Value
» Name Normal Row
» Defaults Background:Cyan
Diameter Length # Flutes SKU Price SKU Price
15 12 mm 2 BJSH1 $13.99 8J5F4 $13.99
25 20 mm 3 l8J5H3 $18.99 BJ5Fé $18.99
3.5 28 mm 2 ‘SJSHS $23.99 8J5F8 $23.99
3.0 24 mm 3 ‘8J5H4 $22.99 8J5F7 $22.99
4.0 30 mm 2 ‘BJEHG $31.99 8J5F3 $31.99
20 16 mm |8J5 H2 $16.99 8J5F5 $16.99

Note once again that the row setting may well affect other cells in the table, not just the ones in the Left Common
Values area.
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Fifth Priority

If there is no default setting on the row, the next priority goes to any Column Settings override, but only ifthe
column type in the Table Definition is the same as that applied in the Transformation, thus:

Pivot Table 1 » |2 3|3 » |4 »|5 »
Compact Partho Compact Price LH Compact Spedfic... LH Compact Spedific... H Compact Spedfic...
(13 sku [T Price (I3 Diameter [IT Length [T #Flutes
1 » Column Head... [|T Name Sk Diameter Length # Flutes
2 »MNormal Row 5 Local h |

3 Format

Text Style fot Defined { | Column types to apply

Badkgrownd Calor [Nt Defined Every Column v | |LH Compact Specifications  w

lUnused w | |MNone v

Vertical Alignment | Center

38 Change Column Settings M L il
15

Width Proportional 2.5
35

Text Style Inherited: CompactSpedificationLeft v | Calumn Type -

Background Color Orange v 4.0

If the column type in the Table Definition does not match the column type that is applied in the Transformation,
then the Column Settings override in the Table Definition will be ignored.

Sixth Priority

If there is no Column Settings override, the last priority goes to the default setting in the column type that is
assigned in the Transformation, thus:

$ Format

Text Style flot Defined iy | Column types to apply
Every Column w | |LH Compact Spedifications

Background Color | Mot Defined

Vertical Alignment | Center Unused w | | Mone W

Column Type Criameter Length # Flutes
15 12 mm 2
Mame *| » |Value Sc =0 mm 3
> Mame LH Compact Spedfications 35 =8 mm z
» Defaults Style:CompactSpedficationLeft Background:Canary Yellow (3.0 24 mm 3
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Formatting Priority Synopsis

Global Override in the Transformation

Cell Setting override in the Table Definition
Row Setting override in the Table Definition

Row Setting default in the Table Definition

ok 0N =

Column Setting override, but only if the column type in the Table Definition matches that which is appplied in
the Transformation

6. Column Setting default, as applied in the Transformation

Comments

Itis not Best Practice to assign settings in such a way that it is difficult to determine which format setting is actually
used. It should be sufficient to make setups such that only one or two levels of priority are necessary.

If you wish to apply background colors to alternating rows you are advised to not use BG colors in any of the
row/column settings that will affect "body" rows (non-header rows) and use the standard transformation that will
apply those BG colors. That transformation may be applied after the Pivot Transformation.

If possible, try to avoid Text Style format setups that will cause a conflict in how the Table Preview can display the
text.
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Header Repeating Pagination Plugin

The Header Repeating Pagination Plugin is accessible on Table Type objects. The settings available in this
'plugin’ allow more control over the behavior of tables—specifically related to the behavior of repeated header and
footer rows—when lengthy tables split across columns or pages.

Though the settings contained within this 'plugin' are not transformations, they are designed to work along with
transformations, or in some cases, in place of them. For example, the Alternate Row Colors transformation may
be sufficient for simple, smaller tables, but for lengthy tables that split, more control is needed in how the alternate
row colors are calculated when headers split across pages. In this instance, the Header Repeating Pagination
Plugin would be used instead of the Alternate Row Colors transformation.

Note that all settings are not necessary for all tables. The specific combinations chosen are dependent on the
unique requirements for the table type being configured.

To configure the Header Repeating Pagination Plugin, follow these steps.

1. In System Setup, expand Table, then expand Table Types.

2. Expandthe Table Type Group that contains the table type that you would like to configure, then select the
relevant table type.

3. Onthe Table Type tab, click in the Pagination Plugin field and select Header Repeating Pagination
Plugin. ('"None' will appear as the default selection.)

Price Table - Table Type

MName >| > |Value »
> D stibo. 1776444
> Mame Price Table
» Edited by 2017-10-18 12:55:58 by USER4
» Defaults
» Dimension Dependencies Language;
»| Pagination Plugin Header Repeating Pagination Plugin « [Change Settings
&~ Legal Row Types Mone

Header Repeating Pagination Plugin

@ Legal Column Types

4. Click on Change Settings, which appears directly to the right of the dropdown list. The Header Repeating
Pagination Plugin displays.
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32 Header Repeating Pagination Plugin

9_

Minimum Body Rows to Keep With Heading at Bottom of Column

Minimum Body Rows to be Carried Over to Top of Next Column
o v
o v

Minimum Body Columns before a table width split 0
Minimum Body Columns after a table width split 0
4
MName >
» [ Add Row Type
i
MName >
* | Add Column Type
4
MName >
» [ Add Row Type
i
MName >
* | Add Column Type
i
MName >
* | Add Row Type
§ MtenatingRow Colors Settngs
[+] Enable alternating row colors

[ Restart row count at always repeated headers
[]Restart row count at repeat last headers

[+] Ignore always repeated headers

[]Ignore repeat last headers

[ 1gnore footers

Mormal Colored Rows

Alternate Colored Rows

§»—~»—~
g

Mormal Color

Alternate Color

=

te ~

G TableRuersand Widthsetngs

[+] Use table bottom ruler on splits as bottom ruler.
[+#] Use table top ruler on splits as top ruler.

[+] Use table left ruler on splits as left ruler.

[+#] Use table right ruler on splits as right ruler.

[] Enable table split when wider than frame

] Break before table width split

[oc ]

In the Row/Column counts area, make the following selections as needed:
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11.
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o In Minimum Body Rows to Keep With Heading at Bottom of Column, select a number from the
dropdown list. Numbers range from 0 to 10.

For example, while doing pagination, if your table is placed at the bottom of the page and continues to the
next page or column, this checks for the minimum number of rows to be placed before splitting the table.

o In Minimum Body rows to be Carried Over to Top of Next Column, select a number from the
dropdown list. Numbers range from 0 to 10.

For example, while doing pagination, if your table is placed at the bottom of the page and continues to the
next page or column, this checks for the minimum number of rows to be placed after splitting the table.

« In Minimum Body Columns before a table width split, select a number from the dropdown list.
Numbers range from 0 to 10.

« In Minimum Body Columns after a table width split, select a number from the dropdown list. Numbers
range from 0 to 10.

In the Always Repeated Row Headers area, click Add Row Type to choose the heading and/or subheading
row types that must always be repeated when a table is split. This will repeat the row header when the table is
continued from one page / column to another.

| Product Name Part No. Price | [Product Name Part No. Price
Lhnstmas Farty Hat T2MM84-A 8759 Yellow & Green Farty Hat THAATE-A 7 4.79
Cosmic Party Hat 134413-A 53.09 Glitter Party Hat 138934-A | §3.99

In the Always Repeated Column Headers area, click Add Column Type to choose the heading and/or
subheading column types that must always be repeated when a table is split.

Inthe Repeat Current Header Row (in order of priority) area, click Add Row Type, then select the
heading and/or subheading row types where only the last row of that type will be repeated when a table is split.

In the Repeat Current Header Column (in order of priority) area, click Add Column Type, then select
the heading and/or subheading column types where only the last column of that type will be repeated when a
table is split.

In the Repeated Table Footers area, click Add Row Type to select the footer row types that must be
repeated at the bottom of a column or page when a table is spilit.

In the Alternating row colors settings area, make selections only if you are not already using the Alternate
Row Colors transformation.

Though the Alternate Row Colors transformation adds color shading to alternating table rows, the
transformation offers no additional control over the alignment of shaded rows when a table splits across a
column or a page.
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Using alternate row color settings in the Header Repeating Pagination Plugin provides a more complex level of
control over the appearance of split tables with multiple repeated headers. The following screenshot shows
neatly aligned row colors in a table split across two columns, accomplished by applying alternate row coloring
using the Header Repeating Pagination Plugin.

Product Name Part No. Price Product Name Part No. Price
Christmas Party Hat 121184-A  57.99 | |Yellow & Green Party Hat | 134416-A  $4.79
Cosmic Party Hat 134413-A  $3.99 Glitter Party Hat 138934-A  $3.99
Pink & Green Party Hat 134420-A 3479 Political Party Hat | 138035-A | §4.79
Pink & Green Pom-Pom Hat | 138925-A $3.99 Birthday Party Hat 134426-A | §3.99
Christmas Party Hat 138926-A  $2.99 | |1st Birthday Party Hat 138936-A | $2.99
Purple & White Party Hat 138027-A  $2.99 2nd Birthday Party Hat 121192-A | $2.99
Glitter Party Hat 121177-A | $3.95 | |3rd Birthday Party Hat | 134417-A $3.99
Purple Foil Party Hat 134414-A  $2.99 Sweet 16 Party Hat 134428-A 0 §2.99
Yellow & Pink Party Hat 134422-A | $2.88 | |Over the Hill Party Hat 138937-A | $2.99
Yellow & Green Party Hat 138928-A  52.09 Fringe Party Hat 138938-A  §3.99
Ice Princess Party Hat 138929-A 52.95 | | Political Party Hat | 138930-A 5209
Fairy Princess Party Hat 138930-A 5299 Purple & White Party Hat 121178-A 0 54.79

« First, check the Enable alternating row colors box to activate the rest of the options in this area.

« Next, check the following boxes as needed to control where alternate row coloring should and/or should not
appear:

« Restart row count at always repeated headers
« Restart row count at repeat last headers
« Ignore always repeated headers
« Ignore repeat last headers
« Ignore footers
« Enter the number of Normal Colored Rows and Alternate Colored Rows in the text boxes

« Selectthe Normal Color and Alternate Color from the dropdown lists. Selections are populated by colors
created in System Setup under Table > Colors

For more information on the Alternate Row Colors transformation, see Table Layout Transformations in the
Tables documentation.

12. Inthe Table Rulers and Width settings area, check the necessary boxes to determine which table rules
must be added to split tables and to fine-tune when tables split based on their width:

« Use table bottom ruler on splits as bottom ruler.
« Use table top ruler on splits as top ruler.

« Use table left ruler on splits as left ruler.

« Use table right ruler on splits as right ruler.

« Enable table split when wider than frame

« Break before table width split
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Exporting and Importing Tables

Table exports and imports cover two sets of definitions: table typesin System Setup, and table definitions that are
created on the Tables tab of product, classification, or product-override objects in the Tree. Table definitions are
further broken down into two areas—Ilocal table definitions, and definitions for resolved tables, i.e., tables that
contain data and can be previewed on the selected product, classification, or product-override object.

The topics in this section explain how to export and import STEP tables in the STEP Workbench. Tables are
exported and imported in the STEPXML format and, depending on what options are chosen in the Export
Manager, information about table types, table definitions, and resolved tables can be included in table exports. To

narrow down the amount of information included in the export file, the Advanced STEPXML format can also be
used.

This documentation section covers the following topics:

Exporting Table Types
Exporting Table Definitions

Exporting Resolved Tables

Importing Tables
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Exporting Table Types

This topic explains how to export table type objects from System Setup.

Table types are exported in the STEPXML format by selecting Include Table Types in the Export Manager when
configuring the export. The resulting file contains the following information, which allows for a complete table types
hierarchy to be built on a target system on import:

« Table colors and table rules

« Table type groups, column type groups, and row type groups
« Table types, row types, and column types

» Default table transformations

« Table pagination plugins

« Table type dimension dependencies

« Heading/footer information and valid publication types for row and column types

System Setup

Eﬂ"By- Reference Types
i Workspaces
=l Table

- & Colors

é;" Rules

Eﬁ Table Types

Eﬂ Table Row Types
Eﬁ Table Column Types
T T REYS

Full details of the contents of the file are explained in the 'Contents of Table Types Export File' subsection below.
For best practices and considerations when importing table types, see the Importing Tables topic.

Exporting the Table Types STEPXML File

The overall steps to export table types in the STEPXML format using the Export Manager are the same as those
used when exporting any other type of data from STEP. The following steps provide a general overview in the
context of configuring a table type—specific export.

1. Toinitiate the export, follow the initial steps outlined in the Creating a Data Export topic in the Export
Manager documentation.

2. Onthe Select Format screen of the Export Manager, select Include Table Types from the outbound
parameters under the 'Configuration' section. Select 'All' if you would like to export all table objects from
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System Setup. If any product and/or classification objects were included in the Select Objects screen, choose
'Minimum' to only include the table type objects that are used on those objects.

Note: Note that Colors and Rules will always be included in the export, regardless of whether All or Minimum
is selected. Since colors / rules may be referenced by transformations, pagination plugins, and so forth, there
is no way to determine which plugins reference which colors / rules.

Select Format

STEPXML w

Exports data in a STEP Product Information XML format. Mote that thi...

Incdude System Settings Mo N
incuce Tabe Types AL
Indude Tags Mo o
Include Transformation Lookup Tables Mone >

W

3. Click Finish to complete the configuration, as all options on the Advanced screen may be ignored.

4. Finish the export as you would any other data export by retrieving the file from the Background Processes tab.

Exporting Table Types Using Advanced STEPXML

Table types may also be exported using the Advanced STEPXML format. Using Advanced STEPXML allows for
the use of an XML file snippet instead of having to make selections from the STEPXML outbound parameter
dropdowns. Advanced STEPXML is also recommended if you want to export only the table type objects
associated with the tables defined on a particular product / classification and exclude the extraneous information
about the product/ classification that would typically be included in a standard STEPXML export, such as attribute
links, product override links, asset references, classification references, product references, and metadata
attribute values.

To export table types in Advanced STEPXML, follow the same steps outlined in the previous section, but choose
Advanced STEPXML on the Select Format screen of the Export Manager instead of STEPXML.

All Table Type Definitions (System Wide)

To export all table types from System Setup (and not just those associated with a selected product or
classification), replace the preexisting information in the Template field with the following code snippet:

<?xml version='1.0"'?>
<STEP-ProductInformation>
<TableColors ExportSize="All"/>
<TableRules ExportSize="All"/>

<TableTypeGrouplist ExportSize="All"/>
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<TableTypeDefinitions ExportSize="All"/>

</STEP-ProductInformation>

Specific Table Type Definitions From Products

To export specific table type objects associated with the locally defined (not inherited) tables on a selected product
only, use a template similar to the following.

<?xml version='1l.0'?>
<STEP-ProductInformation>
<Products ExportSize="Minimum"/>
<TableColors ExportSize="Minimum"/>
<TableRules ExportSize="Minimum"/>
<TableTypeGrouplList ExportSize="Minimum"/>
<TableTypeDefinitions ExportSize="Minimum"/>

</STEP-ProductInformation>

Select Format

Advanced STEFXML s

Exports data in a STEP XML format, Mote that this format ign...

Template | -7xml version='1.0'7=
<STEPProductInformation =

<Products ExportSize="Minimum"/=
<TableColors ExportSize ="Minimum "/ =
«TableRules ExportSize ="Minimum"/=
<TableTypeGroupList ExportSize ="Minimum"/ =
<TableTypeDefinitions ExportSize ="Minimum "/ =
< (STEP-ProductInformation =

Specified Table Type Definitions Only

To export specific table type objects associated with a specific table on a selected product, use a template similar
to the following.

Note: Table types are designated by STEP name, not ID, in the Advanced STEPXML format template.

<?xml version='1l.0'"'?>
<STEP-ProductInformation>
<Products ExportSize="Minimum">
<Product>
<Name/>
<Tables>

<Table IncludeTableTypes="Price Table"/>
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</Tables>

</Product>

</Products>

<TableColors ExportSize="Minimum"/>

<TableRules ExportSize="Minimum"/>

<TableTypeGroupList ExportSize="Minimum"/>

<TableTypeDefinitions ExportSize="Minimum"/>

</STEP-ProductInformation>

Select Format

Advanced STEFXML v

Exports data in a STEP ¥ML format, Maote that this format ignares. ..

Template

Specific Table Type Definitions From Classifications

<?xml version="1.0"7
«STEP-ProductInformation =
<Products ExportSize ="Minimum™ =
<Product
<Mame/=
«Tables>
«<Table IndudeTableTypes="Price Tahlz"/=
«(Tables =
< (Product=
< Products =
<TableColars ExpartSize ="Minimum /=
<TableRules ExportSize ="Minimum®/ =
<TableTypeGroupList ExportSize ="Minimum"/=
«<TableTypeDefinitions ExportSize ="Minimum"/ =
< (STEP-ProductInformation =

StiboSystems

To export specific table type objects associated with the tables defined on a selected classification only, use a
template similar to the following.

<?xml version='1.0'?>

<STEP-ProductInformation>

<Classifications ExportSize="Minimum">

<Classification IncludeParent='false'>

<Name/>

</Classification>

</Classifications>

<TableColors ExportSize="Minimum"/>

<TableRules ExportSize="Minimum"/>

<TableTypeGrouplList ExportSize="Minimum"/>
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<TableTypeDefinitions ExportSize="Minimum"/>

</STEP-ProductInformation>

Select Format

Advanced STEPXML

S

Exports data in a STEP XML format. Mote that this format ignor...

Template

< 7uml version="1.0'7 >
<STEPProductInformation =
< Classifications ExportSize ="Minimum ">

< Classification IndudeParent="false'=

<Mame/=

« [Classification »

= (Classifications =
«TableColors ExportSize="Minimum"} =
<TableRules ExportSize ="Minimum®/=
<TableTypeGroupList ExportSize ="Minimum"/ =
«TableTypeDefinitions ExportSize ="Minimum"/=
< [STEP-ProductInformation |

Contents of the Table Types Export File

The following subsections show samples from a STEPXML Table Types export file, followed by a listing of the
tags and their descriptions.

Colors and Rules

<TakleColors>
<TableColor Mame="Cyan" Color="6750156"/>
<TableColor Mame="Blue" Color="6724095" />
£TableColor Name="Black" Color="0"/>
«TableColor Mame="Red" Color="13369395"/>

</TableColorss

<TakbkleRules>
<TableRule Hame="0.5 pt" Width="1"
<TableRule MNamse="1 pt" Width="1" Color="Black"/ />
<TableRule Name="2 pt" Width="2" Color="Black"/ />

<TableRule

</TableRules:

Description

Color="Black" /=

Hame="Black Dashed 1 pt" Width="1" Color="Black"/>

<TableColors> | Parenttag for <TableColor>
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Description

<TableColor> | Returns the following information:

« Name: The STEP name of the color

« Color: The RGB definition of the color in integer
form

<TableRules> | Parenttag for <TableRule>

<TableRule> Returns the following information:

o« Name: The STEP name of the rule
« Width: The width of the rule, in points

o Color: The STEP name of the color used for the
rule

Group Types

<TableTypeGrouplist>

<RowColumnTableGroup ID="=stibo.2176972">
<Hame>Specifications Tables</Hame>

</RowColumnTableGroup>

<RowColumnTakleGroup ID="=stibo.l1776440">
<Name>Price Tables</HName>

< /RowColumnTableGroup:

< /TableTypeGrouplist>

<ColumnTypeGrouplist>

<RowColumnTakleGroup ID="=tibo.2157533":>
<Hame>Spec Table Columns</Hams>

< /RowColumnTableGroup:

<RowColumnTableGroup ID-"stibo.1776452">
<Hame>Price Table Columns-</Hame:

< /RowColumnTableGroup:

< /ColumnTypeGrouplist:>

<RowTypeGroupList>

<RowColumnTakleGroup ID-"stibo.l1776450">
<Hame>Price Table Rows</Hame:>

< /RowColumnTableGroup:

<RowColumnTableGroup ID-"=stibo.2197597">
<Hame>Spec Table Rows</Hames:>

< fRowColumnTableGroup:>

<fRowTypeGrouplists>
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Description

<TableTypeGroupList> Parent tag for table type groups tag (<RowColumnTableGroup>)

<ColumnTypeGroupList> Parent tag for column type groups tag (<RowColumnTableGroup>)

<RowTypeGroupList> Parent tag for row type groups tag (<RowColumnTableGroup>)

<RowColumnTableGroup> | Tag used to return the STEP ID of the table type group, column type group, or
row type group, depending on which of the above three tags it is nested in

<Name> Nested within <RowColumnTableGroup>; returns the STEP name of the table
type group, column type group, or row type group

Table Types

<TableTypes>
<TableType ID="stibo.1776444" ParentIl="stibo.1776440" TextStyle="Normal L"
BackgroundColor="Light Blue" VerticalAlignment="1" Rulelfbove="1 pt" RuleBelow
="1 pt" BulelLeft="1 pt" RuleRight="1 pt" CellRotation="0"
CellVerticalStoryDirection="fal=se" CellImageScale="20" Width="4.0" WidthUnit=
"onece.anit.INH">
<Hame>Price Table</Hams>
«UgerTypelink UserTypell="ItemFamily" />
<UserTypelink UserTypell="ItemFolder" />
<ColumnType ID="stibo.1776454" ParentID="stibo.1776452" Verticallhlignment=
"1l" HeadingLevel="0">
<RowType ID="s3tibo.1776464" ParentIl="stibo.1776450" VerticaliAlignment="-1"
EuleBelow="0.5 pt" EeepWithNext="false" HeadingLewvel="0">
<Dimensionlink DimensionID="Langnage" />
<TableTransformation ID="AlternateRowColorsTransformation">
<Configuration>
HAsITAAAAAAAAAFINTOrCMBCFS54 1 s ANIvRGQUBREF 0VwPdIpChgzMBnr U1 cFHT 3/ TOTR=spA
mMNEnmfhUXzTTH1IS £S5 JFiWsXvgg+QtpLLE=sY( /FXév/aFBsqNafg HnEI 1l eUMWEmgh 9 r-Cr 3300
w320RuB+Bzl0MozmTvwg 7BpS+WhFSgS8TMI ZYHve fAAFUV+EWQAAAA=—//Configuration>
</TableTransformation>
<TablePaginationPlugin ID="HeaderRepeatingPaginationPlogin"/ >
</ TableTypex>
</Tabletypess>
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Tag Description
<TableTypes> Parent tag for <TableType>
<TableType> Returns the following information:

o ID: The STEP ID of the table type
« ParentID: The ID of the table type group to which the table type belongs

If default settings have been applied to the table type, the following information is
also included, if applicable:

« TextStyle: The default text style
« BackgroundColor: The default background color
« VerticalAlignment: The default vertical alignment of text. Valid values are:
« Notag: Top (default alignment)
« 1:Center
« 2:Bottom
o 3: Justify
« 0:Notdefined
« RuleAbove: The default rule for the top of the table
« RuleBelow: The default rule for the bottom of the table
« RuleLeft: The default rule for the left side of the table
« RuleRight: The default rule for the right side of the table
« CellRotation: The default orientation of cell contents

« CellVerticalStoryDirection: The default direction of cell contents (horizontal or
vertical)

« CelllmageScale: The default size of images linked into the cell
« Width: The width of the table
« WidthUnit: Unit used for the table width. Valid units are:

« in=unece.unit.INH

« mm = unece.unit. MMT

« pica = unece.unit.R1

o pt=unece.unit.N3

« proportional = std.proportional

For more information on table type defaults, see the Configuring Table Type
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Tag Description

Formatting topic.

<Name> STEP name of the table type
<UserTypeLink> Object types for which the table type is resolvable
<ColumnType> Default column type for the table. For more information on column types, see the

'Column Types' subsection below.

<RowType> Default row type for the table. For more information on row types, see the 'Row
Types' subsection below.

<DimensionLink> Returns the DimensionID (dimension dependency) of the table type. Possible
values are 'Language' or 'Country.'

<TableTransformation> Returns the STEP ID of the default table transformation(s) applied to the table

<Configuration> Nested within the <TableTransformation> tag; contains the configuration of the
transformation in an encoded internal format

<TablePaginationPlugin> | Returns the STEP ID of the pagination plugin used for the table, which will always
be HeaderRepeatingPaginationPlugin unless a custom plugin is in use
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Column Types

<ColumnTypes>
<ColunnType ID-"stibo.4645492" ParentIl="stibo.4645484" HeadingLewvel="1">
<Hame>Header Column</Names:>
<TableTypelink TableTvpeIl="stibo.4645484" />
<PublicationTypeValidity IsInNewPublicationTypes="false">
<IncludedPublicationType PublicationTypelID="Defanlt publication
type" /=
<fPublicationTypeValidity>
</ColumnType>
<ColunnType ID-"stibo.4118466" ParentIl="stibo.2197593" Textityle=
"Normal L" BackgroundColor="Yellow" Ruleleft="0.3 pt" RuleRight="0.35 pt"
HeadingLevel="0">
<Hame>Price Column</Nams>
<TableTypelink TableTvpeIl="=tibo.4117215" />
<PublicationTypeValidity IsInNewPublicationTypes="false">
<IncludedPublicationType PublicationTypell="Defaunlt publication
type" /=
</PublicationTypeValidity>
</ ColunnType:
</ ColumnTypess

Description
<ColumnTypes> Parent tag for <ColumnType>
<ColumnType> Returns the following information:

o ID: The STEP ID of the column type
« ParentID: The ID of the column type group to which the column type belongs

« HeadingLevel: The heading level of the column. Possible values are:

e 0:Normal
» 1:Heading
e 2:Subhead

o -1: Footer

Also included are any default settings applied to the column type, if applicable.
The attributes are the same as those used for table types (TextStyle,
Background Color, etc.). For more information on column type defaults, see the
Configuring Column Type Formatting topic.
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Description

<Name> STEP name of the column type

<TableTypeLink> TableTypelD: Returns the STEP ID(s) of the table type(s) for which the column
type is valid

<PublicationTypeValidity> | IsinNewPublicationTypes: Returns a value of 'true' or 'false' depending on
whether the column type will be included in publication types created after the
column type was created

<IncludedPublicationType> | PublicationTypelD: Returns the publication types for which the row type is valid

Row Types

<RowTvypes>
<RowType ID="2tibo.1776464" ParentID="=tibo.1776450" Verticalilignment=
"-1" RuleBelow="0.5 pt" EKeepWithNext="fal=se" HeadingLewvel="0">
<Hame>Normal< /Hame>
<TableTypelink TableTypell="stibo.1776444"/>
<TableTypelink TableTypell="stibo.4645484" />
<PublicationIypeValidity IsInNewPuklicationIypes="false">
<IncludedPublicationType PublicationTypelIl="Defanult publication
type" />
<fPublicationTypevValidity>
< /RowTypes
<RowType ID="stibo.4118474" ParentID="stibo.2197597" TextStyle=
"CompactHeaderRow2" BackgroundColor="Light Blue" Rulelbove="0.5 pt"
EuleBelow="0.5 pt" EHeepWithNext="false" HeadingLewvel="1">
<Hame>Compact Header Row 2</Hame>
<TableTypelink TableTypelD="stibo.4117215"/>
<PublicationTypeValidity IszInNewPublicationTypes="false">
<IncludedPublicationType PublicationTypelIl="Defaunlt publication
type"/>
<fPublicationTypeValidity>
</RowType>
</RowTypess
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Tag Description
<RowTypes> Parent tag of <RowType>
<RowType> Returns the following information:

o ID: The STEP ID of the row type
« ParentID: The ID of the row type group to which the row type belongs

« HeadlingLevel: The heading level of the row. Possible values are the same
as those listed above for column type.

» KeepWithNext: Whether the row should always remain with the next row on
a mounted InDesign page. Value is either 'true' or 'false.’

Also included are any default settings applied to the row type, if applicable. The
attributes are the same as those used for table types (TextStyle, Background
Color, etc.). For more information on row type defaults, see the Configuring
Row Type Formatting topic.

<Name> STEP name of the row type
<TableTypeLink> TableTypelD: Returns the STEP ID(s) of the table type(s) for which the row type
is valid

<PublicationTypeValidity> | IsinNewPublicationTypes: Returns a value of 'true' or 'false' depending on
whether the row type will be included in publication types created after the row
type was created

<IncludedPublicationType> | PublicationTypelD: Returns the publication types for which the row type is valid
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Exporting Table Definitions

This topic explains how to export local and inherited table definitions from tables defined on product, classification,
or product-override objects in the Tree.

Table definitions are exported in the STEPXML format by selecting Include Table Definitions in the Export
Manager when configuring the export. The resulting file contains all of the required information to transfer table
definitions from one STEP instance to another. Additionally, this option allows for table definitions to be exported
from a product or classification object on which a table has been defined but is not necessarily resolved. This is
useful because table definitions are often built at a higher level of a hierarchy for inheritance purposes and
resolved on lower levels.

Exporting the Table Definitions STEPXML File

The overall steps to export table definitions in the STEPXML format using the Export Manager are the same as
those used when exporting any other type of data from STEP. The following steps provide a general overview in
the context of configuring a table-type—specific export.

1. Toinitiate the export, follow the initial steps outlined in the Creating a Data Export topic in the Export
Manager documentation.

2. Onthe Select Objects screen, add the product and/or classification object(s) from which you would like to
export the table definitions. The steps are outlined in the Export Manager - Select Objects topicin the
Export Manager documentation. You can also initiate the export by right-clicking on the relevant product or
classification object and selecting 'Export Data Below.'

3. Onthe Select Format screen of the Export Manager, select Include Table Definitions from the outbound
parameters under the 'Data Objects' section, then choose 'Yes.'

Select Format

STEPXML e

Exparts data in a STEP Product Information XML format. Mote that thi...

Incude Tables Mo e
Incude Table Defiitions Ve T
Indude Assets Mone o
Indude Asset Content Mone ~

To include inherited table definitions, also choose 'Yes' for Include Inherited Data.
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Select Format

STEPXML w

Exports data in a STEP Product Information XML format. Mote that thi...

Indude Schema Reference Mo e

E

Data Objects

Indude Inherited Data

Flatten Hierarchies Mo

To export table definitions from products where the table definition is inherited from the classification structure,
then Include Classifications should also be selected (in addition to Include Products) and set to 'Minimum.'

Select Format

STEPXML e

Exports data in a STEP Product Information XML format. Mote that thi...

Indude Inherited Data Yes [
Flatten Hierarchies Mo w
Include Keys as IDs Mo v
Indude Entities Minimum o
Indude Entity Attribute Values Yes e
Indude Data Containers Mo e
Indude Products Fiima |~ v
Indude Product Attribute Values Yes o
Incude Owverridden Products Mo w
Indude Classifications Minirnum v

Note: If there are two (or more) classifications with different table definitions, but the same product is linked
into both classifications, the table definition exported with the product is chosen at random. When this file is
imported into the target system, the table definition will be local on the product. |.e., all objects that have a table
definition in the STEPXML file will become a local table on the import system.

4. Click Finish to complete the configuration, as all options on the Advanced screen may be ignored.

5. Finish the export as you would any other data export by retrieving the file from the Background Processes tab.
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Exporting Table Definitions Using Advanced STEPXML

Table definitions may also be exported using the Advanced STEPXML format. Using Advanced STEPXML
ensures that the file does not contain extra information that is unrelated to the table definition. Advanced
STEPXML also allows for specific table types to be exported, whereas alllocally defined tables on a product or
classification are exported when using standard STEPXML.

With standard STEPXML, even when all outbound parameters are set to 'No' or 'None' on the Select Format
screen in the Export Manager, the export still contains information about the product and/or classification such as
attribute links, product override links, asset references, classification references, product references, and
metadata attribute values. If this information is not removed from the XML file before it is used to import table
definitions onto another system, unwanted changes could occur on the target system. For example, a product
could be inadvertently linked to a classification, or a metadata attribute value could be changed. Using an
Advanced STEPXML template when configuring the export ensures that this extra information does not appear in
the file to start with.

To export table definitions in Advanced STEPXML, follow the same steps outlined in the previous section, but
choose Advanced STEPXML on the Select Format screen of the Export Manager instead of STEPXML.

Tables on Products

Locally Defined Table Definitions
In the Template field, replace the preexisting information with a code snippet similar to the following.

<?xml version='1.0'?>
<STEP-ProductInformation>
<Products ExportSize="Minimum">

<Product>

<Name/>

</Product>

</Products>
<TableDefinitions/>

</STEP-ProductInformation>
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Advanced STEFXML e

Exports data in a STEF XML format, Maote that this...

Template | <7xml version='1.0'7>
<STEP-ProductInformation =
<Products ExportSize ="Minimum"™ =

<Product

<Mame/ =

< Product=>
< Products =
<TableDefinitions/ =
< {STEP-ProductInformation =

Local and Inherited Table Definitions
To include inherited table definitions, use a snippet similar to the following.

<STEP-ProductInformation>
<Products ExportSize="Minimum">
<Product>
<Name/>
</Product>
</Products>
<TableDefinitions IncludelInherited="true"/>

</STEP-ProductInformation>

Select Format

Advanced STEFXML e

Exports data in a STEP XML format, Mote that this formati. ..

Template | <7wml version='1.0'7
<STEPProductInformation =
<Products ExportSize ="Minimum™ =

<Product:=

<Mame/=

< Product=
< Products =
<TableDefinitions Indudelnherited="true"/>
< [STEP-ProductInformation |
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Definitions From Specified Table Types Only
To export definitions from a specified table type only, replace the preexisting information with a code snippet
similar to the following.

Note: Table types are designated by STEP name, not ID, in the Advanced STEPXML format template.

<?xml version='1l.0'?>
<STEP-ProductInformation>
<Products ExportSize="Minimum">
<Product>
<Name/>
<Tables>
<Table IncludeTableTypes="Price Table"/>
</Tables>
</Product>
</Products>
<TableDefinitions/>

</STEP-ProductInformation>

Select Format

Advanced STEFXML e

Exports data in a STEP XML format. Note that this format ignores t...

Template | <7xml version='1.0'7>
«<STEPProductInformation =
<Products ExportSize="Minimum"=
<Product>
<Mame/ =
«<Tables=
«Table IndudeTableTypes="Price Table"/>
< (Tables=
< Product=
< Products =
«TableDefinitions =
< (STEP-ProductInformation =

Tables on Classifications

Locally Defined Table Definitions
In the Template field, replace the preexisting information with a code snippet similar to the following.

<?xml version='1.0'?>

<STEP-ProductInformation>
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<Classifications ExportSize="Minimum">

<Classification IncludeParent='false'>
<Name/>

</Classification>

</Classifications>

<TableDefinitions/>

</STEP-ProductInformation>

Select Format

Advanced STEFXML e

Exports data in a STEP ¥ML format. Mote that this format...

Template | <7xml version='1.0'7>

«STEP-ProductInformation =

< Classifications ExportSize ="Minimum">
«Classification IndudeParent="falze'>
<Mame/ =

< Classification =

< [Classifications =

<TableDefinitions/ =

< (STEP-ProductInformation =

Local and Inherited Table Definitions
To include inherited table definitions, use a snippet similar to the following.

<?xml version='1.0"'?>
<STEP-ProductInformation>
<Classifications ExportSize="Minimum">
<Classification IncludeParent='false'>
<Name/>
</Classification>
</Classifications>
<TableDefinitions IncludelInherited="true"/>

</STEP-ProductInformation>
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Select Format

Advanced STEPXML
Exports data in a STEP XML format, Mote that this formatig...

S

Template | <7xml version='1.0'7=
<STEP-ProductInformation =
< Classifications ExpartSize ="Minimum ™

< Classification IndudeParent="false'=
<Mame/ =
< Classification =

< (Classifications =
<TableDefinitions Indudelnherited="true"/=

< (STEP-ProductInformation =

Definitions From Specified Table Types Only
To export definitions from a specified table type only, use a template similar to the following.

Note: Table types are designated by STEP name, not ID, in the Advanced STEPXML format template.

<?xml version='1.0'?>
<STEP-ProductInformation>
<Classifications ExportSize="Minimum">

<Classification IncludeParent='false'>

<Name/>

<Tables>
<Table IncludeTableTypes="Price Table"/>

</Tables>

</Classification>
</Classifications>
<TableDefinitions/>

</STEP-ProductInformation>

352
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Select Format

Advanced STEFXML e

Exports data in a STEF XML format, Mote that this format ignar...

Template | <7wml version='1.0'2>
<STEP-ProductInformation =
«Classifications ExportSize ="Minimum "=
«(Classification IndudeParent="false'=
<Mame/ =
<Tables>
«Table IndudeTableTypes="Frice Table™/=
< (Tables:
« [Classification =
< (Classifications =
<TableDefinitions/ =
< (STEPProductinformation =

Contents of the Table Definitions Export File

The configuration of table definitions and table free text is an internal format, which prevents users from making
modifications to the definitions before importing the file into STEP. Thus, the file serves solely as a way to transfer
table definitions from one system to another.

<Product ID="121185%" Userlypell="ItemFolder">
<Hame>Pet Hats</HName>
<Tables>
<TableDefinition>
£TableXML ID="stibo.1776444":
<Configuration>
HAsITAAAAAAAAALIWI1PiIMBE+96,/I9F2gFaQeY53ihhweMoOgBpd50aBfIXNZp001TF
vISNWDoryEnE3QNTArPZ /Xbz7SaiMz rn0JHBLVS LCgqm+AXUzRET2r1CJjeNZ9BTDD
TTDnWl6zeeG4tnvea ImudXVCyGWe £ SgWsp 6 EXemTUIDsM1 tHY LbFm=s1 1 zXHdVw0s
aZFTFugV+q/EJBHgOYORTNeG4 4 FFJgmHCVOuNMY i kUSDoNe21orNEw1T40BrgUih
Mf4LwUHnE6épns jbh3lMaFunBgi Zocl TWOLUGEZy D/ FrhzFdgGwiWzBiUoNyFmEoEqQ
SYppHEFVHh541MnObdLgZ r801wBhSK4dEEoy 2Kl /ROZgjavB2vT14BivwR1UgEAAA=
</Configuration>
</TableXML>
<TakleFreeTextXML ID="stibo.1776444">
<Configuration>
He4sTAAAAAAAAAIMTISaloEVEwWYY /ETSwISyDgeszPs10y1DNUsuNSULABY Sp4ngBF
TEwsDoclONzC3MzAw=slewCEotEFPzy SWz 00 SpwE JUEGUOZmS ieqpACTwmhi +24ADXE
tGZeAAAA< /Configuration>
</TableFreceText¥MHML>
</TableDefinition>

The following table lists the tags contained within the export file and their descriptions. Since the majority of the
information within the file is encoded, few tags appear.
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Tag Description

<Product> Parent tag that contains information about the product object. Tables information is nested
within the <Product> tag. If table definitions have been pulled from a classification object,
the <Classification> tag will appear instead.

<Name> STEP name of the product or classification object

<Tables> Parent tag for <TableDefinition>

<TableDefinition> | Parent tag for <TableXML>

<TableXML> Returns the ID of the table type(s) defined on the product or classification object

<Configuration> Contains all information about the table definitions within an encoded string

<TableFree Returns the ID of the table type(s) defined on the product or classification object
TextXML>

<Configuration> Contains all information about the table free text within an encoded string
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Exporting Resolved Tables

This topic explains how to export resolved tables that are defined on product, classification, or product-override
objects in the Tree. Resolved tables are exported in the STEPXML format by selecting Include Tables in the
Export Manager when configuring the export.

Note: Files containing resolved tables cannot be imported into STEP. They can be used for downstream
purposes, such as translation of free text contained within table cells, but serve no purpose for STEP imports.
Importing a file containing table definitions (obtained by selecting Include Table Definitions in the Export
Manager) will dynamically create resolved tables in the target system.

Exporting the Resolved Tables STEPXML File

The overall steps to export resolved tables in the STEPXML format using the Export Manager are the same as
those used when exporting any other type of data from STEP. The following steps provide a general overview in
the context of configuring a table-type—specific export.

Important: If your table contains dimension-dependent content, such as attribute values or free text, make sure
that you have the correct context selected in STEP before initiating the export.

1. Toinitiate the export, follow the initial steps outlined in the Creating a Data Export topic in the Export
Manager documentation.

2. Onthe Select Objects screen, add the product and/or classification object(s) from which you would like to
export the resolved tables. The steps are outlined in the Export Manager - Select Objects topic in the
Export Manager documentation. You can also initiate the export by right-clicking on the desired product or
classification object and selecting 'Export Data Below.'

3. Onthe Select Format screen of the Export Manager, select Include Tables from the outbound parameters
under the 'Data Objects' section. Choose 'Yes,' then click Next.

Select Format

STEPXML w

Exports data in a STEP Product Information XML format. Mote that thi...

Indude Classifications Maone .~
Include Tables NES.ooh ™
Indude Table Definitions Yes V
Indude Assets Mane |
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If your table contains content relevant to a particular publication (such as column or row types that are only valid
for certain publication types) or a publication version (such as commercial data), you will need to select a
publication version on the Advanced screen. The following screenshot shows a sample resolved table where
this feature might be used, which contains a column with country-specific commercial data (prices in Euros, for
France).

Definition |

Select version | Acme Party Supplie*Frenu:h FR. - Select Preview |

Nom du Produit [Numéro L'Image Le Prix
d'article

Assortiment de 121190-A is €249

chapeaux de féte L

chien

Chapeau féte 121218-A £€19,99

chouette roze & é

bleu

Rose et Chapeau |121183-A A €399

de Féte Girafe ;n‘r

Bleue =

Click on the ellipsis button (...) next to the Select version used to resolve tables field, then browse to or
search for the relevant publication version in the 'Select Publication Version' dialog. Click Select to choose the
version and close the dialog.

Advanced 3} Select Publication Version.
GV | Search
[] Tag conversion Coupaon -
- A
[] Locale conversion from context E@ Publications
Resolve Inline References @ Templates
[+ [l Standard Publications
(") Export Only Local Inline References @ AutoPage Publications
{®) Export Inherited Inline References (+-[@l Flatplanner Publications
-1l Spring Wedding Catalo
Indude Calculated Attribute Values = P o —ond 9
- English US
C EC
Workspace |Main v / B FRCA w
.y
- Details
Select version used to resolve tables E;}
Select None Select Cancel

For more information on publication versions, see the Publication Versions topic in the Publication
Maintenance documentation.

Click Finish to complete the configuration.

Finish the export as you would any other data export by retrieving the file from the Background Processes tab.
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Exporting Resolved Tables Using Advanced STEPXML

Resolved tables may also be exported using the Advanced STEPXML format. Using Advanced STEPXML
allows for specific table types to be exported, whereas all resolved tables on a product or classification are
exported when using standard STEPXML.

Additionally, standard STEPXML exports may contain information about the product and/or classification such as
attribute links, product override links, asset references, classification references, product references, and
metadata attribute values, which may need to be removed before the file can be used for downstream purposes.
Using an Advanced STEPXML template when configuring the export ensures that this extra information does not
appear in the file to start with.

To export table definitions in Advanced STEPXML, follow the same steps outlined in the previous section, but
choose Advanced STEPXML on the Select Format screen of the Export Manager instead of STEPXML.

Resolved Tables on Products

All Resolved Tables

In the Template field, replace the preexisting information with a code snippet similar to the following.

Note: All resolved tables will be exported, whether they are defined locally or inherited from a higher node.

<?xml version='1.0'?>
<STEP-ProductInformation>
<Products ExportSize="Minimum">
<Product>
<Name/>
<Tables Format="Resolved"/>
</Product>
</Products>

</STEP-ProductInformation>
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Select Format

Advanced STEFXML e

Exports data in a STEP XML format, Mote that this form...

Template | <7wml version='1.0'7>
<STEPProductInformation =
<Products ExportSize ="Minimum™ =
<Product:=
<MName/ =
«Tahles Format="Resolved"/=
< Product =
< Products =
< [STEP-ProductInformation |

Resolved Tables of Specified Table Types Only

To export resolved tables from a specified table type only, replace the preexisting information with a code
snippet similar to the following.

Note: Table types are designated by STEP name, not ID, in the Advanced STEPXML format template.

<?xml version='1l .0'?>
<STEP-ProductInformation>
<Products ExportSize="Minimum">
<Product>
<Name/>
<Tables Format="Resolved">
<Table IncludeTableTypes="Price Table"/>
</Tables>
</Product>
</Products>

</STEP-ProductInformation>
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Advanced STEFXML

Exports data in a STEF XML format, Mote that this format ignores ...

Template

<?uml version='1.0'7 >
<STEP-ProductInformation =
«<Products ExportSize ="Minimum "
<Product:
<Mame/=
«Tables Format="Resolved™>
<Table IndudeTableTypes="Frice Table"/=
«(Tables=
< Product=
< Products =
< (STEPProductinformation =

Resolved Tables on Classifications

All Resolved Tables
In the Template field, replace the preexisting information with a code snippet similar to the following.

StiboSystems

Note: All resolved tables will be exported, whether they are defined locally or inherited from a higher node.

<?xml version='1.0'?>

<STEP-ProductInformation>

<Classifications ExportSize="Minimum">

<Classification IncludeParent='false'>

<Name/>

<Tables Format="Resolved"/>

</Classification>

</Classifications>

</STEP-ProductInformation>
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Advanced STEFXML e

Exports data in a STEP XML format, Mote that this format ignar. ..

Template | <7xml version='1.0'7>
<STEP-ProductInformation =

< Classifications ExportSize ="Minimum "
+Classification IndudeParent="false'=
<Mame/ >

<Tables Format="Resolved"/=

« (Classification =

< [Classifications =

< {STEP-ProductInformation =

Resolved Tables of Specified Table Types Only

StiboSystems

To export resolved tables of a specified table type only, replace the preexisting information with a code snippet

similar to the following.

Note: Table types are designated by STEP name, not ID, in the Advanced STEPXML format template.

<?xml version='1l.0"'?>
<STEP-ProductInformation>
<Classifications ExportSize="Minimum">
<Classification IncludeParent='false'>
<Name/>

<Tables Format="Resolved">

<Table IncludeTableTypes="Price Table"/>

</Tables>
</Classification>
</Classifications>

</STEP-ProductInformation>
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Advanced STEFXML

e

Exports data in a STEF XML format, Mote that this format igno...

Template | <7wml version='1.0'7
<STEP-Productinformation =
«Classifications ExportSize ="Minimum "=
= Classification IncdudeParent="false'=
<Mame/=
<Tables Format="Resolved” =
«Table IndudeTableTypes="Frice Table™/=
< Tables>
< [Classification =
« [Classifications =
< (STEPProductinformation =

Contents of the Tables Export File

StiboSystems

The first screenshot below shows a simple resolved table (Price Table) on a product object (Pet Hats) in the Tree.
The second screenshot shows a partially unfolded example of the STEPXML export file of the table, showing four
columns and four rows.

Tree <

Pet Hats rev.0.14 - Tables

E|j Products " Commercial Category Profile || Proof View | Status || Stat
r—=| Apparel Product Product Variants ” Sub Producks ” References H_F
{17 Electronics & Tabi
r—=| ;u;etwear Mame » |Defined At

a
[ safety > Price Table Local
» Bales Price Table Party Supplies
i__=| Furniture > Spedfication Table Local

r_=| Automative
(-1 Building Products
r_=| Electrical and Electronics

> | Add Table Type

pefinition |l

Select version | Acme Party Supplies/English Us

r_=| Food and Beverage

« Select Preview MNod

-7 Kitchen
. 0 ' Product Name
=-{7] Party Supplies
5[ Party Hats Dog Party Hats  [121190-A i 519.99
E‘F_=| Paper Hats Aszzortment -H"“
: Pe Pink & Blue 121183-A A 2249
[+l Balloon Hats . &
: Giraffe Party Hat )4
- Children's Hats st
-] PetHats Pink & Blue Owl |21218-A 5479
G+ [[T] Masks Party Hat é
[T Streamers
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<Product ID="12118%" UserTypell="ItemFolder" ParentID="12116%">

<HName>Pet Hats<,/Hame>

<Takles>

<Takble TableTypell="stibo.l1776444":>

Lo lumn ColumnTypelIl="gtibo.1776454" Euleleft="0.5 pt"
BuleRigHt="1 pt">
<Column ColumnTypelIl="=stibo.1776454" RuleRight="1 pt">
<Column [ColumnTypelIl="=stibo.1776454" RuleRight="1 pt"
CellImageScale="25"/>
<Column ColumnTyvpeID="stibo.1776456" RuleRight="0.5 pt"/>
{RDW|RDwTypEID=“stibn.1??6462“ Height="0.3 onece.unit.INH"
EuleHelow="2 pt" TextStyle="bold" BackgroundColor="White">
<Row JRowIypelIl="stibo.1776464" TextStyle="Normal L"
Back1:nund:ulnr=“Light Blue">
<Row [RowTvpelIlD="stibo.1776464" TextStyle="Normal L"
Backi:uundCDlD:=“WhitE“>
<Row JRowTypelIl="stibo.1776464" TextStyle="Normal L"
BackgroundColor="Light Blues">
</Taklex>

The following subsections provide more details about the file pulled from the example table, along with a listing of
the STEPXML tags and their descriptions. All possible XML tags are not covered; for a full list of available tags,
see the XSD file available in the STEP API Documentation, which is accessed from the STEP WebStart page.

Product and Table Information

<Product ID="121189%" UserTypell="ItemFolder" ParentIl="12116%":>
<Hame>Pet Hats</Name:>
<Tablesx>
«Takle Tablelypell="stibo.1776444">

Description

<Product> | Parent tag that contains information about the product object. Tables information is nested within
the <Product> tag. If table definitions have been pulled from a classification object, the
<Classification> tag will appear instead.

<Name> STEP name of the product or classification object

<Tables> | Parenttag of <Table>

<Table> Returns the STEP ID of the table type (TableTypelD)
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Column Information

<Column ColumnTypelIlD="stibo.1776454" Ruleleft="0.5 pt" BuleRight="1 pt">
<0rigin AttributeID="ProductName" PFull="ValuelUnit"/ >

</Column:

<Column ColumnTypelIl="stibo.1776454" RuleRight="1 pt">
<Origin Pull="ID"/>

</Column>

<Column ColumnTypelIl="stibo.1776454" EuleRight="1 pt" CellImageScale="25"/>

<Column ColumnTypelD="stibo.1776456" EuleRight="0.5 pt"/>

Tag Description

<Column> | Returnsthe STEP ID of the column type (ColumnTypelD) and any settings applied to the column,
if applicable

The attributes for settings are the same as those used for column types (TextStyle, Background
Color, etc.). See the 'Contents of the Table Types Export File' subsection of the Exporting Table
Types topic for more information.

<Origin> Returns the following information:

« AttributelD: The STEP ID of the attribute, if the column / row definition is configured to pull
information from an attribute

o Pull: If 'Attribute’ is chosen for the column's content definition, the 'Pull’ attribute returns the
aspect. Possible values include Name, ID, and ValueUnit. See the Content Definitions topic
for more information.

3% Row/Column Type & Content Definition
Column/Row Content definiion | Attribute e
(") Name
O} i»

() Attribute | Walue & Unit
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Row and Cell Information

<Row Rowlypell="stibo.1776464" TextStyle="Normal L" BackgroundColor=
"Light Blue":
<ProductOrigin ID="12115%0"/>
<Cell Column="0" attributell="ProdunctName" TezxtStyle="Normal L"
BackgroundColor="Light Blue" ERulelfbove="2 pt" RuleBelow="0.5 pt"
EulelLeft="1 pt" EREuleRight="1 pt" VerticaldAligmment="1" CellRotation=
"o CellVerticalStoryDirection="false" CellImageScale="20">
«Text>Dog Party Hats Assortment</Text:
</Cell>
<Cell Column="1" Text3tyle="Normal C" BackgroundColor="Light Blue"
Eulefbove="2 pt" RuleBelow="0.5 pt" ERuleleft="1 pt" RuleRight="1 pt"
VerticalAlignment="1" CellRBotation="0" CellVerticalStoryDirection=
"false" CellImageScale="20">
<Text>121190-A</Text>
<fCell>
<Cell Column="2" Terxtityle="Normal C" BackgroundColor="Light Blue"
Rulelfbove="2 pt" EuleBelow="0.5 pt" Ruleleft="1 pt" RuleRight="1 pt"
VerticalAlignment="1" CellRotation="0" CellVerticalStoryDirection=
"false" CelllmageScale="25">
<Text>
<Image AssetID="121200"/=>
<fText>
<fCell>
<Cell Column="3" Textityle="Normal C" BackgroundColor="Light Blue"
Rulelfbove="2 pt" EuleBelow="0.5 pt" Ruleleft="1 pt" RuleRight="1 pt"
VerticalAlignment="2" CellRotation="0" CellVerticalStoryDirection=
"false" CelllmageScale="20">
<Text>519.99<,/Textc>
<fCell>
< /RowW>

Description

<Row> Returns the STEP ID of the row type (RowTypelD) and any settings applied to the row, if
applicable

The attributes for settings are the same as those used for row types (TextStyle,
Background Color, etc.). See the 'Contents of the Table Types Export File' subsection of
the Exporting Table Types topic for more information.

<ProductOrigin> | ID: The STEP ID of the product from which values are pulled in the table row

<Cell> Returns the following information:
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Tag Description

o Column: The number of the column in which the cell appears (0, 1, 2, 3, etc.)

« attributelD: The attribute from which the information in the cell is pulled

Also included are any settings applied to the cell, if applicable. The attributes for settings are
the same as those used for row, column, and table types (TextStyle, Background Color,
etc.). See the 'Contents of the Table Types Export File' subsection of the Exporting Table
Types topic for more information.

<Text> Returns the text content of the cell

<Image> If an image appears in the cell instead of text, the <Image> tag is nested in the <Text> tag
and the STEP ID of the asset is returned (AssetID).

© Stibo Systems - Confidential - STEP Trailblazer 8.3 365



StiboSystems

Importing Tables

Table type structures and table definitions can be created in STEP through STEPXML imports. However, table
import files are primarily intended to transfer tables from one STEP instance into another, not to build table objects
and tables anew. The recommended steps for using STEPXML files to import tables are as follows:

1. Manually create and configure table type objects and table definitions on a STEP test environment

2. Export these table types and table definitions in STEPXML. It is recommended to export the table types and
table definitions in separate files.

3. Import the table types file into the STEP production environment

4. Import the table definitions file into the STEP production environment

The export and import process itself is straightforward, but multiple considerations must be taken into account to
ensure that the import is successful. For example, since tables are defined on product/ classification hierarchies,
the same product/ classification object types and hierarchies that are present on the source system must also be
present on the target system. This also applies to attributes, assets, transformations, commercial terms,
publication versions, contexts, and so forth. As such, this topic does not address the actual import process, but
provides information on the prerequisites for a successful import and how to troubleshoot any errors that may
occur with an import.

Importing the Files

Two types of files containing tables information can be imported into STEP: those containing System Setup table
types, which are exported by selecting Include Table Types in the Export Manager; and those containing table
definitions from product and classification objects in the Tree, which are exported by selecting Include Table
Definitions in the Export Manager.

Files that contain tables information are imported into STEP like any other STEPXML file, either through the
Import Manager or through an Inbound Integration Endpoint. For more information, see the Import Manager and
Inbound Integration Endpoints sections of the Data Exchange documentation.

Note: Files containing resolved tables, which are exported by selecting Include Tables in the Export Manager,
cannot be imported into STEP. They can be used for downstream purposes, such as translation of free text
contained within table cells, but serve no purpose for a STEP import, as importing table definitions dynamically
creates resolved tables.

Considerations and Limitations for Tables Imports

General

Both the target and source systems must be on the same version of STEP, and both systems must be on version
STEP Trailblazer 8.3 or above.
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Duplicate Data Setups

The setup data should be identical across test, QA, and production STEP systems when tables are being exported
from one system and imported onto another. Considerations for mismatched setups are as follows:

« Object types (product and/or classification): Table object types must be resolvable on at least one product
or classification object type. If these object types are missing in the target system, the table object types can still
be created, but they will not be resolvable on any product / classification objects until those objects are created
in the target system.

« Product and/or classification object hierarchy: It is recommended to use a dedicated 'test' node (or
nodes) to define tables on the source system, then use an identical node on the target system, which uses the
same STEP IDs, to import the definitions into. Once the definitions are applied to the dedicated node on the
target system, the definitions can be copied from this node and pasted onto the table definition on another node
in the same target system.

Tables [ Cateqgory Profile ” Proof View " Status
Produck Sub Products ” References l

' Tables

* Defined At
| Price Tableh o —
Copy

» Gales Price Tabl

Paste
> Spedfication Tz Cop

* | Add Table Typ Create Table

[_P Create Empty Table

Tables [ Category Profile ” Proaf View " Status
Product Sub Products ” References ]

¥ Tables

» |Defined At

9 Local
* Sales Price Table Copy

» Gpedfication Table Paste

* |Add Table T
v YPE Create Tah

[ Definition_|IFR="

Price Table

« Assets: Must have the same IDs and be linked to product objects using the same asset reference types on both
source and target system.

« Contexts / dimensions: Since table types can be dimension dependent, for the purpose of free text, if a
context does not exist on the target system, an error occurs on import. Table definitions themselves are context
independent, so this is not a concern for definitions only, but if a context is present in the import file that does not
exist in the target system, an error will still be thrown on import.
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« Table types, row types, and column types should have the same ID on the source and target systems. If
these types already exist on the target system, care must be taken before importing to ensure that the settings
for these table type objects are the same in the import file, as the settings on the target system will be overridden
and could potentially cause existing table layouts to be destroyed.

« Attributes, attribute transformations, and lookup tables must exist on both systems and have the same
IDs.

» Table Transformations: The same table transformations should be present on both systems. A custom
transformation on a source system cannot be created on a target system through import. If the transformation
does not exist on the target system, an error will be raised in the background process execution report.

Table Type Imports

« lItis not recommend to change column and row type IDs manually in the exported XML file since there are
numerous places within the file where the ID must be changed.

« Atable types import file should not be edited to create new colors. However, if a color already exists in the
target system with the same name, the number associated with the color (the RGB definition of the color in
integer form) will overwrite the color's RGB definition on the target system.

<TableColors>
<TableColor Hame="Cyan"] Color="&675015&"
<TableColor Hame="Blue" Loioro DleOuaoT, >
<TableColor Mame="Black" Color="0"/>
<TableColor Name="Red" Color="13369395"/>
<fTableColors>

« Sincerules do not use IDs, if there is a difference in width or color for a table rule with the same name on the
source and target system, the incoming rule definitions will overwrite those on the target system.

Table Definitions Imports

Table definitions files cannot be edited by users, since all table configurations in a tables definitions file are
contained in encoded strings.

Error Handling

Even if some objects, attributes, transformations, and so forth are missing on a target system, an import of table
types and/or table definitions can be successful, but with errors. Some errors will display in the Execution Report
of the completed background process on the BGProcesses tab. In other instances, a table definition can import
with no errors appearing in the BGP execution report, but the errors will be visible when viewing the table definition
and/or preview on the product or classification object in the Tree.

This section shows a few common examples of errors that can occur with the import of table types and table
definitions and how to troubleshoot them, but it is not a comprehensive list of every potential error. It is
recommended to always run an import of table types and table definitions in test mode first to catch errors in the
BGP Execution Report.
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Errors Displayed in Background Processes

The following screenshot shows an example of errors thrown in a table types import that had table types that were
resolvable (valid) on object types that are not present in the target system. The table types were created in the
target system, but the errors inform users that these object types must be created in the target system before the
configurations of the table types will match that of the source system.

Importing - Background Process

Background Process |EsTENCRG)

EF Properties
' Execution Report

Retrieval started (Tue Oct 17 23:03:35 CEST 2017)

Retrieved 28656 bytes (Tue Oct 17 23:03:35 CEST 2017)

Conversion started (Tue Oct 17 23:03:35 CEST 2017)

Converted 0 objects (Tue Oct 17 23:03:35 CEST 2017)

Logged an

Mapping started (Tue Cct 17 23:03:35 CEST 2017)

Mapping completed (Tue Oct 17 23:03:35 CEST 2017)

Test Imporn Started

Logged On

Using import mode "domain®

Starting first import pass (creating system setup objects)

Starting second import pass (importing data)
! Line 93, TableType 1: Table type 'stibo 4120633" has a user type link to unknown object type with 1D “ltemFolder’.
I Line 93, TableType 1: Table type 'stibo 4120633" has a user type link to unknown object type with 1D “temFamily’.
12 Line 113, TableType 2: Table type ‘stibo.1776444" has a usertype link to unknown object type with ID "SuppliersAf
I Line 113, TableType 2: Table type 'stibo 1776444 has a usertype link to unknown object type with |D "233624".
I Line 113, TableType 2: Table type 'stibo 1776444 has a user type link to unknown object type with ID "SalesltemA
| = Line 113, TableType 2: Table type 'stibo. 1776444' has a user fype link to unknown object fype with 1D ‘ltemFolder]

.y

Errors Displayed in Table Definitions and Previews

This example shows the display of an imported definition where a column type is not valid for the table type. the
column type has been applied, butitis in red since it is not valid for this table type. Either the column type must be
made valid for the table type, or another column type must be used.

Spedfication Table 1 s |2 s (3 3
Spec Column Specculumn w Bpec Column
o 13 _ Price
1 » Mormal Row abe Free Text Heading text | JI'T'E‘QE
2 » Mormal Row abe Free Text Subheading text
3 * Mormal Row 1@ Local
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The following screenshots show another set of errors, using before and after examples. The import was
successful overall, but a few items were missing on the target system that required troubleshooting to correct.

Source Definition:

Price Table 1 j’j ji » |4 j
Mormal ormal ormal rice

[T Productvame || Prirmary Pruduct...b Price

Header (1T mame Product Mame Part No. mage etail Price
Mormal [Cg Local

Target Definition:

[y
W

[
W

In the target system, the table definition has been mostly recreated by the import of the definitions, but an attribute
that was present in the source system (Product Name) is missing in the target system.

Price Table 1 ii ji » |4 j
Normal ormal ormal rice

ﬂi Iﬂi ID Primary Product Image E Price

Header (1T Mame Part Ma. mage etail Price
Mormal [Cg Local

Source Preview:

[y
W

]
W

| pefinition |
Select version | Acme Party Supplies/English LS «w Select Preview Mode | Curre

Product Name |Part No. Image Retail Price

Dog Party Hats ~ [121180-4A - 510,60

Assortment ‘ﬂ‘"&"‘

Pink & Blue 121183-A ‘&J‘ 52,40

(Giraffe Party Hat b,

w©
Pink & Blue 0wl [121218-A $4.79
Party Hat é
> » [Transformation > |Parameters >

» [EH Alternate Row Colors Color 1rows "White™ then 17...
> [FH Remowve Empty Rows/Columns Remove Rows Remove Colu...

ﬂ Add Transformation
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Target Preview:

When viewing the table preview in the target system, additional errors are noticeable. The numbers in the
screenshot correspond with the errors listed in the numbered list below the image.

| pefinition |

Select version or market | Acme ToolsfAcme S «- Select Preview Mode | Current Mod

mage N e) |
I
‘lglht_
3
X
w
* | * [Transformation * [Parameters >
» [EH Alternate Row Colors Color 1rows "White™ then 17...

> [Fd Remowve Empty Rows/Columns o Femowve Rows Remove Colu...
# | Add Transformation

1. Thefirst column of the table is missing because of the missing 'Product Name' attribute. Since the column is
empty, the 'Remove Empty Rows/Columns' transformation has removed the column altogether, so now the
first column in the table is 'Part No.".

2. 'Retail Price' is highlighted in red because the commercial terms list from the source table is missing on the
target system.

3. Even though the IDs display in the Part No. column, the values do not match those in the source table due to a
missing attribute transformation that appends '-A' to the ID.
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